ANSYS CFX-Pre User's Guide
Copyright and Trademark Information

© 2011 SAS IP, Inc. All rights reserved. Unauthorized use, distribution or duplication is prohibited.

ANSYS, ANSYS Workbench, Ansoft, AUTODYN, EKM, Engineering Knowledge Manager, CFX, FLUENT, HFSS and any and all ANSYS, Inc. brand, product, service and feature names, logos and slogans are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries in the United States or other countries. ICEM CFD is a trademark used by ANSYS, Inc. under license. CFX is a trademark of Sony Corporation in Japan. All other brand, product, service and feature names or trademarks are the property of their respective owners.

Disclaimer Notice

THIS ANSYS SOFTWARE PRODUCT AND PROGRAM DOCUMENTATION INCLUDE TRADE SECRETS AND ARE CONFIDENTIAL AND PROPRIETARY PRODUCTS OF ANSYS, INC., ITS SUBSIDIARIES, OR LICENSORS. The software products and documentation are furnished by ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement that contains provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting laws, warranties, disclaimers, limitations of liability, and remedies, and other provisions. The software products and documentation may be used, disclosed, transferred, or copied only in accordance with the terms and conditions of that software license agreement. ANSYS, Inc. is certified to ISO 9001:2008.

U.S. Government Rights

For U.S. Government users, except as specifically granted by the ANSYS, Inc. software license agreement, the use, duplication, or disclosure by the United States Government is subject to restrictions stated in the ANSYS, Inc. software license agreement and FAR 12.212 (for non-DOD licenses).

Third-Party Software

See the legal information in the product help files for the complete Legal Notice for ANSYS proprietary software and third-party software. If you are unable to access the Legal Notice, please contact ANSYS, Inc.

Published in the U.S.A.
# Table of Contents

1. **CFX-Pre Basics** .................................................................................................................. 1
   1.1. Starting CFX-Pre ............................................................................................................... 1
   1.2. CFX-Pre Modes of Operation ......................................................................................... 2
   1.3. Working with the CFX-Pre Interface .............................................................................. 3
       1.3.1. Viewer ................................................................................................................... 4
       1.3.2. CFX-Pre Workspace .............................................................................................. 4
           1.3.2.1. Outline Tree View .......................................................................................... 5
           1.3.2.1.1. General Considerations .............................................................................. 5
           1.3.2.1.2. Outline Tree View Structure ...................................................................... 5
           1.3.2.1.2.1. Outline Tree View Shortcut Menu Commands ........................................ 7
       1.3.2.2. Details View ...................................................................................................... 9
       1.3.3. Physics Message Window ....................................................................................... 11
           1.3.3.1. Physics Errors from Old .def/.res Files ....................................................... 12
           1.3.3.2. Physics Message Window Shortcut Menu Commands ................................... 12
       1.3.4. Menu Bar .............................................................................................................. 13
       1.3.5. Toolbar .................................................................................................................. 13
   1.4. CFX-Pre File Types ......................................................................................................... 13

2. **CFX-Pre 3D Viewer** ........................................................................................................ 17
   2.1. Object Visibility ............................................................................................................ 18
   2.2. 3D Viewer Modes and Commands ............................................................................. 19
       2.2.1. 3D Viewer Toolbar ............................................................................................... 19
       2.2.2. Shortcut Menus .................................................................................................... 21
           2.2.2.1. CFX-Pre 3D Viewer Shortcut Menu ............................................................... 22
           2.2.2.1.1. Shortcuts for CFX-Pre (Viewer Background) ............................................. 22
           2.2.2.1.2. Shortcuts for CFX-Pre (Viewer Object) ..................................................... 23
       2.2.3. Viewer Hotkeys ..................................................................................................... 23
       2.2.4. Mouse Button Mapping ....................................................................................... 24
       2.2.5. Picking Mode ....................................................................................................... 26
           2.2.5.1. Selecting Objects ......................................................................................... 26
       2.2.6. Boundary Markers and Labels .......................................................................... 27
           2.2.6.1. Label Options ............................................................................................... 27
           2.2.6.2. Boundary Markers ....................................................................................... 27
           2.2.6.3. Boundary Vectors ......................................................................................... 27
   2.3. Views and Figures ....................................................................................................... 27
       2.3.1. Switching to a View or Figure .............................................................................. 28
       2.3.2. Changing the Definition of a View or Figure ..................................................... 28
   2.4. Stereo Viewer ............................................................................................................. 28

3. **CFX-Pre File Menu** ....................................................................................................... 31
   3.1. New Case Command .................................................................................................... 31
   3.2. Open Case Command .................................................................................................. 32
       3.2.1. Recover Original Session .................................................................................... 32
       3.2.2. Opening Case (.cfx) Files .................................................................................. 33
       3.2.3. Opening CFX-Solver Input (.def,.mdf), Results (.res), Transient (.trn) or Backup (.bak) Files ................................................................. 33
       3.2.4. Opening CCL (.ccl) Files .................................................................................... 33
       3.2.5. Opening Meshing (.cmdb or .dsdb) Files ............................................................ 33
       3.2.6. Opening CFX-Mesh (.gtm) Files ......................................................................... 34
   3.3. Close Command .......................................................................................................... 34
   3.4. Save Case Command ................................................................................................. 34
   3.5. Save Project Command .............................................................................................. 34
   3.6. Refresh Command (ANSYS Workbench only) .......................................................... 34

---

*Release 14.0 - © SAS IP, Inc. All rights reserved. Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.*
4. CFX-Pre Edit Menu

4.1. Undo and Redo ........................................... 41
4.2. Options ................................................ 42
   4.2.1. CFX-Pre Options .................................... 42
       4.2.1.1. General ........................................ 43
           4.2.1.1.1. Auto Generation .......................... 43
           4.2.1.1.2. Physics .................................... 44
       4.2.1.2. Graphics Style ................................. 44
           4.2.1.2.1. Object Highlighting ..................... 44
           4.2.1.2.2. Background ................................ 45
           4.2.1.2.2.1. Color .................................... 45
           4.2.1.2.2.2. Image .................................... 45
       4.2.1.2.3. Colors ....................................... 45
           4.2.1.2.3.1. Labels ................................... 45
           4.2.1.2.3.2. Legend Text and Turbo Axis ........... 45
       4.2.1.2.4. Visibility .................................... 46
           4.2.1.2.4.1. Axis and Ruler Visibility .............. 46
       4.2.1.3. Render .......................................... 46
       4.2.1.4. Mesh ............................................ 46
           4.2.1.4.1. Mesh Import Options ....................... 46
       4.2.1.5. Turbo ........................................... 46
       4.2.1.6. Labels and Markers ............................ 46
           4.2.1.6.1. Labels ..................................... 46
           4.2.1.6.2. Boundary Markers ......................... 46
           4.2.1.6.3. Boundary Vectors .......................... 47
       4.2.1.7. Extensions ....................................... 47
       4.2.1.8. Customization .................................. 47
       4.2.1.9. Solve ........................................... 47
       4.2.1.10. Viewer .......................................... 47
   4.2.2. Common Options .................................... 47
       4.2.2.1. Appearance ..................................... 48
       4.2.2.2. Viewer Setup .................................. 48
           4.2.2.2.1. Double Buffering ......................... 48
           4.2.2.2.2. Unlimited Zoom ............................ 48
       4.2.2.3. Mouse Mapping ................................. 48
       4.2.2.4. Units ........................................... 48

Release 14.0 - © SAS IP Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>CFX-Pre Session Menu</td>
<td>51</td>
</tr>
<tr>
<td>5.1</td>
<td>New Session Command</td>
<td>51</td>
</tr>
<tr>
<td>5.2</td>
<td>Start Recording and Stop Recording Commands</td>
<td>52</td>
</tr>
<tr>
<td>5.3</td>
<td>Play Session and Play Tutorial Commands</td>
<td>52</td>
</tr>
<tr>
<td>5.3.1</td>
<td>Play Session Command</td>
<td>52</td>
</tr>
<tr>
<td>5.3.2</td>
<td>Play Tutorial Command</td>
<td>53</td>
</tr>
<tr>
<td>6</td>
<td>CFX-Pre Insert Menu</td>
<td>55</td>
</tr>
<tr>
<td>7</td>
<td>CFX-Pre Tools Menu</td>
<td>59</td>
</tr>
<tr>
<td>7.1</td>
<td>Command Editor</td>
<td>59</td>
</tr>
<tr>
<td>7.2</td>
<td>Expand Profile Data</td>
<td>59</td>
</tr>
<tr>
<td>7.3</td>
<td>Initialize Profile Data</td>
<td>60</td>
</tr>
<tr>
<td>7.4</td>
<td>Macro Calculator</td>
<td>60</td>
</tr>
<tr>
<td>7.5</td>
<td>Solve</td>
<td>60</td>
</tr>
<tr>
<td>7.5.1</td>
<td>Write Solver Input File Command</td>
<td>61</td>
</tr>
<tr>
<td>7.6</td>
<td>Applications</td>
<td>61</td>
</tr>
<tr>
<td>7.7</td>
<td>Quick Setup Mode</td>
<td>61</td>
</tr>
<tr>
<td>7.8</td>
<td>Turbo Mode</td>
<td>61</td>
</tr>
<tr>
<td>8</td>
<td>CFX-Pre Extensions Menu</td>
<td>63</td>
</tr>
<tr>
<td>9</td>
<td>Importing and Transforming Meshes</td>
<td>65</td>
</tr>
<tr>
<td>9.1</td>
<td>Importing Meshes</td>
<td>65</td>
</tr>
<tr>
<td>9.1.1</td>
<td>Importing Multiple Meshes</td>
<td>65</td>
</tr>
<tr>
<td>9.1.2</td>
<td>Common Import Options</td>
<td>66</td>
</tr>
<tr>
<td>9.1.2.1</td>
<td>Mesh Units</td>
<td>66</td>
</tr>
<tr>
<td>9.1.2.2</td>
<td>Assembly Prefix</td>
<td>66</td>
</tr>
<tr>
<td>9.1.2.3</td>
<td>Primitive Strategy</td>
<td>66</td>
</tr>
<tr>
<td>9.1.2.4</td>
<td>Ignore Invalid Degenerate Elements</td>
<td>66</td>
</tr>
<tr>
<td>9.1.2.5</td>
<td>Duplicate Node Checking</td>
<td>67</td>
</tr>
<tr>
<td>9.1.3</td>
<td>Supported Mesh File Types</td>
<td>67</td>
</tr>
<tr>
<td>9.1.3.1</td>
<td>ANSYS Meshing Files</td>
<td>67</td>
</tr>
<tr>
<td>9.1.3.1.1</td>
<td>Named Selections</td>
<td>68</td>
</tr>
<tr>
<td>9.1.3.1.2</td>
<td>Contact Detection Settings</td>
<td>68</td>
</tr>
<tr>
<td>9.1.3.2</td>
<td>CFX-Mesh Files</td>
<td>69</td>
</tr>
<tr>
<td>9.1.3.3</td>
<td>CFX-Solver Input files</td>
<td>69</td>
</tr>
<tr>
<td>9.1.3.4</td>
<td>ICEM CFD Files</td>
<td>69</td>
</tr>
<tr>
<td>9.1.3.5</td>
<td>ANSYS Files</td>
<td>69</td>
</tr>
<tr>
<td>9.1.3.6</td>
<td>FLUENT Files</td>
<td>70</td>
</tr>
<tr>
<td>9.1.3.6.1</td>
<td>Override Default 2D Mesh Settings</td>
<td>70</td>
</tr>
<tr>
<td>9.1.3.6.1.1</td>
<td>Interpret 2D Mesh as</td>
<td>70</td>
</tr>
<tr>
<td>9.1.3.6.1.1.1</td>
<td>Axisymmetric</td>
<td>70</td>
</tr>
<tr>
<td>9.1.3.6.1.1.2</td>
<td>Planar</td>
<td>70</td>
</tr>
<tr>
<td>9.1.3.6.1.2</td>
<td>Planar</td>
<td>70</td>
</tr>
<tr>
<td>9.1.3.7</td>
<td>CGNS Files</td>
<td>70</td>
</tr>
<tr>
<td>9.1.3.7.1</td>
<td>Importing CGNS files into CFX</td>
<td>71</td>
</tr>
<tr>
<td>9.1.3.7.1.1</td>
<td>Method</td>
<td>71</td>
</tr>
<tr>
<td>9.1.3.7.1.2</td>
<td>Base (Base_t)</td>
<td>71</td>
</tr>
<tr>
<td>9.1.3.7.1.3</td>
<td>Zone (Zone_t)</td>
<td>71</td>
</tr>
<tr>
<td>9.1.3.7.1.4</td>
<td>Elements (ElementSection_t)</td>
<td>71</td>
</tr>
<tr>
<td>9.1.3.7.1.5</td>
<td>Element Types Supported</td>
<td>71</td>
</tr>
<tr>
<td>9.1.3.7.1.6</td>
<td>Boundary Conditions (BC_t)</td>
<td>72</td>
</tr>
<tr>
<td>9.1.3.7.1.7</td>
<td>Families (Family_t, FamilyBC_t, FamilyName_t)</td>
<td>72</td>
</tr>
<tr>
<td>9.1.3.7.1.8</td>
<td>Grid Connectivity (GridConnectivity_t and GridConnectivity1to1_t)</td>
<td>72</td>
</tr>
<tr>
<td>9.1.3.7.1.9</td>
<td>CGNS Data Ignored</td>
<td>72</td>
</tr>
</tbody>
</table>
9.1.3.7.2. Prefix regions with zone name ................................................................. 72
9.1.3.7.3. Create Regions From: Element Sections .................................................. 73
9.1.3.7.4. Create Regions From: Boundary Conditions ............................................. 73
9.1.3.7.5. Create Regions From: Families ............................................................... 73
9.1.3.7.6. Create Regions From: Connectivity Mappings .......................................... 73
9.1.3.7.7. Example of Create Regions From ........................................................... 73
9.1.3.7.8. Read Only One CGNS Base ........................................................................ 73
9.1.3.8. CFX-TASCflow Files .................................................................................... 74
9.1.3.8.1. Convert 3D Region Labels to Regions ......................................................... 74
9.1.3.8.2. Grid Connections Processed (in the .grd file) ............................................. 74
9.1.3.8.3. Grid Embedding ...................................................................................... 75
9.1.3.8.4. Retain Block-off ....................................................................................... 75
9.1.3.8.5. Regions in the .grd file .............................................................................. 75
9.1.3.8.6. Boundary Conditions in .bcf File ............................................................ 76
9.1.3.8.7. Regions in the .gci File .............................................................................. 76
9.1.3.8.8. Importing CFX-TASCflow TurboPre MFR Grids ....................................... 76
9.1.3.8.9. Parameter File ......................................................................................... 76
9.1.3.9. CFX-4 Grid Files ......................................................................................... 76
9.1.3.9.1. Split Symmetry Planes ............................................................................ 77
9.1.3.9.2. Import from Cylindrical Coordinates ....................................................... 77
9.1.3.9.3. Create 2D Regions on .............................................................................. 77
9.1.3.9.4. Create 3D Regions on .............................................................................. 77
9.1.3.9.5. Blocked Off Regions (SOLIDs) ................................................................ 78
9.1.3.9.6. Conducting Solid Regions (SOLCONS) ................................................... 78
9.1.3.9.7. Import 2D Axisymmetric Mesh ............................................................... 78
9.1.3.9.8. Importing MFR Grids .............................................................................. 78
9.1.3.10. CFX-BladeGenPlus Files ........................................................................... 79
9.1.3.11. PATRAN Neutral Files .............................................................................. 79
9.1.3.12. IDEAS Universal Files ............................................................................. 79
9.1.3.13. GridPro/az3000 Grid Files ........................................................................ 79
9.1.3.14. NASTRAN Files ....................................................................................... 80
9.1.3.15. Pointwise Gridgen Files .......................................................................... 80
9.1.3.16. User Import .............................................................................................. 80
9.2. Mesh Tree View ............................................................................................... 81
9.2.1. Shortcut Menu Commands for Meshes and Regions ...................................... 81
9.3. Deleting Meshes and Mesh Components from the Tree View ............................ 81
9.4. Transform Mesh Command ............................................................................. 82
9.4.1. Target Location ............................................................................................. 82
9.4.2. Reference Coord Frame ............................................................................... 83
9.4.3. Transformation: Rotation ............................................................................ 83
9.4.3.1. Rotation Option: Principal Axis ................................................................. 83
9.4.3.2. Rotation Option: Rotation Axis ................................................................. 83
9.4.3.3. Rotation Angle Option .............................................................................. 83
9.4.3.3.1. Specified ................................................................................................. 83
9.4.3.3.2. Full Circle .............................................................................................. 83
9.4.3.3.3. Two Points ............................................................................................ 83
9.4.4. Transformation: Translation .......................................................................... 84
9.4.4.1. Method: Deltas .......................................................................................... 84
9.4.4.2. Method: Vectors ....................................................................................... 84
9.4.5. Transformation: Scale .................................................................................. 84
9.4.5.1. Method: Uniform ....................................................................................... 84
9.4.5.2. Method: Non Uniform ............................................................................... 84
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.4.5.3. Scale Origin</td>
<td>84</td>
</tr>
<tr>
<td>9.4.5.4. Apply Scale To</td>
<td>85</td>
</tr>
<tr>
<td>9.4.6. Transformation: Reflection</td>
<td>85</td>
</tr>
<tr>
<td>9.4.6.1. Method</td>
<td>85</td>
</tr>
<tr>
<td>9.4.6.2. Apply Reflection To</td>
<td>85</td>
</tr>
<tr>
<td>9.4.7. Transformation: Turbo Rotation</td>
<td>86</td>
</tr>
<tr>
<td>9.4.7.1. Rotation Option: Principal Axis</td>
<td>86</td>
</tr>
<tr>
<td>9.4.7.2. Rotation Option: Rotation Axis</td>
<td>86</td>
</tr>
<tr>
<td>9.4.7.3. Rotation Axis Options</td>
<td>86</td>
</tr>
<tr>
<td>9.4.8. Multiple Copies</td>
<td>86</td>
</tr>
<tr>
<td>9.4.8.1. # of Copies</td>
<td>86</td>
</tr>
<tr>
<td>9.4.8.2. Delete Original</td>
<td>87</td>
</tr>
<tr>
<td>9.4.9. Advanced Options</td>
<td>87</td>
</tr>
<tr>
<td>9.4.9.1. Glue Adjacent Meshes</td>
<td>87</td>
</tr>
<tr>
<td>9.4.10. Automatic Transformation Preview</td>
<td>88</td>
</tr>
<tr>
<td>9.5. Gluing Meshes Together</td>
<td>88</td>
</tr>
<tr>
<td>9.6. Mesh Editor</td>
<td>88</td>
</tr>
<tr>
<td>9.7. Render Options</td>
<td>88</td>
</tr>
<tr>
<td>9.7.1. Render Options Dialog Box</td>
<td>89</td>
</tr>
<tr>
<td>9.7.1.1. Draw Faces</td>
<td>89</td>
</tr>
<tr>
<td>9.7.1.2. Face Color</td>
<td>89</td>
</tr>
<tr>
<td>9.7.1.3. Transparency</td>
<td>89</td>
</tr>
<tr>
<td>9.7.1.4. Draw Mode/Surface Drawing</td>
<td>89</td>
</tr>
<tr>
<td>9.7.1.4.1. Flat Shading</td>
<td>89</td>
</tr>
<tr>
<td>9.7.1.4.2. Smooth Shading</td>
<td>89</td>
</tr>
<tr>
<td>9.7.1.5. Face Culling</td>
<td>89</td>
</tr>
<tr>
<td>9.7.1.5.1. Front Faces</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.5.2. Back Faces</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.5.3. No Culling</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.6. Lighting</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.7. Specular</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.8. Draw Lines</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.9. Edge Angle/Render Edge Angle</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.10. Line Width</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.11. Line Color</td>
<td>90</td>
</tr>
<tr>
<td>9.7.1.12. Visibility</td>
<td>90</td>
</tr>
<tr>
<td>9.7.2. Render Options - Multiple 2D Regions</td>
<td>90</td>
</tr>
<tr>
<td>9.8. Mesh Topology in CFX-Pre</td>
<td>91</td>
</tr>
<tr>
<td>9.8.1. Assemblies, Primitive Regions, and Composite Regions</td>
<td>91</td>
</tr>
<tr>
<td>9.8.1.1. Composite Regions</td>
<td>92</td>
</tr>
<tr>
<td>9.8.1.1.1. Applications of the Composite Regions</td>
<td>92</td>
</tr>
<tr>
<td>9.8.2. Domain and Subdomain Locations</td>
<td>92</td>
</tr>
<tr>
<td>9.8.3. Boundary Condition and Domain Interface Locations</td>
<td>93</td>
</tr>
<tr>
<td>9.8.4. Importing Multi-domain Cases</td>
<td>93</td>
</tr>
<tr>
<td>9.9. Advanced Topic: cfx5gmconv Application</td>
<td>93</td>
</tr>
<tr>
<td>10. Regions</td>
<td>95</td>
</tr>
<tr>
<td>10.1. Primitive Regions</td>
<td>95</td>
</tr>
<tr>
<td>10.2. Composite Regions</td>
<td>95</td>
</tr>
<tr>
<td>10.3. Using Regions in CFX-Pre</td>
<td>96</td>
</tr>
<tr>
<td>10.4. Editing Regions in CFX-Pre</td>
<td>96</td>
</tr>
<tr>
<td>10.4.1. Defining and Editing Primitive Regions</td>
<td>96</td>
</tr>
<tr>
<td>10.4.1.1. Advanced Options</td>
<td>98</td>
</tr>
</tbody>
</table>
12.4.2.3.1. Homogeneous Model ................................................................. 115
12.4.2.3.2. Turbulence: Option ................................................................. 115
12.4.2.3.3. Buoyancy Turbulence ............................................................... 116
12.4.2.3.4. Wall Function ........................................................................ 116
12.4.2.3.5. Turbulent Flux Closure for Heat Transfer ............................... 116
12.4.2.4. Reaction or Combustion Model ................................................. 116
  12.4.2.4.1. Soot Model ........................................................................... 117
12.4.2.5. Thermal Radiation Model ........................................................... 117
12.4.2.6. Electromagnetic Model ............................................................... 118
12.4.2.7. Component Details ..................................................................... 118
12.4.2.8. Additional Variable Details ....................................................... 119
12.4.3. Polydisperse Fluid Tab ................................................................. 119
12.4.4. Fluid Specific Models Tab ............................................................. 119
  12.4.4.1. Fluid List Box ........................................................................... 120
  12.4.4.2. Kinetic Theory ........................................................................ 120
  12.4.4.3. Heat Transfer ........................................................................... 120
    12.4.4.3.1. Heat Transfer Option: Particle Temperature ....................... 121
  12.4.4.4. Turbulence Model ................................................................... 121
  12.4.4.5. Turbulent Wall Functions ......................................................... 121
  12.4.4.6. Combustion Model .................................................................. 121
  12.4.4.7. Erosion Model ........................................................................ 121
  12.4.4.8. Fluid Buoyancy Model ............................................................... 121
  12.4.4.9. Solid Pressure Model ................................................................. 121
  12.4.4.10. Component Details ................................................................. 122
  12.4.4.11. Additional Variable Models ................................................. 122
12.4.5. Fluid Pair Models Tab ................................................................. 122
  12.4.5.1. Fluid Pair List Box ................................................................... 122
  12.4.5.2. Particle Coupling .................................................................. 122
  12.4.5.3. Surface Tension Coefficient .................................................... 122
  12.4.5.4. Surface Tension Force Model .................................................. 123
12.4.5.5. Interphase Transfer Model .......................................................... 123
  12.4.5.5.1. Particle Model ..................................................................... 123
  12.4.5.5.2. Mixture Model ..................................................................... 123
  12.4.5.5.3. Free Surface Model ............................................................... 123
  12.4.5.5.4. None .................................................................................... 123
12.4.5.6. Momentum Transfer ................................................................. 123
  12.4.5.6.1. Drag Force ........................................................................... 124
  12.4.5.6.2. Particle User Source ............................................................... 124
  12.4.5.6.3. Lift Force ............................................................................. 124
  12.4.5.6.4. Virtual Mass Force ................................................................. 124
  12.4.5.6.5. Wall Lubrication Force .......................................................... 124
  12.4.5.6.6. Turbulent Dispersion Force .................................................. 124
  12.4.5.6.7. Pressure Gradient Force ........................................................ 125
12.4.5.7. Turbulence Transfer ................................................................. 125
12.4.5.8. Heat Transfer ........................................................................... 125
12.4.5.9. Mass Transfer ........................................................................... 125
12.4.5.10. Additional Variable Pairs .......................................................... 125
  12.4.5.11. Component Pairs ................................................................. 125
    12.4.5.11.1. Eulerian | Eulerian Pairs .................................................... 126
    12.4.5.11.2. Continuous | Particle Pairs ................................................ 126
  12.4.5.12. Particle Breakup ................................................................. 127
12.4.5.13. Particle Collision ................................................................. 127
13. Domain Interfaces ................................................. 137
   13.1. Creating and Editing a Domain Interface ................. 137
       13.1.1. Domain Interface: Basic Settings Tab ............... 138
           13.1.1.1. Interface Type ................................................. 138
           13.1.1.2. Interface Side 1/2 ................................................. 138
               13.1.1.2.1. Domain (Filter) ................................................. 138
               13.1.1.2.2. Region List ................................................. 139
           13.1.1.3. Interface Models ................................................. 139
               13.1.1.3.1. Interface Model Option: Translational Periodicity .......... 139
               13.1.1.3.2. Interface Model Option: Rotational Periodicity .......... 139
               13.1.1.3.3. Interface Model Option: General Connection .......... 139
                   13.1.1.3.3.1. Frame Change/Mixing Model ................. 139
                       13.1.1.3.3.1.1. Option ................................................. 139
                       13.1.1.3.3.1.2. Frozen Rotor: Rotational Offset Check Box .......... 139
               13.1.1.3.3.1.3. Stage: Pressure Profile Decay Check Box .......... 140
               13.1.1.3.3.1.4. Stage: Constant Total Pressure Check Box .......... 140
           13.1.1.3.2. Pitch Change Options ................................................. 140
               13.1.1.3.2.1. Pitch Change: Value: Pitch Ratio .......... 140
               13.1.1.3.2.2. Pitch Change: Specified Pitch Angles: Pitch Angle Side 1/2 .......... 140
       13.1.2. Domain Interface: Additional Interface Models Tab .......... 140
           13.1.2.1. Mass And Momentum ................................................. 140
                   13.1.2.1.1.1. None ................................................. 141
                   13.1.2.1.1.2. Mass Flow Rate ................................................. 141
               13.1.2.1.1.2.1. Pressure Update Multiplier .......... 141
               13.1.2.1.1.3. Pressure Change ................................................. 141
               13.1.2.1.2. No Slip Wall ................................................. 141

12.4.6. Solid Models Tab ................................................. 128
   12.4.6.1. Heat Transfer ................................................. 128
   12.4.6.2. Thermal Radiation Model ................................................. 128
   12.4.6.3. Electromagnetic Model ................................................. 128
   12.4.6.4. Additional Variables Models ................................................. 128
   12.4.6.5. Solid Motion ................................................. 128
   12.4.7. Porosity Settings Tab ................................................. 129
       12.4.7.1. Area Porosity ................................................. 129
       12.4.7.2. Volume Porosity ................................................. 130
       12.4.7.3. Loss Models ................................................. 130
       12.4.7.4. Contact Area Model ................................................. 130
       12.4.7.5. Fluid Solid Area Density ................................................. 131
       12.4.7.6. Fluid Solid Heat Transfer ................................................. 131
       12.4.7.7. Additional Variable Pair Details ................................................. 131
   12.4.8. Particle Injection Regions Tab ................................................. 131
       12.4.8.1. Particle Injection Regions List Box ................................................. 131
       12.4.8.2. Coordinate Frame ................................................. 131
       12.4.8.3. Fluid: List Box ................................................. 132
       12.4.8.4. [fluid name] Check Box ................................................. 132
           12.4.8.4.1. Injection Method ................................................. 132
               12.4.8.4.1.1. Settings for Cone Definition ................................................. 133
               12.4.8.4.1.2. Settings for Injection Velocity ................................................. 133
               12.4.8.4.1.3. Settings for Particle Primary Breakup ................................................. 134
       12.4.9. Initialization Tab ................................................. 135
       12.4.10. Solver Control Tab ................................................. 135
14. Boundary Conditions .................................................. 149
   14.1. Default Boundary Condition ........................................... 149
   14.2. Creating and Editing a Boundary Condition ...................... 150
      14.2.1. Boundary Basic Settings Tab .................................. 150
          14.2.1.1. Boundary Type ................................................. 151
          14.2.1.2. Location ...................................................... 151
          14.2.1.3. Coord Frame ................................................... 151
          14.2.1.4. Frame Type .................................................... 151
          14.2.1.5. Profile Boundary Conditions .................................. 151
             14.2.1.5.1. Use Profile Data ....................................... 152
                14.2.1.5.1.1. Initializing Profile Data ......................... 152
                14.2.1.5.1.2. Profile Boundary Setup ......................... 152
          14.2.2. Boundary Details Tab ........................................... 152
             14.2.2.1. Boundary Details: Inlet .................................... 153
                14.2.2.1.1. Flow Regime: Inlet .................................... 153
       13.1.2.2. Heat Transfer .................................................. 142
          13.1.2.2.1. Conservative Interface Flux: Interface Model .............. 142
             13.1.2.2.1.1. None ................................................... 142
             13.1.2.2.1.2. Interface Model Option: Thermal Contact Resistance .... 142
             13.1.2.2.1.3. Interface Model Option: Thin Material .................. 142
             13.1.2.2.1.4. Side Dependent ....................................... 142
          13.1.2.2.2. Side Dependent .............................................. 142
      13.1.2.3. Electric Field .................................................. 142
          13.1.2.3.1. Conservative Interface Flux: Interface Model .............. 143
             13.1.2.3.1.1. None ................................................... 143
             13.1.2.3.1.2. Interface Model Option: Electric Field Contact Resistance .... 143
             13.1.2.3.2. Side Dependent ........................................... 143
      13.1.2.4. Additional Variable .............................................. 143
          13.1.2.4.1. Conservative Interface Flux: Interface Model .............. 143
             13.1.2.4.1.1. None ................................................... 143
             13.1.2.4.1.2. Interface Model Option: Additional Variable Contact Resistance .... 143
             13.1.2.4.2. Side Dependent ........................................... 143
      13.1.2.5. Conditional Connection Control ................................ 143
          13.1.3. Domain Interface: Solid Interface Models Tab .................. 144
             13.1.3.1. Heat Transfer .................................................. 144
                13.1.3.1.1. Conservative Interface Flux: Interface Model .............. 144
                   13.1.3.1.1.1. None ................................................... 144
                   13.1.3.1.1.2. Interface Model Option: Thermal Contact Resistance .... 144
                   13.1.3.1.1.3. Interface Model Option: Thin Material .................. 144
                   13.1.3.1.2. Side Dependent ....................................... 144
                13.1.3.2. Additional Variable ........................................... 144
                   13.1.3.2.1. Conservative Interface Flux: Interface Model .............. 145
                      13.1.3.2.1.1. None ................................................... 145
                      13.1.3.2.1.2. Interface Model Option: Additional Variable Contact Resistance .... 145
                      13.1.3.2.2. Side Dependent ....................................... 145
             13.1.4. Domain Interface: Mesh Connection Tab ......................... 145
                13.1.4.1. Mesh Connection Method ................................... 145
                   13.1.4.1.1. Mesh Connection: Option ................................ 145
                   13.1.4.1.2. Intersection Control ................................... 145
                      13.1.4.1.2.1. Intersection Control: Option ....................... 146
14. Boundary Conditions .................................................. 149
   14.1. Default Boundary Condition ........................................... 149
   14.2. Creating and Editing a Boundary Condition ...................... 150
      14.2.1. Boundary Basic Settings Tab .................................. 150
          14.2.1.1. Boundary Type ................................................. 151
          14.2.1.2. Location ...................................................... 151
          14.2.1.3. Coord Frame ................................................... 151
          14.2.1.4. Frame Type .................................................... 151
          14.2.1.5. Profile Boundary Conditions .................................. 151
             14.2.1.5.1. Use Profile Data ....................................... 152
                14.2.1.5.1.1. Initializing Profile Data ......................... 152
                14.2.1.5.1.2. Profile Boundary Setup ......................... 152
          14.2.2. Boundary Details Tab ........................................... 152
             14.2.2.1. Boundary Details: Inlet .................................... 153
                14.2.2.1.1. Flow Regime: Inlet .................................... 153
13.1.3. Domain Interface: Solid Interface Models Tab .................. 144
   13.1.3.1. Heat Transfer .................................................. 144
      13.1.3.1.1. Conservative Interface Flux: Interface Model .............. 144
          13.1.3.1.1.1. None ................................................... 144
          13.1.3.1.1.2. Interface Model Option: Thermal Contact Resistance .... 144
          13.1.3.1.1.3. Interface Model Option: Thin Material .................. 144
      13.1.3.2. Additional Variable ........................................... 144
          13.1.3.2.1. Conservative Interface Flux: Interface Model .............. 145
             13.1.3.2.1.1. None ................................................... 145
             13.1.3.2.1.2. Interface Model Option: Additional Variable Contact Resistance .... 145
             13.1.3.2.2. Side Dependent ....................................... 145
      13.1.4. Domain Interface: Mesh Connection Tab ......................... 145
         13.1.4.1. Mesh Connection Method ................................... 145
            13.1.4.1.1. Mesh Connection: Option ................................ 145
            13.1.4.1.2. Intersection Control ................................... 145
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.2.2.1.2. Mesh Motion: Inlet</td>
<td>153</td>
</tr>
<tr>
<td>14.2.2.2. Boundary Details: Outlet</td>
<td>153</td>
</tr>
<tr>
<td>14.2.2.2.1. Flow Regime: Outlet</td>
<td>153</td>
</tr>
<tr>
<td>14.2.2.2.2. Mass and Momentum: Outlet</td>
<td>153</td>
</tr>
<tr>
<td>14.2.2.2.3. Pressure Averaging: Outlet</td>
<td>153</td>
</tr>
<tr>
<td>14.2.2.2.4. Thermal Radiation: Outlet</td>
<td>153</td>
</tr>
<tr>
<td>14.2.2.2.5. Mesh Motion: Outlet</td>
<td>153</td>
</tr>
<tr>
<td>14.2.2.3. Boundary Details: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.3.1. Mass and Momentum: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.3.2. Flow Direction: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.3.3. Loss Coefficient: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.3.4. Turbulence: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.3.5. Heat Transfer: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.3.6. Thermal Radiation: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.3.7. Component Details: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.3.8. Mesh Motion: Opening</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.4. Boundary Details: Wall</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.4.1. Mass And Momentum</td>
<td>154</td>
</tr>
<tr>
<td>14.2.2.4.1.1. Slip Model Settings</td>
<td>155</td>
</tr>
<tr>
<td>14.2.2.4.1.2. Shear Stress Settings</td>
<td>155</td>
</tr>
<tr>
<td>14.2.2.4.1.3. Wall Velocity Settings</td>
<td>155</td>
</tr>
<tr>
<td>14.2.2.4.1.3.1. Axis Definition</td>
<td>155</td>
</tr>
<tr>
<td>14.2.2.4.2. Wall Roughness</td>
<td>155</td>
</tr>
<tr>
<td>14.2.2.4.3. Solid Motion:Wall</td>
<td>155</td>
</tr>
<tr>
<td>14.2.2.4.4. Heat Transfer: Wall</td>
<td>156</td>
</tr>
<tr>
<td>14.2.2.4.5. Thermal Radiation: Wall</td>
<td>156</td>
</tr>
<tr>
<td>14.2.2.4.6. Mesh Motion:Wall</td>
<td>156</td>
</tr>
<tr>
<td>14.2.2.4.7. Additional Coupling Sent Data</td>
<td>156</td>
</tr>
<tr>
<td>14.2.2.5. Boundary Details: Symmetry</td>
<td>156</td>
</tr>
<tr>
<td>14.2.2.6. Boundary Details: Interfaces</td>
<td>156</td>
</tr>
<tr>
<td>14.2.2.7. Mesh Motion</td>
<td>156</td>
</tr>
<tr>
<td>14.2.3. Boundary Fluid Values Tab</td>
<td>157</td>
</tr>
<tr>
<td>14.2.3.1. Fluid Values:Turbulence</td>
<td>157</td>
</tr>
<tr>
<td>14.2.3.1.1. Intensity and Length Scale</td>
<td>158</td>
</tr>
<tr>
<td>14.2.3.1.2. Intensity and Eddy Viscosity Ratio</td>
<td>158</td>
</tr>
<tr>
<td>14.2.3.1.3. k and Epsilon</td>
<td>158</td>
</tr>
<tr>
<td>14.2.3.1.4. Intensity and Auto Compute Length</td>
<td>158</td>
</tr>
<tr>
<td>14.2.3.2. Fluid Values: Volume Fraction</td>
<td>158</td>
</tr>
<tr>
<td>14.2.3.3. Fluid Values: Heat Transfer</td>
<td>158</td>
</tr>
<tr>
<td>14.2.3.4. Fluid Values for Inlets and Openings</td>
<td>158</td>
</tr>
<tr>
<td>14.2.3.4.1. Multiphase</td>
<td>158</td>
</tr>
<tr>
<td>14.2.3.4.2. MUSIG settings</td>
<td>159</td>
</tr>
<tr>
<td>14.2.3.4.3. Particle Tracking Settings for Inlets and Openings</td>
<td>159</td>
</tr>
<tr>
<td>14.2.3.4.3.1. Phase List</td>
<td>159</td>
</tr>
<tr>
<td>14.2.3.4.3.2. Particle Behavior</td>
<td>159</td>
</tr>
<tr>
<td>14.2.3.4.3.3. Mass and Momentum</td>
<td>159</td>
</tr>
<tr>
<td>14.2.3.4.3.4. Particle Position</td>
<td>160</td>
</tr>
<tr>
<td>14.2.3.4.3.5. Particle Locations</td>
<td>160</td>
</tr>
<tr>
<td>14.2.3.4.3.6. Number of Positions</td>
<td>160</td>
</tr>
<tr>
<td>14.2.3.4.3.7. Particle Mass Flow</td>
<td>160</td>
</tr>
<tr>
<td>14.2.3.4.3.8. Particle Diameter Distribution</td>
<td>160</td>
</tr>
<tr>
<td>14.2.3.4.3.9. Heat Transfer</td>
<td>160</td>
</tr>
</tbody>
</table>
15. Initialization .................................................. 167
  15.1. Using the User Interface .......................................................... 167
    15.1.1. Domain: Initialization Tab ................................................. 167
      15.1.1.1. Domain Initialization .................................................. 168
    15.1.2. Global Settings and Fluid Settings Tabs ............................... 168
      15.1.2.1. Coord Frame Check Box .................................................. 168
        15.1.2.1.1. Coord Frame Check Box: Coord Frame ......................... 168
      15.1.2.2. Frame Type Check Box .................................................. 168
        15.1.2.2.1. Frame Type ............................................................ 168
      15.1.2.3. Initial Conditions: Velocity Type .................................. 168
        15.1.2.4. Initial Conditions: Cartesian Velocity Components ........... 169
          15.1.2.4.1. Option ............................................................... 169
          15.1.2.4.2. Velocity Scale Check Box ....................................... 169
            15.1.2.4.2.1. Velocity Scale Check Box: Value ......................... 169
          15.1.2.4.3. U, V, W ............................................................. 169
      15.1.2.5. Initial Conditions: Cylindrical Velocity Components .......... 169
        15.1.2.5.1. Option ............................................................... 169
        15.1.2.5.2. Velocity Scale Check Box ....................................... 169
        15.1.2.5.3. Axial Component, Radial Component, Theta Component .......... 170
    15.1.2.6. Initial Conditions: Static Pressure .................................. 170
      15.1.2.6.1. Option ............................................................... 170
      15.1.2.6.2. Relative Pressure .................................................. 170
    15.1.2.7. Initial Conditions: Turbulence ....................................... 170
      15.1.2.7.1. Fractional Intensity .................................................. 171
15.1.2.7.2. Eddy Viscosity Ratio .................................................. 171
15.1.2.7.3. Eddy Length Scale .................................................. 171
15.1.2.7.4. Turbulence Kinetic Energy ........................................ 171
15.1.2.7.5. Turbulence Eddy Dissipation ..................................... 172
15.1.2.7.6. Turbulence Eddy Frequency ....................................... 172
15.1.2.7.7. Reynolds Stress Components ..................................... 172
15.1.2.8. Initial Conditions: Temperature ...................................... 172
15.1.2.9. Initial Conditions: Radiation Intensity ................................. 173
15.1.2.9.1. Option ..................................................................... 173
15.1.2.10. Initial Conditions: Mixture Fraction ................................ 173
15.1.2.10.1. Option ................................................................... 173
15.1.2.10.2. Mixture Fraction ..................................................... 173
15.1.2.11. Initial Conditions: Mixture Fraction Variance ....................... 173
15.1.2.11.1. Option .................................................................. 173
15.1.2.11.2. Mix. Fracn. Variance ................................................. 174
15.1.2.12. Initial Conditions: Component Details ................................. 174
15.1.2.12.1. List Box .................................................................. 174
15.1.2.12.2. [component name]: Option ......................................... 174
15.1.2.12.3. [component name]: Mass Fraction ................................ 174
15.1.2.13. Initial Conditions: Additional Variable Details .................... 174
15.1.2.14. Fluid Specific Initialization ............................................ 174
15.1.2.15. Fluid Specific Initialization: List Box .................................. 174
15.1.2.16. Fluid Specific Initialization: [fluid name] Check Box .............. 174
15.1.2.17. Fluid Specific Initialization: [fluid name] Check Box: Initial Conditions .................................................. 175
15.1.2.17.1. Velocity Type .......................................................... 175
15.1.2.17.2. Volume Fraction: Option ............................................ 175
15.1.2.17.3. Volume Fraction: Volume Fraction ................................ 175
15.1.2.18. Solid Specific Initialization .............................................. 175
15.1.2.19. Solid Specific Initialization: List Box .................................. 175
15.1.2.20. Solid Specific Initialization: [solid name] Check Box .............. 175
16. Source Points .......................................................... 177
16.1. Basic Settings Tab ........................................................... 177
16.2. Sources Tab ................................................................. 177
16.2.1. Single-Phase Fluid Sources ............................................. 177
16.2.1.1. Component Mass Fractions .......................................... 178
16.2.1.2. Additional Variables .................................................... 178
16.2.1.3. Continuity ................................................................. 178
16.2.1.3.1. Continuity Option ..................................................... 178
16.2.1.3.2. Additional Variables ................................................ 178
16.2.1.3.3. Component Mass Fractions ........................................ 178
16.2.1.3.4. Temperature ........................................................ 178
16.2.1.3.5. Velocity ............................................................... 179
16.2.1.4. Energy ................................................................. 179
16.2.1.5. Turbulence Eddy Dissipation or Turbulence Kinetic Energy ....... 179
16.2.2. Multiphase Bulk Sources ................................................ 179
16.2.3. Multiplying Sources by Porosity ........................................... 179
16.3. Fluid Sources Tab ............................................................ 179
16.4. Sources in Solid Domains .................................................... 179
16.5. Source Points and Mesh Deformation ....................................... 180
17. Subdomains ............................................................ 181
17.1. Creating New Subdomains ............................................... 181
17.2. The Subdomains Tab ...................................................... 182
17.3. Basic Settings Tab ................................................................. 182
  17.3.1. Location ........................................................................... 182
  17.3.2. Coordinate Frame ............................................................. 182
17.4. Sources Tab ......................................................................... 182
  17.4.1. Single-Phase Fluid Sources .............................................. 182
      17.4.1.1. Momentum Source/Porous Loss ................................ 183
      17.4.1.2. Equation Sources ..................................................... 183
          17.4.1.2.1. Component Mass Fractions .............................. 183
          17.4.1.2.2. Additional Variables ...................................... 183
          17.4.1.2.3. Continuity ......................................................... 184
          17.4.1.2.4. Turbulence Quantities ....................................... 184
          17.4.1.2.5. Energy .............................................................. 185
      17.4.2. Bulk Sources for Multiphase Simulations ....................... 185
      17.4.3. Multiplying Sources by Porosity .................................... 185

17.5. Fluids Tab ......................................................................... 185
  17.5.1. Particle Absorption .......................................................... 185
17.6. Mesh Motion ....................................................................... 185

18. Rigid Bodies .......................................................................... 187
  18.1. Rigid Body User Interface ................................................... 187
      18.1.1. Insert Rigid Body Dialog Box ....................................... 187
      18.1.2. Basic Settings Tab ......................................................... 188
          18.1.2.1. Mass .................................................................... 188
          18.1.2.2. Location ................................................................. 188
          18.1.2.3. Coord Frame .......................................................... 188
          18.1.2.4. Mass Moment of Inertia ........................................ 189
      18.1.3. Dynamics Tab ................................................................. 189
          18.1.3.1. External Force Definitions ........................................ 189
          18.1.3.2. External Torque Definitions ..................................... 190
          18.1.3.3. Degrees of Freedom ............................................... 191
              18.1.3.3.1. Translational Degrees of Freedom ................. 191
              18.1.3.3.2. Rotational Degrees of Freedom .................... 191
          18.1.3.4. Gravity ................................................................. 191
      18.1.4. Initial Conditions Tab .................................................... 191
          18.1.4.1. Center of Mass ...................................................... 192
          18.1.4.2. Linear Velocity ...................................................... 192
          18.1.4.3. Angular Velocity ................................................... 192
          18.1.4.4. Linear Acceleration ............................................... 192
          18.1.4.5. Angular Acceleration ............................................ 192

19. Units and Dimensions .............................................................. 193
  19.1. Units Syntax .................................................................... 193
  19.2. Using Units in CFX-Pre ...................................................... 194
      19.2.1. Units Commonly Used in CFX .................................... 194
      19.2.2. Defining Your Own Units .......................................... 197
  19.3. Setting the Solution Units .................................................. 197

20. Solver Control ...................................................................... 199
  20.1. Basic Settings Tab ............................................................. 199
      20.1.1. Basic Settings: Common ............................................. 199
          20.1.1.1. Advection Scheme ............................................. 199
          20.1.1.2. Turbulence Numerics ......................................... 199
          20.1.1.3. Convergence Criteria .......................................... 200
          20.1.1.4. Elapsed Wall Clock Time Control ......................... 200
          20.1.1.5. Interrupt Control ............................................... 200
21. Output Control ............................................................................. 213

21.1. User Interface ........................................................................ 213

21.1.1. Results Tab .......................................................................... 213

21.1.1.1. Option ............................................................................. 213

21.1.1.2. File Compression .............................................................. 214

21.1.1.3. Output Variable List ........................................................ 214

21.1.1.4. Output Equation Residuals Check Box ................................ 214

21.1.1.5. Output Boundary Flows Check Box ...................................... 214

21.1.1.6. Extra Output Variables List ............................................... 214

21.1.1.7. Extra Output Variables List ............................................... 214

21.1.1.8. Output Particle Boundary Vertex Fields Check Box ............ 214

21.1.2. Backup Tab ......................................................................... 214

21.1.2.1. List Box ......................................................................... 214

21.1.2.2. [Backup Results Name] .................................................... 214

21.1.2.2.1. Option .......................................................................... 214

21.1.2.2.2. File Compression .......................................................... 215

21.1.2.2.3. Output Variables List .................................................... 215

21.1.2.2.4. Output Equation Residuals Check Box ............................ 215

21.1.2.2.5. Output Boundary Flows Check Box ............................... 215

21.1.2.2.6. Output Variable Operators Check Box ............................. 215

21.1.2.2.7. Extra Output Variables List .......................................... 215

21.1.2.2.8. Output Particle Boundary Vertex Fields Check Box .......... 215

21.1.2.2.9. Include Tracks of One-way Coupled Particles Check Box .... 215

21.1.2.2.10. Output Frequency: Option ........................................... 215

21.1.3. Transient Results Tab ............................................................ 215

21.1.3.1. List Box ......................................................................... 215

21.1.3.2. [Transient Results Name] .................................................. 215

21.1.3.2.1. Option .......................................................................... 216

21.1.3.2.2. File Compression .......................................................... 216

21.1.3.2.3. Output Variables List .................................................... 216

21.1.3.2.4. Include Mesh ................................................................. 216

21.1.3.2.5. Output Equation Residuals Check Box ............................ 216
21.1.6. Particles Tab ................................................. ................................................... ................... 224
21.1.6.1. Particle Track File Check Box .......................................................... 224
21.1.6.1.1. Option .......................................................................................... 224
21.1.6.1.2. Track Positions Check Box .......................................................... 225
21.1.6.1.3. Track Positions Check Box: Track Positions ........................................... 225
21.1.6.1.4. Interval .......................................................................................... 225
21.1.6.1.5. Track Distance Spacing ................................................................. 225
21.1.6.1.6. Track Time Spacing ........................................................................ 225
21.1.6.1.7. Track Printing Interval Check Box ................................................... 225
21.1.6.1.8. Track Printing Interval Check Box: Interval ........................................ 225
21.1.6.1.9. Keep Track File Check Box ............................................................. 226
21.1.6.1.10. Track File Format Check Box .......................................................... 226
21.1.6.1.11. Track File Format Check Box: Track File Format Check Box ............... 226
21.1.6.2. Transient Particle Diagnostics ......................................................... 227
21.1.6.3. Transient Particle Diagnostics: List Box .............................................. 227
21.1.6.4. Transient Particle Diagnostics: [Transient Particle Diagnostics Name] ........ 227
21.1.6.4.1. Option .......................................................................................... 227
21.1.6.4.2. Particles List .................................................................................. 227
21.1.6.4.3. Spray Mass Frac. .......................................................................... 227
21.1.6.4.4. Penetration Origin and Direction: Option ............................................. 227
21.1.6.4.5. Penetration Origin and Direction: Injection Center .................................. 227
21.1.6.4.6. Penetration Origin and Direction: Injection Direction ................................ 227
21.1.6.4.6.1. Option ....................................................................................... 227
21.1.6.4.7. Axial Penetration: Option .................................................................. 227
21.1.6.4.8. Radial Penetration: Option ............................................................. 228
21.1.6.4.9. Normal Penetration: Option ............................................................ 228
21.1.6.4.10. Spray Angle: Option ...................................................................... 228
21.1.6.4.10.1. Spray Angle: Spray Radius at Penetration Origin Check Box .......... 228
21.1.6.4.10.2. Spray Angle: Spray Radius at Penetration Origin Check Box: Spray Radi... 228
21.1.7. Export Results Tab ............................................................................... 228
21.1.7.1. List Box ............................................................................................ 228
21.1.7.2. [Export Name]: Export Format ......................................................... 229
21.1.7.2.1. Filename Prefix Check Box ............................................................. 229
21.1.7.2.2. Filename Prefix Check Box: Filename Prefix ....................................... 229
21.1.7.3. [Export Name]: Export Frequency ...................................................... 229
21.1.7.3.1. Option .......................................................................................... 229
21.1.7.4. [Export Name]: Export Surface .......................................................... 229
21.1.7.4.1. List Box .......................................................................................... 229
21.1.7.4.2. [Export Surface Name]: Option ......................................................... 229
21.1.7.4.3. [Export Surface Name]: Output Boundary List ..................................... 229
21.1.7.4.4. [Export Surface Name]: Output Variables List .................................. 230
21.1.7.4.5. [Export Surface Name]: Output Nodal Area Vectors Check Box .......... 230
21.1.8. Common Settings .................................................................................. 230
21.1.8.1. Option ............................................................................................... 230
21.1.8.2. File Compression ............................................................................... 230
21.1.8.3. Output Variables List .......................................................... 231
21.1.8.4. Output Equation Residuals Check Box .................................................. 231
21.1.8.5. Output Boundary Flows Check Box .................................................. 231
21.1.8.6. Output Variable Operators Check Box .................................................. 231
21.1.8.7. Output Particle Boundary Vertex Fields Check Box .................................................. 231
21.1.8.8. Output Frequency Options .................................................. 232
   21.1.8.8.1. Timestep Interval .................................................. 232
   21.1.8.8.2. Timestep List .................................................. 232
   21.1.8.8.3. Time Interval .................................................. 232
   21.1.8.8.4. Time List .................................................. 232
   21.1.8.8.5. Every Timestep .................................................. 232
   21.1.8.8.6. Every Iteration .................................................. 232
   21.1.8.8.7. Iteration Interval .................................................. 232
   21.1.8.8.8. Iteration List .................................................. 232
   21.1.8.8.9. Wall Clock Time Interval .................................................. 232
   21.1.8.8.10. Coupling Step Interval .................................................. 233
   21.1.8.8.11. Every Coupling Step .................................................. 233
   21.1.8.8.12. None .................................................. 233
21.2. Working with Output Control .................................................. 233
   21.2.1. Working with Transient Statistics .................................................. 233
      21.2.1.1. Statistic Initialization and Accumulation .................................................. 233
      21.2.1.2. Statistics as Variable Operators .................................................. 234
      21.2.1.3. Using Statistics with Transient Rotor-Stator Cases .................................................. 235
   21.2.2. Working with Monitors .................................................. 235
      21.2.2.1. Setting up Monitors .................................................. 235
      21.2.2.2. Transient/ Mesh Deformation Runs .................................................. 235
      21.2.2.3. Output Information .................................................. 235
      21.2.2.4. Expression .................................................. 236
      21.2.2.5. Viewing Monitor Values during a Run .................................................. 236
      21.2.2.6. Viewing Monitor Point Values after a Run .................................................. 236
   21.2.3. Working with Export Results .................................................. 237
      21.2.3.1. File Naming Conventions .................................................. 237
      21.2.3.2. Propagating Older Time Step Values .................................................. 237
      21.2.3.3. Output Boundary List and Output Region Naming .................................................. 237
      21.2.3.4. Output Variables List .................................................. 238
22. Transient Blade Row Models .................................................. 239
   22.1. Inserting a New Transient Blade Row Models Object .................................................. 239
   22.2. Transient Blade Row Models Tab .................................................. 239
      22.2.1. Transient Blade Row Model Settings .................................................. 239
         22.2.1.1. Time Transformation Disturbance Settings .................................................. 240
         22.2.1.2. Fourier Transformation Disturbance Settings .................................................. 241
      22.2.2. Transient Details .................................................. 242
23. Mesh Adaption .......................................................... 245
   23.1. Overview .......................................................... 245
   23.2. Setting Up Mesh Adaption .................................................. 246
   23.3. The Details View for Mesh Adaption .................................................. 247
      23.3.1. Basic Settings Tab .................................................. 248
         23.3.1.1. Region List .................................................. 248
         23.3.1.2. Save Intermediate Files .................................................. 248
         23.3.1.3. Adaption Criteria .................................................. 248
            23.3.1.3.1. Variables List .................................................. 248
            23.3.1.3.2. Max. Num. Steps .................................................. 248
23.3.1.3. Option ................................................................. 249
23.3.1.4. Adaption Method .................................................... 249
23.3.1.4.1. Option ............................................................. 249
23.3.1.4.2. Minimum Edge Length ......................................... 249
23.3.1.5. Adaption Convergence Criteria .................................. 249
23.3.2. Advanced Options Tab ................................................ 249
23.3.2.1. Node Alloc. Param. ............................................... 250
23.3.2.2. Number of Levels ................................................. 250

23.4. Advanced Topic: Adaption with 2D Meshes .............................. 250

24. Expert Control Parameters .................................................. 253
24.1. Modifying Expert Control Parameters .................................... 253

25. Coordinate Frames .......................................................... 255
25.1. Creating a New Coordinate Frame ........................................ 255
25.2. Coordinate Frame Basic Settings Tab .................................... 255
25.2.1. Coordinate Frame: Option .............................................. 256
25.2.1.1. Point and Normal .................................................... 256
25.2.1.2. Axis Points .......................................................... 256
25.2.2. Coordinate Frame: Centroid .......................................... 256
25.2.2.1. Location ............................................................. 256
25.2.2.2. Centroid Type ...................................................... 256
25.2.3. Coordinate Frame: Direction ........................................ 257
25.2.3.1. Invert Normal Axis Direction Check Box ....................... 257
25.2.3.2. Point on Reference Plane 1-3 Check Box ....................... 257
25.2.3.3. Point on Reference Plane 1-3 Check Box: Coordinate ........ 257
25.2.4. Coord Frame Type ..................................................... 257
25.2.5. Reference Coord Frame ............................................... 257
25.2.6. Origin ................................................................. 257
25.2.7. Z-Axis Point .......................................................... 258
25.2.8. X-Z Plane Point ...................................................... 258
25.2.9. Frame Motion Settings ................................................ 258
25.2.10. Visibility Check Box ................................................ 258

26. Materials and Reactions .................................................... 259
26.1. Materials ...................................................................... 259
26.1.1. Library Materials ...................................................... 259
26.1.2. Material Details View: Common Settings .......................... 260
26.1.2.1. Option ............................................................... 260
26.1.2.2. Material Group ...................................................... 260
26.1.2.2.1. User ............................................................... 260
26.1.2.2.2. Air Data .......................................................... 261
26.1.2.2.3. CHT Solids ...................................................... 261
26.1.2.2.4. Calorically Perfect Ideal Gases ............................... 261
26.1.2.2.5. Constant Property Gases / Liquids ......................... 261
26.1.2.2.6. Dry/Wet Redlich Kwong ....................................... 261
26.1.2.2.7. Dry/Wet Redlich Kwong RGP .................................. 261
26.1.2.2.8. Dry/Wet Peng Robinson RGP ................................. 261
26.1.2.2.9. Dry/Wet Soave Redlich Kwong RGP ......................... 262
26.1.2.2.10. Dry/Wet Steam ................................................ 262
26.1.2.2.11. Gas Phase Combustion ........................................ 262
26.1.2.2.12. Interphase Mass Transfer ..................................... 262
26.1.2.2.13. Particle Solids ............................................... 262
26.1.2.2.14. Soot .......................................................... 262
26.1.2.2.15. Water Data .................................................... 262
26.1.2.3. Material Description ................................................................. 262
26.1.2.4. Thermodynamic State ............................................................... 262
26.1.2.5. Coord Frame .............................................................................. 263
26.1.3. Material Details View: Pure Substance .............................................. 263
  26.1.3.1. Basic Settings Tab ...................................................................... 263
  26.1.3.2. Material Properties Tab ............................................................. 263
    26.1.3.2.1. General Material ................................................................. 263
      26.1.3.2.1.1. Equation of State - Value .................................................. 264
      26.1.3.2.1.2. Equation of State - Ideal Gas ............................................ 264
      26.1.3.2.1.3. Equation of State - Real Gas ............................................ 264
    26.1.3.2.2. Table .................................................................................. 265
    26.1.3.2.3. Table Generation ................................................................. 265
      26.1.3.2.3.1. Minimum and Maximum Temperature .................................. 265
      26.1.3.2.3.2. Minimum and Maximum Absolute Pressure ......................... 265
      26.1.3.2.3.3. Error Tolerance ................................................................. 266
      26.1.3.2.3.4. Maximum Points ............................................................... 266
      26.1.3.2.3.5. Pressure/Temperature Extrapolation .................................... 266
  26.1.4. Material Details View: Fixed Composition Mixture .............................. 266
    26.1.4.1. Basic Settings Tab .................................................................. 266
    26.1.4.2. Mixture Properties Tab ............................................................ 267
  26.1.5. Material Details View: Variable Composition Mixture ......................... 267
    26.1.5.1. Basic Settings Tab .................................................................. 267
    26.1.5.2. Mixture Properties Tab ............................................................ 267
  26.1.6. Material Details View: Homogeneous Binary Mixture ......................... 267
    26.1.6.1. Basic Settings Tab .................................................................. 268
    26.1.6.2. Saturation Properties Tab ........................................................ 268
      26.1.6.2.1. General .............................................................................. 268
      26.1.6.2.2. Table ................................................................................ 268
      26.1.6.2.3. Real Gas ............................................................................ 268
      26.1.6.2.4. Table Generation ................................................................. 268
  26.1.7. Material Details View: Reacting Mixture ............................................ 268
    26.1.7.1. Basic Settings Tab .................................................................. 268
    26.1.7.2. Mixture Properties Tab ............................................................ 269
  26.1.8. Material Details View: Hydrocarbon Fuel ........................................... 269
    26.1.8.1. Basic Settings Tab .................................................................. 269
    26.1.8.2. Proximate/ Ultimate Analysis Tab ................................................ 269
    26.1.8.3. Mixture Materials Tab ............................................................... 269
  26.2. Reactions ...................................................................................... 270
    26.2.1. Basic Settings Tab ...................................................................... 270
    26.2.2. Single Step ................................................................................ 270
      26.2.2.1. Single Step: Basic Settings ...................................................... 270
      26.2.2.2. Single Step: Reactants ............................................................. 271
      26.2.2.3. Single Step: Products ............................................................... 271
      26.2.2.4. Single Step: Reaction Rates ..................................................... 271
    26.2.3. Multiple Step ............................................................................. 271
    26.2.4. Flamelet Library ........................................................................ 272
    26.2.5. Multiphase ............................................................................... 272
      26.2.5.1. Multiphase: Basic Settings ...................................................... 272
      26.2.5.2. Multiphase: Reactants ............................................................. 272
      26.2.5.3. Multiphase: Products ............................................................... 272
      26.2.5.4. Multiphase: Multiphase Reactions ............................................ 273

27. Additional Variables ............................................................................ 275
# 27. User Interface

27.1. Insert Additional Variable Dialog Box ................................................................. 275
27.1.2. Basic Settings Tab for Additional Variable Objects ............................................. 275
   27.1.2.1. Variable Type .................................................................................................... 275
   27.1.2.2. Units ............................................................................................................. 276
   27.1.2.3. Tensor Type .................................................................................................... 276

27.1.3. Fluid Models and Fluid Specific Models Tabs for Domain Objects ......................... 276
   27.1.3.1. Additional Variable Details; List Box ............................................................ 276
   27.1.3.2. Additional Variable Details: [Additional Variable Name] Check Box ............... 276
      27.1.3.2.1. Option ................................................................................................. 276
      27.1.3.2.1.1. Transport Equation .......................................................................... 276
      27.1.3.2.1.2. Diffusive Transport Equation .............................................................. 276
      27.1.3.2.1.3. Homogeneous Transport Equation .................................................... 277
      27.1.3.2.1.4. Homogeneous Diffusive Transport Equation ...................................... 277
      27.1.3.2.1.5. Poisson Equation .............................................................................. 277
      27.1.3.2.1.6. Homogeneous Poisson Equation ........................................................ 277
      27.1.3.2.1.7. Fluid Dependent ............................................................................... 277
      27.1.3.2.1.8. Algebraic Equation .......................................................................... 277
      27.1.3.2.1.9. Vector Algebraic Equation ................................................................. 277
      27.1.3.2.2. Value .................................................................................................... 277
      27.1.3.2.3. Kinematic Diffusivity Check Box ............................................................ 278
      27.1.3.2.4. Kinematic Diffusivity Check Box: Kinematic Diffusivity ...................... 278
      27.1.3.2.5. AV Properties for Fluid: Frame Overview .............................................. 278
      27.1.3.2.6. AV Properties for Fluid: List Box ............................................................ 278
      27.1.3.2.7. AV Properties for Fluid: [Fluid Name] Check Box .................................. 278
      27.1.3.2.8. AV Properties for Fluid: [Fluid Name] Check Box: Kinematic Diffusivity ... 278
      27.1.3.2.9. Vector xValue, Vector yValue, and Vector zValue .................................... 279

27.1.4. Boundary Details and Fluid Values Tabs for Boundary Condition Objects ............... 279
   27.1.4.1. Additional Variables; List Box ..................................................................... 279
   27.1.4.2. Additional Variables; [Name] ....................................................................... 279
      27.1.4.2.1. Option ................................................................................................. 279
      27.1.4.2.2. Value .................................................................................................... 280
      27.1.4.2.3. Flux ..................................................................................................... 280
      27.1.4.2.4. Transfer Coefficient ............................................................................ 280

27.2. Creating an Additional Variable .............................................................................. 280

## 28. Expressions

28.1. Expressions Workspace .......................................................................................... 281
   28.1.1. Definition ......................................................................................................... 282
   28.1.2. Plot .................................................................................................................. 283
   28.1.3. Evaluate .......................................................................................................... 283

28.2. Creating an Expression .......................................................................................... 283
28.3. Modifying an Expression ....................................................................................... 284
28.4. Importing or Exporting an Expression .................................................................... 284
   28.4.1. Importing CCL Expressions ............................................................................ 284
   28.4.2. Exporting CCL Expressions ............................................................................ 284

## 29. User Functions

29.1. Interpolation Function ......................................................................................... 287
   29.1.1. One Dimensional Interpolation ...................................................................... 287
      29.1.1.1. Extended Minimum and Maximum ............................................................ 288
   29.1.2. Three Dimensional Interpolation ...................................................................... 288
   29.1.3. Importing Data from a File ............................................................................. 289
   29.1.4. Viewing and Editing Data Imported from a File ............................................ 289
30. User Routines .......................................................................................................................... 293
  30.1. User CEL Routines ............................................................................................................. 293
      30.1.1. Calling Name ................................................................................................................. 294
      30.1.2. Library Name and Library Path ..................................................................................... 294
  30.2. Junction Box Routines ........................................................................................................ 295
  30.3. Particle User Routines ........................................................................................................ 295

31. Simulation Control .................................................................................................................. 297

32. Execution and Termination Control .......................................................................................... 299
  32.1. Execution Control ................................................................................................................ 299
      32.1.1. Overview of Defining CFX-Solver Startup ................................................................. 299
      32.1.2. The Details View for Execution Control .................................................................... 299
          32.1.2.1. Solver Input File Name ......................................................................................... 300
          32.1.2.2. Run Definition Tab ............................................................................................. 300
              32.1.2.2.1. Mesh Node Reordering ................................................................................ 301
              32.1.2.2.2. Optional Quitting CFX-Pre ......................................................................... 301
          32.1.2.3. Partitioner Tab ................................................................................................... 301
          32.1.2.4. Solver Tab .......................................................................................................... 304
          32.1.2.5. Interpolator Tab .................................................................................................. 304
      32.2. Termination Control .......................................................................................................... 304
          32.2.1. Overview of Configuration Termination .................................................................. 304
          32.2.2. Details View for Termination Control .................................................................. 305

33. Configurations .......................................................................................................................... 307
  33.1. Overview of Defining a Configuration .................................................................................. 307
  33.2. The Details View for Configuration .................................................................................... 308
      33.2.1. General Settings Tab ................................................................................................ 308
      33.2.2. Remeshing Tab ......................................................................................................... 309
          33.2.2.1. User Defined Remeshing .................................................................................. 310
          33.2.2.2. ANSYS ICEM CFD Replay Remeshing .......................................................... 311
              33.2.2.2.1. ICEM CFD Geometry Control ................................................................. 311
              33.2.2.2.2. ICEM CFD Mesh Control ....................................................................... 312
              33.2.2.2.3. Scalar Parameter ...................................................................................... 312
      33.2.3. Run Definition Tab ................................................................................................... 313
      33.2.4. Partitioner Tab .......................................................................................................... 314
      33.2.5. Solver Tab .............................................................................................................. 316
      33.2.6. Interpolator Tab ........................................................................................................ 317

34. Quick Setup Mode .................................................................................................................... 319
  34.1. Starting a New Case in Quick Setup Mode ....................................................................... 319
  34.2. Simulation Definition Tab ................................................................................................. 319
      34.2.1. Simulation Data ........................................................................................................ 319
          34.2.1.1. Problem Type ................................................................................................... 320
          34.2.2. Working Fluid ..................................................................................................... 320
          34.2.3. Mesh Data ............................................................................................................ 320
      34.3. Physics Definition ........................................................................................................... 320
          34.3.1. Analysis Type ........................................................................................................ 321
          34.3.2. Model Data .......................................................................................................... 321
      34.4. Boundary Definition ....................................................................................................... 321
      34.5. Final Operations ............................................................................................................ 322
35. Turbomachinery Mode .................................................................................................................. 323
  35.1. Starting a New Case in Turbo Mode ......................................................................................... 323
  35.2. Navigation through Turbo Mode ............................................................................................ 324
  35.3. Basic Settings .......................................................................................................................... 324
    35.3.1. Machine Type .................................................................................................................... 324
    35.3.2. Axes .................................................................................................................................. 324
      35.3.2.1. Coordinate Frame ....................................................................................................... 324
      35.3.2.2. Rotational Axis ............................................................................................................ 324
      35.3.2.3. Axis Visibility .............................................................................................................. 325
    35.3.3. Analysis Type ..................................................................................................................... 325
  35.4. Component Definition ............................................................................................................. 325
    35.4.1. Component Selector .......................................................................................................... 325
    35.4.2. Component Type ................................................................................................................ 325
    35.4.3. Mesh File ............................................................................................................................. 325
    35.4.4. Passages and Alignment ...................................................................................................... 326
      35.4.4.1. Passages/Mesh ............................................................................................................. 326
      35.4.4.2. Passages to Model ......................................................................................................... 326
      35.4.4.3. Passages in 360 ............................................................................................................. 326
      35.4.4.4. Theta Offset .................................................................................................................. 326
    35.4.5. Available Volumes ................................................................................................................ 327
    35.4.6. Region Information ............................................................................................................. 327
    35.4.7. Wall Configuration .............................................................................................................. 327
  35.5. Physics Definition ..................................................................................................................... 327
    35.5.1. Fluid .................................................................................................................................. 327
    35.5.2. Model Data .......................................................................................................................... 327
      35.5.2.1. Reference Pressure ....................................................................................................... 327
      35.5.2.2. Heat Transfer ............................................................................................................... 327
      35.5.2.3. Turbulence ................................................................................................................... 327
    35.5.3. Boundary Templates ........................................................................................................... 327
    35.5.4. Interface .............................................................................................................................. 328
    35.5.5. Solver Parameters ............................................................................................................... 328
      35.5.5.1. Advection Scheme ......................................................................................................... 328
      35.5.5.2. Convergence Control .................................................................................................... 328
      35.5.5.3. Time Scale Option ........................................................................................................ 328
      35.5.5.4. Max. Coeff. Loops ....................................................................................................... 328
  35.6. Interface Definition ................................................................................................................... 328
    35.6.1. Type .................................................................................................................................. 329
  35.7. Disturbance Definition ............................................................................................................. 329
    35.7.1. Type .................................................................................................................................. 329
  35.8. Boundary Definition .................................................................................................................. 330
    35.8.1. Boundary Data ................................................................................................................... 330
    35.8.2. Flow Specification/Wall Influence on Flow ....................................................................... 330
  35.9. Final Operations ....................................................................................................................... 330
36. Library Objects ............................................................................................................................ 331
  36.1. Boiling Water ............................................................................................................................ 331
  36.2. Cavitating Water ....................................................................................................................... 332
  36.3. Coal Combustion ....................................................................................................................... 332
  36.4. Comfort Factors ........................................................................................................................ 332
  36.5. Multigray Radiation .................................................................................................................. 333
37. Command Editor Dialog Box ...................................................................................................... 335
  37.1. Using the Command Editor ..................................................................................................... 335
  37.2. Performing Command Actions ................................................................................................ 336
37.3. Using Power Syntax ........................................................................................................... 336
Index ......................................................................................................................................... 337
Chapter 1: CFX-Pre Basics

CFX-Pre is the physics-definition pre-processor for ANSYS CFX. You import meshes (which can be produced in a variety of mesh generation software packages) into CFX-Pre and select physical models to be used in the CFD simulation. Files produced by CFX-Pre are sent to CFX-Solver.

This chapter describes:
1.1. Starting CFX-Pre
1.2. CFX-Pre Modes of Operation
1.3. Working with the CFX-Pre Interface
1.4. CFX-Pre File Types

If you want to start using CFX-Pre immediately, refer to the following CFX Tutorials:
• "Simulating Flow in a Static Mixer Using CFX in Stand-alone Mode"
• "Flow in a Static Mixer (Refined Mesh)"
• "Flow in a Process Injection Mixing Pipe"

1.1. Starting CFX-Pre

When starting CFX-Pre for the first time, the default system font is obtained and, if it is deemed inappropriate for CFX-Pre, a dialog box appears that enables you to choose a new font. When a new font is selected, it is stored for future sessions. For details, see Appearance (p. 48).

CFX-Pre can be started in different ways:
• From within ANSYS Workbench choose Fluid Flow (CFX) from Toolbox > Analysis Systems or CFX from Toolbox > Component Systems. In the Project Schematic, right-click on the Setup cell and select Edit.
• From the ANSYS CFX Launcher: set the working directory and then click CFX-Pre 14.0.
• From the command line. The basic command is:
  <CFXROOT>/bin/cfx5pre

  The command line options are described in the next section.

Starting CFX-Pre from the Command Line

To start CFX-Pre from a command line, you must either:
• Specify the full path to the executable (<CFXROOT>/bin/cfx5pre)
• Append the path to the ANSYS CFX executables (<CFXROOT>/bin/) to your PATH.

For details on physical models, see Physical Models in the CFX-Solver Modeling Guide.
On Windows, right-click the **My Computer** icon and select **Properties**. Click the **Advanced** tab, then click **Environment Variables**. In the **System variables** section, edit **PATH** to include the path to the ANSYS CFX executables; typically this will be something like:

```
C:\Program Files\ANSYS Inc\v140\CFX\bin;
```

On Linux/UNIX, edit your `.<window_manager>rc` file to include the path to the ANSYS CFX executables.

Once the **PATH** has been updated, the basic command is:

```
cfx5pre
```

- Run the executable from the launcher **Tools > Command Line** (which has the path to the ANSYS CFX executables built-in).

There are a number of optional command line flags, some of which are summarized in the following table:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Alternative Form</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-batch file-name.pre</code></td>
<td></td>
<td>Starts CFX-Pre in batch mode(^a), running the session file you enter as an argument.</td>
</tr>
<tr>
<td><code>-display display</code></td>
<td><code>-d</code></td>
<td>Displays the graphical user interface on the X11 server <code>display</code> instead of using the X11 server defined by the DISPLAY environment variable.</td>
</tr>
<tr>
<td><code>-gui</code></td>
<td></td>
<td>Starts CFX-Pre in graphical user interface (GUI) mode. This is the default mode.</td>
</tr>
<tr>
<td><code>-line</code></td>
<td></td>
<td>Starts CFX-Pre in line interface mode.</td>
</tr>
<tr>
<td><code>-graphics ogl</code></td>
<td><code>-gr ogl</code></td>
<td>Specifies the graphics system as ogl or mesa. ogl is the default.</td>
</tr>
<tr>
<td><code>-graphics mesa</code></td>
<td><code>-gr mesa</code></td>
<td></td>
</tr>
<tr>
<td><code>-def file</code></td>
<td></td>
<td>Loads the named CFX-Solver input file after starting.</td>
</tr>
<tr>
<td><code>-session file</code></td>
<td><code>-s</code></td>
<td>Plays the named session file after starting.</td>
</tr>
<tr>
<td><code>-cfx file</code></td>
<td></td>
<td>Loads the named case file after starting.</td>
</tr>
<tr>
<td><code>-verbose</code></td>
<td><code>-v</code></td>
<td>Specifying this option may result in additional output being sent to the standard output.</td>
</tr>
</tbody>
</table>

\(^a\)When launching CFX-Pre on a remote UNIX or Linux machine (though X, Exceed, and so on), the **DISPLAY** variable must be set to a valid X display before running in batch mode. The display will typically be your local Windows, Linux, or UNIX machine. The remote machine must have permission to connect to the display (for example, by use of the `xhost` command if the X display is on a UNIX/Linux machine).

To view a full list of command-line flags, execute:

```
cfx5pre -help
```

### 1.2. CFX-Pre Modes of Operation

When you select **File > New Case** to create a new simulation, CFX-Pre presents four different modes of operations:
Figure 1.1 The New Case Dialog Box

- **General** mode is the general-purpose mode for defining all types of CFD simulation. This mode uses the general CFX-Pre interface, which is described in *Working with the CFX-Pre Interface* (p. 3).

- **Turbomachinery** mode is a customized mode for defining turbomachinery simulations. For details, see *Turbomachinery Mode* (p. 323).

- **Quick Setup** mode greatly simplifies the physics setup for a simulation. Quick Setup mode is limited to a single-domain and single-phase problems; more complex physics, such as multiphase, combustion, radiation, advanced turbulence models, and so on are not available. You can, however, use Quick Setup mode to get started, and then add more physics details later. For details, see *Quick Setup Mode* (p. 319).

- **Library Template** mode provides a set of library files that are available with templates for specific physical problem definitions. In this mode you can easily define a complex physics problem by loading a template file, importing a mesh, and defining specific problem data. For details, see *Library Objects* (p. 331).

### 1.3. Working with the CFX-Pre Interface

The CFX-Pre interface enables the easy definition of a simulation. The main components are the viewer (to display and manipulate meshes), the workspaces (to define different aspects of the physics setup), the physics message window, and the menus and tool bars (access to extra tools and utilities).
Figure 1.2 Sample CFX-Pre Interface

1.3.1. Viewer

The viewer displays imported geometries and meshes and enables manipulations and transformations to be viewed. Information about boundary conditions, domains, point sources, and so on, is also displayed, and items can be picked directly from the Viewer.

CFX-Pre uses the same viewer as CFD-Post. Information on the generic CFX-Pre/CFD-Post viewer is available in CFX-Pre 3D Viewer (p. 17). Many aspects of the viewer appearance can be customized, as described in Options (p. 42).

1.3.2. CFX-Pre Workspace

The CFX-Pre workspace contains a tree view as well as various details views that are used during the specification of mesh import, mesh transformation, physics, regions, materials, and expressions.

A powerful feature of CFX-Pre is automatic physics checking. Objects that contain inconsistent or incorrect settings are highlighted in red. Detailed error messages are shown in the physics validation summary window. For details, see Physics Message Window (p. 11).
1.3.2.1. Outline Tree View

The **Outline** tree view displays a summary of the physics that have been defined for the simulation. The tree view window initially contains a default list of objects in a tree format.

The following topics are discussed in this section:

- *General Considerations* (p. 5)
- *Outline Tree View Structure* (p. 5)
- *Outline Tree View Shortcut Menu Commands* (p. 7)

**Tip**

Typing Ctrl-F activates the search facility, which can be used to quickly locate an item in the tree. Note that the search is case-sensitive and that the text box disappears after a few seconds of inactivity.

1.3.2.1.1. General Considerations

When working with the tree view, note the following:

- New objects are displayed in the tree as they are created.
- Clicking on any object that is applied to a region will highlight that region in the viewer when highlighting is enabled (that is, when the **Highlighting** icon is selected in the 3D Viewer toolbar). For details, see *3D Viewer Toolbar* (p. 19).
- Objects shown in red contain incorrect physics definitions.
- Right-click an object (or group selection of objects) to display the shortcut menu.

For details, see *Outline Tree View Shortcut Menu Commands* (p. 7).

1.3.2.1.2. Outline Tree View Structure

The **Outline** tab displays the tree view, which shows a summary of the current physics definition for a simulation. The tree structure displayed reflects the structure used in the CFX Command Language (CCL) for physics definition. You can select any object in the tree and double-click to gain direct access to the appropriate tab to edit its settings. You can also right-click an object and display the CCL definition of an object in the **Command Editor** dialog box, where it can be edited.

The remainder of this section describes the main areas in the **Outline** view.

**Mesh**

Provides access to all mesh operations in CFX-Pre. This includes mesh import, mesh transformations, and the render/visibility properties of meshes in the viewer. Meshes generated in many other mesh generation packages can be imported into CFX-Pre. For details, see *Importing and Transforming Meshes* (p. 65).

Meshes that have been glued together are listed under **Connectivity** in the tree view.

**Simulation**

Enables you to define the one or more analyses of the simulation.

Optionally, you can open a copy of the Simulation branch in a separate tab.
Analysis
   Enables you to define and edit an analysis:

   **Analysis Type**
   Enables the specification of an analysis as steady state or transient, and whether it requires coupling to an external solver. For details, see *Analysis Type* (p. 101).

   **Domains**
   Enables you to define and edit the type, properties and region of the fluid, porous or solid. For details, see *Domains* (p. 105), *Boundary Conditions* (p. 149), *Subdomains* (p. 181) and *Source Points* (p. 177).

   **Domain Interfaces**
   Enables you to define and edit the method of connecting meshes or domains together. For details, see *Domain Interfaces* (p. 137).

   **Global Initialization**
   Enables you to set global initial conditions (across all domains). Domain specific initialization is set through the domain forms. For details, see *Initialization* (p. 167).

   **Solver**
   Enables the defining and editing of *Setting the Solution Units* (p. 197), *Solver Control* (p. 199), *Solver: Expert Parameter* (p. 57), *Output Control* (p. 213) and *Mesh Adaption* (p. 245).

   **Coordinate Frames**
   Creates and edits coordinate frames. A Cartesian coordinate frame exists by default, but other Cartesian coordinate frames can be made. For details, see *Coordinate Frames in the CFX-Solver Modeling Guide* and *Coordinate Frames* (p. 255).

   **Materials / Reactions**
   Creates, edits, and displays materials and reactions. Many different material types can be defined, edited or imported. Specialist materials and reactions can be imported from external files, such as the RGP (Real Gas Properties) file and Flamelet reaction files. For details, see *Materials and Reactions* (p. 259).

   **Expressions, Functions, and Variables**
   Used to create, edit and plot expressions, user functions, user routines, and Additional Variables. For details, refer to the following sections:
      - *Additional Variables* (p. 275)
      - *Expressions* (p. 281)
      - *User Functions* (p. 287)
      - *User Routines* (p. 293)

   **Simulation Control**
   Enables you to set up the control of analyses in the simulation. This control is facilitated by defining and editing one or more configurations as well as global solver execution control. For more information, see *Solve* (p. 47).

   **Case Options**
   The *Graphics Style, Labels and Markers*, and *General* options enable you to override the defaults for the current simulation only — they will not be retained for future simulations. The default settings for CFX-Pre are set in the *Edit > Options* dialog box — these settings are retained and take effect when a new case is started. See *CFX-Pre Options* (p. 42) for a description of these settings.
Extensions
Enables you to access to any customized extensions available to CFX-Pre. For details, see CFX-Pre Extensions Menu (p. 63).

1.3.2.1.2.1. Outline Tree View Shortcut Menu Commands

Right-clicking on any object in the tree view displays a shortcut menu. Double-clicking on an object performs the default action for that object. Shortcut menu command descriptions follow:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configura-</td>
<td>Simulation Control &gt; Configurations &gt; Insert &gt; Configuration opens the Configuration Editor.</td>
</tr>
<tr>
<td>Copy</td>
<td>The Copy command is usually combined with Paste to quickly replicate objects.</td>
</tr>
<tr>
<td>Define Conn-</td>
<td>Mesh &gt; Define Connection opens the Mesh Connections Editor.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected object. The physics for the simulation are checked after objects are deleted. Objects containing invalid parameters are highlighted in red in the tree view.</td>
</tr>
<tr>
<td>Delete All</td>
<td>Deletes the mesh, but not the named areas in the Outline view. When this happens, the Physics Message Window will show errors that say the named objects cannot be found. If you then import a new mesh that uses the same names for objects, the names will be resolved and the errors will disappear.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Copies the definition of the selected object to a new object. You will be required to enter a name for the duplicated object, which will then be created at the same level (that is, for a boundary condition, the new boundary will be created in the same domain as the initial object).</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the relevant tab where new parameters for the object can be entered. In most cases, you can also edit an object by double-clicking it in the tree view.</td>
</tr>
<tr>
<td>Edit In Com-</td>
<td>Opens the Command Editor dialog box and displays the CCL definition for the highlighted object. You can edit the CCL directly to change the object definition. For details, see Command Editor Dialog Box (p. 335).</td>
</tr>
<tr>
<td>mand Editor</td>
<td></td>
</tr>
<tr>
<td>Expand/Coll-</td>
<td>Provides a fast way to navigate the tree view.</td>
</tr>
<tr>
<td>lapse Sub-</td>
<td></td>
</tr>
<tr>
<td>Branches</td>
<td></td>
</tr>
<tr>
<td>Export CCL</td>
<td>Opens the Export CCL dialog box, which is similar to the dialog box described in Export Region Data, below.</td>
</tr>
<tr>
<td>Export Re-</td>
<td>Opens the Export Region CCL dialog box, used to save the region data to a .ccl file.</td>
</tr>
<tr>
<td>gion Data</td>
<td></td>
</tr>
<tr>
<td>Glue Adjacent</td>
<td>If there are multiple mesh assemblies that have matched meshes, you can use this option to try to glue them together. Select the assemblies in the tree view (while holding down the Ctrl key). Gluing can be useful to avoid setting up a GGI interface within a domain, but does require that the meshes match exactly on the surfaces that are to be glued. When you transform or copy multiple assemblies, each copy is not only glued to its original assembly or to other copies, but also to any other assemblies that are transformed or created. For more information, see Gluing Meshes Together (p. 88).</td>
</tr>
<tr>
<td>Meshes</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide</td>
<td>Makes the active object invisible in the viewer. <strong>Hide</strong> has the same effect as clearing the check box next to an object in the tree view.</td>
</tr>
<tr>
<td>Hide Interface Boundar-</td>
<td>Hides the interface boundaries in the Outline view.</td>
</tr>
<tr>
<td>ies</td>
<td></td>
</tr>
<tr>
<td>Import CCL</td>
<td>Opens the Import CCL dialog box, which is similar to the dialog box described in <strong>Import Region Data</strong>, below.</td>
</tr>
<tr>
<td>Import Mesh</td>
<td>Opens the <strong>Import Mesh</strong> dialog box. This is used to import a new mesh using an appropriate file. For details, see <strong>Importing Meshes</strong> (p. 65).</td>
</tr>
<tr>
<td>Import Library Data</td>
<td>This command, available from the Materials branch in the tree view, is used to add a new material to the simulation. Examples of such a material include Methanol CH4O, Rubber, Water at 25 C, and many more.</td>
</tr>
<tr>
<td>Import Region Data</td>
<td>Opens the <strong>Import Region CCL</strong> dialog box. This is used to load region data from a .ccl file.</td>
</tr>
<tr>
<td>Insert</td>
<td>Various objects are available for insertion, depending on which object is highlighted. All of the options available from this menu can also be accessed from the <strong>Insert</strong> menu. For details, see <strong>CFX-Pre Insert Menu</strong> (p. 55).</td>
</tr>
<tr>
<td>Mesh Statistics</td>
<td>Opens the <strong>Mesh Statistics</strong> dialog box and provides a detailed information about the active mesh. The Mesh Statistics dialog box can be invoked for one or more assemblies and/or primitive 3D/2D regions. The data displayed includes the number of nodes, elements, the number of each element type, and physical extents of the mesh. The Maximum Edge Length Ratio is also calculated.</td>
</tr>
<tr>
<td>Paste</td>
<td>The <strong>Paste</strong> command is available when you have already used the <strong>Copy</strong> command on an object.</td>
</tr>
<tr>
<td></td>
<td>To avoid producing objects with the same name, you are prompted to provide a name when you paste the new object. For objects that contain a location parameter (such as domains and boundary conditions), you will usually need to edit the new object after pasting it to avoid multiple objects that reference the same location.</td>
</tr>
<tr>
<td></td>
<td>If you are pasting a domain object, then you will need to edit each child object in the domain that references a location. For example, you will need to change the locations that boundary conditions reference so that they point to locations in the new domain. You can simply delete a default domain boundary in this situation; this will allow CFX-Pre to create a new default boundary for the domain that references the correct locations.</td>
</tr>
<tr>
<td>Reload Mesh Files</td>
<td>If any of the mesh regions become corrupted or are accidentally deleted, selecting <strong>Reload Mesh Files</strong> reloads all mesh files used in the simulation. This command cannot be used to insert a new mesh; do to so, select <strong>Import Mesh</strong>. For details, see <strong>Reload Mesh Files Command</strong> (p. 34).</td>
</tr>
</tbody>
</table>

**Note**

This command is not required (and is not available) in CFX-Pre launched from ANSYS Workbench.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Changes the selected object’s name.</td>
</tr>
<tr>
<td>Render</td>
<td>Enables you to change the appearance of almost any object. For example, a boundary condition or domain interface can be displayed with a solid color, the transparency of a domain can be altered, and so on.</td>
</tr>
<tr>
<td>Report Interface Summary</td>
<td>Invokes a message box that shows a summary of the interfaces and their types. For details, see Mesh Connection Options in the CFX-Solver Modeling Guide.</td>
</tr>
<tr>
<td>Show/Hide</td>
<td>Makes the active object either visible (Show) or invisible (Hide) in the viewer. Show and Hide have the same respective effects as selecting and clearing the check box next to a specific object in the tree view.</td>
</tr>
<tr>
<td>Show Interface Boundaries</td>
<td>Shows the interface boundaries in the Outline view.</td>
</tr>
<tr>
<td>Start Solver</td>
<td>Enables you to access the Define Run, Run Solver, and Run Solver and Monitor commands. These commands are also available from the main toolbar.</td>
</tr>
<tr>
<td>Transform Mesh</td>
<td>Opens the Mesh Transformation Editor dialog box, allowing you to modify the location of the active mesh through rotation, translation, or reflection. The mesh can also be resized using a scaling method. For details, see Transform Mesh Command (p. 82).</td>
</tr>
<tr>
<td>Use as Workbench Input Parameter</td>
<td>Available when an expression is selected, this command allows the expression to be used as a workbench input parameter.</td>
</tr>
<tr>
<td>View By</td>
<td>This command, available for the Mesh object, opens a new tab that presents a detailed mesh information in one of two ways. Selecting View By &gt; Source File displays the mesh regions based on the mesh file provided, whereas View By &gt; Region Type organizes the areas of the mesh based on the defined 2D regions.</td>
</tr>
<tr>
<td>View in New Tab</td>
<td>Simulation &gt; View in New Tab enables you to view a copy of the contents of the Simulation branch in a separate tab.</td>
</tr>
<tr>
<td>View in CFD-Post</td>
<td>Prompts you to save a DEF file, then automatically starts CFD-Post with that file loaded.</td>
</tr>
<tr>
<td>Write Solver Input File</td>
<td>Has the same effect as clicking Write Solver Input File or selecting Tools &gt; Solve &gt; Write Solver Input File from the menu bar. For details, see Write Solver Input File Command (p. 61).</td>
</tr>
</tbody>
</table>

An expression that is set as an input parameter in ANSYS Workbench cannot be edited in CFX-Pre or CFD-Post (as the results of such edits are not passed to ANSYS Workbench) and will be grayed out. However, the expression can be declared to no longer be an input parameter or it can be deleted.

### 1.3.2.2. Details View

Details view is a generic term for the editor pane that opens when you edit an object in the Outline tree view. These editors appear on tabs beside the Outline tab and present the fields and controls that define the object.
**Figure 1.3 Sample CFX-Pre Details View**

The optional toggles provide you with the opportunity to view and, if desired, to override CFX-Pre default settings. In the example above, selecting the **Upper Courant Number** option has made it possible to see the default value for that setting; the white background indicates that you can then edit that value.

Most CFX-Pre settings have default values that will enable you to define an object or set a control as easily as possible. If there is a setting that requires you to set a value, basic physics checking occurs when you click **OK** or **Apply** on a details view and most missing settings are detected then. Complete physics checking takes place when you attempt to write a solver file and all missing settings are detected and reported at that time.

You use the Details view to define the properties of an object. The Details view contains one or more tabs, depending on the type of object being defined.

Many properties can be set via a CEL expression. To enter an expression:
1. Click in the field for a property.
2. Click the Enter Expression icon that appears beside the field. This enables the field to accept an expression name.
3. Either enter an expression definition directly, or type the name of an existing expression. You must ensure that the expression evaluates to a value having appropriate units for the property that uses the expression.

For details on CEL expressions, see *Expressions* (p. 281).

For CFX components in ANSYS Workbench, any CEL expression can be made into a parameterized CEL expression by defining it as a Workbench input parameter. You can do this by creating an expression and parameterize it by right-clicking it in the Expression editor. You can then use that expression as the value of a property.

You can change a property from being specified by a Workbench input parameter. However, the corresponding CEL expression persists and can be managed by the Expression editor.

### 1.3.3. Physics Message Window

As you work through your simulation, CFX-Pre continually checks the physics definitions you have specified. Whenever an action is carried out, the physics validator runs a check on the CCL definitions of all the objects created up to that point. Physics checking is carried out by comparing the current CCL data against library files such as `RULES`, `VARIABLES` and `PHYSICS`, which are known to contain only valid physics specifications. If an inconsistency is found in the physics, the object with associated error(s) is highlighted in red text in the tree view.

In addition to object name highlighting, the physics validation window displays all error types in the simulation: global errors, physics errors and expression errors. The output in this window gives an explanation of each of the detected errors. Double-clicking on a red item or a maroon item (an expression error) in the physics validation window will take you to the correct place in order to edit the object.

Global errors apply to the entire simulation and show errors that are not specific physics errors. Often these errors show required objects that need to be defined to complete the simulation (for example, initial conditions or a domain). They also show invalid referencing of regions in a simulation. In some cases, the global errors offer a suggestion rather than being a definite error. For example, if you have created two valid boundary conditions on one region, a global error will be shown (despite the fact that the physics for both boundary conditions may be correct) because you cannot specify more than one boundary condition on any given surface.

Physics errors (highlighted in red) involve an incorrect application of physics.

- Global errors appear in blue text.
- Specific physics errors appear in red text. You can double-click these to edit the object containing the error.

There are two common situations when you are likely to encounter physics errors:

1. CFX-Pre defines some objects, such as the **Solver Control** settings, by default. If you create a new object that is not compatible with the default objects settings, the physics validation summary window will show errors in the default object. This occurs when creating a solid domain because the default **Solver Control** settings do not contain a solid time scale. These errors will disappear when you define the **Solver Control** settings.
2. When changing the physics of an existing model, there are many instances where you might want to change the description of your simulation. One particular situation is when you want to use the values in a results file as the initial field for another run with different physics.

When a domain is modified, perhaps with new model options, you will receive errors or warnings in the physics validation summary window if existing boundary conditions, initialization, solver control, etc., need to be revisited and updated. This happens, for example, when the turbulence model is changed from the laminar model to the $k - \varepsilon$ model and the boundary conditions for the laminar case do not contain turbulence data (for example, at an Inlet). You should fix any such errors before writing a CFX-Solver input file.

You should update boundary conditions if the number of Additional Variables has been increased, or if the units for Additional Variable specifications have been changed.

If the simulation is set up correctly, there will not be any physics errors when you are ready to write the CFX-Solver input file.

### 1.3.3.1. Physics Errors from Old .def/.res Files

When you load CFX-Solver input/results files from previous versions of ANSYS CFX, you may receive error messages, despite the fact that the files can be run in the CFX-Solver. This is due to differences in the previous CFX-Solver input files. In CFX-Pre, a more strict approach to CCL structure and content has been implemented to ensure the integrity of the CCL made available to the CFX-Solver.

CFX-Pre performs some automatic updates when opening CFX-Solver input or results files from previous versions of ANSYS CFX.

### 1.3.3.2. Physics Message Window Shortcut Menu Commands

Right-click on a message in the physics message window to perform the following functions:

- **Copy**
  Enables copying of the selected message.

- **Edit**
  Enables you to use the Details View to edit the object generating the error.

- **Auto Fix Physics**
  Enables you to attempt to correct inconsistent physics automatically. In many cases, you will find that this fixes the problem without a need to change any settings on the form. Alternatively, you can use the Details View to edit the object generating the error.

  Viewing the type of error before performing auto fix is strongly recommended. For example, auto fix cannot fix a domain with an incorrectly specified location. In effect, auto fix opens the default layout of the panel and performs an apply. If you are unsure about auto fix, you should subsequently open the form and verify that the settings are still valid for your problem. You should fix all physics validation errors to ensure that the CFX-Solver input file runs in the solver. If any errors are found when you attempt to write the CFX-Solver input file, a warning message is displayed giving you the option to write the file anyway or cancel the operation.

- **Auto Fix All**
  Runs auto-fix on all objects that have physics validation errors.

- **Suppress this message**
  Suppress the selected message; a message summary is displayed instead.
1.3.4. Menu Bar

The menu bar provides access to CFX-Pre functions. Some of these functions are also available from the Toolbar (p. 13).

File Menu
Provides access to file operations including opening and saving simulations, as well as importing or exporting CCL. For details, see CFX-Pre File Menu (p. 31).

Edit Menu
Enables you to change the default options used by ANSYS CFX and undo/redo actions. For details, see CFX-Pre Edit Menu (p. 41).

Note
Some options can be overridden for the current simulation; see Case Options in Outline Tree View Structure (p. 5) for details.

Session Menu
Controls the recording and playing of session files. Session files are used to record a set of operations. You can then play back a session file to quickly reproduce the same operations. For details, see CFX-Pre Session Menu (p. 51).

Insert Menu
Enables you to create new objects such as domains or boundary conditions, or edit existing objects of that type. For details, see CFX-Pre Insert Menu (p. 55).

Tools Menu
Provides access to tools such as command editor, macro calculator as well as quick setup and turbo modes. For details, see CFX-Pre Tools Menu (p. 59).

Extensions Menu
Provides access to any customized extensions available to CFX-Pre. For details, see CFX-Pre Extensions Menu (p. 63).

Help Menu
Provides access to the ANSYS CFX online help. You can access commonly used help pages directly including the master contents and the global search facility. For details, see Help On Help in the CFX Introduction.

1.3.5. Toolbar

The toolbar provides quick access to commonly used functions. The toolbar contains the most common menu items and viewer controls. Holding the mouse pointer over a toolbar icon for a short period of time displays the icon’s function.

1.4. CFX-Pre File Types

The following file types are used by or produced by CFX-Pre:
Case Files (.cfx)
The case file contains the physics data, region definitions, and mesh information for the simulation and is used by CFX-Pre as the 'database' for the simulation setup. The case file is generated when you save a simulation in CFX-Pre. To re-open a simulation, select File > Open Case and pick a case file to open.

When you import a mesh into CFX-Pre, it passes through an import filter and is stored as part of the case file. Therefore, once a mesh has been imported, the original mesh file is not required by CFX-Pre. Additional information on importing meshes is available in Importing Meshes (p. 65).

The case file is a binary file and cannot be edited directly.

You can open cases on any supported platform, regardless of the platform on which they were created.

Mesh Files
There are many types of mesh files that can be imported into CFX-Pre. For details, see Supported Mesh File Types (p. 67).

CFX-Solver Input Files (.def, .mdef)
A CFX-Solver input file is created by CFX-Pre. The input file for a single configuration simulation (.def) contains all physics and mesh data; the input file for multi-configuration simulations (.mdef) contains global physics data only (that is, Library and Simulation Control CFX Command Language specifications). An .mdef input file is supplemented by Configuration Definition (.cfg) files that:

- Are located in a subdirectory that is named according to the base name of the input file
- Contain local physics and mesh data.

Note
Use the -norun command line option (described in Command-Line Options and Keywords for cfx5solve in the CFX-Solver Manager User’s Guide) to merge global information into the configuration definition files, and produce a CFX-Solver input file (.def) that can be run by the CFX-Solver.

You can load a CFX-Solver input file back into CFX-Pre to recreate a simulation. CFX-Solver input files from previous releases of ANSYS CFX can be loaded into CFX-Pre, although the physics definition may have to be updated for such files. For details, see Physics Errors from Old .def/.res Files (p. 12).

CFX-Solver Results Files (.res, .mres, .trn, .bak)
Intermediate and final results files are created by the CFX-Solver:

- Intermediate results files, which include transient and backup files (.trn and .bak, respectively) are created while running an analysis.
- Final results files for single and multi-configuration simulations (.res and .mres, respectively) are written at the end of the simulation's execution. For multi-configuration simulations, a configuration result file (.res) is also created at the end of each configuration's execution.

Each results file contains the following information as of the iteration or time step at which it is written:

- The physics data (that is, the CFX Command Language specifications)
- All or a subset of the mesh and solution data.
CFX-Solver Backup Results Files (.bak)
A backup file (.bak) is created at your request, either by configuring the settings on the Backup tab in Output Control in CFX-Pre, or by choosing to write a backup file while the run is in progress in the CFX-Solver Manager.

CFX-Solver Transient Results Files (.trn)
A transient results file (.trn) is created at your request, by configuring the settings on the Output Control > Trn Results tab in CFX-Pre.

CFX-Solver Error Results Files (.err)
An error results file (.err) is created when the CFX-Solver detects a failure and stops executing an analysis. The .err file can be loaded into CFD-Post and treated the same way as a .bak file, but if the CFX-Solver encounters another failure while writing the .err file, it may become corrupted and accurate solutions cannot be guaranteed.

Session Files (.pre)
Session files are used by CFX-Pre to record CFX Command Language (CCL) commands executed during a session. The commands can be played back at a later date to reproduce the session. These files are in ASCII format and can be edited or written in a text editor. For details, see New Session Command (p. 51).

CCL Files (.ccl)
CFX CCL files are used by CFX-Pre to save CFX Command Language (CCL) statements. CCL files differ from session files in that only a snapshot of the current state is saved to a file. These files are in ASCII format and can be edited or written in a text editor. The CCL statements stored in these files replace or append the existing CCL data, depending on the option chosen. For details, see:

- Import CCL Command (p. 35)
- Append or Replace (p. 35).

An overview of the files used throughout ANSYS CFX is available in ANSYS CFX File Types in the CFX Introduction.
Chapter 2: CFX-Pre 3D Viewer

In CFX-Pre, the 3D viewer is visible whenever a partial or complete case is loaded. After importing a mesh into CFX-Pre, you can see a visual representation of the geometry in the 3D viewer. You can create various other objects that can be viewed in the 3D viewer; for details, see "CFD-Post Insert Menu". The visibility of each object can be turned on and off using the check boxes in the tree view; for details, see Object Visibility (p. 18).

Descriptions of the various viewing modes and 3D viewer commands, including toolbars, shortcut menus, and hotkeys, are given in 3D Viewer Modes and Commands (p. 19).

You can switch between four adjustable “views” that each remember the camera angle and state of visibility of all objects.

The 3D viewer can display multiple viewports at a time. The viewport arrangement is controlled from the viewer toolbar.

This chapter describes:

2.1. Object Visibility
2.2. 3D Viewer Modes and Commands
2.3. Views and Figures
2.4. Stereo Viewer
Note

In order to see correct colors and accurately displayed objects in the 3D Viewer, some combinations of ATI video cards and ATI graphics drivers on Windows XP require that you set the environment variable \texttt{VIEWER\_CACHE\_COLORS} to 0:

1. Right-click on \textit{My Computer} and select \textit{Properties}. The \textit{System Properties} dialog box appears.
2. Click the \textit{Advanced} tab.
3. Click \textit{Environment Variables}.
5. In the \textit{Variable name} field, type: \texttt{VIEWER\_CACHE\_COLORS}
6. In the \textit{Variable value} field, type the number: 0
7. Click \textit{OK}.
8. To verify the setting, open a command window and enter: \texttt{set VIEWER\_CACHE\_COLORS=0}

The results should include the line:

\texttt{VIEWER\_CACHE\_COLORS=0}

This setting will fix problems such as:

- Boundary condition markers placed incorrectly or rendered in white.
- Regions around the circles are incorrect (rendered as yellow areas marked with blue)
- Mesh lines not displayed properly and with dark patches showing.

2.1. Object Visibility

The visibility of each object can be turned on and off using the check boxes in the tree view, as described in \textit{Object Visibility}. However, you can also hide objects by right-clicking on them and selecting \texttt{Hide}. The shortcut menu has a title that indicates the object that will be acted upon so that you do not accidentally hide the wrong object. In the figure that follows, the user right-clicked on an object named \textit{Primitive 2D A}.
Once an object has been hidden, you can show it again by selecting that object's check box in the Outline view.

2.2. 3D Viewer Modes and Commands

The topics in this section include:

- **3D Viewer Toolbar** (p. 19)
- **Shortcut Menus** (p. 21)
- **Viewer Hotkeys** (p. 23)
- **Mouse Button Mapping** (p. 24)
- **Picking Mode** (p. 26)
- **Boundary Markers and Labels** (p. 27)

2.2.1. 3D Viewer Toolbar

The 3D Viewer toolbar has the following tools:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Primitive 2D A" /></td>
<td>Makes one of the picking tools active.</td>
</tr>
<tr>
<td><img src="image" alt="Mesh Statistics" /></td>
<td>Selects objects. When a number of objects overlap, the one closest to the camera is picked. In CFX-Pre, when selecting regions for boundaries, if more than one region is under the mouse pointer at the location that you click, those regions will be listed in a list box, allowing you to select the intended region.</td>
</tr>
</tbody>
</table>

![3D Viewer Toolbar](image)
<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select Box" /></td>
<td>Selects objects using a box. Drag a box around the objects you want to select.</td>
</tr>
<tr>
<td><img src="image" alt="Select Polygon" /></td>
<td>Selects objects using an enclosed polygon. Click to drop points around the objects. Double-click to complete the selection.</td>
</tr>
</tbody>
</table>
| ![Select Visible Only](image) | When you select **Insert > Primitive Region**, this feature controls which objects you can select.  
**Select Visible Only** treats the contents of the Viewer as opaque and enables you to select only the top mesh elements at any point.  
**Select Any Depth** treats the contents of the Viewer as “transparent” and enables you to select any of the mesh elements that you would encounter if you drilled through the object at a given point. You use this option with the depth indicator in the bottom-left of the Viewer. |
| ![Choose Fully Enclosed](image) | When you select **Insert > Primitive Region**, this feature controls which mesh elements you can select with a box or enclosed polygon.  
**Choose Fully Enclosed** selects only the mesh elements that have boundaries that are completely within the box or polygon you draw.  
**Choose Enclosed and Touching** selects both the mesh elements that are completely within the box or polygon you draw as well as any mesh elements of which any part is within that area. |
| ![Prefer Primitive Region](image) | These icons allow primitives to be chosen over composites or vice versa. This feature is selected only when you are in the single-select picking mode. |
| ![Rotate](image) | Rotates the view as you drag with the mouse. Alternatively, hold down the middle mouse button to rotate the view. |

**Note**

Polygon Select mode will not allow you to create an invalid region, such as would occur if you attempted to move a point such that the resulting line would cross an existing line in the polygon.
### Tool Description

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pans the view as you drag with the mouse. Alternatively, you can pan the view by holding down Ctrl and the middle mouse button." /></td>
<td>Pans the view as you drag with the mouse. Alternatively, you can pan the view by holding down Ctrl and the middle mouse button.</td>
</tr>
<tr>
<td><img src="image" alt="Adjusts the zoom level as you drag with the mouse vertically. Alternatively, you can zoom the view by holding down Shift and the middle mouse button." /></td>
<td>Adjusts the zoom level as you drag with the mouse vertically. Alternatively, you can zoom the view by holding down Shift and the middle mouse button.</td>
</tr>
<tr>
<td><img src="image" alt="Zooms to the area enclosed in a box that you create by dragging with the mouse. Alternatively, you can drag and zoom the view by holding down the right mouse button." /></td>
<td>Zooms to the area enclosed in a box that you create by dragging with the mouse. Alternatively, you can drag and zoom the view by holding down the right mouse button.</td>
</tr>
<tr>
<td><img src="image" alt="Centers all visible objects in the viewer." /></td>
<td>Centers all visible objects in the viewer.</td>
</tr>
<tr>
<td><img src="image" alt="Toggles highlighting according to the highlighting preferences (select Edit &gt; Options &gt; CFX-Pre &gt; Object Highlighting &gt; Type). Highlighting is active only when the viewer is set to Picking Mode. For details, see Picking Mode." /></td>
<td>Toggles highlighting according to the highlighting preferences (select Edit &gt; Options &gt; CFX-Pre &gt; Object Highlighting &gt; Type). Highlighting is active only when the viewer is set to Picking Mode. For details, see Picking Mode.</td>
</tr>
<tr>
<td><img src="image" alt="Enables you to select mesh nodes. When picking a point from the viewer to populate a widget that defines a coordinate, the point can either be a point in space or a mesh “node”. This tool enables you to select the mesh node nearest to the location you click." /></td>
<td>Enables you to select mesh nodes. When picking a point from the viewer to populate a widget that defines a coordinate, the point can either be a point in space or a mesh “node”. This tool enables you to select the mesh node nearest to the location you click.</td>
</tr>
<tr>
<td><img src="image" alt="Displays the Labels and Markers dialog box that is used to select/clear the display of named regions and markers in the viewer. For details, see Boundary Markers and Labels." /></td>
<td>Displays the Labels and Markers dialog box that is used to select/clear the display of named regions and markers in the viewer. For details, see Boundary Markers and Labels.</td>
</tr>
<tr>
<td><img src="image" alt="Selects the viewport arrangement. You can perform Independent zoom, rotation and translate options in each viewport." /></td>
<td>Selects the viewport arrangement. You can perform Independent zoom, rotation and translate options in each viewport.</td>
</tr>
<tr>
<td><img src="image" alt="Toggles between locking and unlocking the views of all viewports. When the views are locked, the camera orientation and zoom level of the non-selected viewports are continuously synchronized with the selected viewport. Locking the view for the viewports in this way can be a useful technique for comparing different sets of visible objects between the viewports. This tool is available only when all viewports are using the Cartesian (X-Y-Z) transformation." /></td>
<td>Toggles between locking and unlocking the views of all viewports. When the views are locked, the camera orientation and zoom level of the non-selected viewports are continuously synchronized with the selected viewport. Locking the view for the viewports in this way can be a useful technique for comparing different sets of visible objects between the viewports. This tool is available only when all viewports are using the Cartesian (X-Y-Z) transformation.</td>
</tr>
<tr>
<td><img src="image" alt="Displays the Viewer Key Mapping dialog box. See Viewer Hotkeys for details." /></td>
<td>Displays the Viewer Key Mapping dialog box. See Viewer Hotkeys for details.</td>
</tr>
</tbody>
</table>

### 2.2.2. Shortcut Menus

You can access the shortcut menu by right-clicking anywhere on the viewer. The shortcut menu is different depending on where you right-click.
## 2.2.2.1. CFX-Pre 3D Viewer Shortcut Menu

### 2.2.2.1.1. Shortcuts for CFX-Pre (Viewer Background)

The following commands are available in CFX-Pre when you right-click the viewer background:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Library Data</td>
<td>Opens the Select Library Data to Import dialog box so that you can add a new material to the simulation. Examples of such materials include Methanol CH₄O, Rubber, Water at 25°C, and many more. This option is the same as right-clicking on Materials in the tree view and selecting Import Library Data.</td>
</tr>
<tr>
<td>Start Solver</td>
<td>• Define Run writes the CFX-Solver input file and starts the CFX-Solver Manager. • Run Solver writes the CFX-Solver input file and starts the CFX-Solver. • Run Solver and Monitor writes the CFX-Solver input file and starts both the CFX-Solver and the CFX-Solver Manager.</td>
</tr>
<tr>
<td>View in CFD-Post</td>
<td>Writes the CFX-Solver input file and start CFD-Post</td>
</tr>
<tr>
<td>Write Solver Input File</td>
<td>The same as selecting Tools &gt; Solve &gt; Write Solver Input File. For details, see Write Solver Input File Command.</td>
</tr>
<tr>
<td>Create New View ...</td>
<td>Creates a new view. The new view will become the current view. For more information about views, see Views and Figures.</td>
</tr>
<tr>
<td>Delete View</td>
<td>Delete the current view.</td>
</tr>
<tr>
<td>Predefined Camera</td>
<td>Displays different views by changing the camera angle to a preset direction.</td>
</tr>
<tr>
<td>Fit View</td>
<td>Centers all visible objects in the viewer. This is equivalent to clicking the magnifying glass icon.</td>
</tr>
<tr>
<td>Projection</td>
<td>Switches between perspective and orthographic camera angles.</td>
</tr>
<tr>
<td>Default Legend</td>
<td>Shows or hides the default legend object.</td>
</tr>
<tr>
<td>Axis</td>
<td>Shows or hides the axis orientation indicator (triad) in the bottom-right corner of the viewer.</td>
</tr>
<tr>
<td>Ruler</td>
<td>Shows or hides the ruler on the bottom of the viewer.</td>
</tr>
<tr>
<td>Labels</td>
<td>Controls the display of labels. For more information, see Boundary Markers and Labels.</td>
</tr>
<tr>
<td>Markers</td>
<td>Controls the display and properties of boundary markers. For more information, see Boundary Markers and Labels.</td>
</tr>
</tbody>
</table>
2.2.2.1.2. Shortcuts for CFX-Pre (Viewer Object)

The following commands are available in CFX-Pre when you right-click an object in the viewer:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Picture</td>
<td>Same as selecting <strong>File &gt; Save Picture</strong>. For details, see <strong>Save Picture Command</strong>.</td>
</tr>
<tr>
<td>Viewer Options</td>
<td>Opens the <strong>Options</strong> dialog box with the viewer options displayed. For details, see <strong>Graphics Style</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit, Edit Definition,</strong></td>
<td>Opens the details view for the selected object so that you can edit its properties.</td>
</tr>
<tr>
<td><strong>Edit Mesh</strong></td>
<td>Shows basic information about mesh regions including node count and maximum element edge length ratio. This command is also available by right-clicking a region selection in the tree view. For details, see <strong>Mesh Statistics</strong>.</td>
</tr>
<tr>
<td><strong>Mesh Statistics</strong></td>
<td>Enables you to insert a boundary, interface, subdomain, or source point. For details, see <strong>Boundary Conditions, Domain Interfaces, Subdomains, or Source Points</strong>.</td>
</tr>
<tr>
<td><strong>Insert</strong></td>
<td>Enables you to insert a boundary, interface, subdomain, or source point. For details, see <strong>Boundary Conditions, Domain Interfaces, Subdomains, or Source Points</strong>.</td>
</tr>
<tr>
<td><strong>Edit in Command Editor</strong></td>
<td>Opens the <strong>Command Editor</strong> dialog box, displaying the CEL for the selected object. For details, see <strong>Using the Command Editor</strong>.</td>
</tr>
<tr>
<td><strong>Render</strong></td>
<td>Displays the following render options: <strong>Color</strong> enables you to choose a color for the selected object. <strong>Lines</strong> enables you to select to <strong>Show Wireframe, Show Mesh</strong> or <strong>No Lines</strong>. <strong>Transparency</strong> enables you to set the transparency levels of the domain. The choices are <strong>Opaque, 0.25, 0.5, 0.75, or Fully Transparent</strong>. <strong>Properties</strong> invokes the <strong>Render Options</strong> dialog box. For details, see <strong>Render Options</strong> (p. 88).</td>
</tr>
<tr>
<td><strong>Show</strong></td>
<td>Shows the object in the viewer.</td>
</tr>
<tr>
<td><strong>Hide</strong></td>
<td>Hides the selected object in the 3D viewer.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the selected object.</td>
</tr>
<tr>
<td><strong>Rename</strong></td>
<td>Changes the selected object’s name.</td>
</tr>
<tr>
<td><strong>Alternatives</strong></td>
<td>When you right-click a location in the viewer, CFX-Pre presents a shortcut menu for one object at that location. Shortcut menus for the other objects at the same location are accessible as submenus under the <strong>Alternatives</strong> heading.</td>
</tr>
</tbody>
</table>

2.2.3. Viewer Hotkeys

A number of shortcut keys are available to carry out common viewer tasks. These can be carried out by clicking in the viewer window and pressing the associated key.

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>space</strong></td>
<td>Toggles between picking and viewing mode.</td>
</tr>
<tr>
<td><strong>arrow keys</strong></td>
<td>Rotates about horizontal and vertical axes.</td>
</tr>
<tr>
<td><strong>Ctrl + up/down arrow keys</strong></td>
<td>Rotates about an axis normal to the screen.</td>
</tr>
</tbody>
</table>
## Key & Action

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift + arrow keys</td>
<td>Moves the light source.</td>
</tr>
<tr>
<td>1</td>
<td>Switches to one viewport.</td>
</tr>
<tr>
<td>2</td>
<td>Switches to two viewports.</td>
</tr>
<tr>
<td>3</td>
<td>Switches to three viewports.</td>
</tr>
<tr>
<td>4</td>
<td>Switches to four viewports.</td>
</tr>
<tr>
<td>c</td>
<td>Centers the graphic object in the viewer window.</td>
</tr>
<tr>
<td>n</td>
<td>Toggles the projection between orthographic and perspective.</td>
</tr>
<tr>
<td>r</td>
<td>Resets the view to the initial orientation.</td>
</tr>
<tr>
<td>s</td>
<td>Toggles the level of detail between auto, off, and on.</td>
</tr>
<tr>
<td>u</td>
<td>Undoes transformation.</td>
</tr>
<tr>
<td>Shift-u</td>
<td>Redoes transformation.</td>
</tr>
<tr>
<td>x</td>
<td>Sets view from +X axis.</td>
</tr>
<tr>
<td>Shift-x</td>
<td>Sets view from -X axis.</td>
</tr>
<tr>
<td>y</td>
<td>Sets view from +Y axis.</td>
</tr>
<tr>
<td>Shift-y</td>
<td>Sets view from -Y axis.</td>
</tr>
<tr>
<td>z</td>
<td>Sets view from +Z axis.</td>
</tr>
<tr>
<td>Shift-z</td>
<td>Sets view from -Z axis.</td>
</tr>
</tbody>
</table>

The information in this table is accessible by clicking the Show Help Dialog toolbar icon in the 3D viewer toolbar.

### 2.2.4. Mouse Button Mapping

The mouse mapping options enable you to assign viewer actions to mouse clicks and keyboard/mouse combined clicks. To adjust or view the mouse mapping options, select Edit > Options, then Viewer Setup > Mouse Mapping.
Table 2.1 Mouse Operations and Shortcuts

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Workbench Mode Shortcuts</th>
<th>CFX Mode Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>To zoom out, drag the pointer up; to zoom in, drag the pointer down.</td>
<td>Shift + middle mouse button</td>
<td>Middle mouse button</td>
</tr>
<tr>
<td>Object Zoom</td>
<td></td>
<td></td>
<td>Shift + middle mouse button zooms in a step.</td>
</tr>
<tr>
<td>Camera Zoom</td>
<td></td>
<td></td>
<td>Shift + right mouse button zooms out a step.</td>
</tr>
<tr>
<td>Translate</td>
<td>Drag the object across the viewer.</td>
<td>Ctrl + middle mouse button</td>
<td>Right mouse button</td>
</tr>
<tr>
<td>Zoom Box</td>
<td>Draw a rectangle around the area of interest, starting from one corner and ending at the opposite corner. The selected area fills the viewer when the mouse button is released.</td>
<td>Right mouse button Shift + left mouse button Shift + right mouse button</td>
<td></td>
</tr>
<tr>
<td>Operation</td>
<td>Description</td>
<td>Workbench Mode Shortcuts</td>
<td>CFX Mode Shortcuts</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotate the view about the pivot point (if no pivot point is visible, the rotation point will be the center of the object).</td>
<td>Middle mouse button</td>
<td></td>
</tr>
<tr>
<td>Set Pivot Point</td>
<td>Set the point about which the Rotate actions pivot. The point selected must be on an object in the 3D Viewer. When you set the pivot point, it appears as a small red sphere that moves (along with the point on the image where you clicked) to the center of the 3D Viewer. To hide the red dot that represents the pivot point, click on a blank area in the 3D Viewer.</td>
<td>Left mouse button when in rotate, pan, zoom, or zoom box mode (as set by the icons in the viewer's tool bar).</td>
<td>Ctrl + middle mouse button</td>
</tr>
<tr>
<td>Move Light</td>
<td>Move the lighting angle for the 3D Viewer. Drag the mouse left or right to move the horizontal lighting source and up or down to move the vertical lighting source. The light angle hold two angular values between 0 - 180.</td>
<td>Ctrl + right mouse button</td>
<td>Ctrl + right mouse button</td>
</tr>
<tr>
<td>Picking Mode</td>
<td>Select an object in the viewer.</td>
<td>Ctrl + Shift + left mouse button</td>
<td>Ctrl + Shift + left mouse button</td>
</tr>
</tbody>
</table>

### 2.2.5. Picking Mode

Picking mode is used to select and drag objects in the viewer. The mesh faces must be visible on an object or region to allow it to be picked. Enter picking mode by selecting the Single Select tool in a pull-down menu of the viewer toolbar. If the Single Select icon is already visible, you can simply click the New Selection icon.

You can also pick objects while still in viewing mode by holding down the Ctrl and Shift keys as you click in the viewer.

#### 2.2.5.1. Selecting Objects

Use the mouse to select objects (for example, points and boundaries) from the viewer. When a number of objects overlap, the one closest to the camera is picked.

You can change the picking mode by selecting one of the toolbar icons:

- **Single Select**
- **Box Select**
- **Polygon Select**

For details on the operation of the toolbar icons, see 3D Viewer Toolbar (p. 19).
2.2.6. Boundary Markers and Labels

Click Case Options > Labels and Markers to invoke the Labels and Markers Options details view, used to select/clear the display of named regions and markers in the viewer as well as change the appearance of the markers.

Also see Boundary Condition Visualization (p. 164) for more details.

2.2.6.1. Label Options

Select the options to enable label visibility. To disable all labels, clear the Show Labels option. The first three options refer to primitive and composite regions. For details, see Assemblies, Primitive Regions, and Composite Regions (p. 91).

2.2.6.2. Boundary Markers

The Show Boundary Markers option turns on boundary condition symbols such as arrows indicating flow direction at an inlet.

The Marker Quantity slider controls the number of markers displayed. Moving the slider to the right increases the number.

The Marker Length slider controls the size of the markers displayed. Moving the slider to the right increases the size.

2.2.6.3. Boundary Vectors

The Vector Quantity slider controls the number of vectors displayed. Moving the slider to the right increases the number.

The Vector Length slider controls the size of the vectors displayed. Moving the slider to the right increases the size.

See Boundary Plot Options Tab (p. 163) for a discussion of displaying boundary vectors.

2.3. Views and Figures

The 3D Viewer opens with a single viewport; you can increase the number of viewports to four by using the viewport icon:

Figure 2.2 Viewport Control
The contents of a viewport are a view, which is a CCL object that contains the camera angle, zoom level, lighting, and visibility setting of each object in the tree view.

Each viewport contains a different, independent view. By default, four views exist: View 1, View 2, View 3, View 4.

When you select an object in the tree view, its information is applied to the active viewport. When you manipulate an object in the viewport, the view's CCL is updated immediately. However if the focus is on that viewport, you can press u to revert your change.

2.3.1. Switching to a View or Figure

To switch to a view or figure, do one of the following:

- Use the drop-down menu in the upper-left corner of the viewport.
- For figures only: Double-click the figure in the tree view (under the Report object).
- For figures only: Right-click the figure in the tree view (under the Report object), then select Edit from the shortcut menu.

2.3.2. Changing the Definition of a View or Figure

To change a view or figure:

1. Switch to the view or figure that you want to change.
   
   For details, see Switching to a View or Figure (p. 28).
2. Change the view or figure (for example, rotate the view).

View and figure objects are saved automatically when you switch to a different view or figure.

2.4. Stereo Viewer

If you:

1. Have a standard stereo display
2. Have a graphics card that supports quad buffering OpenGL output
3. Have set your graphics card to "Stereo"
4. Have set your view to Perspective mode (right-click in the Viewer and select Projection > Perspective)

...you can view output in stereo. To enable this functionality:

1. Select Edit > Options.
2. In the Options dialog box, select CFX-Pre > Viewer.
3. On the Viewer panel:
   a. Set the Stereo Mode to Stereo.

---

1The stereo viewer feature has been tested on:

- XP-64 and Vista-64 with an NVidia graphics card and a Planar Stereo Monitor
- XP-64 with an ATI card and a Zalman Stereo Monitor.
b. Set the **Stereo Effect**. The value of the "stereo effect" that is required is related to the distance between the observer and the display. If the stereo effect is too strong, either move away from the display, or move the slider towards **Weaker**.

4. Click **OK** to save the settings.
Chapter 3: CFX-Pre File Menu

There are a number of basic functions available in CFX-Pre, such as opening and saving an existing case. These are described in detail in this chapter:

3.1. New Case Command
3.2. Open Case Command
3.3. Close Command
3.4. Save Case Command
3.5. Save Project Command
3.6. Refresh Command (ANSYS Workbench only)
3.7. Save Case As Command
3.8. Import Mesh Command
3.9. Reload Mesh Files Command
3.10. Import CCL Command
3.11. Export CCL Command
3.12. Save Picture Command
3.13. Recent Case Files Submenu
3.14. Recent CCL Files Submenu
3.15. Recent Session Files Submenu
3.16. Quit Command

3.1. New Case Command

Note

If a case is open, New Case is not available. To create new cases, ensure all open cases are saved (if required) and closed.

1. Select File > New Case.

The New Case dialog box appears.

2. Select a case type.

- **General** makes use of all features in CFX-Pre. This is the most common mode of operation.
- **Turbomachinery** is used specifically for turbomachinery applications and enables quick setup in such cases. For details, see Turbomachinery Mode (p. 323).
- **Quick Setup** provides fewer model options and is suitable for simple physics setup. It is useful as a tool to learn the basic paradigms of CFX-Pre before using General mode. For details, see Quick Setup Mode (p. 319).
- **Library Template** enables a CCL physics definition to be imported for use on a mesh. For details, see Library Objects (p. 331).
3.2. Open Case Command

The Open Case command can be used to open existing CFX-Pre case files (.cfx), as well as implicitly start a new case by opening a *.def, *.mdef, *.res, *.ccl, “full” transient results file (*.trn), or backup file (*.bak). Other supported file types include: Mesh or Simulation Database file (*.cmdb or *.dsdb), and GTM Database file (.gtm).

**Note**

If a case is already open, Open Case is not available. To open cases, ensure that all open cases are saved (if required) and closed.

1. Select File > Open Case.

   The Load Case File dialog box appears.

2. Select a location to open the file from.

3. Under Files of type, select the type of file to open.

   - Case files can be selected. CFX case files (*.cfx) contain all of the physics, region, and mesh information for your case. For details, see Opening Case (.cfx) Files (p. 33).
   - CFX-Solver input or result files can be selected. For details, see Opening CFX-Solver Input (.def, .mdef), Results (.res), Transient (.trn) or Backup (.bak) Files (p. 33).
   - CCL files can be selected. For details, see Opening CCL (.ccl) Files (p. 33).
   - Mesh or Simulation Database files can be selected. For details, see Opening Meshing (.cmdb or .dsdb) Files (p. 33).
   - GTM Database files can be selected. For details, see Opening CFX-Mesh (.gtm) Files (p. 34).

4. Select the file to open and click Open.

**Note**

When CFX-Solver input or results files from a previous release of CFX are opened in CFX-Pre, physics errors are highlighted in red in the message area. If these errors are ignored, a case can still run in the CFX-Solver in many cases, but it is recommend that the errors be fixed. This ensures CCL is updated to the current version. These errors are usually fixed easily by right-clicking on the object and selecting Auto Fix Physics. Also, double-clicking on the error in the message area opens the details view in which the error was made. For details, see Physics Errors from Old .def/.res Files (p. 12). Also, the Command Editor can be used to correct CCL. For details, see Command Editor Dialog Box (p. 335).

3.2.1. Recover Original Session

When opening a CFX-Solver input file, the option Recover Original Session can be used to find the location of the original CFX Case file (that was used to generate the CFX-Solver input file) and load it. Using this option enables CFX-Pre to access more information (such as composite regions, unused materials and meshes, layouts, and views) and then write that information to the CFX-Solver input file.
When the **Recover Original Session** option is selected, the **Replace Flow Data** option is available. This will extract the CCL from the CFX-Solver input file and replace the existing Case file data. This is useful to recover the problem definition when it has been modified outside of CFX-Pre during the run.

### 3.2.2. Opening Case (.cfx) Files

When opening an existing case file, CFX-Pre opens the case in the state in which it was last saved, including the mesh.

### 3.2.3. Opening CFX-Solver Input (.def, .mdef), Results (.res), Transient (.trn) or Backup (.bak) Files

CFX-Solver input and results files from the current and previous releases of CFX can be opened. When opening these files, a new case file is created. The mesh and physics are imported into the new case. All pre-processing information in these files is imported into CFX-Pre and is edited in the same way as in other case files.

CFX-Pre can also load “full” transient results file (*trn*) or backup file (*bak*) by typing *trn* or *bak*, respectively, as the File Name in the Load Case File dialog box. Using the * character returns a list of available files of type *.trn* or *.bak*. The selected file is imported as a CFX-Solver input file.

**Note**

- If a Release 11.0 .def file containing automatically generated interfaces is loaded into CFX-Pre, and these interfaces were generated as a result of ‘contact’ information in the original .cmdb file, these interfaces may be removed by CFX-Pre. This is a problem only when loading Release 11.0 .def files, and will occur only in a small percentage of cases. Loading a .cfx file will work correctly.
- It is not possible to load an .mres file into CFX-Pre.

### 3.2.4. Opening CCL (.ccl) Files

Opening a CCL file creates a new case file. Any physics, material and expression information is imported into CFX-Pre and can be edited in the same way as for case files. CCL files do not contain any mesh data, so it is necessary to import a mesh before assigning locations to domains and boundary conditions.

### 3.2.5. Opening Meshing (.cmdb or .dsdb) Files

Opening a .cmdb or .dsdb file loads the mesh and creates an initial physics state, in the same manner as creating a new case.

**Important**

.cmdb and .dsdb files require the cfxacmo library, which is supplied with ANSYS Workbench. If you are unable to load such files into CFX-Pre, one solution is to install ANSYS Workbench to make those library files available.
3.2.6. Opening CFX-Mesh (.gtm) Files

Opening a .gtm file loads the mesh and creates an initial physics state, in the same manner as creating a new case.

3.3. Close Command

Closes the existing case, prompting to save if appropriate.

3.4. Save Case Command

When CFX-Pre is started from the ANSYS CFX Launcher, the Save Case command writes the current state to the case file. You should save a case before closing it to be able to reopen it at a later date; all data is lost if CFX-Pre is closed without saving the case.

When CFX-Pre is started from ANSYS Workbench, the Save Project command writes the current state of the project.

3.5. Save Project Command

When CFX-Pre is started from ANSYS Workbench, the Save Project command writes the current state of the project.

3.6. Refresh Command (ANSYS Workbench only)

Reads the upstream data, but does not perform any long-running operation.

3.7. Save Case As Command

When using Save As, the previous case files are closed and remain unchanged from the last time they were explicitly saved.

1. Select File > Save Case As.
   
   The Save Case dialog box appears.

2. Select a location where the file will be saved.

3. Under File name, type the name to save the file as.

4. Click Save.
   
   A new file is saved and is kept open in CFX-Pre.

3.8. Import Mesh Command

Numerous options are available when importing a mesh. For details, see Importing Mesbes (p. 65).

3.9. Reload Mesh Files Command

It is possible to import and manipulate many meshes within a CFX-Pre case. In some cases, this can result in a complex set of operations (for example, a single 'blade' mesh may have been imported, and then 30 copies may have been made). In some cases, it is desirable to swap this mesh for one that is much finer, or of better quality. The process of deleting all existing meshes, re-importing the new mesh
and then applying the transformations again could be costly. Hence, the mesh reload function enables one or more mesh files to be replaced in a fraction of the time.

1. Select **File > Reload Mesh Files**.

   The **Reload Mesh Files** dialog box appears.

2. Select or clear the mesh files to replace the ones that were previously imported.

3. Click **OK**.

---

**Note**

This feature is not required (and is not available) in CFX-Pre launched from ANSYS Workbench.

### 3.10. Import CCL Command

CFX Command Language (CCL) consists of commands used to carry out actions in CFX-Pre, the CFX-Solver Manager and CFD-Post. All of the steps carried out in CFX-Pre are executed as CCL commands in the software's engine, and these commands can be exported and imported to other cases.

**Tip**

- You can also import expressions and regions using the Import CCL command.
- To import composite region definitions from older versions of CCL, use the **Import CCL** command found in the File menu, rather than the import command found in the Regions workspace.

A useful application of importing CCL is to apply the same pre-processing data to a number of different meshes. In such a case, the following general workflow may be ensued:

1. Import the new mesh.
2. Import the CCL data.
3. Assign mesh locations to the domains and boundary conditions, if required.
4. Write the CFX-Solver input file for the CFX-Solver.

The benefit of using this workflow is that there would be no need to specify all of the pre-processing data again.

Importing a set of commonly used customized material or reaction definitions is also possible by importing a CCL file. A useful application of the import CCL feature is demonstrated when using Library Mode. For details, see *Library Objects* (p. 331).

### 3.10.1. Append or Replace

**3.10.1.1. Append**

This option never deletes existing objects such as domains, boundary conditions, initialization, and so on. Objects with a different name than existing objects are added. If an object of the same name and type already exists, parameters within the object that are unique to the imported CCL file are added to
the existing object. When the imported CCL file contains parameter definitions that already exist within existing objects, they will replace the existing definitions.

### 3.10.1.2. Replace

This option overwrites, in full, existing objects of the same name and type. Because boundary conditions, subdomains, and so on are defined within a domain, if that domain is replaced, these objects are lost if not defined in the imported CCL file. Objects with a unique name are added to the existing case.

#### 3.10.1.2.1. Auto-load materials

When Replace is selected, the Auto-load materials check box is made available. When a file is imported with the Auto-load materials check box selected, any materials and reactions that are missing from the problem setup being imported, and that are not defined in the case already, will be loaded automatically. These added materials and reactions can be found in the standard materials and reactions library files.

### 3.11. Export CCL Command

Using Export CCL, some or all CCL definitions can be exported to a file.

1. Select File > Export > CCL.

   The Export CCL dialog box appears.

2. Select or clear Save All Objects.

   A list of all existing CCL objects is available. To export particular objects, clear Save All Objects and select only the objects to export. For details, see Save All Objects (p. 36).

3. Select a location to export to.

4. Enter a name for the exported file.

5. Click Save.

To export the physics definition for a problem, select all the FLOW objects. Additional Variables, CEL expressions, User Functions and material definitions are stored in LIBRARY objects; these will need to be included if you want to export these objects.

### 3.11.1. Save All Objects

When Save All Objects is selected, all CCL object definitions are written to the CCL file. To export only a sub-set of CCL objects, clear this and select only the required CCL objects.

#### 3.11.1.1. Sample of Saving CEL Expressions

This sample is specifically for the export of expressions.

1. Select File > Export > CCL.

2. Clear Save All Objects and expand LIBRARY.

3. Expand CEL.

4. Select EXPRESSIONS.

5. Select a location to export to.
6. Enter a name for the exported file.
7. Click Save.

### 3.12. Save Picture Command

The current contents of the viewer can be saved to a file.

1. Select **File > Save Picture**.

   The **Save Picture** dialog box appears.

2. Enter a name for the file. You may enter the file name and path into the **File** text box, or click the **Browse** icon and search for the directory in which the file is to be saved.

3. If you have used the **Browse** feature, click **Save**.

   The **Save Picture** dialog box displays the path and name of the file. If a new format was selected, the default extension changes on this dialog box as well.

4. Under **Format**, select the output style of the image.

   • Portable Network Graphics (*.png) is a file format intended to replace the GIF format. It was designed for use on the World Wide Web and retains many of the features of GIF with new features added.
   • CFD Viewer State (3D) is a 3D file format that can be read back directly into a stand-alone CFD Viewer.
   • JPEG (*.jpg) is a compressed file format developed for compressing raw digital information. File sizes are small but it is not recommended for line drawings.
   • Bitmap (*.bmp) files are usually large and do not adjust well to resizing or editing. They do retain all of the quality of the original image and can be easily converted to other formats.
   • Portable Pixel Map (*.ppm) is similar to the Bitmap format.
   • PostScript (*.ps) and Encapsulated PS (*.eps) are generally recommended for output to a printer or line drawings. However, labels\(^1\), the ruler\(^2\) and transparency\(^3\) will cause the PS/EPS to output as a very large bitmap file, in which case a PNG file would be a more efficient alternative. Note that the ANSYS logo and the axis do not cause the PS/EPS output to become a bitmap.
   • Virtual Reality Modeling Language (VRML, *.wrl) is used to present interactive three-dimensional views and can be delivered across the World Wide Web. The only supported VRML viewer is Cortona from Parallel Graphics (see http://www.parallelgraphics.com/products/cortona/).

5. Select or clear **Use Screen Capture**.

   If selected, a screen capture of the viewer is saved to the output. Note that **Face Culling** affects printouts done using screen capture mode only.

6. Select or clear **White Background**.

---

\(^1\)You can hide labels from **Edit > Options > CFX-Pre > Labels and Markers > Labels**.

\(^2\)You can hide the ruler from **Edit > Options > CFX-Pre > Graphics Style > Visibility > Ruler Visibility**.

\(^3\)You can control transparency from **Edit > Render > Transparency**.
If selected, white objects appear in black and black objects appear in white in the image file (except VRML). All objects are affected by this toggle and slightly off-white and off-black objects are also inverted.

7. Select or clear **Enhanced Output (Smooth Edges).**

If selected, the image is processed by antialiasing.

8. Select or clear **Use Screen Size.**

If selected, the current screen size is used. Otherwise, set a width and height.

9. Select or clear **Scale (%).**

If selected, the size of the image is reduced or increased to a percentage of the current viewer screen size.

10. If exporting to JPEG format, select or clear **Image Quality.**

Set between 0 (lowest) and 100 (highest).

11. Set a **Tolerance.**

The default tolerance is 0.0001. This is a non-dimensional tolerance used in face sorting when generating hardcopy output. Larger values result in faster printing times, but may cause defects in the resulting output.

Note that the paper orientation for printing, portrait or landscape, is determined by the size of the viewer window. If the height of the window is larger then the width, then portrait is used. If the width is larger then the height, then landscape is used.

---

**Important**

When a clip plane is coincident with regions, boundaries, or interfaces that are planes, the results of a **Save Picture** command may not match what you see in the 3D Viewer (depending on the orientation of the case). In this situation, select the **Use Screen Capture** check box.

### 3.13. Recent Case Files Submenu

CFX-Pre saves the file paths of the last five case files (.cfx) opened. To open one of these case files, select **File > Recent Case Files.**

### 3.14. Recent CCL Files Submenu

CFX-Pre saves the file paths of the last five CCL files opened. To open one of these CCL files, select **File > Recent CCL Files.**

### 3.15. Recent Session Files Submenu

CFX-Pre saves the file paths of the last five session files opened. To open one of these session files (*pre), select **File > Recent Session Files.**
3.16. Quit Command

To quit CFX-Pre, select **File > Quit**. In stand-alone mode, if the case is not already saved, there will be a prompt as to whether a save should be done.
Chapter 4: CFX-Pre Edit Menu

This chapter describes:

4.1. Undo and Redo
4.2. Options

**Undo** and **Redo** commands are available in the **Edit** menu. Additionally, there are a variety of options that can be set to customize the software.

### 4.1. Undo and Redo

The undo and redo capability is limited by the amount of available memory.

In stand-alone mode, the undo stack is cleared whenever a **New**, **Open**, or **Close** action occurs. Similarly, when using CFX-Pre/CFD-Post from within ANSYS Workbench, the undo stack is cleared in CFX-Pre/CFD-Post after the application receives commands from ANSYS Workbench.

Issue the **Undo** command by doing any of the following:

- Select **Edit > Undo**.
- Click **Undo** on the toolbar.
- Press **Ctrl + Z**

**Note**

- You can repeatedly issue the **Undo** command.
- Some viewer manipulations cannot be reverted using the **Undo** command.
- Some commands that you issue have multiple components. For example, when you create some objects the software creates the object and sets the visibility of the object on (in two separate operations). Thus, when you perform an undo operation in such a situation, you are setting the visibility of the object off; you must choose undo a second time to “uncreate” the object.
- **Undo** cannot be used when recording session files.

The redo feature is used to do an action that you have just undone using the **Undo** command. Issue the **Redo** command by doing any of the following:

- Select **Edit > Redo**.
- Click **Redo** on the toolbar.
- Press **Ctrl + Y**
4.2. Options

The **Options** dialog box enables you to set various general preferences. Settings are retained per user.

1. Select **Edit > Options**.

   The **Options** dialog box appears.

2. Set options as required. For descriptions of the available options, see:
   - *CFX-Pre Options* (p. 42)
   - *Common Options* (p. 47)

   If desired, you can use the **CFX Defaults** or the **Workbench Defaults** buttons at the bottom of the dialog box to quickly set CFX-Pre, CFX-Solver Manager, and CFD-Post to have the standard appearance and operation of CFX or Workbench respectively. The only CFX-Pre settings that are affected by these buttons are:
     - **CFX-Pre > Graphics Style > Background > Color Type**
     - **CFX-Pre > Graphics Style > Background > Color**
     - **CFX-Pre > Colors > Labels**
     - **CFX-Pre > Colors > Legend Text**
     - **CFX-Pre > Colors > Turbo Axis**
     - **Common > Viewer Setup > Mouse Mapping**

3. Click **OK**.

---

**Note**

Changes made under the **Options** dialog box do not take effect until a new case is opened.

When changing some user preferences, it will be necessary to restart the application for the setting to take effect. For example, changes to the highlighting mode, whether made in the **Edit > Options** panel or from the **Outline** tree **Case Options > General > General Options** panel, do not take place until the application is restarted.

### 4.2.1. CFX-Pre Options

When the **Options** dialog box appears, the CFX-Pre options can be configured under **CFX-Pre**.

- **Record Default Session File**

  When selected, a session file named _cfx.xx.pre_ will be recorded automatically each time CFX-Pre is started (where ‘xx’ is the next available number). For more information on session files, see *Playing a Tutorial Session File*.

- **Default User Mode** can be set to General, Turbo, or Quick Setup.

This determines the default mode that CFX-Pre will use when creating a simulation. For details on Turbo mode, see _Turbomachinery Mode_ (p. 323). For details on Quick Setup mode, see *Quick Setup Mode* (p. 319).
• **Report CCL Update Summary** produces an information window when you load a file that contains CCL from a previous version of CFX-Pre. This window describes the updates that were made to the CCL to make it compatible with the current software release.

### 4.2.1.1. General

Settings made here set the default operation for CFX-Pre; however, you can override these settings for your current simulation by going to the Outline tree view and editing Case Options > General.

#### 4.2.1.1.1. Auto Generation

- **Automatic Default Domain**

  When this option is selected, a domain with the name Default Domain will be created upon importing a mesh.

  To toggle default domain generation on or off for a session, without affecting the user preference setting, you can right-click the Simulation object in the tree view and select Automatic Default Domain from the shortcut menu.

  If you manually delete a default domain, the default domain mechanism will be disabled, and a warning message will appear in the physics message window.

  If you create a domain that uses the same region(s) as the default domain, the latter will be redefined with the remaining locations, or deleted if all the regions are referenced by user-defined domains.

  If you modify the location of the default domain, the name will change to Default Domain Modified and no additional default domain will be generated.

  When loading an existing case (cfx file or def file), if there are any mesh volumes that are not assigned to a domain, the default domain generation will be disabled. It can be re-activated as described previously.

- **Automatic Default Interfaces**

  When selected, CFX-Pre will attempt to create domain interfaces when a domain is created or modified.

  To toggle default interface generation on or off for a session, without affecting the user preference setting, you can right-click the Simulation object in the tree view and select Automatic Default Interfaces from the shortcut menu.

  Domain interface generation is always deactivated when loading an existing simulation.

- **Interface Method**

  When Automatic Default Interfaces has been selected, the Interface Method can be set to one of the following to control how interfaces are automatically generated between domains where regions are found to be connected:

  - One per Interface Type

    This method groups as many domains into as few interfaces as possible.

  - One per Domain Pair

    An interface is generated for each pair of domains.
• **Default Boundary** can be set to one of the following:
  
  - **Standard**
    
    A default boundary condition is created that covers all primitive regions that are not assigned to any boundary condition in the current domain. The default boundary is modified dynamically when other boundary conditions are subsequently added or deleted such that it includes all regions not assigned to any other boundary condition.
  
  - **One per Relevant Region**
    
    A default boundary condition on each relevant region not assigned to any boundary condition is created. In this context, ‘relevant’ means every composite 2D region, plus any 2D primitive regions that are not referenced by a composite 2D region. If boundary conditions are subsequently deleted, causing some regions to be unassigned, a single default boundary condition will include all such regions.
  
  - **One per Primitive Region**
    
    A default boundary condition on each individual 2D primitive region not assigned to any boundary condition is created. If boundary conditions are subsequently deleted, causing some regions to be unassigned, a single default boundary condition will include all such regions.
  
  - **Disabled**

**4.2.1.2. Physics**

- **Disable Physics Validation**
  
  This option prevents CFX-Pre from issuing messages in the physics message window. For details, see *Physics Message Window* (p. 11).

- **Enable Beta Features**
  
  Some beta features are hidden in the user interface. You can select this option to unhide those beta features. When selected, such Beta features will be identified by "(Beta)" in the user interface.

- **Automatic Physics Update**
  
  If this option is selected and you change settings in the simulation definition, CFX-Pre will, for certain settings, respond by changing other settings automatically in an attempt to make problem specification consistent. This incurs an overhead, so for large problems you may want to disable this feature.

- **Show Interface Boundaries in Outline Tree**
  
  Shows the interface boundaries in the Outline view.

**4.2.1.2. Graphics Style**

Settings made here set the default operation for CFX-Pre; however, you can override these settings for your current simulation by going to the **Outline** tree view and editing **Case Options > Graphics Style**.

**4.2.1.2.1. Object Highlighting**

Controls how an object that is generated after a change to the setting of this option is highlighted in the viewer. Such highlighting occurs when in picking mode, when selecting a region in a list, or when selecting items in the tree view.
Under **Type**, select one of the following:

- **Surface Mesh**: Displays the surface mesh for selected regions using lines.
- **Face Highlight**: Displays the selected regions using faces.
- **Wireframe**: Traces objects that contain surfaces with green lines.
- **Bounding Box**: Highlights the selected objects with a green box.

**Note**

When you load a case, the highlighting is dictated by the setting that is stored in the case, rather than by the current preferences setting.

### 4.2.1.2.2. Background

Set **Mode** to **Color** or **Image**.

#### 4.2.1.2.2.1. Color

Use **Color Type** to set either a solid color or a gradient of colors; use **Color** to set the color (and **Color 2** for gradients).

#### 4.2.1.2.2.2. Image

Select one of a list of predefined images or a custom image.

If selecting a custom image, choose an image file and a type of mapping. Image types that are supported include *.*bmp (24-bit BMP only), *.*jpg, *.*png, and *.*ppm. Mapping options are **Flat** and **Spherical**. Flat maps are stationary while spherical maps surround the virtual environment and rotate with the objects in the viewer.

Custom images have some restrictions: all background images and textures sent to the viewer must be square and must have dimensions that are powers of 2 (for example, 512 x 512 or 1024 x 1024).

If the dimensions of your background image is not a power of 2, the viewer sizes the image to be a power of 2 by doing bicubic resampling.

To make the background image square, transparent pixels are added to the smaller dimension to make it the same as the larger dimension. The transparent pixels enable you to see the regular viewer background, which gives you control over what fill color your background has.

### 4.2.1.2.3. Colors

#### 4.2.1.2.3.1. Labels

Set the labels to be bright or dark.

#### 4.2.1.2.3.2. Legend Text and Turbo Axis

Select a color by clicking in the box, or clicking the **Ellipsis** icon.
4.2.1.2.4. Visibility

4.2.1.2.4.1. Axis and Ruler Visibility

Select or clear Axis Visibility or Ruler Visibility to show or hide the axis indicator or ruler in the viewer.

4.2.1.3. Render

These settings are used to control the display properties of faces and lines. For details, see Render Options (p. 88).

4.2.1.4. Mesh

Mesh Match Tolerance is used when creating domain interfaces. It is used to determine whether a one-to-one connection can be made at a domain interface. The tolerance is relative to the local mesh length scale; the default value is 0.005 (or 0.5%) of the local edge length on the first side of the interface. A node on the second side must be within this tolerance to a node on the first side for the two to be considered coincident.

4.2.1.4.1. Mesh Import Options

Source Format specifies which type of mesh file is the general default. For details, see Supported Mesh File Types (p. 67). Source Directory specifies the default directory from which meshes are imported upon selecting the Import Mesh command. It is also possible to set other general options (such as mesh units) and specific advanced options on a per-mesh format basis.

4.2.1.5. Turbo

These settings are used in the recognition of turbo regions when importing a mesh using Turbo mode.

4.2.1.6. Labels and Markers

The settings under this category control whether labels and boundaries appear in the cases displayed in the 3D Viewer. Settings made here set the default operation for CFX-Pre; however, you can override these settings for your current simulation by going to the Outline tree view and editing Case Options > Labels and Markers.

4.2.1.6.1. Labels

The Show Labels option controls whether any labels are displayed; when selected, the remaining options control whether particular types of labels are displayed.

4.2.1.6.2. Boundary Markers

When Show Boundary Markers is selected, the check boxes in that panel control which markers are displayed.

The Marker Quantity slider controls the number of markers displayed. Moving the slider to the right increases the number.

The Marker Length slider controls the size of the markers displayed. Moving the slider to the right increases the size.
4.2.1.6.3. Boundary Vectors

The **Vector Quantity** slider controls the number of vectors displayed. Moving the slider to the right increases the number.

The **Vector Length** slider controls the size of the vectors displayed. Moving the slider to the right increases the size.

See *Boundary Plot Options Tab* (p. 163) for a discussion of displaying boundary vectors.

4.2.1.7. Extensions

When **Include Installed Extension Files** is selected, you have the option of creating a comma-separated list of file to exclude.

4.2.1.8. Customization

The **Use Custom Files** setting enables the creation of special-purpose interfaces that extend the functionality of CFX-Pre for your environment. Contact your Customer Support representative for more information.

The **Force generation of rules files** an advanced setting used to maintain synchronization of customized RULES files. This option is useful during the development of customized RULES files and is available only when **Use Custom Files** is selected.

4.2.1.9. Solve

The **Definition File Timeout** setting controls how long CFX-Pre will wait in seconds while attempting to obtain enough data from the CFX-Solver in order to spawn a CFX-Solver Manager to monitor an existing batch run. This parameter is used when employing the Simulation Control > Start Solver > Run Solver and Monitor command to start the CFX-Solver Manager. See Simulation Control in Outline Tree View Structure (p. 5) for details on monitoring a running solver batch run.

4.2.1.10. Viewer

For details on **Stereo** settings, see Stereo Viewer (p. 28).

4.2.2. Common Options

**Auto Save**
- Select the time between automatic saves.

To turn off automatic saves, set **Auto Save** to **Never**.

---

**Note**

This option affects more than one CFX product.

**Temporary directory**
- To set a temporary directory, click **Browse** to find a convenient directory where the autosave feature will save state files.
4.2.2.1. Appearance

The appearance of the user interface can be controlled from the Appearance options. The default user interface style will be set to that of your machine. For example, on Windows, the user interface has a Windows look to it. If, for example, a Motif appearance to the user interface is preferred, select to use this instead of the Windows style.

1. Under GUI Style, select the user interface style to use.
2. For Font and Formatted Font, specify the fonts to use in the application.

Note

It is important not to set the font size too high (over 24 pt. is not recommended) or the dialog boxes may become difficult to read. Setting the font size too small may cause some portions of the text to not be visible on monitors set at low resolutions. It is also important not to set the font to a family such as Webdings, Wingdings, Symbols, or similar type faces, or the dialog boxes become illegible.

4.2.2.2. Viewer Setup

1. If you have complicated simulations that feature many overlapping lines, you can specify a Picking Tolerance that will increase the resolution for picking operations. Values must be between 1 (low resolution) and 0 (very high resolution); the default value is 0.1. Note that increasing the resolution will slow printing times.
2. Select Double Buffering to use two color buffers for improved visualization. For details, see Double Buffering (p. 48).
3. Select or clear Unlimited Zoom. For details, see Unlimited Zoom (p. 48).

4.2.2.2.1. Double Buffering

Double Buffering is a feature supported by most OpenGL implementations. It provides two complete color buffers that swap between each other to animate graphics smoothly. If your implementation of OpenGL does not support double buffering, you can clear this check box.

4.2.2.2.2. Unlimited Zoom

By default, zoom is restricted to prevent graphics problems related to depth sorting. Selecting Unlimited Zoom allows an unrestricted zoom.

4.2.2.3. Mouse Mapping

The mouse-mapping options allow you to assign viewer actions to mouse clicks and keyboard/mouse combinations. These options are available when running in stand-alone mode. To adjust or view the mouse mapping options, select Edit > Options, then Viewer Setup > Mouse Mapping. For details, see Mouse Button Mapping.

4.2.2.4. Units

1. Under System, select the unit system to use. Unit systems are sets of quantity types for mass, length, time, and so on.
The options under System include SI, CGS, English Engineering, British Technical, US Customary, US Engineering, or Custom. Only Custom enables you to redefine a quantity type (for example, to use inches for the dimensions in a file that otherwise used SI units).

The most common quantity types appear in the main Options dialog box; to see all quantity types, click More Units.

2. Select or clear Always convert units to Preferred Units.

If Always convert units to Preferred Units is selected, the units of entered quantities are immediately converted to those set in this dialog box.

For example, if you have set Velocity to \([\text{m s}^{-1}]\) in this dialog box to make that the preferred velocity unit, and elsewhere you enter 20 \([\text{mile hr}^{-1}]\) for a velocity quantity, the entered value is immediately converted and displayed as 8.94078 \([\text{m s}^{-1}]\).

The two sets of units are:

- The units presented on this dialog box, which control the default units presented in the user interface as well as the units used for mesh transformation.
- The solution units. For details, see Setting the Solution Units (p. 197).

4.2.2.4.1. Additional Help on Units

For additional information about units, see Mesh Units (p. 66).
Chapter 5: CFX-Pre Session Menu

A session file is a record of the actions performed during a CFX-Pre session, saved in a file as commands. The actions that cause commands to be written to a session file include:

- Viewer manipulation performed using the commands available by right-clicking in the viewer window.
- All actions available from the File and Edit menus.
- Creation of expressions.
- Creation of new objects and changes to an object committed by clicking OK or Apply on any of the panels available from the Tools and Insert menus/toolbars.
- Commands issued in the Command Editor dialog box.
- Mesh import, delete, and transformation operations.

This chapter describes:

5.1. New Session Command
5.2. Start Recording and Stop Recording Commands
5.3. Play Session and Play Tutorial Commands

5.1. New Session Command

To record your actions in CFX-Pre in a session file:

1. Select Session > New Session. This opens the Set Session File dialog box, where you can enter a file name for your session file. Once you have saved the file, it becomes the current session file.

   **Note**

   This command is available only when a session file is not currently being recorded.

2. Browse to the directory in which you want to create the session file, and then enter a name for the file ending with a .pre (CFX-Pre) extension.
3. Click Save to create the file.
4. To start recording to the session file, select Session > Start Recording.
5. To stop recording to the session file, select Session > Stop Recording.

   **Important**

   Session files must not contain > undo commands. These commands would produce errors when playing back the session file.

If you create more than one session file during a CFX-Pre session, the most recently created file is the current session file by default. You can set a different file to be the current session file by selecting an
existing file from the **New Session > Set Session File** window and then clicking **Save**. Because the file exists, a warning dialog box appears:

- If you select **Overwrite**, the existing session file is deleted and a new file is created in its place.
- If you select **Append**, commands will be added to the end of the existing session file when recording begins.

**Note**

By default, CFX-Pre does not continuously write commands to a session file while you are working on your simulation. You can change a setting in **Edit > Options** so that a session file is recorded by default. If a session file is being recorded by CFX-Pre, whether by default or intentionally, a new session file cannot be recorded.

### 5.2. Start Recording and Stop Recording Commands

The **Start Recording** action activates recording of CCL commands issued to the current session file. A session file must first be set before you can start recording (see **New Session Command** (p. 51)).

**Stop Recording** terminates writing of CCL commands to the current session file. You can start and stop recording to a session file as many times as necessary.

### 5.3. Play Session and Play Tutorial Commands

A session file is a record of the actions performed during a CFX-Pre session, saved to a file when you have defined a session file name and have clicked **Session > Start Recording**. By default, this file is stored in your working directory.

A tutorial file is a record of the actions performed during a CFX-Pre tutorial; you can find tutorial files provided by ANSYS in `<CFXROOT>/examples`.

This section describes:

- **Play Session Command** (p. 52)
- **Play Tutorial Command** (p. 53)

### 5.3.1. Play Session Command

After you have recorded a session file, you can select **Session > Play Session**, which opens the **Play Session File** dialog box in which you can select the session file to play. The commands listed in the selected session file are then executed.
**Important**

If a session file is played while a current simulation is open, existing data will be lost in the following situations:

- If the session file starts a new simulation (that is, if it contains a `>load` command), then the current simulation is closed without saving.
- If the session file does not contain a `>load` command, the behavior is the same as importing a CCL file using the **Append** option. For details, see **Append or Replace** (p. 35). Existing objects with the same name as objects defined in the session file are replaced by those in the session file.

To play a session file:

1. From the menu bar, select **Session > Play Session**.
2. Browse to the directory containing the session file and select the file you want to play.
3. Click **Open** to play the session file.

**Note**

You can play session files in stand-alone CFX-Pre, but not in CFX-Pre in ANSYS Workbench.

### 5.3.2. Play Tutorial Command

Selecting **Session > Play Tutorial** opens the **Play Session File** dialog box where you can select a tutorial session file (.pre) to play from the **examples** directory of your CFX installation. The commands listed in the selected tutorial session file are then executed.

Tutorial session files cannot be played while other simulations are open.

**Note**

You can play tutorial session files in stand-alone CFX-Pre, but not in CFX-Pre in ANSYS Workbench.
Chapter 6: CFX-Pre Insert Menu

The **Insert** menu enables you to create new objects, such as domains or boundary conditions, or to edit existing objects.

**Tip**

You are also able to create objects from shortcut menus in some contexts.

The settings specified in the various **Insert** menu panels correspond to all the data displayed in the tree view. In many cases, the name of the new object can be specified. This name must be no more than 80 characters in length.

**Valid Syntax for Named Objects** Any of the following characters are allowed in names of objects in CFX-Pre: A-Z a-z 0-9 <space> (however, the first character must be A-Z or a-z). Multiple spaces are treated as a single space character, and spaces at the end of a name are ignored.

In general, object names must be unique within the physics setup.

**Analysis**

Creates a new **Flow Analysis** in the Outline tree under **Simulation**. This enables you to define a steady-state analysis or a transient analysis.

**Analysis Type**

Specifies a steady-state or a transient analysis (in the analysis you select, when multiple analyses are available). Steady-state analyses are used to model flows that do not change over time, while transient analyses model flows that are time-dependent. For details, see **Analysis Type** (p. 101).

**Domain**

Creates new fluid and solid domains (in the analysis you select, when multiple analyses are available). These are the bounding volumes within which your CFD analysis is performed. You can create many domains in CFX-Pre and each can be stationary or rotate at its own rate, using different mesh element types. For details, see **Domains** (p. 105).

**Boundary**

Sets the conditions on the external boundaries of a specified domain in a selected analysis. In CFX-Pre, boundary conditions are applied to existing 2D mesh regions. For details, see **Boundary Conditions** (p. 149).

**Subdomain**

Creates subdomains, which are volumes within a specified domain in a selected analysis that are used to create volumetric sources. For details, see **Subdomains** (p. 181).

**Source Point**

Creates sources of quantities at a point location within a specified domain in a selected analysis. For details, see **Source Points** (p. 177).

**Domain Interface**

Connects fluid domains together (in the analysis you select, when multiple analyses are available). If a frame change occurs across the interface, you have the choice of using a frozen rotor, stage, or transient
rotor-stator model to account for the frame change. You can also take advantage of domain interfaces to produce periodic connections between dissimilar meshes. For details, see *Domain Interfaces* (p. 137).

**Global Initialization**

Sets values or expressions for the global initial conditions (across all domains in the analysis you select, when multiple analyses are available). Domain specific initialization is set through the domain forms. In CFX-Pre, you can set linearly varying conditions from inlet to outlet using the initialization forms. For details, see *Initialization* (p. 167).

**Coordinate Frame**

Creates and edits coordinate frames. A Cartesian coordinate frame exists by default, but other Cartesian frames can be made. For details, see *Coordinate Frames in the CFX-Solver Modeling Guide* and *Coordinate Frames* (p. 255).

**Material / Reaction**

Creates and modifies materials and reactions. For details, see *Materials and Reactions* (p. 259).

**CFX-RIF**

Inserts a flamelet library defined using CFX-RIF, a type of library generation software. For details, see *CFX-RIF in the CFX-Solver Modeling Guide*.

**Regions: Composite Region / Primitive Region**

Composite regions can be created from basic primitive regions that are imported with a mesh. The Regions details view supports union and alias operations. This enables you to manipulate existing 2D and 3D regions without returning to the mesh generation software package. The creation of new regions is limited by the topology of the existing primitive regions; therefore, you must still create appropriate regions in the mesh-generation software package.

You can specify physics on either a primitive region, a composite region, or a mixture of both.

For details, see *Regions* (p. 95).

**Additional Variable**

Under *Expressions, Functions and Variables, Additional Variable* creates and modifies additional solution variables. For details, see *Additional Variables* (p. 275).

**Expression**

Under *Expressions, Functions and Variables, Expression* creates and generates expressions using the CFX Expression Language (CEL). For details, see *Expressions* (p. 281).

**User Functions**

Under *Expressions, Functions and Variables, User Function* creates 1D and cloud of points interpolation functions. The interpolation functions are typically used to set boundary and initialization values in addition to profile data interpolation functions. For details, see *User Functions* (p. 287).

**User Routines**

Under *Expressions, Functions and Variables, User Routine* creates User CEL, Junction Box, and Particle User Routines. For details, see *User Routines* (p. 293).

**Solver: Solution Units**

Sets the solution units used by the CFX-Solver (in the analysis you select, when multiple analyses are available). These are the units that your results will appear in. For details, see *Units and Dimensions* (p. 193).

**Solver: Solver Control**

Controls the execution of the CFX-Solver (in the analysis you select, when multiple analyses are available). This includes timestep and convergence details, as well as the choice of advection scheme. For details, see *Solver Control* (p. 199).
Solver: Output Control
Controls output from the CFX-Solver, including backup and transient results file creation (in the analysis you select, when multiple analyses are available). For details, see Output Control (p. 213).

Solver: Mesh Adaption
Controls if and how the mesh will be automatically refined during the solution (in the analysis you select, when multiple analyses are available). This technique can be used to refine the mesh to a particular flow feature whose location is unknown prior to starting the analysis, such as a shock wave. For details, see Mesh Adaption (p. 245).

Solver: Expert Parameter
Provides advanced control of the CFX-Solver (in the analysis you select, when multiple analyses are available). For most analyses, you do not need to use expert parameters. For details, see Expert Control Parameters (p. 253).

Solver: Execution Control
Enables you to define how the CFX-Solver is to be started for a simulation. See Execution Control (p. 299) for details.

Configurations: Configuration / Termination Control
Simulation controls enable you to define the execution of analyses and related tasks such as remeshing in the simulation. Specific controls include definitions of global execution and termination controls for one or more configurations. See Configurations (p. 307) for additional information.
Chapter 7: CFX-Pre Tools Menu

The **Tools** menu provides access to the following:

- **7.1. Command Editor**
- **7.2. Expand Profile Data**
- **7.3. Initialize Profile Data**
- **7.4. Macro Calculator**
- **7.5. Solve**
- **7.6. Applications**
- **7.7. Quick Setup Mode**
- **7.8. Turbo Mode**

### 7.1. Command Editor

Displays and edits the CCL definition of objects, and as well issues commands directly to CFX-Pre. For details, see *Command Editor Dialog Box* (p. 335).

### 7.2. Expand Profile Data

When setting up a boundary profile for a turbomachinery case (such as a transient blade row case involving an inlet disturbance), it is sometimes convenient to use a profile that wraps completely around the machine axis.

Given an existing profile data file that describes, in Cartesian coordinates, a section that possesses rotational periodicity around a *Rotation Axis*, you can use the **Expand Profile Data** dialog box to obtain a new profile file that contains a 360° profile. The input profile is replicated about the specified axis in the positive rotational direction (according to the right-hand rule). The number of replications required is given by the ratio of the specified **Passages In 360** and **Passages In Profile** settings.

---

**Note**

Vector data is rotated in terms of both direction and position (while point data is rotated only in terms of position).

---

**Note**

If a non-integer number of replications is needed to obtain a 360° profile, then the data for the last replicated portion is truncated and a gap is left. The gap is positioned to be as far away from the original profile as possible.

To expand profile data:

1. Select **Tools > Expand Profile Data**.

   The **Expand Profile Data** dialog box appears.
2. Set **Data File To Expand** to the name of the current profile file.

   You may use the file browser for this purpose, by clicking **Browse**.

3. Set **Write To Profile** to the name of the file that will hold the expanded profile.

   You may use the file browser for this purpose, by clicking **Browse**.

4. Set **Passages in Profile** to the number of passages that the current profile models.

5. Set **Passages in 360** to the number of passages in a complete 360° revolution.

6. Set **Rotation Axis** to the rotation axis around which the profile rotates.

7. Click **OK** to begin the operation.

8. When finished, click **Close** to close the dialog box.

### 7.3. Initialize Profile Data

Imports data from a file to use a profile boundary condition. For details, see *Initializing Profile Data* (p. 152).

### 7.4. Macro Calculator

The macro calculator in CFX-Pre is very similar to the one in CFD-Post. For details, see *Macro Calculator in the CFD-Post User’s Guide*. There are some minor differences between the two, however. For instance, an additional widget type, **Location**, is available in the CFX-Pre macro calculator. This enables the selection of mesh regions within the macro. An example of how to use this widget type is:

```python
# Macro GUI begin
#
# macro name = StaticMixer
# macro subroutine = test
# macro report file = test_report.html
#
# macro parameter = Domain Location
# type = Location
# value list = 3d composites, 3d primitives
```

A number of standard lists are available for this widget. The valid value list entries are as follows:

- **2d primitives / 3d primitives**: all primitive 2D and 3D regions for the model
- **internal 2d primitives**: all primitive 2D regions that are internal to the model
- **composites**: all composite regions
- **2d composites / 3d composites**: all 2D and 3D composite regions
- **assemblies**: all assemblies

Also, predefined macros are not supplied for CFX-Pre the way they are in CFD-Post. For details, see *Predefined Macros in the CFD-Post User's Guide*.

### 7.5. Solve

Available in stand-alone mode for the current definition of the case, you can use the **Solve** option to:

- from **Start Solver**;
  - select **Define Run** to write the CFX-Solver input file and start the CFX-Solver Manager,
– select Run Solver to write the CFX-Solver input file and start the CFX-Solver,
– select Run Solver and Monitor to write the CFX-Solver input file and start both the CFX-Solver and the CFX-Solver Manager.

- from View in CFD-Post, write the CFX-Solver input file and start CFD-Post
- from Write Solver Input File, write the CFX-Solver input file.

### 7.5.1. Write Solver Input File Command

A CFX-Solver input file contains information (such as physics, mesh) required to execute a case in CFX-Solver to solve physics.

1. Select Tools > Solve > Write Solver Input File from the menu bar or click Write Input Solver File.

   The Write Solver Input File dialog box appears.

2. Select a location to which to save the file.

3. Under File name, type the name of the file.

4. Click Save.

   If the file name assigned is the same as an existing file name in the same location, select Overwrite to overwrite the original file, Re-select to specify a new file name, or Cancel to cancel the writing of the .def file.

### 7.6. Applications

Available in stand-alone mode, these commands immediately load CFX-Solver Manager or CFD-Post.

### 7.7. Quick Setup Mode

Quick Setup Mode is used to quickly specify cases that involve simple physics. For details, see Quick Setup Mode (p. 319).

### 7.8. Turbo Mode

Set up certain turbomachinery cases quickly and easily using Turbo mode. For details, see Turbomachinery Mode (p. 323).
Chapter 8: CFX-Pre Extensions Menu

The Extensions menu provides access to any customized extensions available to CFX-Pre.
Chapter 9: Importing and Transforming Meshes

CFX-Pre can import meshes from a wide range of sources. Once imported, you can position and scale each mesh as required (as described in Transform Mesh Command (p. 82)).

You can import more than one mesh per CFX-Pre simulation. After you have imported all your meshes and created all your domains, the domains should be joined together, either by gluing them together, or by using domain interfaces. For details, see Gluing Meshes Together (p. 88) and Domain Interfaces (p. 137).

This chapter describes:
9.1. Importing Meshes
9.2. Mesh Tree View
9.3. Deleting Meshes and Mesh Components from the Tree View
9.4. Transform Mesh Command
9.5. Gluing Meshes Together
9.6. Mesh Editor
9.7. Render Options
9.8. Mesh Topology in CFX-Pre
9.9. Advanced Topic: cfx5gtmconv Application

Additional information on assemblies, primitive regions, composite regions, and the regions that are created when importing meshes is available in Mesh Topology in CFX-Pre (p. 91).

9.1. Importing Meshes

Meshes are imported via the Import Mesh dialog box, which is accessible in several ways:

- By selecting File > Import > Mesh
- By right-clicking the Mesh branch in the tree view and selecting Import Mesh from the shortcut menu
- By selecting Browse when setting the file name for a mesh (for example, in Turbomachinery mode).

You can multi-select mesh files by holding the Ctrl key while you click the file names.

Import options may appear on the Import Mesh dialog box, depending on the type of mesh being imported. Some common import options are described next. Other options that are specific to particular mesh formats are discussed in Supported Mesh File Types (p. 67).

9.1.1. Importing Multiple Meshes

It is possible in CFX-Pre to import multiple mesh file to construct an appropriate model for your simulation. Each mesh imported is represented in the Mesh part of the Outline tree by a unique identifier based on the name of the mesh file imported.

In general, a mesh file is represented by the file name of the file imported without any preceding path (for example, if you imported C:\Directory\File.cmdb, this will be represented in the tree as
File.cmdb). If after transforming the file name in this way the transformed name is already present in the tree, either because this is an earlier import of the same file or another file with the same name has been imported from a different directory, the new file will be labelled with a suffix, such as File.cmdb(1) for example.

If multiple mesh files are transformed in such a way that the result of the transformation glues the two files together or the files are explicitly glued together, the original mesh file entries will no longer appear under the Mesh entry as file names, but the resulting Principal 3D regions will appear under a Merged Meshes item under Mesh.

**9.1.2. Common Import Options**

**9.1.2.1. Mesh Units**

This option is displayed depending on the file type selected. The units selected on the Import Mesh dialog box are the units used to import the mesh and are the default units for transforming mesh assemblies using the Mesh Transformation Editor dialog box. These units are local to the mesh import and transformation options and do not affect either the solution units or the units set under Edit > Options. For details, see:

- Setting the Solution Units (p. 197)
- Units (p. 48).

CFX-Pre will attempt to determine the units used in a mesh file and convert them to the specified units during import. For example, a mesh of 1000 units long, with units in the mesh file of mm, will appear in CFX-Pre as 1 m long, if units of m are set on the Import Mesh dialog box. If CFX-Pre cannot determine the units used in the mesh file, then in this example the mesh would appear as 1000 m long.

**9.1.2.2. Assembly Prefix**

This is the name used to prefix the assemblies that are created when the mesh is imported. A number suffix is added to the second, and any subsequent meshes, using the same assembly prefix, so that each assembly is named uniquely.

**9.1.2.3. Primitive Strategy**

This setting enables you to control the names of split regions.

The following options are available:

**Standard** - Select this option so that the name of each split region starts with “Primitive 2D” or “Primitive 3D”. For example, this option splits “My Region Name” into “Primitive 2D A” and “Primitive 2D B”.

**Derived** - Select this option so that the name of each split region is derived from the name of the region that is being split. For example, this option splits “My Region Name” into “My Region Name A” and “My Region Name B”.

**9.1.2.4. Ignore Invalid Degenerate Elements**

If your mesh import fails because of invalid degenerate elements, then you can enable this toggle. However, your mesh may not be valid for use in the CFX-Solver. You may have to fix or remove the degenerate elements in the software used to generate the mesh.
9.1.2.5. Duplicate Node Checking

Duplicate Node Checking is off by default and, in general, need not be selected.

Nodes within the specified relative tolerance are equivalenced into a single node (duplicate node removal). The default tolerance of 1e-04 is sensible and you should not change it. The relative tolerance is based on the local mesh length scale, so by default nodes within 0.001% of the average mesh edge length of all edges connected to a node will be equivalenced.

9.1.3. Supported Mesh File Types

Mesh file types supported by CFX-Pre are:

9.1.3.1. ANSYS Meshing Files
9.1.3.2. CFX-Mesh Files
9.1.3.3. CFX-Solver Input files
9.1.3.4. ICEM CFD Files
9.1.3.5. ANSYS Files
9.1.3.6. FLUENT Files
9.1.3.7. CGNS Files
9.1.3.8. CFX-TASCflow Files
9.1.3.9. CFX-4 Grid Files
9.1.3.10. CFX-BladeGenPlus Files
9.1.3.11. PATRAN Neutral Files
9.1.3.12. IDEAS Universal Files
9.1.3.13. GridPro/az3000 Grid Files
9.1.3.14. NASTRAN Files
9.1.3.15. Pointwise Gridgen Files
9.1.3.16. User Import

Note


9.1.3.1. ANSYS Meshing Files

ANSYS Meshing files of the form .cmdb and .dsdb can be imported.

Note

- You must have ANSYS Workbench installed in order to import ANSYS Meshing files (.cmdb and .dsdb) into CFX-Pre or CFD-Post.
- CFX-Pre does not support importing meshes from .cmdb files generated by the Meshing application prior to Release 11.0.

You can specify an assembly prefix. For details, see Common Import Options (p. 66).

There are import settings that are specific to ANSYS Meshing files.
The **Model(s) To Read** setting defaults to **All**, which specifies that all models are to be imported from the ANSYS Meshing file. However, if you load a .cmdb/.dsdb file that has multiple models in it, you can specify which models to load.

**Note**

You must click next to the **Model(s) To Read** setting before the other models will appear.

### 9.1.3.1.1. Named Selections

Named selections are aliases for collections of regions. When importing a mesh, you can preserve these named selections based on where they were created:

- **CFX Mesh Names** for regions defined in CFX-Mesh.
- **Simulation Names** for named selections generated in the Mechanical application and ANSYS Workbench Meshing.
- **Symmetry Names** for named selections of 2D symmetry and periodic regions generated in the Mechanical application and ANSYS Workbench Meshing.
- **Part Manager Names** for named selections generated in DesignModeler or other CAD systems that are not written to the .cmdb file by the meshing application.
- **Fall Back to Part Manager Names** for using named selections generated directly by DesignModeler or other CAD systems as a fall back if no CFX-Mesh, Simulation or Symmetry named selections are found.

### 9.1.3.1.2. Contact Detection Settings

The **Contact** check box, when selected, makes contact detection settings available.

When importing ANSYS Mesh files (.cmdb/.dsdb files), it is possible to select **Detection Method > Read** to read contact information from the file or to select **Detection Method > Detect** to use the contact detection methods to determine whether regions within the mesh are “in contact” with each other. CFX-Pre uses the Mechanical application contact detection methods to determine which mesh volumes should be placed within each mesh assembly and which 2D regions are connected.

The **Detection Between** setting can be set to **Bodies** or **All Contact**. When using the **Bodies** option, 2D regions will be matched between different bodies. This is the default option and should result in bodies that are “close” to one another being placed in the same mesh assembly. If automatic domain interface generation is selected, interfaces will be generated between such regions. When using the **All Contact** option, CFX-Pre will still recognize contact between discrete bodies, but in addition, it will look for contact between 2D regions within the same “body,” or “volume.” This can result in unexpected behavior, such as adjacent surfaces being considered “in contact” and hence this is not the default option, but in some cases, where there are non-matched 2D mesh regions within a mesh volume, it can help generate “internal” interfaces.

The tolerance that is used in detecting contact can be altered and it is possible to define it relative to the local geometry size, or as an absolute spatial value.

If CFX-Pre is set to read contact information from the file, then it will import only connections that connect two single regions. Connections connecting multiple regions to a single region, or multiple regions to multiple regions, will be ignored. Also, contact detection works only within a single file; CFX-Pre will not read or detect contact between meshes that are imported from different files.
If the Meshing application is set to generate connections automatically, you can set the **Global Contact Setting** option to **Group By > None** to generate only single region to single region connections. For more details, see *Generation of Contact Elements in the Meshing User's Guide.*

### 9.1.3.2. CFX-Mesh Files

The CFX-Mesh (.gtm, .cfx) files are native for CFX-Pre; therefore, all information in such a file is read in by the import process. There are no options needed to control the reading of these files.

**Note**

Only .cfx files that are version 11.0 or newer are supported.

### 9.1.3.3. CFX-Solver Input files

CFX-Solver files include CFX-Solver input (.def), results (.res), transient results (.trn), and backup (.bak) results files. There are no options specific to importing CFX Def/Res, files but the general advanced options are described in *Common Import Options* (p. 66).

For additional information on the regions created in CFX-Pre when CFX-Solver files are imported, see *Mesh Topology in CFX-Pre* (p. 91).

### 9.1.3.4. ICEM CFD Files

ICEM CFD files are of the form .cfx, .cfx5, .msh. There are no import options specific to ICEM CFD files; however the *Common Import Options* (p. 66) apply.

### 9.1.3.5. ANSYS Files

ANSYS files are of the form .cdb or .inp. There are no import options specific to ANSYS files; however the *Common Import Options* (p. 66) apply.

Only .cdb files can be imported into CFX-Pre. If you have an ANSYS .db file, you can convert it to a .cdb file in ANSYS by:

1. Opening the ANSYS database in ANSYS.
2. Issuing the ALLSEL command to select everything.
3. Issuing the CDWRITE, DB command to write the .cdb file.

To get a list of all element types \((ET)/\text{keyops}(\text{KEYOP})\) that are supported by mesh import, you can run the following from the operating system command line:

```
<CFXROOT>/bin/<OS>/ImportANSYS.exe -S
```

**Note**

Before executing the CDWRITE command, verify that the data base has a separate named component of 2D MESH200 elements for each surface that will require a boundary condition. Delete any MESH200 elements that are not members of named components. To define specific 3D regions, create a 3D named component of 3D elements. The component names will appear in CFX-Pre as defined regions.
9.1.3.6. FLUENT Files

FLUENT files of the form .cas and .msh can be imported.

**Note**

When importing meshes from FLUENT files in CFX-Pre, Release 12.0 (or later), the topology and naming of regions may not be the same as those generated by importing these meshes into previous releases. As a result, session files generated in CFX-Pre Release, 11.0 (or earlier) that import meshes from FLUENT files may generate errors when loaded into CFX-Pre, Release 12.0 (or later).

9.1.3.6.1. Override Default 2D Mesh Settings

9.1.3.6.1.1. Interpret 2D Mesh as

9.1.3.6.1.1.1. Axisymmetric

This option enables you to create a 3D geometry by extruding a 2D geometry through a specified rotation angle in the third dimension.

**Number of Planes:**

This value enables you to create additional planes, arranged in the extruded direction, to create a 3D problem. This will increase the number of elements in the extruded direction, but does not change the enclosed angle of the mesh.

**Angle (deg):**

This is the angle through which the original 2D mesh is extruded.

**Remove Duplicate Nodes at Axis:**

This check box enables you to choose to have the duplicate node removed from the axis of an axisymmetric case upon import.

9.1.3.6.1.1.2. Planar

This option enables you to create a 3D geometry by linearly extruding a 2D geometry in the third dimension.

**Extrude Distance:**

This is the distance through which the geometry is extruded in the third direction.

For further advice on how to model 2D problems in CFX, refer to Modeling 2D Problems in the CFX-Solver Modeling Guide.

9.1.3.7. CGNS Files

CGNS files are of the form: .cgns. Applicable import options are:

- Ignore Invalid Degenerate Elements (p. 66)
- Duplicate Node Checking (p. 67)
9.1.3.7.1. Importing CGNS files into CFX

9.1.3.7.1.1. Method

Mesh data contained within CGNS files can be read into a CFX-Pre after a new case has been created or an existing case has been opened. To read the CGNS file, select the file to import and, if necessary, alter the options used to import the mesh under the Advanced Options section.

Further information on importing files is contained within the standard documentation.

9.1.3.7.1.2. Base (Base_t)

The top-level object in a CGNS file is a container called a base, a CGNS file that can contain multiple bases. What a base contains is user defined so that CFX-Pre allows all bases to be read by one import, or single bases to be read by separate imports.

9.1.3.7.1.3. Zone (Zone_t)

Each base contains one or more zones. For each base read, the import process reads all zones, provided they are 3D dimensional (structured or unstructured zones are supported).

- Grids can be read in single or double precision.
- Zones may be specified in Cartesian or Cylindrical coordinates. Other coordinate systems are not currently supported.

9.1.3.7.1.4. Elements (ElementSection_t)

Element sections can be imported as regions of interest or ignored. How this is done is controlled by the user interface - you must understand which behavior you want to see. It may be useful to import the element sections, for example, if the file has been written with all faces (2D elements) in a boundary patch as a separate element section, which could be useful for setting up the problem in CFX-Pre. Similar scenarios can be imagined in 3D element sections or even mixed element sections.

9.1.3.7.1.5. Element Types Supported

Supported 3D elements (TETRA_4, PYRA_5, PENTA_6 and HEXA_8). Other 3D elements can be read but are reduced to the lower order elements (that is, TETRA_10 is translated to TETRA_4 and then this is imported).

Supported 2D elements (TRI_3 and QUAD_4). Other 2D elements can be read but are reduced to the lower order elements (that is, TRI_6 is translated to TRI_3 and then is imported).

The vertices of 2D elements should ideally be based on the node indices as are used for to define the 3D elements.

It is preferable to define 2D elements with parent information so that mapping from 2D elements to 3D elements does not have to be determined by the process, therefore, reducing import times.

9.1.3.7.1.6. Boundary Conditions (BC_t)

Boundary conditions are processed but physical setup information (for example, equations) is ignored. The facility for importing the CGNS files into CFX (CFX-Pre) is a mesh (grid) importer, not a physics importer.
No physics information is imported. Boundary condition locations are read because the collections (regions) of mesh elements the condition is defined upon are required for ease of use and correct physics setup in CFX.

It is quicker to read boundary conditions when they are defined as a range of elements (ElementRange) or a list of elements (ElementList), rather than a range of nodes (PointRange) or a list of nodes (PointList). The latter may also be read, but the nodes referenced must also be used by higher-dimension elements (for example, 3D elements) for correct interpretation.

9.1.3.7.1.7. Families (Family_t, FamilyBC_t, FamilyName_t)

Families are read and, in general, imported as composite regions (groupings) of underlying primitive regions.

9.1.3.7.1.8. Grid Connectivity (GridConnectivity_t and GridConnectivity1to1_t)

Grid connectivity can be read but with certain restrictions.

- If the interface is read from a GridConnectivity1to1_t node or is a read from a GridConnectivity_t node and is of type Abutting1to1, importing of the node mapping is attempted.
- If the node mapping cannot be established or the user requests that the two sides of the interface are imported as separate regions.

Other interface types are always imported as two separate regions.

9.1.3.7.1.9. CGNS Data Ignored

The CGNS Mid Level Library Documentation Page (http://www.grc.nasa.gov/WWW/cgns/CGNS_docs_current/midlevel/index.html) details the interface used for reading CGNS files within CFX-Pre. The following high level headings used within the document are ignored.

- Simulation Type
- Descriptors
- Physical Data
- Location and Position
- Auxiliary Data
- Solution Data
- Equation specification
- Time Dependent Data

9.1.3.7.2. Prefix regions with zone name

This check box determines whether or not each imported region is prefixed with the name of the zone within which it is defined.

---

1 Rind Data is processed but not imported.
9.1.3.7.3. Create Regions From: Element Sections

Each element section that specifies the topology of elements within the CGNS file may or may not imply a grouping of these elements that is important. If the grouping of elements within each element section is important, this option should be selected so the grouping is preserved within CFX-Pre.

Element sections can be 2D or 3D or a mixture of both, and as such can form 3D regions or 2D regions in CFX-Pre.

The way they are grouped depends on vendor interpretation of the CGNS standard.

9.1.3.7.4. Create Regions From: Boundary Conditions

This check box determines whether or not to import boundary conditions as regions.

9.1.3.7.5. Create Regions From: Families

This check box determines whether or not to import families of elements, or faces as regions.

9.1.3.7.6. Create Regions From: Connectivity Mappings

This check box determines whether or not to import zone interfaces (that is, 1-to-1 and GGI connections) as regions.

9.1.3.7.7. Example of Create Regions From

Consider a CGNS file with one zone, Zone 1, comprising of four elements sections (ES1 and ES2 defining the 3D elements, and ES3 and ES4 defining the 2D elements). It also contains 2D boundary conditions BC1 and BC2.

These element sections, ES1 and ES2, could be, for example, comprised of hexahedral elements in ES1 and tetrahedral elements in ES2. In this case, the groupings of elements into the first two element sections appears to be due to their topological identity. However, this may or may not be the case and you must decide as to whether importing these groupings is important.

In this case, it may be that ES1 and ES2 should be combined by clearing the Create Regions From: Element Sections option. Another possibility is that ES1 may be a subregion of mesh that should be kept separate (that is, it will be set up as a subdomain). If that were the case, Element Sections should be selected.

If BC1 is defined on all the faces in ES3 and BC2 is defined on all the faces in ES4, then it will probably not be necessary to select Boundary Conditions if Element Sections is selected, as this would introduce complexity in the region definitions (that is, composites would be defined). However if the groupings of ES3 and ES4 are different from the groupings in the boundary conditions then Create Regions From: Boundary Conditions should be selected.

9.1.3.7.8. Read Only One CGNS Base

When this toggle is selected, a mesh is read from a single base specified by the CGNS base to read number. If your CGNS file contains only a single base, you should leave the number set to 1. If it contains more than one base, you should specify the base number from which to read. If the base number specified does not exist, an error will be raised. If it does not contain a valid mesh then a mesh will not be imported.
Note

You must click before you can specify which base to read.

If you disable the Read Only One CGNS Base toggle, then CFX-Pre will look for meshes in all bases and import them. If multiple assemblies are imported and they overlap, then the mesh will be invalid within CFX-Pre unless assemblies are transformed in some way.

For details, see SplitCGNS.exe in the CFX Reference Guide. This is a program that splits a CGNS file into multiple problem files.

9.1.3.8. CFX-TASCflow Files

CFX-TASCflow mesh files are of the form .grd or are simply named grd. You may receive warning messages when importing a CFX-TASCflow mesh file: these will usually tell you which regions have not been imported. The sections below indicate the situations when a warning message may occur.

- If Convert 3D Region Labels to Regions is selected, then the 3D Region labels in the .grd file are imported as individual 3D Regions. The default setting omits all 3D Region labels.
- If Ignore One-to-One Connections is selected, then one-to-one contiguous grid connections are deleted on import. You would then have to recreate the connections in CFX-Pre. There are very few cases when you would want to enable this toggle.
- Select the file type for the imported mesh from the GRD File Format Type drop-down. You can select from Formatted, Unformatted or Unknown. If you select Unknown, CFX attempts to determine the file format before importing the mesh.
- If Retain Block Off is selected, then “user defined” elements that are blocked off in the mesh file are not imported into CFX-Pre. If not selected, then “user defined” objects are ignored and the elements are included in the imported mesh (rarely desired).

Additional information is available in:

- Ignore Invalid Degenerate Elements (p. 66)
- Duplicate Node Checking (p. 67).

9.1.3.8.1. Convert 3D Region Labels to Regions

This toggle controls 3D region import from the .grd file only. When selected, 3D regions in the .grd file will be imported into separate 3D primitives in CFX-Pre. If you do not select this option, all mesh elements will be imported into a single 3D primitive that is uniquely named by the import process. 3D regions defined in the .gci and .bcf files are always imported.

9.1.3.8.2. Grid Connections Processed (in the .grd file)

When importing CFX-TASCflow meshes, the only grid connections that are imported automatically are “many-to-one” contiguous topology connections that are specified as one-to-one node pairings.

“Many-to-one” contiguous topology connections that involve any number of many-to-one node groupings are ignored and a warning message is issued; however, the two sides of the connection are preserved as a pair of 2D regions on which a GGI Connection can be defined. You should recreate the connection in CFX-Pre using a Fluid-Fluid Domain Interface. For details, see Creating and Editing a Domain Interface (p. 137). In some cases, if you have not created regions in CFX-TASCflow on each side of an
interface, you will not be able to recreate it in CFX-Pre because there will be no region available for selection. If this occurs, you should explicitly create regions in CFX-TASCflow before importing the mesh into CFX-Pre.

---

**Important**

Some ANSYS TurboGrid grids contain many-to-one node groupings. These will not be imported into CFX-Pre. You need to know if your grid contains these connections and then recreate them in CFX-Pre using Fluid-Fluid Domain Interfaces.

“Many-to-one” periodic topology connections are always removed with a warning message issued. You should recreate the connections using a periodic domain interface. For details, see *Creating and Editing a Domain Interface* (p. 137).

The regions associated with periodic boundary conditions are imported, but you will need to assign the regions to a periodic domain interface.

**9.1.3.8.3. Grid Embedding**

Embedded grids, along with the parent grid, are automatically imported into separate assemblies in CFX-Pre. The many-to-one topology connections on the interface between the embedded grid and the parent grid will be removed and a warning issued. You will need to create fluid-fluid domain interfaces between the embedded grid and the parent grid. For details, see *Creating and Editing a Domain Interface* (p. 137).

**9.1.3.8.4. Retain Block-off**

The Retain BlockOff toggle is selected by default. There is no harm in leaving this on, but it is not required unless user defined block-off is defined in the .bcf file, and you want it to remain blocked-off (ignored).

Porous and CHT objects in the .bcf file are ignored, and must be manually created in CFX-Pre after importing the grid. You should make sure that a 3D volume region was defined in the grd file for the porous or CHT object location prior to import.

By default, CFX-Pre will look in the same directory as the .grd file to locate the .bcf file. If the .bcf file is located elsewhere, you can browse and select the file.

**9.1.3.8.5. Regions in the .grd file**

You should delete any regions from the .grd file that are not needed.

If necessary, you can force all “user defined” regions to be included in a .grd file by executing the following command at the TASCtool command prompt:

```
TASCtool{}: write grd all_regions_to_grd=on
```

This is usually not needed because you can import regions from the .gci file directly (see below).

Note that when faces are referenced by more than one named region, the import process will resolve this conflict such that faces are not referenced by more than one region.
9.1.3.8.6. Boundary Conditions in .bcf File

The regions associated with the boundary conditions defined in the .bcf file are imported into CFX-Pre. The boundary condition physics definitions are ignored and must be defined in CFX-Pre.

The CFX-TASCflow symmetry.slip boundary condition should be recreated as either:

- A symmetry boundary condition for flat surfaces.
- A wall boundary condition using the Free Slip option for curved surfaces.

9.1.3.8.7. Regions in the .gci File

Regions in the .gci file defined in (i, j, k) coordinates (such as boundary conditions) are imported if the Use GCI file toggle is enabled on the Advanced Options tab. By default, CFX-Pre looks in the same directory as the .grd file for the location of the .gci file. You should select the location of the .gci file by clicking on the browse icon if it is located elsewhere.

Regions defined in physical space (x, y, z coordinates) are always ignored.

An alternative method for reading the .gci file is to force all regions to be included in the .grd file. For details, see Regions in the .grd file (p. 75).

9.1.3.8.8. Importing CFX-TASCflow TurboPre MFR Grids

You can create multiple domains from a single .grd file if it contains multiple 3D regions or GGI connections. For an MFR grid, a separate assembly will be created for each noncontinuous grid region. This enables a multiple frame of reference (MFR) case to be easily recreated in CFX-Pre from a single mesh import.

Grids from CFX-TASCflow TurboPre usually contain many named regions that may not be required to set up the problem in CFX-Pre. You might want to remove some of these regions before importing the grid to speed up the import of the mesh and simplify the imported mesh.

In CFX-TASCflow TurboPre, you can create multiple copies of blade passages. The ‘open ends’ of the machine section will use a periodic connection. These must be recreated in CFX-Pre using a periodic domain interface. For details, see Creating and Editing a Domain Interface (p. 137). The internal connection between blade passages can be connected in CFX-TASCflow TurboPre using an automatic periodic boundary condition. If such a connection is used you will have to manually reconnect each passage in CFX-Pre. You might therefore want to define a many-to-one topology connection for one-to-one grid connections so that passages are connected by CFX-TASCflow TurboPre as topology connections (which import immediately). For details, see Grid Connections Processed (in the .grd file) (p. 74).

9.1.3.8.9. Parameter File

CFX-TASCflow does not have units checking, whereas CFX-Pre does. Grid numbers will be imported using the units specified on the Import Mesh dialog box. You should convert all units in the properties and parameter files within TASCflow into SI units (kg, meter, second) prior to import.

9.1.3.9. CFX-4 Grid Files

CFX grid files are of the form .geo.

- Select Split Symmetry Planes to split symmetry planes that exist in more than one region. For details, see Split Symmetry Planes (p. 77).
• Select **Import from Cylindrical Coordinates** to transform a problem defined in cylindrical coordinates into Cartesian coordinates for use in CFX-Pre. It should be selected for all CFX-4 problems that use cylindrical coordinates. For details, see **Import from Cylindrical Coordinates (p. 77)**.

• Select **Block Interfaces** to create 2D regions in CFX-Pre on block interfaces. For details, see **Create 2D Regions on (p. 77)**.

• Import 2D axisymmetric mesh. For details, see **Import 2D Axisymmetric Mesh (p. 78)**.

Other available options are:

- **Ignore Invalid Degenerate Elements (p. 66)**
- **Duplicate Node Checking (p. 67)**

### 9.1.3.9.1. Split Symmetry Planes

The **Split Symmetry Planes** option is on by default. Symmetry planes that are defined by more than one CFX-4 region will be split so that each definition is imported. For example, a symmetry plane that is defined on two sides of a 3D region will be split into regions named `<regionname>1` and `<regionname>2`, and so on, where `<regionname>` is the original name of the symmetry plane in the CFX-4 file.

### 9.1.3.9.2. Import from Cylindrical Coordinates

CFX-Pre can import problems defined in Cylindrical Coordinate \((x, r, \theta)\) form from CFX-4. The problem is converted to Cartesian Coordinates \((x, y, z)\) by the import process. The resulting CFX-Solver input file will not be written in cylindrical coordinates. You must select the **Import from Cylindrical Coordinates** option to successfully import a CFX-4 cylindrical coordinate problem.

---

**Note**

This is *not* the same as an axisymmetric problem. For details, see **Import 2D Axisymmetric Mesh (p. 78)**.

### 9.1.3.9.3. Create 2D Regions on

**Block Interfaces**

When this option is selected, named regions will be created on the interfaces between mesh blocks. This can produce many regions in CFX-Pre, so it is usually better to define all the regions you require as patches in CFX-4.

### 9.1.3.9.4. Create 3D Regions on

**Fluid Regions (USER3D, POROUS)**

In CFX-4, most 3D regions are classified as USER3D patches. Porous regions are treated in the same way as USER3D regions when importing them into CFX-Pre. When the **Fluid Regions (USER3D, POROUS)** toggle is not selected, these regions are not imported. When the toggle is selected, they are imported as separate 3D regions. This toggle should be selected if you need the USER3D regions to create domains and subdomains. You should disable it to simplify the regions created in CFX-Pre. If, in CFX-4, you have created a USER3D region for the purpose of creating thin surfaces, you do not need to import the USER3D region in CFX-Pre because thin surfaces can be defined without the need for a separate subdomain.
9.1.3.9.5. Blocked Off Regions (SOLIDs)

- If Fluid Regions (USER3D, POROUS) is not selected, and Blocked Off Regions (SOLIDs) is not selected, then SOLID regions are blocked-off (that is, this part of the mesh is not imported).
- If Fluid Regions (USER3D, POROUS) is not selected, and Blocked Off Regions (SOLIDs) is selected, then SOLID regions are imported into the default 3D region created by the import process.
- If Fluid Regions (USER3D, POROUS) is selected, and Import SOLID regions is toggled OFF, then SOLID regions become blocked-off (that is, this part of the mesh is not imported).
- If Fluid Regions (USER3D, POROUS) is selected, and Import SOLID regions is toggled ON, then SOLID regions are imported as separate 3D regions (which can be useful for CHT simulations).

9.1.3.9.6. Conducting Solid Regions (SOLCONs)

- These are regions defined as conducting solid regions in CFX-4. There is no way to completely ignore SOLCON regions, they are always imported as either a separate region or as part of the parent region. If you want to ignore these regions (that is, so that there is no flow), then they should be removed from the CFX-4 mesh file using CFX-4 or with manual editing. Alternatively they can be imported but simply not used to define a subdomain in CFX-Pre. The import behavior is described below:
  - If Fluid Regions (USER3D, POROUS) is not selected, and Conducting Solid Regions (SOLCONs) is not selected, then SOLCON regions are imported as part of the “Assembly 3D” region.
  - If Fluid Regions (USER3D, POROUS) is not selected, and Conducting Solid Regions (SOLCONs) is selected, then SOLCON regions are imported as separate 3D regions.
  - If Fluid Regions (USER3D, POROUS) is selected, and Conducting Solid Regions (SOLCONs) is not selected, then SOLCON regions are imported as part of the regions in which they appear.
  - If Fluid Regions (USER3D, POROUS) is selected, and Conducting Solid Regions (SOLCONs) is selected, then SOLCON regions are imported as separate 3D regions and will be cut out of the parent regions.

9.1.3.9.7. Import 2D Axisymmetric Mesh

You can enable this toggle if you want to import a mesh created as a 2D mesh on an axisymmetric section in CFX-4. This is different to a mesh defined using cylindrical coordinates; however, it can also use an (x, r, \( \theta \)) coordinate system. The CFX-4 mesh must be only 1 element thick in the k direction to use this option.

The **Number of Planes** value enables you to create additional planes in the \( \theta \) direction within the original 2D mesh to create a 3D problem. This will increase the number of elements in the k direction, but does not change the extent of the mesh.

The **Angle** value should be the \( \theta \) angle of the mesh section in degrees. Because the mesh is only one element thick, then \( \theta \) is the same for all nodes.

9.1.3.9.8. Importing MFR Grids

If you have a CFX-4 MFR case, it can easily be imported into CFX-Pre and recreated.
- Each noncontinuous mesh section will be imported into a separate assembly.
- Each USER3D region will be imported into a separate 3D primitive.
- Both assemblies and 3D primitives can be used to create separate domains.
9.1.3.10. CFX-BladeGenPlus Files

CFX-BladeGenPlus files are of the form .bg+. There are no options specific to importing CFX-BladeGenPlus files. For details, see Common Import Options (p. 66).

9.1.3.11. PATRAN Neutral Files

PATRAN Neutral files are of the form .out.

- Select Import Distributed Loads as 2D Regions to convert predefined distributed loads as 2D primitives within CFX-Pre.

For details, see Common Import Options (p. 66).

9.1.3.12. IDEAS Universal Files

IDEAS Universal files are of the form .unv.

- Select the entities, under IDEAS Universal Specific Options, to import from Permanent Groups.

For details, see Common Import Options (p. 66).

IDEAS mesh files contain groups of nodes, faces and/or elements. The groups can be normal groups or permanent groups. The normal groups are imported into CFX-Pre as up to three separate regions, depending on the information available in the mesh file. These regions will be named:

- <groupName>_Nodes
- <groupName>_Faces
- <groupName>_Elements

Only permanent groups of the selected types are imported into CFX-Pre. If overlapping regions are imported, CFX-Pre will split them into distinct regions; therefore, you may not want to import all permanent group types.

9.1.3.13. GridPro/az3000 Grid Files

GridPro/az3000 'grid' files are of the form .grid.

- Select Include Periodic Regions to convert predefined periodic boundaries into 2D primitives on import.
- Select Ignore Connectivity to import grid blocks as unconnected 3D primitives. Ignoring connectivity does not equivalence nodes at grid block interfaces.
- Select Import Grid Blocks as Subdomains so that for each predefined grid block, a separate 3D primitive is created.
- Selecting Ignore Properties causes data in the properties file to be ignored. This includes boundary conditions, 2D and 3D regions, and other data.

Additional information is available in:

- Ignore Invalid Degenerate Elements (p. 66)
- Duplicate Node Checking (p. 67).
9.1.3.14. NASTRAN Files

NASTRAN files can be imported.

- When Include Subdomains is cleared, all mesh elements are merged into a single 3D primitive.
- “Distributed loads” are pressure boundaries that, if imported, are used to generate 2D primitives in CFX-Pre. Select Import Loads as 2D Regions to import distributed loads.

Additional information is available in:

- Ignore Invalid Degenerate Elements (p. 66)
- Duplicate Node Checking (p. 67).

9.1.3.15. Pointwise Gridgen Files

Pointwise Gridgen files can be imported. There are no options available specific to the Pointwise Gridgen format. For details, see Common Import Options (p. 66).

9.1.3.16. User Import

If you should require facilities for importing a mesh other than those available through the standard Mesh Import forms, you can create your own customized mesh import program and make it available through the Import Mesh forms. For details, see Volume Mesh Import API in the CFX Reference Guide.

If you have created your own mesh import program, it must be run from within CFX-Pre; one way of doing this is by using the Import Mesh dialog box.

To run a custom import program using the Import Mesh dialog box:

1. Open the Import Mesh dialog box.
   For details, see Importing Meshes (p. 65).
2. Set Files of Type to User Import (*).
3. Select the file containing the mesh to import.
4. Click Browse to browse to the location of the user executable file or enter its name under Exec Location.
5. Under Exec Arguments, enter the command-line arguments that should be passed to the import program.
6. Set advanced options as required.
   For details, see:
   - Ignore Invalid Degenerate Elements (p. 66)
   - Duplicate Node Checking (p. 67)
7. Click Open.

CFX-Pre calls the custom import program with a command line that has the following form:

`<user import executable> <executable arguments> <mesh file>`

It is important therefore that the executable handles any arguments that are specified.
If you usually use a particular import program, you can set it as the default import program by any one of the following methods:

- Specify the full path name of the import program, and other settings, in the Options dialog box.
- Add the following line to the .cfxsrc file:
  
  CFX_IMPORT_EXEC="<executable_path>"

  where `<executable_path>` is the full path and name of your executable.

  For details, see Resources Set in cfxSrc Files in the CFX Introduction.
- Set CFX_IMPORT_EXEC in the system environment.

### 9.2. Mesh Tree View

The Mesh branch of the main tree view shows the regions of the imported meshes arranged in a hierarchy for each loaded mesh file. You can also view regions arranged in a hierarchy based on composite regions and mesh assemblies. To view either hierarchy in a separate Mesh tree view, right-click Mesh (from the Mesh branch of the main tree view) and select one of the View by submenu commands.

When viewing the file-based hierarchy, each imported mesh forms one or more assemblies at the first level of the tree. The second level of the tree shows all 3D primitives and the third level shows

- 2D primitives bounding each 3D primitive
- some composite regions.

#### 9.2.1. Shortcut Menu Commands for Meshes and Regions

Right-clicking on a region, mesh assembly, 3D primitive, or 2D primitive in the tree view displays a shortcut menu containing various options depending on what is selected. For details about the generic shortcut menu commands, see Outline Tree View Shortcut Menu Commands (p. 7). Details about the mesh-related shortcut menu items are provided in:

- Importing Meshes (p. 65)
- Deleting Meshes and Mesh Components from the Tree View (p. 81)
- Transform Mesh Command (p. 82)
- Gluing Meshes Together (p. 88)
- Mesh Editor (p. 88)
- Render Options (p. 88)

**Note**

If Highlighting is selected (from the viewer toolbar), mesh entities will be highlighted in the viewer when you select them in the tree view.

### 9.3. Deleting Meshes and Mesh Components from the Tree View

There are several options for deleting meshes and mesh components and composite regions using shortcut menu items available in the Outline tree view in CFX-Pre. These options are:
• **Delete All Mesh**: Available when you right-click Mesh. When selected this option deletes all meshes currently present.

• **Delete Mesh**: Available when you right-click individual meshes themselves or Composite 3D Regions or Primitive 3D Regions that map directly and entirely to one or more assemblies. When selected, this option deletes all mesh associated with the selected assemblies.

• **Delete Definition**: Available when you right-click a composite region. When selected this option deletes the definition of the composite region name but not the underlying mesh.

### 9.4. Transform Mesh Command

You can transform meshes using the **Mesh Transformation Editor** dialog box. To access this dialog box, right-click a mesh file or selection of one or more 3D meshes in the tree view, then select the **Transform Mesh** command from the shortcut menu. There are four basic transformations: **Rotation**, **Translation**, **Scale**, and **Reflection**. More complex transformations can be achieved by successive application of the basic types. You can also copy meshes, either by retaining the original mesh, or by creating multiple copies.

When picking points from the Viewer, the **Show Faces** render option must be selected to allow a point on a region to be picked. It may also be useful to have **Snap to Node** selected (on by default in the viewer toolbar).

The values entered on this form use the units defined on the **Edit > Options > Common > Units** form. For details, see **Units** (p. 48).

The topics in this section include:

• **Target Location** (p. 82)
• **Reference Coord Frame** (p. 83)
• **Transformation: Rotation** (p. 83)
• **Transformation: Translation** (p. 84)
• **Transformation: Scale** (p. 84)
• **Transformation: Reflection** (p. 85)
• **Transformation: Turbo Rotation** (p. 86)
• **Multiple Copies** (p. 86)
• **Advanced Options** (p. 87)
• **Automatic Transformation Preview** (p. 88)

### 9.4.1. Target Location

Select the assemblies and/or other regions to transform from the **Target Assemblies** drop-down box.

Click the ![icon](image) icon to access the full list of available regions.

Not all regions are transformable. For example, 2D regions or 3D regions not resolving to at least one assembly are not transformable.
9.4.2. Reference Coord Frame

Toggle on Reference Coord Frame to specify if the transformation is defined in another coordinate frame. Select the reference coordinate frame from the Coord Frame list.

9.4.3. Transformation: Rotation

Use the Rotation transformation to rotate an assembly about an axis defined by two points or a principal axis.

9.4.3.1. Rotation Option: Principal Axis

This Rotation Option uses the X, Y, or Z axis as the axis of rotation. Select one of the principal axes, under Axis, to be the axis of rotation.

9.4.3.2. Rotation Option: Rotation Axis

This Rotation Option uses a user-defined axis as the axis of rotation for the transformation. This axis is defined by two Cartesian points, From and To. These points can be entered manually or selected in the Viewer by clicking any coordinate box and then clicking in the Viewer.

9.4.3.3. Rotation Angle Option

The rotation angle options are Specified, Full Circle, and Two Points.

9.4.3.3.1. Specified

The Specified option simply rotates the assembly by the specified angle. When looking from the start point to the end point of the axis, a positive angle will produce a rotation in the clockwise direction.

9.4.3.3.2. Full Circle

The Full Circle option should be used in conjunction with Multiple Copy, otherwise, the assembly will simply be transformed back to its original position. The effect this has is described more fully in Multiple Copy.

9.4.3.3.3. Two Points

The Two Points option calculates an angle using the axis of rotation and the two points specified, as shown in the following figure. The two points and the start point of the axis define a plane with a normal direction pointing towards the end point of the axis. The angle proceeds in the clockwise direction from the Start to the End point when looking from the start point to the end point of the axis. When picking points from the Viewer, the Show Faces render option must be selected to allow a point on a region to be picked. It may also be useful to have Snap to Node selected (on by default in the Viewer toolbar).
9.4.4. Transformation: Translation

Use the translation transformation to move an assembly in the X, Y, and Z directions.

9.4.4.1. Method: Deltas

The Deltas method moves the mesh by the $D_x, D_y, D_z$ values entered. Enter the $D_x, D_y, D_z$ values with which to translate the mesh. This is equivalent to a vector translation, using the origin as the start point of the vector and the point entered as the end point. A point can be entered manually or selected in the Viewer after clicking any coordinate box.

9.4.4.2. Method: Vectors

The Vector option moves the assembly by the vector described by the From and To points.

Enter From and To points to describe the translation. These points can be entered manually or selected in the Viewer after clicking any coordinate box.

9.4.5. Transformation: Scale

The Scale method is used to scale an assembly by a scale factor.

9.4.5.1. Method: Uniform

The Uniform option uses the same scale factor for all coordinate directions, therefore scaling the size of the assembly while maintaining the same aspect ratio. Specify the scale factor by entering a value for Uniform Scale (which must be greater than zero).

9.4.5.2. Method: Non Uniform

The Non Uniform option can scale the assembly using a different scale factor in each coordinate direction, producing stretching effects.

Enter a scale factor, $S_x, S_y, S_z$ and the mesh is scaled by the scale factor value in the X, Y and Z coordinate directions.

9.4.5.3. Scale Origin

Scaling is achieved by multiplying the location of each mesh node relative to the Scale Origin by the scaling factor.
Enter the **Scale Origin** as a Cartesian coordinate (for example, \([0 \ 0 \ 0]\)), or click any Cartesian coordinate box then pick a point from the Viewer. When you are in Picking mode, the Cartesian coordinate boxes turn yellow. To manipulate the object in the viewer while in this state you have to click the viewer icons (rotate, pan, zoom) in the toolbar. You can turn off Picking mode by changing the keyboard focus (by clicking on another field, for example).

### 9.4.5.4. Apply Scale To

This setting controls whether the transformation is applied to the original mesh or to a copy of the mesh. If you have set up physics locations on the original mesh, such locations are retained after the transformation.

The following options are available:

- **Original (No Copy)**  
  Transforms the original mesh without making a copy.

- **Copy (Keep Original)**  
  Copies the original mesh before applying the transformation. In this case, the original mesh remains in its current location.

### 9.4.6. Transformation: Reflection

The **Reflection** method is used to mirror a mesh in a specified plane. Apart from using the principal planes (for example, the XY plane), arbitrary planes can be created with the Three Points and the Point and Normal methods. These are the same plane definition methods that are available in CFD-Post.

#### 9.4.6.1. Method

The options available are **YZ Plane**, **XZ Plane**, **XY Plane**, **Three Points** and **Point and Normal**.

When using the **YZ Plane**, **XZ Plane**, or **XY Plane** method, an offset, **X**, **Y**, and **Z** respectively, can be applied by entering a value in the **X, Y, Z** offset box.

If you use the **Three Points** or **Point and Normal** method, the points can be manually entered or selected in the Viewer after you click in any coordinate field.

#### 9.4.6.2. Apply Reflection To

This setting controls whether the transformation is applied to the original mesh or to a copy of the mesh. If you have set up physics locations on the original mesh, such locations are retained after the transformation.

The following options are available:

- **Original (No Copy)**  
  Transforms the original mesh without making a copy.

- **Copy (Keep Original)**  
  Copies the original mesh before applying the transformation. In this case, the original mesh remains in its current location.
9.4.7. Transformation: Turbo Rotation

Use the Turbo Rotation transformation to rotate an assembly about an axis defined by the rotation axis or a principal axis.

9.4.7.1. Rotation Option: Principal Axis

This Rotation Option uses the X, Y or Z axis as the axis of rotation. Select one of the principal axis, under Axis, to be the axis of rotation.

9.4.7.2. Rotation Option: Rotation Axis

The Rotation Option uses a user-defined axis as the axis of rotation for the transformation. This axis is defined by two Cartesian points, From and To. These points can be entered manually or selected in the Viewer by clicking any coordinate box and then clicking in the Viewer.

9.4.7.3. Rotation Axis Options

In addition to the From and To points, you can select the following options:

Passages per Mesh
- An indication of the number of blade passages that exist in the selected mesh file. The value will normally be 1.

Passages to Model
- An optional parameter that is used to specify the number of passages in the section being modeled. This value is used in CFD-Post.

Passages in 360
- An optional parameter that is used to specify the number of passages in the machine. This value is used in CFD-Post.

Theta Offset
- Rotates the selected mesh, about the rotational axis, through an angle Theta. The offset can be a single value or set to an expression by clicking .

9.4.8. Multiple Copies

When the Multiple Copies toggle is disabled, then the assembly is simply transformed to the new location, without retaining a copy of the assembly at the original location. You can enable the Multiple Copies toggle to allow multiple copies of an assembly to be made during the transformation. It should be noted that this section is not available for Scale Transformations.

In general, the multiple copies will be evenly spaced throughout the transformation. For rotational transformations copies will appear at evenly spaced angles, while for translational transformations copies will appear at evenly spaced intervals along the vector describing the translation. For example, if you have a mesh for a single blade passage, you can make copies of it using the rotation transformation. If your full machine has 60 blades and you want to reproduce the full geometry, you should use the Full Circle option for the Angle and select to make 59 copies (the original copy is the 60th).

9.4.8.1. # of Copies

Enter the number of copies for the assembly to make. This number does not include the original copy.
9.4.8.2. Delete Original

Controls whether the original copy is retained or deleted after the transformation. Composite regions associated with the original mesh are not deleted during this operation.

9.4.9. Advanced Options

The Advanced Options control your mesh-gluing strategy as described below.

9.4.9.1. Glue Adjacent Meshes

If you enable this toggle, CFX-Pre will attempt to automatically glue each copy of the assembly together. This means that CFX-Pre will try to create a continuous mesh contained in a single assembly from the multiple copies. For the glue to be successful, physically matching boundaries with one-to-one node pairings must be found between the copy (or copies) and the original. The multiple copies will then be treated as a single continuous mesh in a single assembly with multiple 3D regions. A single domain can be created for the entire assembly without the need to create domain or periodic interfaces between each copy. If multiple domains are created, automatic domain interfaces can be created. For details, see Automatic Creation and Treatment of Domain Interfaces in the CFX-Solver Modeling Guide.

If boundaries do not physically match or one-to-one node pairings do not exist, then each copy will form a new assembly, which will require the creation of domain interfaces to connect them together.

When Delete Original is used in conjunction with Glue Matching Meshes, the original is deleted only if the gluing operation is successful.

For more information on gluing, see Gluing Meshes Together (p. 88).

You can set the following advanced options:

Glue Strategy
Choose the strategy that CFX-Pre will use in deciding how mesh selections being transformed are glued with each other and with other areas of mesh:

• Location and Transformed causes CFX-Pre to try to create connections automatically between the selected location being transformed and any copies that are made.

• Location and Transformed and Touching requests that CFX-Pre tries to glue the transformed locations with any copies made and also with any other mesh locations that are in contact with the transformed location or transformed copies.

Keep Assembly Names
An assembly is a group of mesh regions that are topologically connected. Each assembly can contain only one mesh, but multiple assemblies are permitted.

When transforming a location, existing assemblies can be modified or created by removing connections between 3D regions or can be merged by creating connections between 3D regions. The setting of Keep Assembly Names can be altered to indicate whether CFX-Pre should attempt to preserve assembly names that were present in the problem before the transformation took place, therefore ensuring that the locations used by physics objects are not invalidated:

• None: no attempt is made by CFX-Pre to retain existing assembly names

• Existing: assembly names specified before the transformation takes place are preserved

• Existing and Intermediate: the names of assemblies prior to the transformation and also any intermediate assembly names created during the transformation process will be preserved.
9.4.10. Automatic Transformation Preview

This toggle enables you to see the transformation before you click Apply. After you click Apply, the preview toggle clears automatically.

9.5. Gluing Meshes Together

If there are multiple mesh assemblies that have matched meshes, you can try to glue these together by selecting the assemblies in the tree view (using the Ctrl key), right-clicking, and selecting Glue Regions from the shortcut menu. If the meshes match exactly, a 1:1 connection is made; otherwise a GGI connection is used. In either case, the connection appears as a mapping of two regions under Connectivity in the tree view (for example, F3.B1.P3<->F3.B2.P4). Note that you can select Connectivity > Hide 1:1 Connections so that the list of GGI connections is easier to work with.

Important

Merging/connecting meshes in CFX-Pre is not supported when those meshes are provided by ANSYS Workbench during a Workbench session. Doing so may result in extra copies of these meshes appearing when refreshing meshes.

Tip

Another way to glue two meshes together is to select Connectivity > Define Connection from the tree view. In the Mesh Connections Editor that appears, click ... to browse the Selection Dialog for the regions to choose for Side One and Side Two. If is selected, the regions are highlighted in the viewer as you highlight regions in the Selection Dialog.

If a pair of meshes cannot be glued together, you can use a domain interface instead. For details, see Domain Interfaces (p. 137).

Note

• There is limited checking of the validity of GGI connections created by gluing meshes together.
• When you transform or copy multiple assemblies, it is possible to have each copy glued to its original assembly or to other copies made. For details, see Advanced Options (p. 87) in the Transform Mesh Command (p. 82) section.
• For more information on mesh connection types, see Mesh Connection Options in the CFX-Solver Modeling Guide.

9.6. Mesh Editor

The mesh editor is described in Editing Regions in CFX-Pre (p. 96).

9.7. Render Options

The Render Options dialog box controls how 2D objects will appear in the Viewer, such as visibility, line width, line color, and so on. Rendering for individual 2D Primitives, or any composite regions that
resolve to only one 2D Primitive, is set on the Render Options dialog box for 2D Primitives. For details, see Render Options Dialog Box (p. 89).

Render Options for any regions that are made up of more than one 2D primitive (such as a 3D region or a composite 2D region consisting of more than one 2D primitive) can be set on a global basis for all 2D primitives within the particular region. For details, see Render Options - Multiple 2D Regions (p. 90).

You can access the Render Options dialog box by right-clicking on a region in the tree view and then selecting Render > Properties from the shortcut menu.

9.7.1. Render Options Dialog Box

When the Render Options dialog box is accessed by right-clicking on regions, the controls apply only to those regions selected.

9.7.1.1. Draw Faces

Shows the faces of the mesh elements on 2D primitives. Show Faces should be selected if the effect of changing the face options is to be seen.

9.7.1.2. Face Color

The color used for the mesh faces drawn on the 2D primitives. Pick a Face Color by clicking on the color box to cycle through common colors or click to select a custom face color.

9.7.1.3. Transparency

Select a Transparency level from 0 to 1, where 0 is opaque and 1 is transparent.

9.7.1.4. Draw Mode/Surface Drawing

Controls the shading property applied to mesh element faces on 2D primitives

9.7.1.4.1. Flat Shading

Each element is colored a constant color. Color interpolation is not used across or between elements.

9.7.1.4.2. Smooth Shading

Color interpolation is applied, which results in color variation across an element based on the color of surrounding elements.

9.7.1.5. Face Culling

This controls the visibility for element faces of objects that either face the Viewer or point away from the Viewer. Domain boundaries always have a normal vector that points out of the domain. The two sides of a thin surface have normal vectors that point towards each other.

Note

Face Culling affects printouts performed using the Screen Capture method only.
9.7.1.5.1. Front Faces

Clears visibility for all outward-facing element faces (the faces on the same side as the normal vector).

9.7.1.5.2. Back Faces

Clears visibility for inward-facing element faces (the faces on the opposite side to the normal vector).

9.7.1.5.3. No Culling

Shows element faces when viewed from either side.

9.7.1.6. Lighting

Toggle the lighting source on or off.

9.7.1.7. Specular

When selected, treats the object as a reflector of light.

9.7.1.8. Draw Lines

Shows the lines of the surface mesh elements on 2D primitives.

9.7.1.9. Edge Angle/Render Edge Angle

To change how much of the mesh wireframe is drawn, you can change the edge angle. The Edge Angle is the angle between one edge of a mesh face and its neighboring face. Setting an Edge Angle will define a minimum angle for drawing parts of the surface mesh. If you want to see more of the surface mesh, reduce the edge angle.

9.7.1.10. Line Width

The line width can be changed by entering a value in the Line Width text box corresponding to the pixel width of the line. When the box is active, the up and down arrow keys on your keyboard can be used to increment the value.

9.7.1.11. Line Color

Pick a Line Color by clicking on the color box to cycle through common colors or click ... to select a custom line color.

9.7.1.12. Visibility

Set the visibility for the primitives in the Viewer. Clearing the visibility may improve the Viewer performance for complex meshes.

9.7.2. Render Options - Multiple 2D Regions

The Render Options dialog box for multiple regions is both an indicator of consistency of the render options of the regions selected, and a tool to set render options for all selected regions. The presence
of a check mark in the check box for an option indicates whether consistent settings exist for that option across all of the selected regions.

For example if the **Shading** option is selected and set to **Flat Shading** this means that all the regions selected have their **Shading** options set to **Flat Shading**. By contrast, if **Face Color** is cleared this indicates that at least one region has a different color. You can still apply a color to all regions by enabling the check box next to **Face Color** and selecting a color. After any changes, CFX-Pre will recheck all objects for consistency, and update the form accordingly. The options themselves are the same as for individual regions.

### 9.8. Mesh Topology in CFX-Pre

The mesh topology in CFX-Pre is largely determined by the primitive regions imported with the mesh. You must consider the requirements of the physics being simulated when generating the geometry and mesh outside of CFX-Pre.

#### 9.8.1. Assemblies, Primitive Regions, and Composite Regions

Each mesh is imported into one or more assemblies. An assembly represents a connected mesh. A mesh containing one-to-one node connections is considered to be connected and is imported into a single assembly.

Each assembly contains one or more 3D primitives (mesh regions), and each 3D primitive is bounded by one or more 2D primitive mesh regions. Each 3D primitive may also contain 2D mesh primitives that are located within the interior of the mesh. A primitive is the lowest level of region information available in a mesh file.

Primitives could be regions that were explicitly created in the mesh generation software. However, in some mesh files, the mesh references underlying CAD faces, in which case these will be the primitive regions. GTM files are an example of this; a 2D primitive region will resolve to the CAD face Solid 1.2, for example. If CAD face data is available in the mesh file, then regions explicitly created in the mesh generation software, or in CFX-Pre, will reference the CAD faces and, therefore, themselves will not be the lowest level of region data. These regions are known as composite regions because they are composed of one or more primitive regions.

---

**Note**

Because CFX-Pre can recognize underlying CAD surfaces from CFX GTM Files, it is not necessary to create composite regions, although it will often make selecting locations easier in CFX-Pre. Other mesh types may or may not require the definition of composite regions within CFX-Pre.

New composite regions can be created in CFX-Pre using the **Regions** details view. However, the topology of the existing primitives limits the scope of composite region creation and it is not possible to create any new primitives in CFX-Pre. For details, see *Defining and Editing Composite Regions* (p. 98).

The number and location of 2D primitives and 3D primitives is defined by the software that generated the mesh. You should consider your domain, boundary condition, domain interface and subdomain requirements when creating the mesh and create appropriate regions that can be used in CFX-Pre. You will need to create each region explicitly in the mesh generation software if your mesh file does not contain data that references the underlying CAD faces.
If primitives reference the underlying CAD faces, it does not mean that the exact CAD geometry is recovered. The mesh simply references all the CAD faces and makes the mesh associated with them available in CFX-Pre.

In CFX-Pre 3D primitives are always distinct, as such a mesh element is always contained in a single 3D primitive. All regions in the mesh file that define a set of 3D elements are imported into CFX-Pre. If any element exists in more than one grouping of elements, the import process will split the groupings so that each element is contained within a single 3D primitive. Composite regions will be defined that group the 3D primitives into the topology that the original mesh file represented. Depending on your mesh file, this could include 3D subregions, solid regions, block-off regions, user defined 3D regions, porous regions, and so on.

If a 2D primitive spans more than one 3D primitive, it will be split into multiple 2D primitives on import, so that each 2D primitive is part of only one 3D primitive. All overlapping 2D primitives are also split into distinct primitives upon import and composite regions are created to represent the original regions read from the mesh file. When a 2D primitive forms a boundary between 3D primitives, it will be split into two sides, such that a 2D primitive is associated with each 3D primitive. When a 2D primitive is split, a suffix is added to the name so that the resulting 2D primitives are named uniquely. For example, a 2D primitive called Solid 1.2 would be split into Solid 1.2A and Solid 1.2B.

### 9.8.1.1. Composite Regions

Composite regions are defined as combinations of one or more 2D primitive, 3D primitive or other composite regions. New composite regions created in CFX-Pre must therefore be defined by a combination of at least one other region, however it is possible that a composite region can be defined that resolves to nothing.

Composite regions that are specified in the original mesh file imported into CFX-Pre will be imported into the application if the import format can be translated into one that CFX-Pre can use. The composite regions imported into CFX-Pre can be selected, modified and deleted in the same way as composite regions defined in the application.

Additional information on primitive and composite regions is available in *Assemblies, Primitive Regions, and Composite Regions* (p. 91).

For details about creating regions, see *Regions* (p. 95).

### 9.8.1.1.1. Applications of the Composite Regions

For details, see *Applications of Composite Regions* (p. 99).

### 9.8.2. Domain and Subdomain Locations

Domains are created from a list of 3D primitives, and subdomains from list of 3D primitives that are also contained in a domain. Assemblies and 3D composites can also be used as locations for domains and subdomains. In this case, all 3D primitives contained within the assembly or 3D composite are included in the domain.

Assemblies and 3D primitives not included in a domain are not used in the simulation. A 3D primitive may be implicitly included if it forms part of a 3D composite or assembly that is used in a domain.

The domains in a multi-domain simulation must be continuous or connected via domain interfaces - you cannot have separate isolated domains.
9.8.3. Boundary Condition and Domain Interface Locations

2D primitives and 2D composite regions can be used as locations to create boundary conditions and domain interfaces.

If your assembly has more than one 3D primitive and they share a common boundary, then at least one pair of 2D primitives will exist at the common boundary. One 2D primitive of each pair will bind one of the 3D primitives that shares the common boundary.

It is not possible for a region to span more than one domain in a single boundary condition.

9.8.4. Importing Multi-domain Cases

Meshes intended or previously used for multi-domain simulations can be imported into CFX-Pre. You will still be able to set up a multi-domain simulation from a single mesh import.

If the imported mesh is not connected, a separate assembly will be created for each connected section. Each assembly can be used to create a separate domain. If the mesh is connected, then a single assembly will be created but 3D primitives will be created for each 3D region defined in the mesh file. Each 3D primitive can be used to create a separate domain, even if it is contained in a single assembly.

9.9. Advanced Topic: cfx5gtmconv Application

The cfx5gtmconv application is a command line executable that can be used to convert between a number of mesh file formats. It can be used to perform import of a mesh into a GTM database or to convert a GTM database into a CFX-Solver input file that can be viewed in CFD-Post. If appropriate physics CCL is available, it can also be used to create a definition that can be run in a solver. In this case, the exported mesh obeys the constraints imposed on it by the solver and the physics model.

Full details can be found by entering:

```
<CFXROOT>/bin/cfx5gtmconv -help
```

at the command line, where `<CFXROOT>` is the path to your installation of CFX-Pre.
Chapter 10: Regions

CFX-Pre has two types of regions:

- Primitive
- Composite

This chapter describes:

10.1. Primitive Regions
10.2. Composite Regions
10.3. Using Regions in CFX-Pre
10.4. Editing Regions in CFX-Pre
10.5. Applications of Composite Regions

Additional information on primitive and composite regions is available. For details, see Mesh Topology in CFX-Pre (p. 91).

10.1. Primitive Regions

Primitive regions are a unique selection of 2D faces or 3D elements that define a location in the model.

A model containing a mesh will have at least one 2D primitive region and one 3D primitive region.

It is not possible for a primitive region to contain 2D faces and 3D elements.

10.2. Composite Regions

Composite regions are regions defined in terms of other regions. For example:

- A named Region “A” may be an alias for another Region “B”

  A composite region that is an alias can directly reference only one other region, but may reference more than one region if the region it references is itself another composite region.

- Region “C” may be a union (that is, all) of Region “D” and Region “E”

  A composite region that is a union will reference one or more other regions directly and may indirectly reference many other regions if the regions it references themselves reference other regions.

Composite regions ultimately resolve to primitive regions.

The tree view and the Region details view are used to select, create, rename, modify, and delete composite regions.

If any of the primitive regions to which a composite region resolves does not exist in the model, the composite region is said to be unresolved.
Composite regions can be defined in terms of 2D and 3D primitive regions. If the composite region resolves to both 2D and 3D primitive regions, the composite region is known as a mixed dimensionality composite.

An Assembly is a special case of a mixed-dimensionality composite region. It can be used in the same way, but its composition implies connectivity within the mesh. All 3D mesh volumes within an Assembly ‘know’ about their connections to each other. This information is used by CFX-Pre when calculating interfaces between domains.

Composite regions that are specified in the original mesh file imported into CFX-Pre will be imported into the application if the import format can be translated into one that CFX-Pre can use. The composite regions imported into CFX-Pre can be selected, modified, and deleted in the same way as composite regions defined in CFX-Pre.

10.3. Using Regions in CFX-Pre

A composite 2D region may be used in exactly the same way as a primitive 2D region to define the location of a Boundary Condition, Domain Interface, and so on, in the model.

A composite 3D region may be used in exactly the same way as a primitive 3D region to define the location of a Domain or Sub-domain in the model.

Mixed-dimensionality composite regions can be used as locators, but only the primitive regions of appropriate dimensionality are used in the location. For example, a mixed-dimensionality region used as the location of a boundary condition will mean that the boundary condition is defined only on the 2D components.

10.4. Editing Regions in CFX-Pre

As there are two types of regions in CFX-Pre, there are two editors used for defining and modifying these regions. For details, see:

- Defining and Editing Primitive Regions (p. 96)
- Defining and Editing Composite Regions (p. 98)

10.4.1. Defining and Editing Primitive Regions

Currently only definition and modification of 2D primitive regions is supported.

To define a primitive region, select Regions from the Insert > Primitive Region on the main menu or from the shortcut menu available from Mesh in the Outline or Mesh trees. To edit an existing primitive 2D region when on the name of the region in the Outline or Mesh trees, right-click and select Edit Mesh from the shortcut menu.
Faces can be moved or copied from one or more 2D primitive regions into a new or an existing 2D primitive region.

The Region Filter enables you to modify the source from which faces will be picked. Select All Regions from the drop-down list if faces are to be selected from anywhere in the model, or any number of regions if you want to restrict your source regions. (Note: If you have entered the editor by selecting Edit Mesh, the region filter will be set to the regions selected in the tree by default. You are able to change this selection if required.)

Initially no faces will be selected in the viewer and the dialog box will indicate this.

Click Start Picking and use one of the toolbar buttons on the 3D viewer, for details, see 3D Viewer Toolbar (p. 19):

- To set the pick mode to single face selection, click this button. Clicking in the viewer will select the first face to move.

- To flood fill an area, click this button and then click in the viewer. Changing the crease angle will control how far the flood will extend. The angle indicates that any face that bounds the face first selected and has a normal within the angle will be selected. The same angle is then used again on any faces selected by the algorithm until no more faces can be reached using this method.
To select all faces within a rectangle, click this button and then click in the viewer and drag the box to perform the selection. The option to the left of Pick All indicates whether the selection only includes fully enclosed faces or any touching or enclosed faces.

To select all faces within a polygon, click this button and then click multiple times in the viewer finishing with a double-click to perform the selection. The option to the left of Pick All indicates whether the selection only includes fully enclosed faces or any touching or enclosed faces.

Appending further faces to the current selection is performed in the same way as above, but by using Ctrl and click to pick the faces in the viewer. All operations can use this method.

The names of the 2D primitive regions from which faces have been selected are shown in the Mesh Face Selection tree. The number of faces selected from each 2D primitive is also shown. The set of faces associated with a single 2D primitive can be removed by right-clicking the 2D primitive in the tree.

Faces are moved or copied to a destination region; the action can be selected from those shown in Destination box.

You can select the destination for the faces from the list to the right of the Move Faces To field, or you can type a new name into the field.

**Note**

Unexpected results may occur if the topology of the current model is altered in some way during the course of the edit. For example adding a new composite region or deleting an existing one or importing or deleting a mesh may alter how the editor acts. In a similar way, performing an Undo or Redo when faces are selected may change the topology. If any of these operations are performed, click Reset and re-pick the faces as required.

### 10.4.1.1. Advanced Options

At the bottom of the form, the Options box can be expanded and Remove Invalid Components from Composite Definitions can be selected. Selecting this option will remove any references to primitives that are completely removed by the operation. If this is not done, composite regions that reference a removed primitive region will become unresolved.

### 10.4.2. Defining and Editing Composite Regions

The Regions details view is used to create new, and edit existing composite regions. To create a new region, select Composite Region from either the Insert >Regions menu or the shortcut menu available from Mesh in the Outline or Mesh trees. To edit an existing composite region, right-click it in the Outline or Mesh tree view, then select Edit Definition from the shortcut menu.

A composite region is defined by specifying a list of regions and a method for combining them. The Regions details view can be used to create or modify a region by selecting a method of combination from the Combination list and a selection of regions from the Region List.
The **Regions** details view enables you to restrict the regions available for selection by limiting them by **Dimension(Filter)**. Selecting 2D will cause the **Region List** to only display 2D regions and selecting 3D will cause the **Region List** to only select 3D regions. Regions of mixed dimensionality are always available.

### 10.4.2.1. Union

A **Combination** setting of **Union** combines the area or volume of the selected regions to create a new region. The new region will include all the regions from which it is constructed. For example, two or more 3D regions can be combined to create a new region, which can then be used as the location for a domain.

### 10.4.2.2. Alias

A **Combination** setting of **Alias** is used to produce a composite region that when resolved is based upon the same set of primitive regions as the region it is defined on. A composite region with a **Combination** of **Alias** may only reference a single region (this may be a composite or primitive region). The new composite region may, however, resolve to more than one primitive region. This feature is useful to assign recognizable names to regions with non-intuitive names.

### 10.5. Applications of Composite Regions

Composite Regions that are defined in the simulation can be used as locations for domains, sub-domains, boundary conditions and domain interfaces. For example, a composite region with a combination method of **Union** can be used to group two separate 3D regions. A domain that spans both 3D regions can then be created using the single composite 3D region. Domain interfaces should still be created to connect the two assemblies together if the composite region does not form a continuous mesh and flow is to pass between the two assemblies. For details, see *Mesh Topology in CFX-Pre (p. 91).*

Another application of composite regions is to set up a consistent set of locations that can be applied to a number of different simulations that use the same physics definition. By referencing the composite regions in the physics definitions, the need to edit the definitions for each mesh is avoided and if differences in the mesh topology do exist this can be coped with by editing the composite regions used to locate the physics relatively simply. In this way for every problem in which the physics is to be applied, the mesh, region CCL, and physics CCL can be imported. Locations of boundary conditions, domains and subdomains should all match provided that the composite regions can all be resolved as expected.
Chapter 11: Analysis Type

The **Analysis Type** details view is used to specify whether the analysis requires coupling to an external solver, such as ANSYS Multi-field, and whether the analysis is steady state, transient, or transient blade row. A discussion of external solver coupling is presented in *Coupling CFX to an External Solver: ANSYS Multi-field Simulations in the CFX-Solver Modeling Guide*. A discussion on steady state and transient flows is presented in *Steady State and Transient Flows in the CFX-Solver Modeling Guide*.

### 11.1. Basic Settings Tab

The following topics are discussed in this section:

- **External Solver Coupling Settings** (p. 101)
- **Analysis Type Settings** (p. 101)

#### 11.1.1. External Solver Coupling Settings

Most analyses will require no coupling to another solver and **Option** can remain set to the default of **None**. If you are setting up a two-way fluid-structure analysis, coupling CFX-Solver to ANSYS solver, then you need to set **Option** to either **ANSYS MultiField** or **ANSYS MultiField via Prep7**. Use **ANSYS MultiField** if you want to do a full ANSYS Multi-field set-up, or **ANSYS MultiField via Prep7** if you want to do a minimal set-up in CFX-Pre and define the ANSYS Multi-field set-up in the ANSYS Prep7 user interface. A full description of these two modes of operation can be found in *Overview of Pre-Processing for ANSYS Multi-field Simulations in the CFX-Solver Modeling Guide*.

If **ANSYS MultiField** is selected, then additional information must be specified. The **ANSYS Input File** setting is described in *Input File Specification for the Mechanical Application in the CFX-Solver Modeling Guide*, and the **Coupling Time Control** settings are described in *Coupling Time Control in the CFX-Solver Modeling Guide*.

#### 11.1.2. Analysis Type Settings

The **Analysis Type** settings enable you to specify an analysis as being **Steady State**, **Transient**, or **Transient Blade Row**. Steady state analyses are used to model flows that do not change over time; transient analyses model flows that are time-dependent. Transient blade row analyses are transient analyses that have special handling for turbomachinery cases.

The **Analysis Type** options are described in the following sections:

- **Steady State** (p. 102)
- **Transient** (p. 102)
- **Transient Blade Row** (p. 103)
11.1.2.1. Steady State

No further settings are required for the Steady State option. Modeling advice for setting the time scale for steady state simulations is provided in Steady State Time Scale Control in the CFX-Solver Modeling Guide.

11.1.2.2. Transient

11.1.2.2.1. Time Duration

Set Option to determine the length of the transient analysis:

- Total Time
- Time per run
- Maximum Number of Timesteps
- Number of Timesteps per Run
- Coupling Time Duration

For details, see Time Duration in the CFX-Solver Modeling Guide.

11.1.2.2.2. Time Steps

Set Option to determine the size of timesteps for the run:

- Timesteps
- Timesteps for the Run
- Adaptive
- Coupling Timesteps

The Timesteps and Timesteps for the Run parameters can accept a single value or lists. If a list is entered, it should be comma separated, for example, 2, 1.2, 2.4. If an expression is used, you must associate units with each item in the list, for example, 2 [s], 1.2 [s], 2.4 [s]. In addition, it is possible to define multiples of a timestep value in the user interface when not using the expression method. For example, you could enter 5*0.1, 2*0.5, 10*1 as a list of values, and set the units to [s] separately. The corresponding CCL that would be generated would be:

0.1 [s], 0.1 [s], 0.1 [s], 0.1 [s], 0.5 [s], 0.5 [s], 1 [s], 1 [s], 1 [s], 1 [s], 1 [s], 1 [s], 1 [s], 1 [s], 1 [s]

If you accidentally enter 5*0.1 [s], 2*0.5 [s], 10*1 [s] as an expression, the multiplication would be carried out, and the corresponding CCL that would be generated would be:

0.5 [s], 1.0 [s], 10.0 [s]

For details, see Transient Timestep Control in the CFX-Solver Modeling Guide.

When Adaptive time is selected, set one of the following three conditions for Timestep Adaption to automate the calculation of timestep size:

- Number of Coefficient Loops
- RMS Courant Number
11.1.2.2.3. Initial Time

Set the **Option** to specify the **Initial Time** for a transient analysis.

- Automatic
- Automatic with Value
- Value
- Coupling Initial Time

For details, see **Initial Time** in the *CFX-Solver Modeling Guide*.

**11.1.2.3. Transient Blade Row**

The **Transient Blade Row** option is required in order to access the Transient Blade Row models:

- None
- Profile Transformation
- Time Transformation
- Fourier Transformation

The **Initial Time** settings must be specified in the **Analysis Type** settings. For details on these settings, see **Initial Time** (p. 103).

For instructions on setting up and using Transient Blade Row models, see **Transient Blade Row Modeling** in the *CFX-Solver Modeling Guide*.
Chapter 12: Domains

This chapter describes:

12.1. Creating New Domains
12.2. The Details View for Domain Objects
12.3. Using Multiple Domains
12.4. User Interface

CFX-Pre uses the concept of domains to define the type, properties, and region of the fluid, porous, or solid. Domains are regions of space in which the equations of fluid flow or heat transfer are solved. This section describes how to use the domain details view to define the physics of fluid, porous or solid domains in your simulation. This includes selecting the 3D bounding regions and choosing appropriate physical models.

A list of the physical models available in CFX, as well as additional information on the physical meaning of the models used, is available. For details, see Physical Models in the CFX-Solver Modeling Guide.

Domains are created from a list of Assemblies, 3D primitive regions and/or 3D composite regions that are associated with a volume of an imported mesh. A discussion of these objects can be found in CFX-Pre. For details, see Mesh Topology in CFX-Pre (p. 91).

In some cases, separate domains will need to be connected via a domain interface, while in other cases, no interface is required or a default interface is created and is suitable. For details, see Domain Interfaces (p. 137).

Within fluid, porous, and solid domains, internal 3D regions can be assigned to a subdomain. These are used to create volumetric sources of mass, momentum, energy, and so on. For details, see Subdomains (p. 181).

Boundary conditions can be applied to any bounding surface of a 3D primitive that is included in a domain (that is, including internal surfaces). For details, see Boundary Conditions (p. 149).

12.1. Creating New Domains

New domains are created by selecting Insert > Domain or clicking the Domains icon. Note that creation of domains from the menu bar or toolbar may subsequently require selection of the appropriate analysis type. Domains can also be created by right-clicking the appropriate analysis type in the Outline view.

Creating a new domain will present a dialog box where a unique name for the domain should be entered.

Additional information on valid names is available in Valid Syntax for Named Objects (p. 55). Existing domains may be edited by double-clicking the domain in the Outline view, or by right-clicking the domain and selecting Edit. For details, see Outline Tree View (p. 5).
12.2. The Details View for Domain Objects

After entering a name for the domain, or selecting a domain to edit, the domain details view appears in the workspace. In this view, you should complete each of the following tabs in turn, proceeding from left to right across the tabs. The tabs shown depends on your simulation, but could be:

- **Basic Settings**: Sets the location and type of domains, as well as the fluid, porous or solid, used in the domain. The reference pressure, buoyancy options and domain motion are also set here. For details, see *Basic Settings Tab* (p. 107).

- **Porosity Settings**: Only available for porous domains. Set the general description of a porous domain.

- **Fluid Models**: Only available for fluid domains. Sets the physical models that apply to all domain fluids. For details, see *Fluid Models Tab* (p. 113).

- **Fluid Specific Models** (for example, Water at RTP): Only available for fluid or porous domains when more than one fluid is selected, or for a single phase case when particles are included. A separate tab is used for each fluid in the domain and uses the fluid name as the name for the tab. This sets physical model options that are specific to each domain fluid. For details, see *Fluid Specific Models Tab* (p. 119).

- **Fluid Pair Models**: Only available for fluid domains using multiple fluids or when particles are included. This sets options that depend on the interaction between fluid pairs, such as transfer options. For details, see *Fluid Pair Models Tab* (p. 122).

- **Solid Models**: Only available for solid domains. Sets the physical models that apply to the solid. For details, see *Solid Models Tab* (p. 128).

- **Particle Injection Regions**: When a particle tracking simulation is used, custom injection regions can be created using this tab. For details, see *Particle Injection Regions Tab* (p. 131).

- **Initialization**: Sets initial conditions on a domain basis. For details, see *Initialization Tab* (p. 135). This is optional since global initialization can also be performed, but is essential for solid domains.

- **Solver Control**: Sets solver control settings on a domain basis. For details, see *Solver Control Tab* (p. 135).

12.3. Using Multiple Domains

For any given CFD problem, more than one domain may be defined. By default, the physical models used in each domain must be consistent; therefore, each time you create or edit a domain, the physical models (fluid lists, heat transfer models, and so on) are applied across all domains of the same type (such as fluid or solid), possibly overwriting models chosen earlier for other domains.

Note the following:

- Some exceptions exist when using fluid and solid domains together and also to allow MFR (multiple frame of reference) simulations to be defined.

- If a domain interface is required, refer to *Using Domain Interfaces in the CFX-Solver Modeling Guide* for information on the correct use of interfaces.

12.3.1. Multiple Fluid Domains

When consistent physics has been enforced, all settings are copied across all fluid domains when any fluid domain is edited with the following exceptions:

- **Location**: The location of each domain must obviously be different.

- **Coordinate Frame**: Each domain can use a different reference local coordinate frame.
• **Domain Motion**: Each domain can be independently stationary or rotating. For rotating domains, the angular velocity and axis of rotating can be different for each domain. This enables MFR simulations to be set up.

Note that these parameters are all set on the **Basic Settings** tab on the **Domains** form.

Fluid and Solid Domains: Settings are not copied between fluid and solid domains with the exception of **Thermal Radiation Model**. If any solid domain uses the Monte Carlo radiation model, then all fluid domains must also model radiation and must use the Monte Carlo model. If no solid domain has radiation modeling (that is, **Option** = **None**), then the fluid domains can use any radiation model.

### 12.3.2. Multiple Solid Domains

Settings are not copied between solid domains. Each solid domain can be made from a different material and can mix the Monte Carlo radiation model and no radiation model.

### 12.4. User Interface

The following topics will be discussed:
- **12.4.1. Basic Settings Tab**
- **12.4.2. Fluid Models Tab**
- **12.4.3. Polydispersed Fluid Tab**
- **12.4.4. Fluid Specific Models Tab**
- **12.4.5. Fluid Pair Models Tab**
- **12.4.6. Solid Models Tab**
- **12.4.7. Porosity Settings Tab**
- **12.4.8. Particle Injection Regions Tab**
- **12.4.9. Initialization Tab**
- **12.4.10. Solver Control Tab**

#### 12.4.1. Basic Settings Tab

The basic settings apply to the whole of the domain. When you create a new domain, the **Basic Settings** tab is initially shown.

#### 12.4.1.1. Location and Type

##### 12.4.1.1.1. Location

The **Location** is the list of assemblies, 3D primitive regions and/or 3D composite regions that define the volume of the domain. For details, see *Mesh Topology in CFX-Pre* (p. 91). Using an assembly or a composite region in the Location list implicitly includes all 3D primitives contained within the object. You can use more than one location by using the **Shift** or **Ctrl** keys to pick multiple entries from the drop-down list. The ... icon to the right of the drop-down list can be used to pick locations from an expanded list. Alternatively, clicking a location in the viewer displays a small box containing the available locations.

For details, see *Domain and Subdomain Locations* (p. 92).

##### 12.4.1.1.2. Domain Type

The **Domain Type** setting can be set to one of the following:
12.4.1.1.3. Coordinate Frame

By default in a fluid domain, **Coordinate Frame** is set to the default Cartesian frame, Coord 0, but you can select any predefined coordinate frame. To create a new coordinate frame, select **Insert > Coordinate Frame** from the menu bar. For details, see **Coordinate Frames** (p. 255) and **Coordinate Frames in the CFX-Solver Modeling Guide**.

The coordinate frame set for a domain is local to only that domain and is used to interpret all x, y and z component values set in the domain details view. This includes the gravity components in a buoyant flow and the rotation axis definition in a rotating domain. The coordinate frame set here has no influence on boundary conditions for the domain. For details, see **Global Coordinate Frame (Coord 0)** in the **CFX-Solver Modeling Guide**.

12.4.1.2. Fluid and Particle Definitions and Solid Definitions

To define a fluid, particle or solid (including the solid portion of a porous domain):

1. If required, click **Add new item** to the right of the definition list, type a name for the definition and click **OK**. For multiphase simulation, more than one fluid is required. For details, see **Multiphase Flow Modeling in the CFX-Solver Modeling Guide**.

2. For the definition **Option** select **Material Library** (the default) to enable choosing a material from a supplied or user defined library or **Material Definition for Reacting Mixtures**.

3. For the definition **Material** select from the drop-down list for some commonly used materials or click **Select from extended list** to access a complete list of materials.
4. After clicking you may also choose to select Import Library Data to load library data from a file.

The specification of material properties (for example, density and viscosity) and the creation of custom materials is performed in the Materials details view. For details, see Materials (p. 259). New materials are added to the relevant drop-down list.

A solid domain must be made from a single solid material.

**12.4.1.2.1. Morphology**

Which morphology options are available depends on whether you are setting fluid-specific details for an Eulerian phase or for a particle phase. For Eulerian phases, the options are:

- Continuous Fluid
- Dispersed Fluid
- Dispersed Solid
- Droplets with Phase Change
- Polydispersed Fluid

For details, see Morphology in the CFX-Solver Modeling Guide.

For a particle phase, the options are:

- Particle Transport Fluid
- Particle Transport Solid

For details, see Particle Morphology Options in the CFX-Solver Modeling Guide.

**12.4.1.2.1.1. Mean Diameter**

For Dispersed Fluid and Dispersed Solid phases, a mean diameter is required. For details, see Mean Diameter in the CFX-Solver Modeling Guide.

**12.4.1.2.1.2. Minimum Volume Fraction**

This is available for dispersed phases, but you will not usually need to set a value. For details, see Minimum Volume Fraction in the CFX-Solver Modeling Guide.

**12.4.1.2.1.3. Maximum Packing**

This is available for the Dispersed Fluid and Dispersed Solid phases. For details, see Maximum Packing in the CFX-Solver Modeling Guide.

**12.4.1.2.1.4. Restitution Coefficient**

This restitution coefficient setting holds a value from 0 to 1 that indicates the degree of elasticity of a collision between a pair of particles. For such a collision, the restitution coefficient is the ratio of separation speed to closing speed. This restitution coefficient setting is used only for the kinetic theory model. For details, see Kinetic Theory Models for Solids Pressure in the CFX-Solver Theory Guide.
12.4.1.2.1.5. Particle Diameter Distribution

This is available for particle phases. For details, see Particle Diameter Distribution in the CFX-Solver Modeling Guide.

12.4.1.2.1.6. Particle Shape Factors

This is available for particle phases. For details, see Particle Shape Factors in the CFX-Solver Modeling Guide.

12.4.1.2.1.7. Particle Diameter Change

This option is available when multiphase reactions have been enabled with particle tracking. When Particle Diameter Change is selected choose either Mass Equivalent or Swelling Model.

12.4.1.2.1.7.1. Swelling Model

Select a reference material from the list. Enter a Swelling Factor greater than or equal to zero; a value of zero indicates no swelling, and CEL expressions are permitted. For details, see Particle Diameter Change Due to Swelling in the CFX-Solver Modeling Guide.

12.4.1.3. Particle Tracking

To include particles in the domain, define a particle in Fluid and Particle Definitions... select the particle material and select the Particle Transport Fluid or Particle Transport Solid option for Fluid and Particle Definitions... > <particle definition> > Morphology on the Basic Settings tab. For details, see Particle Transport Modeling in the CFX-Solver Modeling Guide.

12.4.1.4. Domain Models

12.4.1.4.1. Pressure: Reference Pressure

This sets the absolute pressure level to which all other relative pressure set in a simulation are measured. For details, see Setting a Reference Pressure in the CFX-Solver Modeling Guide.

12.4.1.4.2. Buoyancy: Option

For flows in which gravity is important, you should include the buoyancy term. Gravity components in the x, y and z directions should be entered; these are interpreted in the coordinate frame for the domain. For details, see Coordinate Frames in the CFX-Solver Modeling Guide.

There are two different buoyancy models in CFX: the one used depends upon the properties of the selected fluid(s). Depending on the types of fluid selected, a Buoyancy Reference Temperature and / or a Buoyancy Reference Density must be set. This is because different fluids use either the full or Boussinesq buoyancy model. In multiphase flows, the reference density can have a significant effect.

The Buoyancy Reference Location can be set automatically, or to a specific location with X/Y/Z coordinates. For details, see:

- Buoyancy in the CFX-Solver Modeling Guide
- Buoyancy in the CFX-Solver Theory Guide.
12.4.1.4.3. Domain Motion

The available Domain Motion options depend on the type of domain, and are described in Table 12.1: Domain Motion Options (p. 111):

Table 12.1 Domain Motion Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Eligible Domain Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stationary</td>
<td>All domain types</td>
<td>The domain remains stationary in the absolute frame of reference.</td>
</tr>
<tr>
<td>Rotating</td>
<td>All domain types</td>
<td>The domain rotates with a specified angular velocity about the given axis.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For fluid, porous, and solid domains, a Rotational Offset setting exists.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For fluid and porous domains, an Alternate Rotation Model option exists.</td>
</tr>
<tr>
<td>Speed and Direction</td>
<td>Immersed solid domain</td>
<td>The domain translates at the specified speed in the specified direction. The translation direction can be specified by Cartesian components, or by a coordinate axis.</td>
</tr>
<tr>
<td>Specified Displacement</td>
<td>Immersed solid domain</td>
<td>The domain is displaced according to the specified Cartesian components. For example, you could use CEL expressions that are functions of time to move the domain.</td>
</tr>
<tr>
<td>General Motion</td>
<td>Immersed solid domain</td>
<td>Specify a reference origin that is considered to be attached to the domain. Then specify a motion for that origin, and a rotation of the domain about that origin. The reference origin location is specified by the Reference Location settings. The motion of the reference origin is specified by Origin Motion settings that are similar to those for the Domain Motion options (other than General Motion). The rotation of the domain about the reference origin is specified by the Body Rotation settings.</td>
</tr>
</tbody>
</table>
| Rigid Body Solution     | Immersed solid domain | Specify a mass, moment of inertia, and various dynamics settings. The dynamics settings include external forces and torques, translational and rotational degrees of freedom, and gravity. All of these settings are analogous to the settings of the rigid body object, which is described in Rigid Bodies (p. 187). Note that, unlike for a rigid body object, you cannot specify initialization values for the rigid body solution that applies to an immersed solid domain; these initialization values (such
### Option | Eligible Domain Types | Description
--- | --- | ---
| as angular velocity and angular acceleration) are effectively initialized with values of magnitude zero. For additional information on modeling rigid bodies, see Rigid Body Modeling in the CFX-Solver Modeling Guide.

Details of some of the settings mentioned in *Table 12.1: Domain Motion Options* (p. 111):

- **Angular Velocity**: The angular velocity gives the rotation rate of the domain, which can be a function of time.

- **Axis Definition**: The axis of rotation can be a coordinate axis of the local coordinate frame or a local cylindrical axis defined by two points.
  - If *Coordinate Axis* is selected, the available axes are all local and global coordinate axes. *Coord 0* is the global coordinate frame, and its axes are referred to as *Global X*, *Global Y*, and *Global Z*. A local coordinate frame’s axes are referred to as *myCoord.1*, *myCoord.2*, *myCoord.3* where 1,2,3 represent the local X,Y,Z directions.
  - If *Two Points* is selected, **Rotation Axis From** and **Rotation Axis To** must be set. The points are interpreted in the coordinate frame for the domain. If the coordinate frame is cylindrical, then the components correspond to the *r*, *θ*, *z* directions. For details, see Coordinate Frames in the CFX-Solver Modeling Guide.

- **Rotational Offset**: This setting transforms the domain by the specified rotation angle. The rotation axis used for this transformation is specified by the **Axis Definition** settings.

- **Alternate Rotation Model**: For details, see Alternate Rotation Model in the CFX-Solver Modeling Guide.

- **Reference Location**: The reference location is an origin point that should be defined to conveniently describe the body rotation of the immersed solid domain. When **Body Rotation > Option** is set to None, the reference location will be neglected. Specify the reference location by choosing an existing coordinate frame origin, or by specifying Cartesian coordinates.

  A solver run that starts from a previous run should have the same domain motion options in the immersed solids domains, and must have identical reference location specifications if supplied.

- **Origin Motion**: The origin motion can be specified in any of the ways that the domain motion can be specified (not counting the **General Motion** option for domain motion), and by **Specified Velocity**, which accepts Cartesian components of velocity.

- **Body Rotation**: The body rotation options are:
  - None
  - Rotating
    - Specify an angular velocity and the instantaneous axis of rotation.
  - Specified Angular Velocity
    - Use Cartesian components to define a vector. The rotation axis passes through the reference location in the direction of the specified vector. The angular velocity is the magnitude of the specified vector.
Note

- CEL expressions used to define domain motion can be functions of time only.
- If you create two or more fluid domains and modify a model setting of one of the domains, that setting is generally copied to all other fluid domains in the simulation. An exception to this is that if you edit the Domain Motion settings of a domain, those settings are not copied to any other domains; this enables each domain to rotate or remain stationary independently of the other domains.

12.4.1.4.4. Mesh Deformation

Mesh deformation can be used to model flows with a varying geometry, for both transient and steady-state simulations. There are three options for the specification of mesh deformation for a domain:

- None
- Regions of Motion Specified: permits wall boundaries and subdomains to move, and makes mesh motion settings available. These include a mesh motion option (which must be set to Displacement Diffusion) and mesh stiffness settings. For details, see Regions of Motion Specified in the CFX-Solver Modeling Guide.
- Junction Box Routine: reads mesh coordinate datasets from a file into the CFX-Solver as the solution proceeds. This step requires the specification of a series of meshes and User Fortran routine(s). For details, see Junction Box Routine in the CFX-Solver Modeling Guide.

12.4.1.4.5. Passage Definition

For Transient Blade Row cases, specify the number of passages in 360° and the number of passages per component for the domain. This information may be used in the automatic calculation of time step size, depending on the Transient Details settings (which are described in Transient Details (p. 242)).

12.4.2. Fluid Models Tab

The Fluid Models tab is where models are chosen, which apply to all Eulerian fluids in the simulation. By default, the fluids models must be consistent between all fluid domains in a multidomain simulation, but CFX supports inconsistent physics through the setting of an environment variable. For details, see:

- Using Multiple Domains (p. 106)
- Solid Models Tab (p. 128).

In a multiphase simulation, the options that are allowed to vary between fluids will appear on the Fluid Specific Models tab instead. For details, see Fluid Specific Models Tab (p. 119).

Some fluid models can apply to all fluids or can be set on a fluid-specific basis, these models will appear on the Fluid Models section with a Fluid Dependent option. If this is selected, then the model appears on the Fluid Specific Models tab.

The options available on the Fluid Specific Models tab depends on the simulation set up (including the type and number of fluids used in the simulation (such as single or multicomponent, single or multiphase, reacting or non-reacting)) and whether Additional Variables have been created.

All details related to Particle Tracking are set on the General Settings tab and the models chosen on the Fluid Models tab do not apply to the particle phase.
Radiation with multiphase is not supported. However, it is allowed for single Eulerian particle tracking cases on the Fluid Specific Models tab.

The available settings depend on the physical models chosen in your simulation.

12.4.2.1. Multiphase Options

These options are only applicable to multiphase simulations.

12.4.2.1.1. Homogeneous Model

Inhomogeneous is the general case of multiphase flow, where each fluid has its own velocity field, turbulence field, and so on. You can select the Homogeneous Model check box to switch to this model, where all fluids share a velocity field, turbulence field, and so on. For details, see The Homogeneous and Inhomogeneous Models in the CFX-Solver Modeling Guide. Both the inhomogeneous and homogeneous models have a Free Surface Model option.

12.4.2.1.2. Free Surface Model

You can select the Standard free surface model if you are modeling multiphase flow with a distinct interface between the fluids. For details, see Free Surface Flow in the CFX-Solver Modeling Guide.

12.4.2.1.3. Multiphase Reactions

Multiphase Reactions are available when any reactions have been defined with type Multiphase. For details, see Multiphase: Basic Settings (p. 272). Any reactions that are to be included in the simulation should be selected from the drop-down list. For details, see Multiphase Reactions in the CFX-Solver Modeling Guide.

12.4.2.2. Heat Transfer

12.4.2.2.1. Homogeneous Model

For details, see Homogeneous Heat Transfer in Multiphase Flow in the CFX-Solver Modeling Guide.

12.4.2.2.2. Heat Transfer: Option

Depending on your simulation, the following heat transfer options are possible. For details, see Heat Transfer in the CFX-Solver Modeling Guide.

- None: Not available for compressible fluids, since a temperature is required at which to evaluate the fluid properties.
- Isothermal: Not available for reacting fluids.
- Thermal Energy: Models the transport of enthalpy through the fluid and is suitable for modeling heat transfer in low-speed flows. For details, see The Thermal Energy Equation in the CFX-Solver Theory Guide.

The Turbulent Prandtl Number may be customized by selecting the Turbulent Flux Closure check box in the Turbulence settings.

- Total Energy: Includes high-speed energy effects. You can include the Viscous Work Term in the energy equation. For details, see The Total Energy Equation in the CFX-Solver Theory Guide.
The **Turbulent Prandtl Number** may be customized by selecting the **Turbulent Flux Closure** check box in the **Turbulence** settings.

- **Fluid Dependent**: Is used to set different heat transfer models for each fluid in a multiphase simulation. A heat transfer model is then set for each fluid on the **Fluid Specific Models** tab. This option cannot be used when **Homogeneous Model** is selected.

### 12.4.2.3. Turbulence

Advice on which turbulence model is appropriate for your simulation and a description of each model can be reviewed. For details, see:

- **Turbulence and Near-Wall Modeling in the CFX-Solver Modeling Guide**
- **Turbulence Modeling in Multiphase Flow in the CFX-Solver Modeling Guide**
- **Turbulence Models in the CFX-Solver Theory Guide**.

#### 12.4.2.3.1. Homogeneous Model

If you have not selected **Homogeneous Model** under **Multiphase Options**, then **Homogeneous Model** under **Turbulence** frame will be available.

If selected, this will solve a single turbulence field for an inhomogeneous simulation. There will be no fluid-specific turbulence data to set. For details, see **Homogeneous Turbulence in Inhomogeneous Flow in the CFX-Solver Modeling Guide**.

If you do not enable this check box, then you will usually select **Fluid Dependent** and specify turbulence data on the fluid-specific tabs. Alternatively, the Laminar model can be picked to apply to all fluids (this is not homogeneous turbulence).

Homogeneous multiphase flow always uses homogeneous turbulence; therefore, you only need select the turbulence model to use.

#### 12.4.2.3.2. Turbulence: Option

You can select one of the following turbulence models:

- **None (Laminar)**: Turbulence is not modeled. This should only be used for laminar flow. Of the combustion models, only Finite Rate Chemistry is available for laminar flow. For details, see **The Laminar Model in the CFX-Solver Modeling Guide**.

- **k-Epsilon**: A standard fluid model that is suitable for a wide range of simulations. For details, see **The k-epsilon Model in the CFX-Solver Modeling Guide**.

- **Fluid Dependent**: Allows you to set different turbulence models for each fluid in the domain. If this option is selected, the turbulence model for each fluid is set in the **Fluid Specific Models** tab. This is only available for multiphase simulations when **Homogeneous Model** is not selected.

- **Shear Stress Transport**: Recommended for accurate boundary layer simulations. For details, see **The k-omega and SST Models in the CFX-Solver Modeling Guide**.

- **Omega Reynolds Stress / BSL Reynolds Stress**: For details, see **Omega-Based Reynolds Stress Models in the CFX-Solver Modeling Guide**.

- **QI / SSG / LRR Reynolds Stress**: Provides high accuracy for some complex flows. For details, see **Reynolds Stress Turbulence Models in the CFX-Solver Theory Guide**.
• Zero Equation: Only the Finite Rate Chemistry combustion model is available when using the zero equation turbulence model. For details, see The Zero Equation Model in the CFX-Solver Modeling Guide.

• RNG k-Epsilon: A variation of the k-epsilon model.

• k-Omega / BSL: The SST model is often preferred to this model.

• k epsilon EARSM / BSL EARSM: These models are a simplified version of the Reynolds Stress models with application to problems with secondary flows as well as flows with streamline curvature and/or system rotation. For details, see Explicit Algebraic Reynolds Stress Model in the CFX-Solver Theory Guide

• LES Smagorinsky / LES WALE / LES Dynamic Model: Available for transient simulation only. For details, see The Large Eddy Simulation Model (LES) in the CFX-Solver Modeling Guide.

• Detached Eddy Simulation: Available for transient simulation only. For details, see The Detached Eddy Simulation Model (DES) in the CFX-Solver Modeling Guide.

The available Advanced Turbulence Control settings for turbulence modeling depend on the turbulence model. The settings can be used to specify the coefficients for the selected turbulence model. For details, refer to the appropriate sections of the Turbulence and Near-Wall Modeling in the CFX-Solver Modeling Guide and Turbulence and Wall Function Theory in the CFX-Solver Theory Guide.

12.4.2.3.3. Buoyancy Turbulence

Buoyancy Turbulence is available for two (or more) equation turbulence models. For details, see Buoyancy Turbulence in the CFX-Solver Modeling Guide.

12.4.2.3.4. Wall Function

The wall function is automatically set depending on the turbulence model selected. Therefore, you will not need to change this setting. For multiphase flow, if the fluid dependent turbulence model option is selected, the wall function option appears on the fluid-specific tabs. The Laminar and zero equation turbulence models do not use wall functions. For details, see Modeling Flow Near the Wall in the CFX-Solver Modeling Guide.

12.4.2.3.5. Turbulent Flux Closure for Heat Transfer

Turbulent Flux Closure for Heat Transfer is available for turbulent flow with Thermal Energy or Total Energy heat transfer model. For details, see Heat Transfer in the CFX-Solver Modeling Guide.

12.4.2.4. Reaction or Combustion Model

If the fluid material is defined as Option is Material Definition and Composition Option is Reacting Mixture, or if a reacting mixture from the material library has been selected as the material for one of the domain fluids, then you can select a combustion model as:

• Eddy Dissipation
• Finite Rate Chemistry
• Finite Rate Chemistry and Eddy Dissipation
• PDF Flamelet
• BVM (Partially Premixed)
• Extended Coherent Flame Model
• Fluid Dependent (multiphase only)
Only Finite Rate Chemistry is available when Laminar or Zero Equation turbulence model is used.

In multiphase simulations, when Fluid Dependent is selected, a different combustion model can be used for each reacting fluid in the simulation. If the homogeneous multiphase model is used, all fluids must be reacting mixtures that include reactions to allow a combustion to be modeled.

If the fluid material is defined as a reacting mixture from the material library, then the available combustion models are filtered in order to be compatible with the reactions specified in the reacting material.

If the fluid material is defined as Option is Material Definition and Composition Option is Reacting Mixture, then the complete list of combustion models is presented and the reactions list for the mixture has to be specified. Only those reactions from the material library will be available that are compatible with the selected combustion model.

Depending on the selected combustion model, additional options (such as Autoignition Model, NO Model, and Chemistry Post-Processing) and parameters may be available. For details, see Combustion Modeling in the CFX-Solver Modeling Guide.

12.4.2.4.1. Soot Model

When a combustion model is selected, you can optionally enable the Magnussen soot model to account for the formation of soot. In multiphase simulations, this model appears on the fluid-specific tab for each fluid that uses a combustion model.

A Fuel and Soot Material is required, and the following optional parameters can also be set:

- Fuel Consumption Reaction
- Fuel Carbon Mass Fraction
- Soot Density
- Soot Particle Mean Diameter

For details, see Soot Model in the CFX-Solver Modeling Guide.

12.4.2.5. Thermal Radiation Model

If a heat transfer model other than None has been selected, you can model thermal radiation. If a radiation model is selected, you must make sure that the radiation properties for that fluid have been set in the Material details view. For details, see Material Properties Tab (p. 263). Radiation is not supported for multiphase simulations in CFX.

The four radiation models available in CFX are:

- Rosseland
- P1
- Discrete Transfer
- Monte Carlo

A Spectral Model can be selected for all radiation models. If the Multigray or Weighted Sum of Gray Gases representation is selected for the Spectral Model, then you should create the required number of gray gases.
1. Click **Add new item** to add a new gray gas. (You can click **Delete** to delete a highlighted gray gas.)

2. Set the **Weight** and **Absorption Coefficient** for each gray gas.
   
   For details, see *Multigray/Weighted Sum of Gray Gases in the CFX-Solver Modeling Guide*.

Alternatively, if the **Multiband** representation is selected, you should create **Spectral Bands**:

1. Click **Add new item** to add a new spectral band. (You can click **Delete** to delete a highlighted spectral band.)

2. Set **Option** to either **Frequency**, **Wavelength** or **Wavenumber**.

3. Enter upper and lower limits for the option selected.
   
   This defines the range of the spectral band. For details, see:
   
   - **Multiband in the CFX-Solver Modeling Guide**
   - **Spectral Model in the CFX-Solver Modeling Guide**
   - **Radiation Modeling in the CFX-Solver Modeling Guide**.

### 12.4.2.6. Electromagnetic Model

The **Electromagnetic Model** enables you to define:

**Electric Field Model**

- **Option** can be set to None, Electric Potential, or User Defined.

**Magnetic Field Model**

- **Option** can be set to None, Magnetic Vector Potential, or User Defined.

If a user-defined model is selected, you must make sure that the electromagnetic properties have been set in the **Material** details view. For details, see *Material Properties Tab* (p. 263). Electromagnetic models are supported for multiphase simulations only if homogeneous.

For more information on electromagnetic theory, see *Electromagnetic Hydrodynamic Theory in the CFX-Solver Theory Guide*.

### 12.4.2.7. Component Details

If your fluid contains more than one component (that is, you are using a variable composition or reacting mixture, or HCF fuel, created in the **Material** details view), then **Component Details** will need to be set on the **Fluid Models** tab. If using the Algebraic Slip Multiphase model (ASM), the settings are specified in this view as well. For details, see *Algebraic Slip Model (ASM) in the CFX-Solver Modeling Guide*. When a non-ASM multiphase model is used, the **Component Details** form appears on the fluid-specific tabs.

- Select each component in turn and set the required option.

- Select the type of equation to solve for this component as Automatic, Transport Equation, Constraint, Algebraic Equation or Algebraic Slip. A description of the multiphase model is available in:
  
  - **Algebraic Slip Model (ASM) in the CFX-Solver Modeling Guide**
  - **Component Domain Settings in the CFX-Solver Modeling Guide**.
If you have chosen to solve a transport equation for the component, you can optionally enter a value for **Kinematic Diffusivity**. If you do not set **Kinematic Diffusivity**, then the **Bulk Viscosity** value is used.

If you have chosen to solve a transport equation or an Algebraic Slip component, you can optionally set a component dependent **Turbulent Schmidt Number** by enabling the **Turbulent Flux Closure** check box. If you do not select **Turbulent Flux Closure**, the value from **Turbulence > Turbulent Flux Closure for Heat Transfer** will be used.

The **Component Details** specify the model used to calculate the mass fraction of each component throughout the domain. For details, see Component Domain Settings in the *CFX-Solver Modeling Guide*.

**12.4.2.8. Additional Variable Details**

If you have defined any Additional Variables from the Additional Variable details view, then you can choose to include or exclude them here. An Additional Variable is included by selecting it from the **Additional Variables Details** list and then enabling the check box with the name of the Additional Variable. For details, see *Additional Variables* (p. 275).

If an Additional Variable is included, you must select how the Additional Variable level is calculated.

For single phase flows, the CFX-Solver can solve different variations of the conservation equations for the variable including **Transport Equation**, **Diffusive Transport Equation**, or **Poisson Equation**.

For multiphase flows, the CFX-Solver can solve different variations of the conservation equations for the variable including **Homogeneous Transport Equation**, **Homogeneous Diffusive Transport Equation**, **Homogeneous Poisson Equation**, or **Fluid Dependent**. When the **Fluid Dependent** option is selected, the Additional Variable model details can be set for each fluid on the **Fluid Specific Models** tab.

If a transport equation is being solved for an Additional Variable, the **Turbulent Flux Closure** may be optionally specified for turbulent flow. If you do not select **Turbulent Flux Closure** for the Additional Variable, the default is **Option is Eddy Diffusivity** and the **Turb. Schmidt Num.** is set to **0.9**.

Alternatively, you can define the variable value algebraically using CEL by selecting the **Algebraic Equation** option. Note that the **Algebraic Equation** option is not available for homogeneous Additional Variables. In addition, only specific Additional Variables are permitted to be homogeneous. For details, see *Additional Variables in the CFX-Solver Modeling Guide*.

**12.4.3. Polydispersed Fluid Tab**

The **Polydispersed Fluid** tab for a domain object contains settings that define the properties of polydispersed (MUSIG) fluids. It is accessible by selecting the **Polydispersed Fluid** option for **Fluid and Particle Definitions... > <fluid definition> > Morphology** on the **Basic Settings** tab.

For details, see *Polydispersed, Multiple Size Group (MUSIG) Model in the CFX-Solver Modeling Guide*.

**12.4.4. Fluid Specific Models Tab**

The **Fluid Specific Models** tab contains settings for fluid-specific properties. It appears for multiphase simulations and when particles are included in the domain.
Which options are available depends on the simulation set up, including the type and number of fluids used in the simulation (for example, single or multicomponent, single or multiphase, reacting or non-reacting), and whether Additional Variables have been created.

### 12.4.4.1. Fluid List Box

This list box is used to select a fluid (which can, in some cases, represent a solid). The rest of the tab contains settings for the selected fluid.

### 12.4.4.2. Kinetic Theory

The **Kinetic Theory** settings control the solid particle collision model. When you set **Kinetic Theory** to Kinetic Theory, you should set the granular temperature model and radial distribution function. CFX-Pre will also set the **Solid Pressure Model**, **Solid Bulk Viscosity**, and the **Solid Shear Viscosity** settings to **Kinetic Theory**.

<table>
<thead>
<tr>
<th>For details on these settings:</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Granular temperature model</td>
<td>Granular Temperature</td>
</tr>
<tr>
<td>Radial distribution function</td>
<td>Kinetic Theory Models for Solids Pressure</td>
</tr>
<tr>
<td>Solid pressure model</td>
<td>Solids Pressure</td>
</tr>
<tr>
<td>Solid bulk viscosity</td>
<td>Solids Bulk Viscosity</td>
</tr>
<tr>
<td>Solid shear viscosity</td>
<td>Solids Shear Viscosity</td>
</tr>
</tbody>
</table>

For modeling information about solid particle collision models, see [Solid Particle Collision Models in the CFX-Solver Modeling Guide](#).

For theoretical information about solid particle collision models, see [Solid Particle Collision Models in the CFX-Solver Theory Guide](#).

### 12.4.4.3. Heat Transfer

If you have set **Heat Transfer** to **Fluid Dependent** on the **Fluid Models** tab, the **Heat Transfer** options appear on the fluid-specific tabs for each Eulerian phase. The available options are similar to those in the single-phase case. For details, see [Heat Transfer](#) (p. 114). If the heat transfer occurs between two fluids, then additional information must be entered on the **Fluid Pairs** tab.

**Important**

If a compressible transient flow is undertaken with only one iteration per time step, then the solution can be incorrect if the **Heat Transfer** option is not set to **Total Energy**, or if heat transfer is not included in the simulation. This is due to the CFX-Solver not extrapolating the pressure at the start of the time step in these circumstances. This means that density is not extrapolated, and so the solver cannot calculate an accurate value for the time derivative of density on the first iteration. The workaround for this problem is to either run with at least two iterations per time step, or to use the **Total Energy** option for **Heat Transfer**.

The **Total Energy** heat transfer model is not available for multiphase simulations because high-speed compressible multiphase flow is not supported. For details, see [Heat Transfer in the CFX-Solver](#).
**Modeling Guide.** Additional information on heat transfer between phases is available in [Interphase Heat Transfer in the CFX-Solver Modeling Guide](https://www.ansys.com).  

### 12.4.4.3.1. Heat Transfer Option: Particle Temperature  
When heat transfer is modeled, heat transfer for the particles is enabled by setting this option to **Particle Temperature**. For details, see [Heat Transfer in the CFX-Solver Modeling Guide](https://www.ansys.com).  

### 12.4.4.4. Turbulence Model  
If you have set **Turbulence** to **Fluid Dependent** on the **Fluid Models** tab, the **Turbulence Model** option appears on the fluid-specific tabs for each Eulerian phase. The models available are similar to those available in single-phase simulations, with the following exceptions:

- For dispersed fluid, or dispersed/polydispersed solid phases, only the **Dispersed Phase Zero Equation**, **Laminar or Zero Equation** models are available. The Dispersed Phase Zero Equation model is the recommended choice. For details, see [Phase-Dependent Turbulence Models in the CFX-Solver Modeling Guide](https://www.ansys.com).  
- The LES and DES models are available for transient simulations for the continuous phase.  
For details, see [Turbulence](p. 115).  

### 12.4.4.5. Turbulent Wall Functions  
The turbulent wall functions are selected automatically, but apply only to the current fluid. For details, see [Wall Function](p. 116).   

### 12.4.4.6. Combustion Model  
If you have set the reaction or combustion model to **Fluid Dependent** on the **Fluid Models** tab, the **Reaction or Combustion Model** option can appear on the **Fluid Specific Models** tab for each Eulerian phase. You will only be able to pick a combustion model for fluids that are reacting mixtures. The models available are similar to those available in single-phase simulations. For details, see:

- [Phasic Combustion in the CFX-Solver Modeling Guide](https://www.ansys.com)  
- [Reaction or Combustion Model](p. 116).  

### 12.4.4.7. Erosion Model  
The erosion properties specified on this form are applied to all wall boundaries. The wall boundaries can also have erosion properties set to override the global settings specified here. For details, see [Erosion in the CFX-Solver Modeling Guide](https://www.ansys.com).  

### 12.4.4.8. Fluid Buoyancy Model  
This option is available for multiphase buoyant flows and/or buoyant flows that include particles (set on the **Basic Settings** tab). For details, see [Buoyancy in Multiphase Flow in the CFX-Solver Modeling Guide](https://www.ansys.com).  

### 12.4.4.9. Solid Pressure Model  
This option is available for **Dispersed Solid Eulerian** phases (phases with **Dispersed Solid** as the **Morphology** setting). For details, see [Solid Pressure Force Model in the CFX-Solver Modeling Guide](https://www.ansys.com).
12.4.4.10. Component Details

This is available for each Eulerian phase in the simulation that is a mixture of more than one component. It does not apply to fluids or solids using the particle tracking model. The options available are the same as those on the Fluid Models tab in a single-phase simulation. For details, see Component Details (p. 118).

If the component transfer occurs between two fluids, then additional information must be entered on the Fluid Pairs tab. This is only possible when more than one multicomponent fluid exists in a simulation. For details, see Interphase Species Mass Transfer in the CFX-Solver Modeling Guide.

12.4.4.11. Additional Variable Models

This is available for each Eulerian phase in the simulation when Additional Variables have been created as well as selected and set to Fluid Dependent on the Fluid Models tab. The options available are the same as those on the Fluid Models tab in a single-phase simulation. It does not apply to fluids or solids using the particle tracking model. For details, see Additional Variable Details (p. 119).

If the Additional Variable transfer occurs between two fluids, then additional information must be entered on the Fluid Pairs tab. This is possible only when more than one phase in a simulation includes Additional Variables. For details, see Additional Variables in Multiphase Flow in the CFX-Solver Modeling Guide.

12.4.5. Fluid Pair Models Tab

The Fluid Pairs tab appears for multiphase simulations and/or when particles are included in the domain. It is used to specify how the fluids interact in a multiphase simulation and how particles interact with the fluids when particles are included.

For details, see Interphase Radiation Transfer in the CFX-Solver Modeling Guide.

12.4.5.1. Fluid Pair List box

The top of the Fluid Pair Models tab shows a list of all the phase pairs in the simulation. A phase pair will exist when the morphology of the pair is Continuous Fluid | Continuous Fluid, Continuous Fluid | Dispersed Fluid or Continuous Fluid | Dispersed Solid. If particles have also been included, then a pair will exist for each Continuous Fluid | Particle pair. You should select each pair in turn and set the appropriate options.

The options available will vary considerably depending on your simulation. Many options are not available when the homogeneous multiphase model is used. This is because the interphase transfer rates are assumed to be very large for the homogeneous model and do not require further correlations to model them.

12.4.5.2. Particle Coupling

This only applies to Continuous Fluid | Particle pairs. For details, see Particle Fluid Pair Coupling Options in the CFX-Solver Modeling Guide.

12.4.5.3. Surface Tension Coefficient

You can optionally provide a Surface Tension Coefficient. This should be set in either of the following two cases:
- For a **Continuous Fluid | Dispersed Fluid** pair when you want to model the Drag Force using either the Grace or Ishii Zuber models. The flow must also be Buoyant to allow these models to be selected. For details, see Interphase Drag for the Particle Model in the CFX-Solver Modeling Guide.

- When you want to use the surface tension model. This model is only available when Standard has been selected as the **Free Surface Model** on the **Fluid Models** tab.

You can set a **Surface Tension Coefficient** in other cases, but it will not be used in your simulation. It does not apply to **Continuous Fluid | Particle** pairs.

For details, see Surface Tension in the CFX-Solver Modeling Guide.

### 12.4.5.4. Surface Tension Force Model

You can model the surface tension force that exists at a free surface interface. This model applies to all morphology combinations for Eulerian | Eulerian pairs. You must also specify a **Surface Tension Coefficient** and select the **Primary Fluid**. For liquid-gas free surface flows, the primary fluid should be the liquid phase.

For details, see Surface Tension in the CFX-Solver Modeling Guide.

### 12.4.5.5. Interphase Transfer Model

This can be selected as one of the following:

#### 12.4.5.5.1. Particle Model

This model assumes a continuous phase fluid containing particles of a dispersed phase fluid or solid. It is available when the morphology of the pair is **Continuous Fluid | Dispersed Fluid** or **Continuous Fluid | Dispersed Solid**. For details, see The Particle Model in the CFX-Solver Modeling Guide.

#### 12.4.5.5.2. Mixture Model

This model is only available when the morphology of the pair is **Continuous Fluid | Continuous Fluid**. An **Interface Length Scale** is required. It is usually used as a first approximation or combined with a custom interface transfer model. For details, see The Mixture Model in the CFX-Solver Modeling Guide.

#### 12.4.5.5.3. Free Surface Model

This model is available when the free surface model is selected. For details, see The Free Surface Model in the CFX-Solver Modeling Guide. For free surface flow, the particle model is also available if the phase pair is **Continuous Fluid | Dispersed Fluid**, and the mixture model is also available if the phase pair is **Continuous Fluid | Continuous Fluid**.

#### 12.4.5.5.4. None

For homogeneous multiphase flow in which there is no interphase transfer of any type, the interphase transfer model is not relevant and **None** may be selected.

### 12.4.5.6. Momentum Transfer

There are a variety of momentum transfer that can be modeled, including the drag force and non-drag forces, which include lift force, virtual mass force, wall lubrication force and turbulent dispersion force.
12.4.5.6.1. Drag Force

This option applies to all morphology pair combinations including Continuous Fluid | Particle pairs, but does not apply when the Homogeneous multiphase model is active.

There are many drag force models available in CFX, but most are only applicable to certain morphology combinations. For Continuous Fluid | Particle pairs, the available options are:

- The Schiller-Naumann drag model.
  For details, see Interphase Drag in the CFX-Solver Modeling Guide.
- The Drag Coefficient.
  For details, see Drag Force for Particles in the CFX-Solver Modeling Guide.
- The Ishii Zuber drag model.
- The Grace drag model.
  For details see, Sparsely Distributed Fluid Particles: Grace Drag Model in the CFX-Solver Modeling Guide and Densely Distributed Fluid Particles: Grace Drag Model in the CFX-Solver Modeling Guide.

12.4.5.6.2. Particle User Source

The Particle User Source check box is available when any User Routines of type Particle User Routines exist. For details, see:

- Particle User Routines (p. 295)
- Particle User Sources in the CFX-Solver Modeling Guide.

12.4.5.6.3. Lift Force

The lift force is only applicable to the Particle Model, which is active for Continuous Fluid | Dispersed (Fluid, Solid) and Continuous Fluid | Polydispersed Fluid. For details, see Lift Force in the CFX-Solver Modeling Guide.

12.4.5.6.4. Virtual Mass Force

This option applies to Continuous Fluid | Dispersed Fluid pairs using the Particle Model, and to Continuous Fluid | Particle pairs, but does not apply when the Homogeneous multiphase model is active. For details, see Virtual Mass Force in the CFX-Solver Modeling Guide.

12.4.5.6.5. Wall Lubrication Force

This option is only applicable to the Particle Model. For details, see Wall Lubrication Force in the CFX-Solver Modeling Guide.

12.4.5.6.6. Turbulent Dispersion Force

This applies to Continuous Fluid | Dispersed Fluid, Continuous Fluid | Polydispersed Fluid and Continuous Fluid | Dispersed Solid pair combinations for Eulerian | Eulerian pairs, but does not apply
when the Homogeneous multiphase model is active. In these cases, the Lopez de Bertodano model is used. For details, see Interphase Turbulent Dispersion Force in the CFX-Solver Modeling Guide.

When particle tracking is used, the turbulent dispersion force also applies to Continuous Fluid | Particle pairs. In these cases, the Particle Dispersion models is used. For details, see Turbulent Dispersion Force in the CFX-Solver Modeling Guide.

**12.4.5.6.7. Pressure Gradient Force**

This option is only available for Particle Tracking simulations. For details, see Pressure Gradient Force in the CFX-Solver Modeling Guide.

**12.4.5.7. Turbulence Transfer**

This model is available for Continuous Fluid | Dispersed Fluid, Continuous Fluid | Polydispersed Fluid and Continuous Fluid | Dispersed Solid pair combinations for Eulerian | Eulerian pairs, but does not apply when the Homogeneous multiphase model is active and is not available for Continuous Fluid | Particle pairs. For details, see Turbulence Enhancement in the CFX-Solver Modeling Guide.

**12.4.5.8. Heat Transfer**

This applies to all morphology combinations for Eulerian | Eulerian and Continuous Fluid | Particle pairs, but does not apply when the Homogeneous multiphase model is active.


**12.4.5.9. Mass Transfer**

Mass transfer can occur in homogeneous and inhomogeneous Eulerian multiphase flows. For such flows, you can set the Mass Transfer option to one of the following:

- None
- Specified Mass Transfer
  
  This is an advanced option that allows you to define your own mass transfer sources. For details, see User Specified Mass Transfer in the CFX-Solver Modeling Guide.

- Phase Change
  
  This models mass transfer due to phase change, such as boiling, condensation, melting or solidification. For details, see Thermal Phase Change Model in the CFX-Solver Modeling Guide.

- Cavitation
  
  Vapor formation in low pressure regions of a liquid flow (cavitation) can be modeled using the Rayleigh Plesset model or, for advanced users, a user-defined model. For details, see Cavitation Model in the CFX-Solver Modeling Guide.

**12.4.5.10. Additional Variable Pairs**

Additional Variable Pairs details describe the way in which Additional Variables interact between phases. It applies to all morphology combinations for Eulerian | Eulerian pairs, but does not apply when the Homogeneous multiphase model is active.
Only Additional Variable pairs where both are solved using the Transport Equation and have a Kinematic Diffusivity value set can be transferred between phases. These options are set on the fluid-specific tabs for each phase.

For example, consider two phases, Phase A and Phase B, and two Additional Variables, AV1 and AV2.

- AV1 uses a Transport Equation with diffusion in Phase A and is unused in Phase B.
- AV2 uses an Algebraic Equation in Phase A and uses a Transport Equation with diffusion in Phase B.

Additional Variable interphase transfer can only occur between Phase A / AV1 and Phase B / AV2.

For details, see Additional Variables in Multiphase Flow in the CFX-Solver Modeling Guide.

### 12.4.5.11. Component Pairs

#### 12.4.5.11.1. Eulerian | Eulerian Pairs

You can model transfer of components between phases for Eulerian | Eulerian pairs, when both fluids are multicomponent mixtures of any type (except fixed composition mixtures). Mixtures are created in the Material details view. For example, to create a Variable Composition Mixture, see Material Details View: Variable Composition Mixture (p. 267). Component (or species) transfer enables you to model processes such as evaporation, absorption and dissolution.

To specify the component transfer model, you should select the component pair from the list on the Fluid Pairs tab and then select the associated toggle. The first component of the component pair corresponds to the first fluid in the fluid pairs list.

Option can be set to Two Resistance or Ranz Marshall. For details, see:

- Two Resistance Model in the CFX-Solver Modeling Guide

The choice of interfacial equilibrium model depends on the process that you are modeling. For details, see Interfacial Equilibrium Models in the CFX-Solver Modeling Guide.

The Fluid1 and Fluid2 Species Mass Transfer options are used to choose a correlation to model the mass transfer coefficient on each side on the interface. For details, see Species Mass Transfer Coefficients in the CFX-Solver Modeling Guide.

#### 12.4.5.11.2. Continuous | Particle Pairs

Selecting the toggle enables mass transfer between the two phases.

The options for mass transfer are:

- Liquid Evaporation Model. For details, see Liquid Evaporation Model in the CFX-Solver Modeling Guide. For oil evaporation, the Light Oil check box should be selected. For details, see Liquid Evaporation Model: Oil Evaporation/Combustion in the CFX-Solver Modeling Guide.
- None

For details on these options, see:
Latent Heat in the CFX-Solver Modeling Guide

Particle User Source in the CFX-Solver Modeling Guide.

The drop-down list will contain any User Particle Routines you have created. For details, see Particle User Routines (p. 295).

Mass transfer between a species in a particle phase and a species in the continuous phase is possible. For example, consider liquid water from a particle evaporating into gaseous H20 in a continuous phase mixture. The particle can be a pure substance or variable composition mixture.

12.4.5.12. Particle Breakup

The Particle Breakup models allow you to simulate the breakup of droplets due to external aerodynamic forces. The droplet breakup models are set on a per fluid-pair basis. By default, the Use Liu Dynamic Drag Modification option is activated for the TAB, ETAB and CAB breakup models, whereas the Use Schmehl Dynamic Drag Law option is activated for the Schmehl breakup model. See Particle Breakup Model in the CFX-Solver Modeling Guide for details on the available particle breakup models.

12.4.5.13. Particle Collision

The particle collision model enables you to simulate dense gas-solid flows with high mass-loading while the particle volume fraction is still low. Select either Sommerfeld Collision Model or User Defined and specify values for the particle collision parameters outlined below:

**Sommerfeld Collision Model**

- Coefficient of Restitution: Enter a numerical quantity or CEL based expression to specify the value of coefficient of restitution for inter-particle collisions. A value of ‘1.0’ means a fully elastic collision, while a value of ‘0.0’ would result in an inelastic collision.

- Static Friction Coefficient and Kinetic Friction Coefficient: Enter a numerical quantity or CEL based expression to specify values of coefficients of friction for inter-particle collisions.

  See Implementation Theory in the CFX-Solver Theory Guide for more information on setting up Coefficient of Restitution, Static Friction Coefficient, and Kinetic Friction Coefficient.

**User Defined**

This option is available only if you have created a particle user routine to set up the model. Specify the name of Particle User Routine and select input arguments and type of particle variables returned to the user routine from the Arguments and Variable List drop-down list, respectively. See Particle User Routines in the CFX-Pre User’s Guide for information on setting up a particle user routine.

For additional information, see Particle Collision Model in the CFX-Solver Modeling Guide and the following topics available under Particle Collision Model in the CFX-Solver Theory Guide:

- Introduction to the Particle Collision Model
- Implementation of a Stochastic Particle-Particle Collision Model in ANSYS CFX (includes the discussion on the implementation theory, particle variables, and virtual collision partner)
- Particle Collision Coefficients Used for Particle-Particle Collision Model
- Range of Applicability of Particle-Particle Collision Model
- Limitations of Particle-Particle Collision Model in ANSYS CFX
12.4.6. Solid Models Tab

The **Solid Models** tab sets the models that apply to solid domains and to the solid material in a porous domain. The models chosen can vary between each domain, but if radiation is modeled, then all fluid domains must also model radiation. For details, see *Using Multiple Domains* (p. 106).

### 12.4.6.1. Heat Transfer

The **Thermal Energy** model and **Isothermal** model are available for the solid domain. If you do not want to model heat transfer for the domain, then set **Heat Transfer > Option** to *None*.

For details, see *Conjugate Heat Transfer in the CFX-Solver Modeling Guide*.

### 12.4.6.2. Thermal Radiation Model

You can use only the **Monte Carlo** option to model radiation in a solid domain. The options available are the same as for the **Monte Carlo** model in a fluid domain. For details, see *Thermal Radiation Model* (p. 117).

You cannot model radiation in a porous domain.

### 12.4.6.3. Electromagnetic Model

The **Electromagnetic Model** enables you to define:

**Electric Field Model**

- **Option** can be set to *None*, **Electric Potential**, or **User Defined**.
  
  For a **User Defined** setting, you have to specify the electric field strength for the X, Y, and Z directions.

**Magnetic Field Model**

- **Option** can be set to *None*, **Magnetic Vector Potential**, or **User Defined**.

  For the **Magnetic Vector Potential** option, you can specify **External Magnetic Field** settings using Cartesian or cylindrical components. Using the **User Defined** option will enable you to specify the induced magnetic field model in the X, Y, and Z directions.

If a user-defined model is selected, you must make sure that the electromagnetic properties have been set in the **Material** details view. For details, see *Material Properties Tab* (p. 263). Electromagnetic models are supported for multiphase simulations only if homogeneous.

For more information on electromagnetic theory, see *Electromagnetic Hydrodynamic Theory in the CFX-Solver Theory Guide*.

### 12.4.6.4. Additional Variables Models

See *Additional Variables*.

### 12.4.6.5. Solid Motion

You can model the motion of a solid that moves relative to its reference frame by selecting the **Solid Motion** option and specifying a velocity.
Examples of such motions include:

- A continuous sheet of material moving along a conveyor belt
- A material being continuously extruded
- An axisymmetric solid that rotates about its symmetry axis

You can specify the velocity using one of the following methods:

- Cartesian velocity components
  You must specify values for \( U \), \( V \), and \( W \).
- Cylindrical velocity components
  You must specify values for \( \text{Axial Component} \), \( \text{Radial Component} \), and \( \text{Theta Component} \). You must also specify an \text{Axis Definition}.
- Rotating
  Specify an \text{Angular Velocity} and an \text{Axis Definition}.

The velocity that you specify is interpreted as being relative to the domain motion which is, in turn, relative to the coordinate frame; both of these are specified on the Basic Settings tab for the domain.

The solid motion model does not involve changing the mesh. Instead, motion of the solid is simulated by imposing a velocity field in the solid domain. The velocity field causes the advection of energy and Additional Variables as applicable.

On interfaces to other domains (fluid-solid or solid-solid interfaces) the solid must move only tangentially to its surface. On an external boundary, if the solid has a velocity component normal to the surface, then consider activating the advection term(s) on the boundary condition for that surface, by visiting the Boundary Details tab and selecting Solid Motion > Boundary Advection. For details on setting up boundary advection on a wall, see Solid Motion: Wall (p. 155).

**Note**

- Most solid motion cases will involve setting either non-stationary domain motion (on the Basic Settings tab) or activating the Solid Motion setting (on the Solid Models tab) but not both.
- If you have a solid with Solid Motion activated that meets a fluid domain at a fluid-solid interface, then you must explicitly set the wall boundary condition applied to the fluid side of the interface to have a wall velocity corresponding to the solid motion, as required.

### 12.4.7. Porosity Settings Tab

The Porosity Settings tab is where the general description of a porous domain is specified for the simulation.

#### 12.4.7.1. Area Porosity

Area Porosity represents the fraction of physical area that is available for the flow to go through. The default setting is Isotropic.
12.4.7.2. Volume Porosity

**Volume Porosity** is the local ratio of the volume of fluid to the total physical volume.

12.4.7.3. Loss Models

The porous loss options are:

- **Isotropic Loss**
  
  For the isotropic loss model, the loss may be specified using either one of the following methods:
  - Permeability And Loss Coefficient
  - Linear And Quadratic Resistance Coefficients

- **Directional Loss**
  
  Specify the streamwise direction via Cartesian or cylindrical components (in the coordinate frame specified on the **Basic Settings** tab).

  The loss in the streamwise direction can be specified using one of the following options:
  - Permeability And Loss Coefficient
  - Linear And Quadratic Resistance Coefficients
  - No Loss

  The loss in the transverse directions can be specified using one of the following options:
  - Streamwise Coefficient Multiplier
  - Permeability and Loss Coefficient
  - Linear and Quadratic Resistance Coefficients
  - No Loss

- **None**

When specifying the loss coefficients, it is important to set the **Loss Velocity Type** properly. For details, see Porous Momentum Loss Models in the **CFX-Solver Theory Guide**.

12.4.7.4. Contact Area Model

This setting is available only when the porous domain has a solid phase.

When there is more than one fluid in a porous domain that has a solid phase, specify the contact area model to indicate how the contact area between a given fluid and the solid is to be calculated.

The options are:

- **Use Volume Fraction**
  
  This option makes use of the volume fraction of each fluid to calculate the contact area between that fluid and the solid.

- **Fluid Dependent**
  
  This option enables the direct specification of the contact area fraction for each fluid. The area fractions must sum to unity.
12.4.7.5. Fluid Solid Area Density

This setting is available only when the porous domain has a solid phase.

Specify the fluid-solid area density, which is the contact area per unit volume, where the contact area is the surface area of the solid in contact with the fluid(s).

12.4.7.6. Fluid Solid Heat Transfer

This setting is available only when the porous domain has a solid phase.

Specify the overall heat transfer coefficient for heat transfer between the fluid(s) and the solid. This is analogous to the heat transfer coefficient between fluids in an inhomogeneous multiphase case, as described in Inhomogeneous Interphase Heat Transfer Models.

12.4.7.7. Additional Variable Pair Details

This setting is available only when the porous domain has a solid phase.

Specify pairs of the same Additional Variable to enable the Additional Variable transfer between the solid and the fluid(s).

The options are:

- Additional Variable Transfer Coefficient
  - This option applies a bulk value of the Additional Variable transfer coefficient between the fluid(s) and the solid.
- Fluid Dependent
  - This option enables the direct specification of the Additional Variable transfer coefficient for each fluid.

The Additional Variable transfer coefficient is analogous to the transfer coefficient between fluids in an inhomogeneous multiphase case. For details, see Additional Variable Interphase Transfer Models in the CFX-Solver Modeling Guide and Additional Variables in Multiphase Flow in the CFX-Solver Theory Guide.

12.4.8. Particle Injection Regions Tab

Injection regions are used to define locators anywhere within a domain, and can be set up as spheres, cones, or using a custom Fortran subroutine. For details, see Particle Injection Regions in the CFX-Solver Modeling Guide.

12.4.8.1. Particle Injection Regions List Box

This list box is used to select Particle Injection Regions for editing or deletion. Particle Injection Regions can be created or deleted with the icons that appear beside the list box.

12.4.8.2. Coordinate Frame

In some cases it may be useful to specify injection quantities using coordinates from a coordinate frame other than the global default frame (Coord 0). To do this, choose a local coordinate frame from the drop-down list. You can then set the injection center and the injection direction relative to the selected
coordinate frame. In a typical application, it makes sense to use a coordinate frame that has a principal axis aligned with the general spray direction.

**Note**

The coordinate frame of a particle injection region is independent of the coordinate frame of the domain.

**Note**

In the case of user defined injection, the particle position and the injection velocity – if returned from the user routine – refer to the global coordinate frame Coord 0 rather than to the one specified under Coordinate Frame.

### 12.4.8.3. Fluid: List Box

This list box is used to select a particle material in order to apply it to the injection region and define its properties for the injection region.

### 12.4.8.4. [fluid name] Check Box

This check box determines whether or not the particle is to be injected over the selected injection region.

For multicomponent particles, specify the mass fraction of each. Other quantities are optional and are the same as found on the Fluid Values tab. For details, see Fluid Values for Inlets and Openings (p. 158).

### 12.4.8.4.1. Injection Method

The following table outlines various settings available on Particle Injection Regions tab. The settings are marked as required or optional based on the type of injection method chosen.

<table>
<thead>
<tr>
<th>Settings for Injection Method</th>
<th>Injection Method</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cone</td>
</tr>
<tr>
<td>Injection Center</td>
<td>Required</td>
</tr>
<tr>
<td>Injection Velocity Magnitude a</td>
<td>Required</td>
</tr>
<tr>
<td>Radius of Injection Sphere a</td>
<td>Required</td>
</tr>
<tr>
<td>Number of Positions a</td>
<td>Required</td>
</tr>
<tr>
<td>Particle Diameter Distribution</td>
<td>Optional</td>
</tr>
<tr>
<td>Particle Mass Flow Rate</td>
<td>Optional</td>
</tr>
<tr>
<td>Cone Definition</td>
<td>Required</td>
</tr>
<tr>
<td>Cone Definition</td>
<td>Required</td>
</tr>
<tr>
<td>For details, see Settings for Cone Definition (p. 133).</td>
<td></td>
</tr>
<tr>
<td>Injection Direction</td>
<td>Required</td>
</tr>
<tr>
<td>Injection Velocity</td>
<td>Required</td>
</tr>
</tbody>
</table>

Release 14.0 - © SAS IP Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
### Settings for Injection Method

<table>
<thead>
<tr>
<th>Injection Method</th>
<th>Cone</th>
<th>Cone with Primary Breakup</th>
<th>Sphere</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cone</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cone Angle</strong></td>
<td>a</td>
<td>Required</td>
<td></td>
</tr>
<tr>
<td><strong>Dispersion Angle</strong></td>
<td>a</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td><strong>Radius of Injection Plane</strong></td>
<td>a</td>
<td>Required</td>
<td>Re-quired</td>
</tr>
<tr>
<td><strong>Inner Radius Of Plane</strong></td>
<td>a</td>
<td>Required</td>
<td></td>
</tr>
<tr>
<td><strong>Outer Radius Of Plane</strong></td>
<td>a</td>
<td>Required</td>
<td></td>
</tr>
</tbody>
</table>

### Cone in the CFX-Solver Modeling Guide

- **Point Cone**
- **Hollow Cone**
- **Ring Cone**
- **Full Cone**

### Settings for Cone Definition

- **Cone Angle**
- **Dispersion Angle**
- **Radius of Injection Plane**
- **Inner Radius Of Plane**
- **Outer Radius Of Plane**

### Settings for Injection Velocity

#### Velocity Magnitude

Specify the component of velocity normal to the 2D injection region. Note that the normal direction is specified by the **Injection Direction** settings.

Specify the cone angle, measured as the angle between the axis of the cone (which, for the Velocity Magnitude option, is normal to the 2D injection region) and one side of the cone.

#### Cartesian Components
Specify the particle velocity components in Cartesian coordinates. These coordinates are in the coordinate frame specified for the particle injection region. The velocity components can be expressions.

- **Cylindrical Components**

Specify the particle velocity components in cylindrical coordinates. These coordinates are in the coordinate frame specified for the particle injection region. The velocity components can be expressions.

You can put swirl into the flow of injected particles by specifying a non-zero theta (circumferential) component of velocity.

- **Zero Slip Velocity**

Particles are injected at the local velocity of the continuous phase.

### 12.4.8.4.1.3. Settings for Particle Primary Breakup

<table>
<thead>
<tr>
<th>Settings</th>
<th>Blob Method</th>
<th>Enhanced Blob Method</th>
<th>Lisa Model</th>
<th>Turbulence Induced Atomization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cone Angle a, b</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
<td></td>
</tr>
<tr>
<td>Coefficient of Contraction a</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Injection Total Pressure a</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Injection Pressure Difference a</td>
<td></td>
<td></td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Pressure Probe Normal Distance a</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Density Probe Normal Distance</td>
<td></td>
<td></td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Length/Diameter Ratio</td>
<td></td>
<td></td>
<td></td>
<td>Required</td>
</tr>
<tr>
<td>Particle Material Vapor Pressure</td>
<td></td>
<td></td>
<td>Required</td>
<td></td>
</tr>
<tr>
<td>Critical Weber Number</td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Short Wave Ligament Factor</td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Long Wave Ligament Factor</td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Droplet Diameter Size Factor</td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Swirl Definition</td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Form Loss Coefficient</td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>C1 Constant</td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>C2 Constant</td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td>Blob Method</td>
<td>Enhanced Blob Method</td>
<td>Lisa Model</td>
<td>Turbulence Induced Atomization</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>----------------------</td>
<td>------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>C3 Constant</td>
<td></td>
<td></td>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>C4 Constant</td>
<td></td>
<td></td>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>CA1 Constant</td>
<td></td>
<td></td>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>K1 Constant</td>
<td></td>
<td></td>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>Average Turbulent Energy Dissipation Factor</td>
<td></td>
<td></td>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>Turbulent Length Scale Power Factor</td>
<td></td>
<td></td>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>Nozzle Discharge Coefficient</td>
<td></td>
<td></td>
<td></td>
<td>Required</td>
</tr>
</tbody>
</table>

\(^a\)Enter a numerical quantity or CEL expression for the indicated parameter.

\(^b\)Cone Angle: Specify a fixed cone angle or select Reitz and Bracco option to set a correlation to compute the injection angle based on the nozzle geometry.

For details, see Cone with Primary Breakup in the CFX-Solver Modeling Guide.

### 12.4.9. Initialization Tab

Initialization can be set on a domain or global basis; the available options are the same. For details, see Initialization (p. 167).

The Initialization tab for the domain sets domain initial conditions. These will override any settings made in the Global Initialization details view. Any domain for which initialization is not set will use the global initial conditions.

### 12.4.10. Solver Control Tab

For immersed solid domains, the Solver Control tab contains the Immersed Solid Control settings. For details, see Immersed Solid Control (p. 202).
Chapter 13: Domain Interfaces

Domain interfaces have multiple purposes:

- Connecting domains or assemblies
  
  Domain interfaces are required to connect multiple unmatched meshes within a domain (for example, when there is a hexahedral mesh volume and a tetrahedral mesh volume within a single domain) and to connect separate domains.

- Modeling changes in reference frame between domains
  
  This occurs when you have a stationary and a rotating domain or domains rotating at different rates.

- Creating periodic interfaces between regions
  
  This occurs when you are reducing the size of the computational domain by assuming periodicity in the simulation.

- Creating thin surfaces
  
  Thin surfaces enable you to model physics such as heat transfer across a thin material or gap without needing to explicitly mesh the surface. For example, thin surfaces can be used to model contact resistance at a solid-solid interface, a thin film on a fluid-solid interface, or a thin baffle at a fluid-fluid interface.

Interface boundaries are created automatically for each domain interface. For details, see Interface Boundary Conditions (p. 163).

Additional information about domain interfaces is provided in Overview of Domain Interfaces in the CFX-Solver Modeling Guide.

Note

If you are running a simulation with ANSYS Multi-field coupling to the ANSYS solver, you will need to create fluid-solid interfaces with the fluid side in CFX and the solid side in ANSYS. Such an interface is actually an external boundary so far as CFX-Solver is concerned, as it lies on the boundary of the CFX domain(s). You should create a Boundary Condition, not a Domain Interface, when setting up such an interface.

13.1. Creating and Editing a Domain Interface

To create a domain interface:

1. Select Insert > Domain Interface from the main menu or by clicking Domain Interface on the main toolbar.
2. Enter a new name, if required, using the rules described in *Valid Syntax for Named Objects* (p. 55) and click **Apply**.

To edit an existing domain interface:
1. Right-click the domain interface's name in the **Outline** view.
2. Select **Edit**. The details view for the domain interface appears.

   For more information on the edit command, see *Outline Tree View* (p. 5).

The details view describes the characteristics of a domain interface on a series of tabs:

- *Domain Interface: Basic Settings Tab* (p. 138)
- *Domain Interface: Additional Interface Models Tab* (p. 140).

### 13.1.1. Domain Interface: Basic Settings Tab

The **Basic Settings** tab is where you define the domain interface. It is accessible by clicking **Domain Interface**, or by selecting **Insert > Domain Interface**.

#### 13.1.1.1. Interface Type

- **Fluid Fluid**
  
  Connects two fluid domains or makes a periodic connection between two regions in a fluid domain.

- **Fluid Porous**
  
  Connects a fluid domain to a porous domain.

- **Fluid Solid**
  
  Connects a fluid domain to a solid domain.

- **Porous Porous**
  
  Connects two porous domains or makes a periodic connection between two regions in a porous domain.

- **Solid Porous**
  
  Connects a solid domain to a porous domain.

- **Solid Solid**
  
  Connects two solid domains or makes a periodic connection between two regions in a solid domain.

The interface type you select controls the domains that are available for **Interface Side 1/2**.

#### 13.1.1.2. Interface Side 1/2

#### 13.1.1.2.1. Domain (Filter)

The domain filter is used to filter out 2D regions that are of no interest. The drop-down list contains commonly used regions (all composite names and primitive names that are not referenced by any
composites) and the extended list (displayed by clicking the Ellipsis icon) contains all regions in a domain.

13.1.1.2.2. Region List

Region List 1 and Region List 2 allow selection of regions that form each side of the interface.

13.1.1.3. Interface Models

The interface model options (Translational Periodicity, Rotational Periodicity, and General Connection) each require that you specify a mesh connection method as well as specialized settings for some model options.

13.1.1.3.1. Interface Model Option: Translational Periodicity

In the case of Translational Periodicity, the two sides of the interface must be parallel to each other such that a single translation transformation can be used to map Region List 1 to Region List 2. The Translational Periodicity model requires no specialized settings.

For details on the Translational Periodicity model, see Translational Periodicity in the CFX-Solver Modeling Guide.

13.1.1.3.2. Interface Model Option: Rotational Periodicity

In the case of Rotational Periodicity, the two sides of the periodic interface can be mapped by a single rotational transformation about an axis. This is the most common case of periodicity and is used, for example, in the analysis of a single blade passage in a rotating machine.

If a domain interface involves rotational periodicity, the axis for the rotational transformation must also be specified in the Axis Definition area.

13.1.1.3.3. Interface Model Option: General Connection

In the case of a General Connection, more options apply. The settings are described below; for information about the General Connection model, see General Connection in the CFX-Solver Modeling Guide.

13.1.1.3.3.1. Frame Change/Mixing Model

13.1.1.3.3.1.1. Option

• None
• Frozen Rotor
• Stage
• Transient Rotor-Stator

For details, see Frame Change/Mixing Model in the CFX-Solver Modeling Guide.

13.1.1.3.3.1.2. Frozen Rotor: Rotational Offset Check Box

This check box determines whether or not to apply a rotational offset for one side of the interface. For details, see Rotational Offset in the CFX-Solver Modeling Guide.

When set, enter a Rotational Offset for one side of the interface.
13.1.1.3.1.3. Stage: Pressure Profile Decay Check Box

This option affects solution stability. For details, see Pressure Profile Decay in the CFX-Solver Modeling Guide.

When set, enter a Pressure Profile Decay numerical quantity or CEL expression that specifies the rate of decay of the pressure profile.

13.1.1.3.1.4. Stage: Constant Total Pressure Check Box

For details, see Downstream Velocity Constraint in the CFX-Solver Modeling Guide.

13.1.1.3.2. Pitch Change Options

The Pitch Change options are:

- **None**
  
  A pitch change option of None cannot be used for a stage interface.

- **Automatic**
  
  (applies only when Interface Models: Frame Change/Mixing Model: Option is not set to None)

- **Value**
  
  (applies only when Interface Models: Frame Change/Mixing Model: Option is not set to None)

- **Specified Pitch Angles**
  
  (applies only when Interface Models: Frame Change/Mixing Model: Option is not set to None)

For details, see Pitch Change in the CFX-Solver Modeling Guide.

13.1.1.3.2.1. Pitch Change: Value: Pitch Ratio

Enter the pitch ratio. For details, see Value in the CFX-Solver Modeling Guide.

13.1.1.3.2.2. Pitch Change: Specified Pitch Angles: Pitch Angle Side 1/2

Enter pitch angle for each side of the interface. For details, see Specified Pitch Angles in the CFX-Solver Modeling Guide.

13.1.2. Domain Interface: Additional Interface Models Tab

The Additional Interface Models tab is where you set the Mass And Momentum, Heat Transfer, Electric Field and Additional Variable options.

13.1.2.1. Mass And Momentum

Determines whether or not mass and momentum models are applied between the sides of the interface. For details, see Mass and Momentum Models in the CFX-Solver Modeling Guide.

The mass and momentum options are:

- **Conservative Interface Flux**
The **Conservative Interface Flux** Mass And Momentum option enables you to define the physics across a thin surface.

- **No Slip Wall**
- **Free Slip Wall**
- **Side Dependent**

### 13.1.2.1.1. Conservative Interface Flux: Interface Models

#### 13.1.2.1.1.1. None

No models are provided for any additional mass or momentum between side 1 and side 2 of the interface.

#### 13.1.2.1.1.2. Mass Flow Rate

Enter a numerical quantity or CEL expression that specifies the value of the mass flow rate from side 1 to side 2 of the interface.

**Note**

The Pressure Update Multiplier provides user control to tune convergence behavior. For details, see *Pressure Update Multiplier* (p. 141).

#### 13.1.2.1.1.2.1. Pressure Update Multiplier

Enter a numerical quantity or CEL expression that specifies the pressure update multiplier.

When imposing a mass flow rate at a domain interface, the CFX-Solver updates the pressure change to drive the mass flow rate toward the specified value. The update is based on an internally-estimated coefficient, which may not be optimal.

The Pressure Update Multiplier provides user control to tune convergence behavior. The default value is 0.25. If convergence is slow (as may occur for low Reynolds number flows), consider increasing the value. If convergence is unstable, consider decreasing the value. Note that values above 1 are permissible.

#### 13.1.2.1.1.3. Pressure Change

Enter a numerical quantity or CEL expression that specifies the pressure change across the interface (from side 1 to side 2). If there is a pressure drop, the specified value should be negative.

#### 13.1.2.1.2. No Slip Wall

For a description of the options that influence flow on a wall boundary, see *Mass and Momentum in the CFX-Solver Modeling Guide*.

#### 13.1.2.1.2.1. No Slip Wall: Wall Velocity

When set, this option enables you to specify the following:

- **Wall Velocity Option: Cartesian Components** (Wall U, Wall V, Wall W)
- **Wall Velocity Option: Cylindrical Components** (Axial Component, Radial Component, Theta Component), Axis Definition: Option: Coordinate Axis and Rotational Axis
• Wall Velocity Option: Rotating Wall (Angular Velocity), Axis Definition: Option: Coordinate Axis and Rotational Axis

13.1.2.1.3. Free Slip Wall

Free Slip Wall has no suboptions.

13.1.2.1.4. Side Dependent

Side Dependent has no suboptions.

13.1.2.2. Heat Transfer

Determines whether or not heat transfer models are applied between the sides of the interface.

The options are:

• Conservative Interface Flux

  This option enables you to define the Thermal Contact Resistance or Thin Material, which are two ways of defining the same characteristics. That is, if you do not know the contact resistance, you can define the thin material and its thickness and have the solver derive the resistance.

• Side Dependent

13.1.2.2.1. Conservative Interface Flux: Interface Model

13.1.2.2.1.1. None

No models are provided for any additional heat transfer between side 1 and side 2 of the interface.

13.1.2.2.1.2. Interface Model Option: Thermal Contact Resistance

Enter a numerical quantity or CEL expression that specifies the value of the thermal contact resistance from side 1 to side 2 of the interface.

13.1.2.2.1.3. Interface Model Option: Thin Material

Select a material and enter a numerical quantity or CEL expression that specifies the value of the thickness of the material spanning from side 1 to side 2 of the interface.

13.1.2.2.2. Side Dependent

Side Dependent has no suboptions.

13.1.2.3. Electric Field

Determines whether or not electric field models are applied between the sides of the interface.

The options are:

• Conservative Interface Flux

• Side Dependent
13.1.2.3.1. Conservative Interface Flux: Interface Model

13.1.2.3.1.1. None

No models are provided for the electric field between side 1 and side 2 of the interface.

13.1.2.3.1.2. Interface Model Option: Electric Field Contact Resistance

Enter a numerical quantity or CEL expression that specifies the value of the electric field contact resistance from side 1 to side 2 of the interface.

13.1.2.3.2. Side Dependent

Side Dependent has no suboptions.

13.1.2.4. Additional Variable

Determines whether or not additional variable models are applied between the sides of the interface. The options are:

- Conservative Interface Flux
- Side Dependent

13.1.2.4.1. Conservative Interface Flux: Interface Model

13.1.2.4.1.1. None

No models are provided for the additional variable between side 1 and side 2 of the interface.

13.1.2.4.1.2. Interface Model Option: Additional Variable Contact Resistance

Enter a numerical quantity or CEL expression that specifies the value of the additional variable contact resistance from side 1 to side 2 of the interface.

13.1.2.4.2. Side Dependent

Side Dependent has no suboptions.

13.1.2.5. Conditional Connection Control

Conditional Connection Control is an optional group of settings, activated by a check box. These settings enable you to use an expression to control whether an interface is open (connected) or closed (not connected; a wall boundary is applied).

When the Conditional Connection Control check box is active, you can select from one of these options:

- Specified Open State
  
  Provide a CEL expression. The connection is open when the expression evaluates to true, and closed when the expression evaluates to false.

- Irreversible State Change
  
  Provide a CEL expression and an initial state. The latter is “Open” or “Closed.”
The state switches once the expression evaluates to true but then remains in that opposite state (that is, opposite to the initial condition) regardless of what happens to the expression after that point.

For details on conditional connection control, see Conditional Connections in the CFX-Solver Modeling Guide.

13.1.3. Domain Interface: Solid Interface Models Tab

The Solid Interface Models tab is where you set the Heat Transfer and Additional Variable boundary conditions at the domain interface for a solid in a porous domain.

13.1.3.1. Heat Transfer

Determines whether or not heat transfer models are applied to the solid in a porous domain.

The options are:

- **Conservative Interface Flux**
  
  This option is only available if there are solids on both sides of the domain interface. It enables you to define the Thermal Contact Resistance or Thin Material, which are two ways of defining the same characteristics. That is, if you do not know the contact resistance, you can define the thin material and its thickness and have the solver derive the resistance.

- **Side Dependent**

  The boundary condition details are set independently on each side of the domain interface. When the domain interface is created, new boundaries are added to the Outline tree. You will have to edit those boundaries manually.

13.1.3.1.1. Conservative Interface Flux: Interface Model

13.1.3.1.1.1. None

No models are provided for any additional heat transfer between side 1 and side 2 of the interface.

13.1.3.1.1.2. Interface Model Option: Thermal Contact Resistance

Enter a numerical quantity or CEL expression that specifies the value of the thermal contact resistance from side 1 to side 2 of the interface.

13.1.3.1.1.3. Interface Model Option: Thin Material

Select a material and enter a numerical quantity or CEL expression that specifies the value of the thickness of the material spanning from side 1 to side 2 of the interface.

13.1.3.1.2. Side Dependent

Side Dependent has no suboptions.

13.1.3.2. Additional Variable

Determines whether or not additional variable models are applied between the sides of the interface.
The options are:

- Conservative Interface Flux
- Side Dependent

### 13.1.3.2.1. Conservative Interface Flux: Interface Model

#### 13.1.3.2.1.1. None

No models are provided for the Additional Variable between side 1 and side 2 of the interface.

#### 13.1.3.2.1.2. Interface Model Option: Additional Variable Contact Resistance

Enter a numerical quantity or CEL expression that specifies the value of the Additional Variable contact resistance from side 1 to side 2 of the interface.

### 13.1.3.2.2. Side Dependent

Side Dependent has no suboptions.

### 13.1.4. Domain Interface: Mesh Connection Tab

The Mesh Connection tab contains the following groups of settings:

- **Mesh Connection Method** (p. 145)

#### 13.1.4.1. Mesh Connection Method

You must specify a mesh connection method for all interface models.

#### 13.1.4.1.1. Mesh Connection: Option

The following options may be available, depending on other settings:

- **Automatic**
- **1:1 Direct (One-to-One)**
- **GGI (General Grid Interface)**

For details on these options, see Mesh Connection Options in the CFX-Solver Modeling Guide.

#### 13.1.4.1.2. Intersection Control

You can use the options described in this section to control the intersection of non-matching meshes for a particular interface.

---

**Note**

You can also use Solver Controls to apply default controls for the intersection of all interfaces (settings which are overwritten by Intersection Control settings that you apply individually to domain interfaces using the settings below). See Intersection Control (p. 209) to learn how to apply default Intersection Control settings to all interfaces.
Note

- If Direct (one-to-one) mesh connectivity is available, the solver will ignore the **Intersection Control** option and will instead use a 'topological intersection', that is, use the one-to-one information to generate the intersection data.
- If you are restarting a run, the intersection step is skipped and the intersection data is read from the results file. This behavior can be overridden by setting the expert parameter `force intersection` to `True`.

### 13.1.4.1.2.1. Intersection Control: Option

The **Intersection Control** options for when the **Mesh Connection Option** is set to **GGI** or **Automatic** are as described below. The following options can be used to control the intersection of non-matching meshes. CFX provides the GGI (General Grid Interface) capability which determines the connectivity between the meshes on either side of the interface using an intersection algorithm. In general, two intersection methods are provided:

- **Bitmap Intersection:**
  
  Two faces on either side of the interface which have to be intersected are both drawn into an equidistant 2D pixel map. The area fractions are determined by counting the number of pixels which reside inside both intersected faces (that is, within the union of the two faces). The area fraction for a face is then calculated by dividing the number of overlapping pixels by the total number of pixels in the face. This method is very robust.

- **Direct Intersection (Default):**
  
  Two faces on either side of the interface are intersected using the Sutherland-Hodgeman clipping algorithm. This method computes the exact area fractions using polygon intersection, and is much faster and more accurate than the bitmap method.

The **Bitmap Resolution** controls the number of pixels used to fill the 2D pixel map (see description of the bitmap intersection method above). The higher this number, the more accurate the final calculation of the area fractions. In general, the default resolution of 100 should be sufficient but large differences in the mesh resolution on both sides of the interface as well as other mesh anomalies may require the bitmap resolution to be increased. Larger numbers will cause longer intersection times, for example, doubling the bitmap resolution will approximately quadruple the GGI intersection time.

Both **Intersection Control** options enable you to set the following:

**Permit No Intersection**

When the **Permit No Intersection** option is set, the solver will run when there is no overlap between the two sides of an interface. This parameter is mainly useful for transient cases where interface geometry is closing and opening during the run. For example, transient rotor-stator cases with rotating valves, or moving mesh cases where the GGI interface changes from overlap to non-overlap during the simulation both can exhibit this type of behavior. This parameter is not switched on by default.

**Discernible Fraction**

Controls the minimum area fraction below which partially intersected faces are discarded. The following default values used by the solver depend on the intersection method:

- **Bitmap Intersection:** $1/(\text{Bitmap Resolution})^{1.5}$
- **Direct Intersection:** $1.0E-06$
**Edge Scale Factor**

Controls the value of the GGI edge scale factor. Control volume sector faces on GGI interfaces are detected as degenerate if two opposite edges are smaller than the GGI edge scale factor times the cube root of the corresponding sector volume. Those faces are not intersected.

**Periodic Axial Radial Tolerance**

Used when determining if the surface represented by the interface is a constant axial or radial surface. For a rotational periodic GGI interface, the solver ensures that the ratio of the radial and axial extent compared to the overall extent of each interface side is bigger than the specified value and therefore, the interface vertices do not have the same radial or axial positions.

**Circumferential Normalized Coordinates Option**

The **Circumferential Normalized Coordinates Option** is used to set the type of normalization applied to the axial or radial position coordinates ($\eta$). Mesh coordinate positions on GGI interfaces using pitch change are transformed into a circumferential ($\theta$) and axial or radial position ($\eta$). The $\eta$ coordinates span from hub to shroud and are normalized to values between 0 and 1. In cases where the hub and/or shroud curves do not match on side 1 and side 2, different approaches are available to calculate the normalized $\eta$ coordinates based on side local or global minimum and maximum $\eta$ values:

- **Mixed** (Default for Fluid Fluid interfaces): Normalization of $\eta$ is based on local minimum and maximum $\eta$ values as well as the $\eta$ range of side 1. This method forces the hub curves on side 1 and 2 to align. Non-overlap regions adjacent to the shroud may be produced if the shroud curves are not the same.
- **Global** (Default for Fluid Solid Interfaces): Normalization of $\eta$ is based on global minimum and maximum $\eta$ values. This method intersects side 1 and 2 unchanged from their relative positions in physical coordinates. If the hub and shroud curves do not match then non-overlap regions will be produced.
- **Local**: Normalization of $\eta$ is done locally for each side of the interface. This method will always produce an intersection of side 1 and 2, but may cause undesirable scaling of the geometry in some cases.

**Face Search Tolerance Factor**

A scaling factor applied to the element sized based separation distance, which is used to find candidates for intersection. For a given face on side 1 of the interface, candidate faces for intersection are identified on side 2 using an octree search algorithm. The octree search uses this tolerance to increase the sizes of the bounding boxes used to identify candidates. Making this parameter larger will increase the size of the bounding boxes, resulting in possible identification of more candidates.

**Face Intersection Depth Factor**

A scaling factor applied to the element sized based separation distance used when performing the direct or bitmap intersection. The final intersection of faces is only applied to those faces which are closer to each other than a specified distance. This distance is calculated as the sum of the average depth of the elements on side 1 and side 2 of the interface. This factor is applied as a scaling on the default distance. It might be necessary to adjust this factor if the normal element depth on the two interfaces sides varies a lot, or side 1 and 2 of the interface are separated by thin regions (for example, thin fin type geometries).
Chapter 14: Boundary Conditions

Boundary conditions must be applied to all the bounding regions of your domains. Boundary conditions can be inlets, outlets, openings, walls, and symmetry planes.

Unspecified external regions are automatically assigned a no-slip, adiabatic wall boundary condition. Such regions assume the name `<Domain> Default`, where `<Domain>` corresponds to the name of the domain. Unspecified internal boundaries are ignored.

You can apply boundary conditions to any bounding surface of a 3D primitive that is included in a domain (including internal surfaces). If you choose to specify a boundary condition on an internal surface (for example, to create a thin surface), then boundary conditions must be applied to both sides of the surface.

This chapter describes:

14.1. Default Boundary Condition
14.2. Creating and Editing a Boundary Condition
14.3. Interface Boundary Conditions
14.4. Symmetry Boundary Conditions
14.5. Working with Boundary Conditions

Additional information on boundary conditions is available in:

- The Purpose of Boundary Conditions in the CFX-Solver Modeling Guide
- Available Boundary Conditions in the CFX-Solver Modeling Guide
- Using Boundary Conditions in the CFX-Solver Modeling Guide

14.1. Default Boundary Condition

You should be familiar with the concept of primitive and composite regions before reading this section. If you are not, see Mesh Topology in CFX-Pre (p. 91) for details.

When a domain is created, all of the bounding 2D regions that are not used elsewhere are assigned to a default boundary condition that is created automatically. These regions can be considered to be the boundary between the current domain and the rest of the "world". The boundary that is generated is given the name `<Domain Name> Default`. When 2D primitives (or composites that reference them) are assigned to other boundary conditions and domain interfaces, they are removed from the `<Domain Name> Default` boundary condition. The default boundary condition is a no-slip adiabatic wall, but this can be edited like any other boundary condition. Solid-world 2D primitives behave in a similar way.

Removing Regions from the Default Domain

Fluid-solid regions are initially contained in the `<Domain Name> Default` boundary condition. When a CFX-Solver input file is written, or a user-defined domain interface is created, any fluid-solid regions referenced by this interface are removed from the default boundary.

If every region is assigned to another boundary condition, the `<Domain Name> Default` boundary object will cease to exist. In such a case, if a boundary condition is subsequently deleted, the `<Domain
Internal 2D Regions

Any 2D regions that lie within a domain are ignored unless a boundary condition is explicitly assigned (these are treated as thin surfaces). Each side of a fluid-fluid 2D primitive can have a different boundary condition, but most often both sides will be a wall. Thin surfaces are created by assigning a wall boundary condition to each side of a fluid-fluid 2D region. You can specify physics (such as thermal conduction) across thin surfaces in CFX-Pre by defining a domain interface. For details, see Defining Domain Interfaces as Thin Surfaces in the CFX-Solver Modeling Guide.

14.2. Creating and Editing a Boundary Condition

To create a new boundary:

1. Select Insert > Boundary from the main menu or by clicking Boundary on the main toolbar.
2. Enter a new name, if required, using the rules described in Valid Syntax for Named Objects (p. 55) and click Apply.

To edit an existing boundary:

1. Right-click the boundary’s name in the Outline view.
2. Select Edit. The details view for the boundary appears.

For more information on the edit command, see Outline Tree View (p. 5).

The details view describes the characteristics of a boundary condition on a series of tabs:

- Boundary Basic Settings Tab (p. 150)
- Boundary Details Tab (p. 152)
- Boundary Fluid Values Tab (p. 157)
- Boundary Sources Tab (p. 163)
- Boundary Plot Options Tab (p. 163)

14.2.1. Boundary Basic Settings Tab

This tab sets the type, location, coordinate frame, and frame type (stationary or rotating) for each boundary condition as detailed in the following sections:

- Boundary Type (p. 151)
- Location (p. 151)
- Coord Frame (p. 151)
- Frame Type (p. 151)
- Profile Boundary Conditions (p. 151)
14.2.1.1. Boundary Type

Inlet, outlet, opening, wall, and symmetry boundary conditions can be selected. Interface boundaries can be edited, but not created. For details, see Available Boundary Conditions in the CFX-Solver Modeling Guide.

14.2.1.2. Location

You can choose the location of a boundary condition from a list containing all 2D composite and primitive regions. For details, refer to the following sections:

- Mesh Topology in CFX-Pre (p. 91)
- Boundary Condition and Domain Interface Locations (p. 93)

The drop-down list contains commonly used regions (all composite names and primitive names that are not referenced by any composites) and the extended list (displayed when clicking the Ellipsis icon) contains all regions in a domain.

Tip

- Hold the Ctrl key as you click to select multiple regions.
- With the Location drop-down list active, you can select regions by clicking them in the viewer with the mouse. This will display a small box containing the names of the regions that are available for selection.

14.2.1.3. Coord Frame

Coordinate frames are used to determine the principal reference directions of specified and solved vector quantities in your domain, and to specify reference directions when creating boundary conditions or setting initial values. By default, CFX-Pre uses Coord 0 as the reference coordinate frame for all specifications in the model, but this can be changed to any valid CFX-Pre coordinate frame. For details, see Coordinate Frames (p. 255) and Coordinate Frames in the CFX-Solver Modeling Guide.

14.2.1.4. Frame Type

When the boundary condition is in a rotating domain, the Frame Type setting affects whether the conditions you specify on the boundary (pressure, velocity, and so on) are interpreted relative to the (rotating) domain (Frame Type set to Rotating) or relative to the absolute (stationary) frame of reference (Frame Type set to Stationary), from the point of view of absolute versus relative quantities.

For details, refer to the following sections:

- Cartesian Velocity Components in the CFX-Solver Modeling Guide
- Cylindrical Velocity Components

14.2.1.5. Profile Boundary Conditions

This option is available only if profile data is loaded.
14.2.1.5.1. Use Profile Data

Select **Use Profile Data** to define this boundary condition using an external profile data file, rather than using a value or expression. In order to do this, it is necessary to load the profile data file into CFX-Pre.

### 14.2.1.5.1.1. Initializing Profile Data

1. Select **Tools > Initialize Profile Data**
   - The **Initialize Profile Data** dialog box appears
2. Click **Browse**.
3. Select the file containing your profile data.
4. Click **Open**. The profile data is loaded and the profile data name, coordinates, variable names and units are displayed.

   Note that if the path or filename are altered by typing in **Data File** the **OK** and **Apply** buttons will become unavailable. You must then click **Reload** to read the specified file and update the contents in the displayed profile data information.
5. Click **OK**.

   Under the library section of the object tree, a new User Function object is generated for this profile function.

### 14.2.1.5.1.2. Profile Boundary Setup

Choose from the **Profile Name** list and click **Generate Values** to apply.

### 14.2.2. Boundary Details Tab

Boundary value settings depend on characteristics of the flow. For instance, temperature is required at a boundary only if heat transfer is being modeled.

If you are changing the characteristics of the flow, ensure that boundary conditions are correctly updated. In most cases, CFX-Pre alerts you of the need to update settings in the form of physics validation errors. For details, see **Physics Message Window** (p. 11).

Example:

Suppose a domain is created, isothermal flow is specified, and an inlet boundary condition set. If flow characteristics are then altered to include heat transfer, the inlet specification must be changed to include the temperature of the fluid at that location.

More information on some of the settings is available:

- Mass and Momentum in the **CFX-Solver Modeling Guide**
- Flow Direction in the **CFX-Solver Modeling Guide**
- Turbulence in the **CFX-Solver Modeling Guide**
- Heat Transfer in the **CFX-Solver Modeling Guide**
- Mesh Deformation in the **CFX-Solver Modeling Guide**

Various settings are available on the **Boundary Details** tab, depending on the type of boundary condition:
14.2.2.1. Boundary Details: Inlet

14.2.2.1.1. Flow Regime: Inlet

Option can be set to one of Subsonic, Supersonic, or Mixed. For details, refer to the following sections:

- Inlet (Subsonic) in the CFX-Solver Modeling Guide
- Inlet (Supersonic) in the CFX-Solver Modeling Guide
- Inlet (Mixed Subsonic-Supersonic) in the CFX-Solver Modeling Guide

14.2.2.1.2. Mesh Motion: Inlet

The option for Mesh Motion is set to Stationary by default. For details, see Mesh Deformation in the CFX-Solver Modeling Guide.

14.2.2.2. Boundary Details: Outlet

14.2.2.2.1. Flow Regime: Outlet

First, specify the flow regime option. For details, refer to the following sections:

- Outlet (Subsonic) in the CFX-Solver Theory Guide
- Outlet (Supersonic) in the CFX-Solver Theory Guide

14.2.2.2.2. Mass and Momentum: Outlet

For details, see Mass and Momentum in the CFX-Solver Modeling Guide.

14.2.2.2.3. Pressure Averaging: Outlet

This option appears when Average Static Pressure is selected under Mass and Momentum. For details, see Average Static Pressure in the CFX-Solver Modeling Guide.

14.2.2.2.4. Thermal Radiation: Outlet

For details, see Thermal Radiation in the CFX-Solver Modeling Guide.

14.2.2.2.5. Mesh Motion: Outlet

The option for Mesh Motion is set to Stationary by default. For details, see Mesh Deformation in the CFX-Solver Modeling Guide.
14.2.2.3. Boundary Details: Opening

14.2.2.3.1. Mass and Momentum: Opening

For details, see Mass and Momentum in the CFX-Solver Modeling Guide.

14.2.2.3.2. Flow Direction: Opening

This option appears when a flow direction is required; that is, when one of Opening Pres. and Dirn. or Static Pres. and Dirn. is selected under Mass and Momentum. For details, see Flow Direction in the CFX-Solver Modeling Guide.

14.2.2.3.3. Loss Coefficient: Opening

For details, see Loss Coefficient in the CFX-Solver Modeling Guide

14.2.2.3.4. Turbulence: Opening

For details, see Turbulence in the CFX-Solver Modeling Guide.

14.2.2.3.5. Heat Transfer: Opening

For details, see Heat Transfer in the CFX-Solver Modeling Guide.

14.2.2.3.6. Thermal Radiation: Opening

This is the same as specifying thermal radiation at an inlet. For details, see Thermal Radiation in the CFX-Solver Modeling Guide.

14.2.2.3.7. Component Details: Opening

The Component Details section appears when a variable composition/reacting mixture has been created for a single phase simulation, or a simulation with one continuous phase and particle tracking.

The mass fractions must sum to unity on all boundaries. With this in mind, highlight the materials you want to modify and enter the mass fraction. To enter an expression for the mass fraction, click Enter Expression and enter the name of your expression.

14.2.2.3.8. Mesh Motion: Opening

The option for Mesh Motion is set to Stationary by default. For details, see Mesh Deformation in the CFX-Solver Modeling Guide.

14.2.2.4. Boundary Details: Wall

14.2.2.4.1. Mass And Momentum

Option can be set to one of No Slip Wall, Free Slip Wall, Finite Slip Wall, Specified Shear, Counter-rotating Wall, Rotating Wall or Fluid Dependent. For details, see Mass and Momentum in the CFX-Solver Modeling Guide.
14.2.2.4.1.1. Slip Model Settings

The Slip Model settings apply for finite slip walls.

The only available option is Power Law. You must provide the nominal slip speed \((U_s)\), the critical stress \((\tau_c)\), the slip power \((m)\), the pressure coefficient \((B)\), and the normalizing stress \((\tau_n)\).

For details about the finite slip wall model, see Finite Slip Wall in the CFX-Solver Modeling Guide.

14.2.2.4.1.2. Shear Stress Settings

The Shear Stress settings apply for walls with specified shear.

You specify the shear stress value directly, using a vector that points tangentially to the wall. The normal component of the vector that you specify is ignored.

14.2.2.4.1.3. Wall Velocity Settings

The Wall Velocity settings apply for no slip walls, and walls with finite slip.

If Wall Velocity > Option is set to Cartesian Components, you must specify the velocity in the X, Y, and Z-axis directions. Similarly, if you choose Cylindrical Components then values are required for Axial Component, Radial Component, and Theta Component.

Specifying a Rotating Wall requires an angular velocity and, if the domain is stationary, an axis definition.

14.2.2.4.1.3.1. Axis Definition

If you select Coordinate Axis, a Rotation Axis is required. The Two Points method requires a pair of coordinate values specified as Rotation Axis From and Rotation Axis To.

14.2.2.4.2. Wall Roughness

For details, see Wall Roughness in the CFX-Solver Modeling Guide.

14.2.2.4.3. Solid Motion: Wall

If the boundary is for a domain that involves solid motion, then the Solid Motion > Boundary Advection option may be available. If the velocity for the solid motion (specified in the Boundary Details tab for the domain) is directed into the domain everywhere on a boundary, and if you specify a fixed temperature or a fixed value of an Additional Variable on that boundary, then you should consider turning on the Boundary Advection option.

If you have specified a fixed temperature, then turning on the Boundary Advection option causes the advection of thermal energy into the solid domain at a rate that is consistent with the velocity normal to the boundary, the specified fixed temperature, and the material properties.

If you have specified a fixed value for an Additional Variable, then turning on the Boundary Advection option causes the advection of that Additional Variable into the solid domain at a rate that is in accordance with the velocity normal to the boundary, the specified fixed value of the Additional Variable, and, for mass-specific Additional Variables, the density of the solid material.

For a boundary where the solid is moving out of the domain, consider turning on the Boundary Advection option in order to allow thermal energy and Additional Variables to be advected out.
For details on setting up the solid motion model for a domain, see *Solid Motion* (p. 128). For details on Additional Variables, see *Additional Variables* (p. 275).

### 14.2.2.4.4. Heat Transfer: Wall

For details, see *Heat Transfer in the CFX-Solver Modeling Guide*.

### 14.2.2.4.5. Thermal Radiation: Wall

For details, see *Thermal Radiation in the CFX-Solver Modeling Guide*.

### 14.2.2.4.6. Mesh Motion: Wall

The option for Mesh Motion is set to Stationary by default. For details, see *Mesh Motion in the CFX-Solver Modeling Guide*.

### 14.2.2.4.7. Additional Coupling Sent Data

This setting is available for ANSYS Multi-field runs. For details, see *Additional Coupling Sent Data in the CFX-Solver Modeling Guide*.

### 14.2.2.5. Boundary Details: Symmetry

Only Mesh Motion can be set in this tab for Symmetry boundary conditions. The option for Mesh Motion is set to Unspecified by default. For details, see *Mesh Deformation in the CFX-Solver Modeling Guide*.

### 14.2.2.6. Boundary Details: Interfaces

The options for Mass and Momentum, Turbulence, Heat transfer, Mesh Motion, and Additional Variables are set to Conservative Interface Flux by default.

#### Important

Conservative Interface Flux implies that the quantity in question will “flow” between the current boundary and the boundary on the other side of the interface. This means that Conservative Interface Flux must also be used on the boundary on the other side of the interface. Accordingly, the CFX-Solver will not be able to handle cases where Conservative Interface Flux is set on just one side of the interface, or where the quantity being transferred does not exist on the other side. CFX-Pre will issue a warning if either of these cases exist.

For details on Nonoverlap Conditions, refer to *Non-overlap Boundary Conditions*.

### 14.2.2.7. Mesh Motion

When mesh deformation is selected for the domain that contains a boundary condition, mesh motion can be specified for the boundary on the Boundary Details tab.

The available options are:

- Conservative Interface Flux
- Unspecified
• Stationary
• Specified Displacement
• Specified Location
• ANSYS MultiField
• Rigid Body Solution

For details on these options, see Mesh Motion Options in the CFX-Solver Modeling Guide.

For details on mesh deformation, see Mesh Deformation in the CFX-Solver Modeling Guide.

See Mesh Deformation (p. 113) for information about activating mesh deformation for the domain.

14.2.3. Boundary Fluid Values Tab

The Fluid Values tab for a boundary condition object is used to set boundary conditions for each fluid in an Eulerian multiphase simulation and each particle material when particle tracking is modeled.

The Boundary Conditions list box contains the materials of the fluid passing through the boundary condition. Selecting a material from the list will create a frame with the name of the material and properties available to edit. These properties are detailed in the following sections.

14.2.3.1. Fluid Values: Turbulence

Turbulence \( > \) Option can be set to any one of the following values. Unless otherwise specified, do not change any further turbulence settings.

• Low (Intensity = 1%)
• Medium (Intensity = 5%)
• High (Intensity = 10%)
• Intensity and Length Scale

For details, see Intensity and Length Scale (p. 158).

• Intensity and Eddy Viscosity Ratio

For details, see Intensity and Eddy Viscosity Ratio (p. 158).

• \( \kappa \) and Epsilon

For details, see \( \kappa \) and Epsilon (p. 158).

• \( \kappa \) and Omega
• \( \kappa \) and Eddy Viscosity Ratio
• \( \kappa \) and Length Scale
• Reynolds Stresses and Epsilon
• Reynolds Stresses and Omega
• Reynolds Stresses and Eddy Viscosity Ratio
• Reynolds Stresses and Length Scale
• Default Intensity and Autocompute Length Scale
14.2.3.1.1. Intensity and Length Scale
Enter a numeric value or an expression for Value, and specify a value for the eddy length scale.

14.2.3.1.2. Intensity and Eddy Viscosity Ratio
Enter a numeric value or an expression for Value, and specify a value for the eddy viscosity ratio.

14.2.3.1.3. k and Epsilon
Specify a turbulent kinetic energy value and a turbulent eddy dissipation value.

14.2.3.1.4. Intensity and Auto Compute Length
Enter a numeric value or an expression for Value.

14.2.3.2. Fluid Values: Volume Fraction
Volume Fraction > Option can be set to:

  • Value

    If set to Value, you must enter a numeric value or an expression for the volume fraction for each fluid. Note that the total volume fractions of the fluids in the list box must be equal to 1.

  • Zero Gradient

    The volume fraction can also be set to Zero Gradient, which implies that the volume fraction gradient perpendicular to the boundary is zero. This setting can be useful for subcritical free surface flow when the free surface elevation is specified (via a pressure profile) at the outlet.

14.2.3.3. Fluid Values: Heat Transfer
If Option is set to Static Temperature, you must specify a value for the static temperature.

If Option is set to ANSYS MultiField, then only the data to Receive from ANSYS can be specified. While data can be received from ANSYS on a fluid specific basis, data can not be sent to ANSYS on that basis (that is, multiple CFX values sent to the same receiving value in ANSYS). To send data to ANSYS, create an Additional Coupling Sent Data object on the Boundary Details tab. For details, see Additional Coupling Sent Data in the CFX-Solver Modeling Guide.

14.2.3.4. Fluid Values for Inlets and Openings

14.2.3.4.1. Multiphase

1. Set the fluid velocity on the Boundary Details tab.
2. Select from the following:
   • Normal Speed
• Cartesian Velocity Components
• Mass Flow Rate

For details, see Mass and Momentum in the CFX-Solver Modeling Guide.

3. Set the static pressure on the Boundary Details tab.

4. Select from the following:
   • Normal to Boundary
   • Directional Components

For details, see Mass and Momentum in the CFX-Solver Modeling Guide.

5. Set turbulence quantities at the inlet boundary (if applicable).

For details, see Turbulence in the CFX-Solver Modeling Guide.

6. Set the inlet temperature of each phase (if applicable).

For details, see Heat Transfer in the CFX-Solver Modeling Guide.

7. Enter the volume fraction of the selected fluid at the inlet.

The total volume fraction summed over all the fluids must be equal to 1.

8. If one of the fluids is a variable composition mixture, specify the mass fractions of each of the components.

For details, see Component Details: Opening (p. 154).

14.2.3.4.2. MUSIG settings

When the fluid selected in the list box at the top of the Fluid Values tab has a morphology of Polydispersed Fluid, size fractions must be specified for each of the size groups. The size fractions can be set to Value or Automatic. All size fractions set to Automatic are calculated to have the same value such that the overall sum of size fractions (including those that are specified by value) is unity. If all size fractions are set to Value, you must ensure that the specified size fractions sum to unity.

14.2.3.4.3. Particle Tracking Settings for Inlets and Openings

14.2.3.4.3.1. Phase List

Select the phase for which to set properties.

14.2.3.4.3.2. Particle Behavior

Optionally, specify particle properties at the boundary.

When this check box is disabled, particles do not enter through this boundary.

14.2.3.4.3.3. Mass and Momentum

For details, see Mass and Momentum in the CFX-Solver Modeling Guide.
14.2.3.4.3.4. Particle Position

For details, see Particle Position in the CFX-Solver Modeling Guide.

14.2.3.4.3.5. Particle Locations

For details, see Particle Locations in the CFX-Solver Modeling Guide.

14.2.3.4.3.6. Number of Positions

Select from Direct Specification or Proportional to Mass Flow Rate. For details, see Number of Positions in the CFX-Solver Modeling Guide.

14.2.3.4.3.7. Particle Mass Flow

For details, see Particle Mass Flow Rate in the CFX-Solver Modeling Guide.

14.2.3.4.3.8. Particle Diameter Distribution

For details, see Particle Diameter Distribution in the CFX-Solver Modeling Guide.

14.2.3.4.3.9. Heat Transfer

Available when heat transfer is selected. For details, see Heat Transfer in the CFX-Solver Modeling Guide.

14.2.3.4.3.10. Component Details

Available when the particle phase has been set up as a variable composition mixture. For details, see Component Details in the CFX-Solver Modeling Guide.

14.2.3.5. Fluid Values for Outlets

If you are using the inhomogeneous multiphase model and have selected the Fluid Velocity option on the Boundary Details tab, the fluid-specific velocity information is set on the tab shown below at an outlet boundary.

Specify the Mass and Momentum as:

- Normal Speed
- Cartesian Velocity Components
- Cylindrical Velocity Components
- Mass Flow Rate

For details, see Mass and Momentum in the CFX-Solver Modeling Guide.

14.2.3.6. Fluid Values for Walls

14.2.3.6.1. Particle Tracking Settings for Walls

This tab enables you to define particle behavior at walls. This is done by selecting a particle type from the list box and specifying its properties as outlined below:

- Select a particle-wall interaction option - for details, see Settings for Particle-Wall Interaction (p. 161).
• Specify an erosion model - for details, see Erosion Model in the CFX-Solver Modeling Guide.

• Specify a particle-rough wall model - for details see Particle-Rough Wall Model (Virtual Wall Model) in the CFX-Solver Modeling Guide.

• Specify the amount of mass absorbed at a wall - for details, see Mass Flow Absorption in the CFX-Solver Modeling Guide.

• Define the particle behavior - Select this option to control the entry of particles and to specify particle properties at wall boundaries. The settings for this option are similar to those available for inlets and openings. For details, see Particle Tracking Settings for Inlets and Openings (p. 159).

### 14.2.3.6.2. Settings for Particle-Wall Interaction

The particle-wall interaction can be controlled by selecting one of the following Wall Interaction options:

- **Equation Dependent** - This is the default option in ANSYS CFX and requires the specification of the following Velocity settings:
  - **Restitution Coefficient** - The droplet reflection at the wall can be controlled by specifying the values for Perpendicular Coefficient and Parallel Coefficient.
    
    The impact of droplet collision and the resulting momentum change across the collision can be described by specifying the perpendicular and parallel coefficients of restitution. For details, see Restitution Coefficients for Particles in the CFX-Solver Modeling Guide.
  - **Minimum Impact Angle** - Select this check box if you want to specify the minimum impact angle. Below this impact angle, particles will be stopped with the fate Sliding along walls.

- **Wall Film** - When Wall Interaction is set to Wall Film, then the following Wall Film Interaction models can be selected:
  - **Stick to Wall** - This model enforces all particles that hit a wall to become part of the wall film. This option does not require any further settings.
  - **Elsaesser** - This model requires the specification of Wall Material.
  - **User Defined** - The settings for this option are similar to those described for User Wall Interaction.

For details on various wall interaction options, see Wall Interaction in the CFX-Solver Modeling Guide.

**User Wall Interaction** - This option is available when a Particle User Routine has been created. For details, refer to the following sections:

- Particle User Routines (p. 295)
- Wall Interaction in the CFX-Solver Modeling Guide

For additional modeling information on particle transport, see Particle Transport Modeling in the CFX-Solver Modeling Guide.

### 14.2.3.7. Fluid Values for Interfaces

#### 14.2.3.7.1. Fluid-Solid Interface, Fluid Side

The Fluid Values tab is available on the fluid side of a fluid-solid interface for an inhomogeneous multiphase setup.

When you are using the inhomogeneous multiphase model, you must use a no-slip wall or set a wall velocity. For details, see Mass and Momentum in the CFX-Solver Modeling Guide.
When particle transport is selected, additional settings are available. These contain the same options as those that appear for wall boundaries. For details, refer to the following sections:

- Restitution Coefficients for Particles in the CFX-Solver Modeling Guide
- Erosion Model in the CFX-Solver Modeling Guide

Particles are introduced into the domain from this boundary. For details, see Fluid Values for Inlets and Openings (p. 158).

14.2.3.7.2. Fluid-Fluid and Periodic Interfaces

For periodic and fluid-fluid interfaces, Conservative Interface Flux is the only available option for all quantities and cannot be changed.

14.2.4. Boundary Solid Values Tab

14.2.4.1. Heat Transfer

14.2.4.1.1. Adiabatic

The heat flux across the boundary is zero. The boundary is insulated.

14.2.4.1.2. Fixed Temperature

The boundary is fixed at a specified temperature $T_w$.

14.2.4.1.3. Heat Flux

A heat flux is specified across the boundary. A positive value indicates heat flux into the domain.

14.2.4.1.4. Heat Transfer Coefficient

In this case, the heat flux at a boundary is implicitly specified using an external heat transfer coefficient, $h_c$, and an outside or external boundary temperature, $T_o$. This boundary condition can be used to model thermal resistance outside the computational domain. The heat flux, when calculated using the Heat Transfer Coefficient, is:

$$q_w = h_c (T_o - T_w) \quad (14-1)$$

where $T_o$ is the specified outside or external boundary temperature and $T_w$ is the temperature at the boundary (edge of the domain).

14.2.4.1.5. Conservative Interface Flux

Conservative Interface Flux implies that the heat flow in question will be between the current solid on this boundary and another solid on the other side of the interface. This means that Conservative Interface Flux must also be used on the boundary on the other side of the interface. Accordingly, the CFX-Solver will not be able to handle cases where Conservative Interface Flux is set on just one side of the interface, or where the quantity being transferred does not exist on the other side. CFX-Pre will issue a warning if either of these cases exist.
14.2.4.2. Additional Variables

See Boundary Details and Fluid Values Tabs for Boundary Condition Objects for details.

14.2.5. Boundary Sources Tab

Boundary sources of mass (continuity), energy, radiation, Additional Variables, component mass fractions, and turbulence can be specified at inlet, opening, outlet, interface, and wall boundaries. For details, see Sources in the CFX-Solver Modeling Guide.

Selecting Boundary Source > Sources enables you to specify sources for this boundary. For more information about sources, see Sources.

14.2.6. Boundary Plot Options Tab

The Plot Options tab enables you to create Boundary Contour and Boundary Vector graphics to display scalar and vector values at boundaries, respectively, as detailed in the following sections:

- Boundary Contour (p. 163)
- Boundary Vector (p. 163)

14.2.6.1. Boundary Contour

Selecting this option and choosing a Profile Variable draws the boundary surface colored by the selected variable. The available variables depend on the settings on the Boundary Details and Sources tabs, as applicable. A legend appears by default showing the variable plotted on the boundary with a local range. You can clear visibility for the legend and the plots by clearing the check box next to the boundary contour object associated with your boundary condition in the Outline tree view. You may have to click the + sign next to the boundary condition in order to view the contour object in the Outline tree view.

14.2.6.2. Boundary Vector

Selecting this option draws vectors at the nodes of the boundary surface, pointing in the direction specified by the Profile Vector Component setting. The availability of vectors (and this option) depends on the settings on the Boundary Details and Basic Settings tabs. For example, vector plots are available if you specify Basic Settings > Boundary Type as Inlet and the Boundary Details > Mass and Momentum option as velocity components.

14.3. Interface Boundary Conditions

All domain interfaces automatically create boundaries of type Interface that contain the regions used in the domain interface. These boundaries are named <Domain Interface Name> Side <Number>. For example, for a domain interface named myInterface, the related boundary conditions would be called myInterface Side 1 and myInterface Side 2. At least one of these boundaries will be auto-created for each domain involved in the interface. You can edit these boundaries like any other boundary, but you cannot create new interface boundaries directly.

You will usually not need to edit an auto-generated Interface boundary, but options are available for fluid-solid interfaces (which can be considered a special case of wall boundaries). Settings and options available when editing interface boundaries can be configured. For details, refer to the following sections:

- Boundary Details: Interfaces (p. 156)
14.4. Symmetry Boundary Conditions

When specifying symmetry boundary conditions, select the locations from the drop-down list box and select the Frame Type if your domain is rotating. No further settings are required, and the same settings apply for fluid and solid domains.

For details, see Symmetry Plane in the CFX-Solver Modeling Guide.

14.5. Working with Boundary Conditions

The topics in this section include:

- Boundary Condition Visualization (p. 164)
- Profile Data and CEL Functions (p. 164)

14.5.1. Boundary Condition Visualization

When you create a boundary condition in CFX-Pre, several things happen in the Viewer:

- Symbols for the boundary conditions are displayed in the viewer, based on type. The visibility of these symbols is determined by the Label and Marker control form. For details, see Boundary Markers and Labels (p. 27).
- Boundary condition symbols are shown at surface display line intersections.
- Regions comprising the boundary condition are highlighted according to settings specified under Edit > Options. For details, see 3D Viewer Toolbar (p. 19).

If multiple boundary conditions are defined on a region of mesh, an error appears in the physics validation window below the viewer.

Note

Inlets, outlets, and openings use arrow symbols that are locally normal to the boundary surface, irrespective of the actual direction specified for the boundary condition. It is possible to show arrows pointing in the specified direction by creating a Boundary Vector object. You can optionally turn off the default arrow symbols by clearing the check boxes on Label and Marker control form (see above). Also see Boundary Vector (p. 163) and Boundary Markers (p. 27) for more details.

When using CFX-Pre within ANSYS Workbench or with a pale viewer background color, the colors of these symbols are black in order to make them more visible.

14.5.2. Profile Data and CEL Functions

Profile data can be used to define a boundary condition based on a distribution of appropriate values.

14.5.2.1. Types of Discrete Profiles

- 1D profile uses one spatial coordinate to define the data position; for example, x, y, z, or a cylindrical value. This could be used to describe the axisymmetric flow down a cylindrical pipe (that is, the data values for a value of ‘r’).
• 2D profile uses two spatial coordinates (Cartesian or polar); for example, \((x, y), (x, z), (r, t), (a, t)\), and so on. If you are importing the data from a 2D code on a planar boundary, you may want to use this as a boundary condition in a 3D case in CFX.

• 3D profile uses three spatial coordinates; for example, \((x, y, z)\) or \((r, t, a)\). Among various uses of 3D Profile Data are boundary conditions, spatially varying fluid properties, Additional Variables, or equation sources.

### 14.5.2.2. Profile Data Format

The following is the format of the profile data file:

```plaintext
# Comment line
# The following section (beginning with [Name] and ending with # [Data]) represents one profile, which can be repeated # to define multiple profiles.
[Name]
My Boundary
[Spatial Fields]
  r, theta, z
  .
  .

[Data]
  X [ m ], Y [ m ], Z [ m ], Area [ m^2 ], Density [ kg m^-3 ]
  -1.773e-02, -5.382e-02, 6.000e-02, 7.121e-06, 1.231e+00
  -1.773e-02, -5.796e-02, 5.999e-02, 5.063e-06, 1.231e+00
  .
  .
# -------- end of first profile 'My Boundary'----------
[Name]
Plane 2
  .
  .
```

The following is a guideline for creating profile data format:

• The name of each locator is listed under the [Name] heading.

• The names of the fields are case-insensitive (that is, [data] and [Data] are acceptable).

• The names of variables used in the data fields are case sensitive.

  For example, \(u\ [m]\) is a valid x velocity component, whereas \(U\ [m]\) is an unrecognized field name. You have to map this unrecognized field name with a valid variable name when loading into CFX-Pre. This is consistent with the use of CEL elsewhere.

• Comments in the file are preceded by `#` (or `##` for the CFX polyline format) and can appear anywhere in the file.

• Commas must separate all fields in the profile. Any trailing commas at the end of a line are ignored. Any additional commas within a line of data will be a syntax error.

• Blank lines are ignored and can appear anywhere in the file (except between the [<data>] and first data line, where <data> is one of the key words in square brackets shown in the data format).

• If any lines with text are included above the keyword [Name], a syntax error will occur. Such lines should be preceded by `#` character to convert them into comments.

• Multiple data sets are permitted within the same file by repeating the sequence of profiles; each profile begins with keyword [Name].

• Point coordinates and the corresponding variable values are stored in the [Data] section.
[Spatial Fields] can contain 1, 2, or 3 values, corresponding to 1D, 2D, or 3D data.

- The data file has a .csv extension for compatibility with other software packages.
- When this data file is read in, it is checked for any format violations; physics errors are shown for such situations.

**Note**

Files exported from CFD-Post in a user-specified coordinate system will contain a coordinate frame ([CoordFrame]) section. The coordinate frame definition is written to the profile file; CFX-Pre will define that coordinate frame for you when you initialize the data.

Additional information on profile data is available:

- Physics Message Window (p. 11)
- RULES and VARIABLES Files in the CFX-Solver Manager User's Guide
- Profile Boundary Conditions in the CFX-Solver Modeling Guide

### 14.5.2.3. Multiphase Boundary Condition Example

Consider a multiphase boundary condition set up using the following:

- The profile data file has a profile named myProfile
- One of the data fields is Temperature [K]

CFX-Pre enables a function such as myProfile.water.Temperature(x, y, z) to refer to a data field stored in the profile. This derived value can be assigned to a parameter, such as Fixed Temperature.

The expressions that are automatically generated in CFX-Pre for profile boundaries are simply the expressions in terms of interpolation functions. Modify them in the same way as a normal CEL expression.

For example, the expression myProfile.Temperature(x, y, z) could be modified to 2*myProfile.Temperature(2x, y, z). For details, see Profile Boundary Conditions in the CFX-Solver Modeling Guide.
Chapter 15: Initialization

Initialization is the process by which all unspecified solution field values are assigned at the beginning of a simulation. These values are commonly referred to as initial values. For steady state simulations, they may be collectively referred to as an initial guess.

For steady state simulations, initial values can be set automatically if a good initial guess is not known or is not required. Although accurate initial values may not always be available, a good approximation can reduce the time to solve a steady state simulation and reduce the chance that the solution fails to converge due to diverging residuals. The more complicated the simulation and models used, the more important it becomes to start the solution process with sensible initial values. Advice about choosing sensible initial values is available in Initialization Parameters in the CFX-Solver Modeling Guide.

For transient simulations, the initial values must be specified for all variables because the data describes the state at the simulation start time.

If available, the results from a previous simulation can be used to provide the initial values. In this case, any values chosen to be automatically set will be overridden by values from the initial values file(s). See Reading the Initial Conditions from a File in the CFX-Solver Modeling Guide for details.

Global and domain initialization settings may be specified. Global settings apply to only those domains that do not have their own initialization settings.

Information on modeling initial values is available in Initial Condition Modeling in the CFX-Solver Modeling Guide.

15.1. Using the User Interface

The following topics will be discussed:

- Domain: Initialization Tab (p. 167)
- Global Settings and Fluid Settings Tabs (p. 168)

The Global Settings and Fluid Settings tabs for the global initialization object (listed as Initialization under Simulation in the tree view) contain settings that specify how initial values are to be determined, and, in some cases, the initial values themselves. They are accessible by clicking Global Initialization by selecting Insert > Global Initialization, or by editing the initialization object listed in the tree view under Simulation.

15.1.1. Domain: Initialization Tab

The Initialization tab for a domain contains settings that specify how initial values are to be determined, and, in some cases, the initial values themselves. It is accessible by editing a domain object.
15.1.1.1. Domain Initialization

This check box determines whether or not the domain is initialized based on its own settings or based on global initialization settings. When this check box is selected, an interface that is essentially the same as that for global initialization is displayed. Any initialization values defined on a per-domain basis will override values defined at the global level. For details, see Global Settings and Fluid Settings Tabs (p. 168). After specifying and applying domain initialization, an entry called Initialization is listed in the tree view under the applicable domain.

15.1.2. Global Settings and Fluid Settings Tabs

When a simulation involves only one fluid, the Fluid Settings tab is not available, but then all of its contents are added to the Global Settings tab.

15.1.2.1. Coord Frame Check Box

This check box determines whether or not a specified coordinate frame is used for interpreting initial conditions. If the check box is not selected, the default coordinate frame, Coord 0, is used.

15.1.2.1.1. Coord Frame Check Box: Coord Frame

Select a coordinate frame to use for interpreting initial conditions. For details, see:

• Coordinate Frames (p. 255)
• Coordinate Frames in the CFX-Solver Modeling Guide
• Coord Frame in the CFX-Solver Modeling Guide

15.1.2.2. Frame Type Check Box

This check box determines whether or not a specified frame type is used for interpreting initial values of velocity. If the check box is not selected, the default frame of reference is used. The default frame of reference is stationary or rotating, depending on whether the domain is stationary or rotating, respectively.

15.1.2.2.1. Frame Type

• Stationary

The frame of reference used to interpret initial values of velocity is the stationary frame of reference. For example, if the initial velocity throughout a domain is parallel to the rotation axis of the domain, the flow will initially have no swirl in the stationary frame of reference, even if the domain is rotating.

• Rotating

The frame of reference used to interpret initial values of velocity is that of the associated domain. For example, if the initial velocity throughout a domain is specified as being parallel to the rotation axis of the domain, and if the domain is rotating, the flow will have swirl in the stationary frame of reference.

For details, see Frame Type in the CFX-Solver Modeling Guide.

15.1.2.3. Initial Conditions: Velocity Type

• Cartesian
15.1.2.4. Initial Conditions: Cartesian Velocity Components

15.1.2.4.1. Option

- Automatic

  The initial velocity field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial velocity field is computed from built-in algorithms. For details, see Automatic in the CFX-Solver Modeling Guide.

- Automatic with Value

  The initial velocity field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial velocity field is set to user-specified values. For details, see Automatic with Value in the CFX-Solver Modeling Guide.

15.1.2.4.2. Velocity Scale Check Box

(applies only when Option is set to Automatic)

This check box determines whether or not a specified velocity scale is used. If the check box is not selected, a velocity scale will be calculated internally by the CFX-Solver, based on a weighted average value of velocity over all applicable Boundary Conditions (inlets, openings and outlets). Initial guess values that are calculated based on the internally calculated velocity scale may be unsuitable due to the shape of your domain, or, for example, due to a small, high-speed inlet which results in an over-prediction of the velocity magnitude.

15.1.2.4.2.1. Velocity Scale Check Box: Value

Enter a numerical quantity or CEL expression for the velocity scale. This is not a normalized value; it is essentially the velocity magnitude that will be used for all applicable velocity vectors. For details, see Velocity Scale in the CFX-Solver Modeling Guide.

15.1.2.4.3. U, V, W

(applies only when Option is set to Automatic with Value)

Enter a numerical quantity or CEL expression for each Cartesian velocity component. For details, see Cartesian Velocity Components in the CFX-Solver Modeling Guide.

15.1.2.5. Initial Conditions: Cylindrical Velocity Components

15.1.2.5.1. Option

For details, see Option (p. 169).

15.1.2.5.2. Velocity Scale Check Box

(applies only when Option is set to Automatic)

For details, see Velocity Scale Check Box (p. 169).
15.1.2.5.3. Axial Component, Radial Component, Theta Component

(applies only when Option is set to Automatic with Value)

Enter a numerical quantity or CEL expression for each cylindrical velocity component. For details, see Cylindrical Velocity Components in the CFX-Solver Modeling Guide.

15.1.2.6. Initial Conditions: Static Pressure

15.1.2.6.1. Option

- Automatic

The initial static pressure field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial static pressure field is computed from built-in algorithms.

- Automatic with Value

The initial static pressure field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial static pressure field is set to user-specified values.

For details, see Static Pressure in the CFX-Solver Modeling Guide.

15.1.2.6.2. Relative Pressure

(applies only when Option is set to Automatic with Value)

Enter a numerical quantity or CEL expression for the relative pressure.

For details, see Static Pressure in the CFX-Solver Modeling Guide.

15.1.2.7. Initial Conditions: Turbulence

From Option, the various initial condition settings for turbulence are:

- Low Intensity and Eddy Viscosity Ratio: This sets intensity to 1% and viscosity ratio to 1.
- Medium Intensity and Eddy Viscosity Ratio: This sets intensity to 5% and viscosity ratio to 10.
- High Intensity and Eddy Viscosity Ratio: This sets intensity to 10% and viscosity ratio to 100.
- Intensity and Eddy Viscosity Ratio: Use this option to specify fractional intensity and eddy viscosity ratio.
- Intensity and Length Scale: Use this option to specify fractional intensity and length scale.
- k and Epsilon: Use this option to specify turbulence kinetic energy and turbulence eddy dissipation.
- k and Omega: Use this option to specify turbulence kinetic energy and turbulence eddy frequency.
- k and Eddy Viscosity Ratio: Use this option to specify turbulence kinetic energy and eddy viscosity ratio.
- k and Length Scale: Use this option to specify turbulence kinetic energy and length scale.
Reynolds Stresses and Epsilon: Use this option to specify Reynolds Stresses and turbulence eddy dissipation.

Reynolds Stresses and Omega: Use this option to specify Reynolds Stresses and turbulence eddy frequency.

Reynolds Stresses and Eddy Viscosity Ratio: Use this option to specify Reynolds Stresses and eddy viscosity ratio.

Reynolds Stresses and Length Scale: Use this option to specify Reynolds Stresses and length scale.

For additional details, see K (Turbulent Kinetic Energy), Epsilon (Turbulence Eddy Dissipation), and Reynolds Stress Components in the CFX-Solver Modeling Guide.

15.1.2.7.1. Fractional Intensity

- **Option:** Automatic
  
The fractional intensity field is loaded from an initial values file, if one is available. If an initial values file is not available, the fractional intensity field is computed automatically.

- **Option:** Automatic with Value
  
The fractional intensity field is loaded from an initial values file, if one is available. If an initial values file is not available, the fractional intensity field is set to user-specified values.

15.1.2.7.2. Eddy Viscosity Ratio

- **Option:** Automatic
  
The eddy viscosity ratio field is loaded from an initial values file, if one is available. If an initial values file is not available, the eddy viscosity ratio field is computed automatically.

- **Option:** Automatic with Value
  
The eddy viscosity ratio field is loaded from an initial values file, if one is available. If an initial values file is not available, the eddy viscosity ratio field is set to user-specified values.

15.1.2.7.3. Eddy Length Scale

- **Option:** Automatic
  
The eddy length scale field is loaded from an initial values file, if one is available. If an initial values file is not available, the eddy length scale field is computed automatically.

- **Option:** Automatic with Value
  
The eddy length scale field is loaded from an initial values file, if one is available. If an initial values file is not available, the eddy length scale field is set to user-specified values.

15.1.2.7.4. Turbulence Kinetic Energy

- **Option:** Automatic
  
The turbulence kinetic energy field is loaded from an initial values file, if one is available. If an initial values file is not available, the turbulence kinetic energy field is computed automatically.

- **Option:** Automatic with Value
The turbulence kinetic energy field is loaded from an initial values file, if one is available. If an initial values file is not available, the turbulence kinetic energy field is set to user-specified values.

15.1.2.7.5. Turbulence Eddy Dissipation

- **Option: Automatic**

  The turbulence eddy dissipation field is loaded from an initial values file, if one is available. If an initial values file is not available, the turbulence eddy dissipation field is computed automatically.

- **Option: Automatic with Value**

  The turbulence eddy dissipation field is loaded from an initial values file, if one is available. If an initial values file is not available, the turbulence eddy dissipation field is set to user-specified values.

15.1.2.7.6. Turbulence Eddy Frequency

- **Option: Automatic**

  The turbulence eddy frequency field is loaded from an initial values file, if one is available. If an initial values file is not available, the turbulence eddy frequency field is computed automatically.

- **Option: Automatic with Value**

  The turbulence eddy frequency field is loaded from an initial values file, if one is available. If an initial values file is not available, the turbulence eddy frequency field is set to user-specified values.

15.1.2.7.7. Reynolds Stress Components

- **Option: Automatic**

  The Reynolds stress components fields are loaded from an initial values file, if one is available. If an initial values file is not available, the Reynolds stress components fields are computed automatically.

- **Option: Automatic with Value**

  The Reynolds stress components fields are loaded from an initial values file, if one is available. If an initial values file is not available, the Reynolds stress components fields are set to user-specified values.

15.1.2.8. Initial Conditions: Temperature

(applies only when heat transfer is active)

- **Automatic**

  The initial temperature field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial temperature field is computed from built-in algorithms.

- **Automatic with Value**

  The initial temperature field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial temperature field is set to user-specified values.
15.1.2.9. Initial Conditions: Radiation Intensity

(applies only when using the P1, Discrete Transfer, or Monte Carlo model for Thermal Radiation)

15.1.2.9.1. Option

• Automatic

  The initial radiation intensity field and blackbody temperature field are loaded from an initial values file, if one is available. If an initial values file is not available, the initial radiation intensity field and blackbody temperature field are computed from built-in algorithms.

• Automatic with Value

  The initial radiation intensity field and blackbody temperature field are loaded from an initial values file, if one is available. If an initial values file is not available, the initial radiation intensity field and blackbody temperature field are set to user-specified values.

For details, see Radiation Intensity in the CFX-Solver Modeling Guide.

15.1.2.10. Initial Conditions: Mixture Fraction

15.1.2.10.1. Option

• Automatic

  The initial mixture fraction field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial mixture fraction field is computed from built-in algorithms.

• Automatic with Value

  The initial mixture fraction field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial mixture fraction field is set to user-specified values.

15.1.2.10.2. Mixture Fraction

Enter a numerical quantity or CEL expression that specifies the value of the mixture fraction throughout the domain.

15.1.2.11. Initial Conditions: Mixture Fraction Variance

15.1.2.11.1. Option

• Automatic

  The initial mixture fraction variance field is loaded from an initial values file if, one is available. If an initial values file is not available, the initial mixture fraction variance field is computed from built-in algorithms.

• Automatic with Value

  The initial mixture fraction variance field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial mixture fraction variance field is set to user-specified values.
15.1.2.11.2. Mix. Fracn. Variance

Enter a numerical quantity or CEL expression that specifies the value of the mixture fraction variance throughout the domain.

15.1.2.12. Initial Conditions: Component Details

(applies only when the relevant fluid is a variable composition mixture)

15.1.2.12.1. List Box

This list box is used to select a component (of a fluid that is a variable composition mixture) in order to set its fluid-specific initialization options.

15.1.2.12.2. [component name]: Option

- Automatic

  The initial mass fraction field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial mass fraction field is computed from built-in algorithms.

- Automatic with Value

  The initial mass fraction field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial mass fraction field is set to user-specified values.

15.1.2.12.3. [component name]: Mass Fraction

Available when Option is set to Automatic with Value, you must enter a numerical quantity or CEL expression that specifies the value of the component mass fraction throughout the domain.

15.1.2.13. Initial Conditions: Additional Variable Details

This section is similar to Component Details, dealing with Additional Variables instead. For details, see Initial Conditions: Component Details (p. 174).

15.1.2.14. Fluid Specific Initialization

(applies only when multiple fluids are involved)

The fluid-specific initialization settings are grouped together, either in the Fluid Specific Initialization section or, in the case of global initialization, on the Fluid Settings tab.

15.1.2.15. Fluid Specific Initialization: List Box

This list box is used to select a fluid in order to set its fluid-specific initialization options.

15.1.2.16. Fluid Specific Initialization: [fluid name] Check Box

This check box determines whether or not the initialization options for the indicated fluid are specified explicitly or are left at default values.
15.1.2.17. Fluid Specific Initialization: [fluid name] Check Box: Initial Conditions

Most of the fluid-specific initial condition settings are described in this section as they appear in the non-fluid specific initial condition section in the case of a single-fluid simulation. Those that are not are described here.

15.1.2.17.1. Velocity Type

The velocity type can be either Cartesian or Cylindrical. For details, see Velocity Type in the CFX-Solver Modeling Guide.

15.1.2.17.2. Volume Fraction: Option

- Automatic

  The initial volume fraction field is loaded from an initial values file, if one is available. If an initial values file is not available, the initial volume fraction field is computed from built-in algorithms.

- Automatic with Value

  The initial volume fraction field is loaded from an initial values file if one is available. If an initial values file is not available, the initial volume fraction field is set to user-specified values.

15.1.2.17.3. Volume Fraction: Volume Fraction

Enter a numerical quantity or CEL expression that specifies the value of the volume fraction throughout the domain. For details, see Initial Conditions for a Multiphase Simulation in the CFX-Solver Modeling Guide.

15.1.2.18. Solid Specific Initialization

(applies only when there are solids in porous domains)

The solid-specific initialization settings are grouped together, either in the Solid Specific Initialization section or, in the case of global initialization, on the Solid Settings tab.

15.1.2.19. Solid Specific Initialization: List Box

This list box is used to select a solid in order to set its solid-specific initialization options.

15.1.2.20. Solid Specific Initialization: [solid name] Check Box

This check box determines whether or not the initialization options for the indicated solid are specified explicitly or are left at default values.
Chapter 16: Source Points

Source points are sources that act on a single mesh element. The location of the point is entered in Cartesian coordinates, and the source is created for the element whose center is closest to the specified point. Source points appear as red spheres in the Viewer. For a transient run or run with a moving mesh, the closest element is identified once at the start and is used for the remainder of the run.

This chapter describes:

- 16.1. Basic Settings Tab
- 16.2. Sources Tab
- 16.3. Fluid Sources Tab
- 16.4. Sources in Solid Domains
- 16.5. Source Points and Mesh Deformation

Sources are specified in a way similar to subdomain sources with the exceptions that momentum and radiation sources cannot be specified and only "Total Source" values can be entered. For details, see Subdomains (p. 181).

The visibility of source points can be turned on and off using the check box in the tree view. For details, see Object Visibility (p. 18) and Outline Tree View (p. 5).

Additional information on sources is available in Sources in the CFX-Solver Modeling Guide.

16.1. Basic Settings Tab

The Basic Settings tab defines the coordinate frame and the point coordinates for the source point.

1. Enter Cartesian Coordinates for the source point.
   - Points entered are relative to the selected coordinate frame.
2. Use the default coordinate frame or a user-specified coordinate frame. For details, see:
   - Coordinate Frames in the CFX-Solver Modeling Guide
   - Coordinate Frame Basic Settings Tab (p. 255).

The default coordinate frame, Coord 0, will be used as the basis for the entered Cartesian coordinates, unless you have created your own coordinate frame and have selected it from the drop-down list.

16.2. Sources Tab

The point sources that can be set depend on the physical models used in the simulation. Sources of mass (continuity), energy, radiation, Additional Variables, component mass fractions, and turbulence are all possible.

16.2.1. Single-Phase Fluid Sources

1. Select the Sources check box to specify sources for the point.
2. Select the equation source to specify.

   Equation sources include other sources such as mass fraction, energy, continuity (mass), turbulence, Additional Variables, and so on. For details, see Source Coefficient / Total Source Coefficient in the CFX-Solver Modeling Guide.

3. Select the Continuity check box to set sources for the continuity equation.

   For details, see Mass (Continuity) Sources in the CFX-Solver Modeling Guide.

Additional information is available in:
- Sources in the CFX-Solver Modeling Guide
- General Sources in the CFX-Solver Modeling Guide.

16.2.1.1. Component Mass Fractions

   This is only available when mixtures are included in the fluids list in the domain. You can specify a Total Source and an optional Total Source Coefficient for improved convergence for strongly varying sources. For details, see General Sources in the CFX-Solver Modeling Guide.

16.2.1.2. Additional Variables

   Set the Total Source for the Additional Variable and an optional Total Source Coefficient. A source for an Additional Variable can be set only if it is solved for.

16.2.1.3. Continuity

   Continuity sources differ from other sources because you are introducing new fluid into the domain. Properties that are required of the fluid, which is entering the domain, appear in the Variables section of the form. These values are not used if the source is negative, because no new fluid is introduced into the subdomain. For details, see Mass (Continuity) Sources in the CFX-Solver Modeling Guide.

16.2.1.3.1. Continuity Option

   The value of the mass source is set using the Total Fluid Mass Source option. For details, see Mass (Continuity) Sources in the CFX-Solver Modeling Guide.

16.2.1.3.2. Additional Variables

   Set a value for any Additional Variables that are introduced with the mass source. For details, see Mass (Continuity) Sources in the CFX-Solver Modeling Guide.

16.2.1.3.3. Component Mass Fractions

   Enter mass fractions of each of the components in the mass source. For details, see Mass (Continuity) Sources in the CFX-Solver Modeling Guide.

16.2.1.3.4. Temperature

   Enter the temperature for the mass source.
16.2.1.3.5. Velocity

Set velocity components for the mass source.

16.2.1.4. Energy

A total source for the energy equation can be set. The optional Total Source Coefficient provides improved convergence for strongly varying sources. An energy source can set specified when the parent domain models heat transfer using the thermal energy or total energy models.

16.2.1.5. Turbulence Eddy Dissipation or Turbulence Kinetic Energy

When the flow is turbulent, a total source for the Turbulence Eddy Dissipation or Turbulence Kinetic Energy can specified. The optional Total Source Coefficient provides improved convergence for strongly varying sources. For details, see General Sources in the CFX-Solver Modeling Guide.

16.2.2. Multiphase Bulk Sources

In a multiphase simulation, source terms that apply to all fluids in the simulation are set on the Sources tab. Bulk sources take account of the volume fraction of each phase when applying the source term. For details, see Bulk Sources in the CFX-Solver Modeling Guide.

- Select Bulk Sources to specify bulk sources. Bulk sources apply to all fluids in a multiphase simulation.

16.2.3. Multiplying Sources by Porosity

Selecting the Multiply by Porosity check box causes the equation source to be scaled by the porosity value. For example, if a porous domain has a volume porosity of 0.8, then if the Multiply by Porosity check box is selected, 80% of the source is applied to the fluid; if the check box is not selected then 100% of the source is applied to the fluid.

16.3. Fluid Sources Tab

Fluid sources can be set when more than one fluid is selected. The options depend on the type of simulation you are running, and whether bulk sources are used.

1. Select the fluid from the Fluid Specific Source Point Sources list
2. Select the check box next to the selected variable to enter a source, then select the Continuity check box.
3. Enter a value for Total Source.
4. Optionally, enter a total mass source coefficient for either pressure or volume fraction.
   - For details, see Source Coefficient / Total Source Coefficient in the CFX-Solver Modeling Guide.
5. Set the values for the continuity equation.
   - For details, see Mass (Continuity) Sources in the CFX-Solver Modeling Guide.

16.4. Sources in Solid Domains

Source points can exist in solid domains to provide sources of thermal energy and radiation.

- Select Energy to enable an energy source.
16.5. Source Points and Mesh Deformation

When mesh deformation is selected, the volume element whose centroid is closest to the source point at the beginning of the simulation will move with the mesh (if that part of the mesh is deforming). The location of the point source will, therefore, move as the mesh deforms. For details, see *Mesh Deformation* (p. 113).
Chapter 17: Subdomains

A subdomain is a 3D region within a predefined domain that can be used to specify values for volumetric sources. Fluid or porous subdomains (that is, when the parent domain is of type Fluid) allow sources of energy, mass, momentum, radiation, Additional Variables, components, and turbulence to be specified. Solid subdomains allow only sources of energy and radiation to be set.

This chapter describes:

- Creating New Subdomains (p. 181)
- The Subdomains Tab (p. 182)
- Basic Settings Tab (p. 182)
- Sources Tab (p. 182)
- Fluids Tab (p. 185)
- Mesh Motion (p. 185)

A domain must be created before a subdomain can be created. The location of a subdomain must be a 3D region that is part of a single parent domain. 3D primitives are implicitly included in a parent domain if 3D composites or assemblies are used in the domain location. A subdomain cannot span more than one domain, but you can create many subdomains in each domain. You should consider subdomain requirements when you generate a mesh, because subdomains must be created on existing 3D regions. Definitions for primitive and composite regions are available in *Mesh Topology in CFX-Pre* (p. 91).

Additional information on the physical interpretation of subdomain sources and modeling advice is available, as well as additional information on the mathematical implementation of sources, is available in *Sources in the CFX-Solver Modeling Guide*.

The CFX Expression Language (CEL) can be used to define sources by creating functions of any CFX System Variables. For details, see *CEL Operators, Constants, and Expressions in the CFX Reference Guide*.

17.1. Creating New Subdomains

New subdomains are created by selecting **Insert > Sub Domain** from the main menu or by clicking **Subdomain** on the main toolbar. Note that creation of subdomains from the main menu or toolbar may subsequently require selection of the appropriate analysis type and domain. Subdomains can also be created by right-clicking the appropriate domain in the **Outline** view.

1. Enter a new name using the syntax described below or pick an existing subdomain to edit.
2. Select the parent domain for the subdomain.

Additional information on valid names is available in *Valid Syntax for Named Objects* (p. 55). You can also edit an existing subdomain by selecting its name from the drop-down list. Existing subdomains can also be edited from the **Outline** view using the usual methods; for details, see *Outline Tree View* (p. 5).
17.2. The Subdomains Tab

After entering a name for the subdomain, or selecting the subdomain to edit, the subdomain details view will be displayed. This contains two tabs, Basic Settings and Sources, that are accessed by selecting the tabs located across the top. You should complete each tab in turn, proceeding from left to right.

**Note**

Fluid sources are on their own tab.

- **Basic Settings**: Sets the location and the coordinate frame for the subdomain. For details, see Basic Settings Tab (p. 182).
- **Sources**: Defines volumetric source terms in the subdomain for single-phase simulations, or volumetric source terms that apply to all fluids in a multiphase simulation. For details, see Sources Tab (p. 182).
- **Fluid Sources**: Defines volumetric source terms that apply to individual fluid in a multiphase simulation.

17.3. Basic Settings Tab

The following settings are required on the Basic Settings tab.

- **Location** (p. 182)
- **Coordinate Frame** (p. 182)

17.3.1. Location

Select the region name that the subdomain will occupy. The location can be defined as multiple regions, assemblies and/or user 3D Regions. For details, see Mesh Topology in CFX-Pre (p. 91).

17.3.2. Coordinate Frame

By default, Coordinate Frame is set to Coord 0. You may use alternative coordinate frames. To create a new coordinate frame, select Insert > Coordinate Frame from the main menu. For details, see:

- Coordinate Frames (p. 255)
- Coordinate Frames in the CFX-Solver Modeling Guide.

17.4. Sources Tab

The volumetric sources that can be set in a subdomain depend on the physical models used in the simulation. Sources of mass (continuity), momentum, energy, radiation, Additional Variables, component mass fractions, and turbulence are all possible.

17.4.1. Single-Phase Fluid Sources

In a single-phase simulation, the volumetric or total source terms are set on the Sources tab. For details, see Sources in the CFX-Solver Modeling Guide.

1. Select the Sources check box to specify sources for the subdomain.
2. Select the Momentum Source/Porous Loss check box to specify a momentum source.
For details, see *Momentum Source/Porous Loss* (p. 183).

3. Select the equation source to specify.

Equation sources include other sources such as mass fraction, energy, continuity (mass), turbulence, Additional Variables, and so on. For details, see:

- *Equation Sources* (p. 183)
- *Source Coefficient / Total Source Coefficient in the CFX-Solver Modeling Guide*.

### 17.4.1.1. Momentum Source/Porous Loss

A source of momentum is introduced by setting X, Y, and Z, or r, Theta and Axial components for the momentum source under **General Momentum Source**. All three components must be set if a general momentum source is defined. You can optionally specify a **Momentum Source Coefficient** to aid convergence. When employing a cylindrical coordinate frame, you must specify an axis using a rotation axis or two points.

In addition to specifying a general source of momentum, you can model porous loss in a flow using an isotropic or directional loss model. In each case, the loss is specified using either linear and quadratic coefficients, or permeability and loss coefficients. For the **Directional Loss** model, the loss in the transverse direction can be set using the **Loss Coefficient**, which multiplies the streamwise loss by the entered factor. When using the **Directional Loss** model, you must supply a streamwise direction. The direction can be specified with Cartesian or cylindrical coordinates. If you choose cylindrical coordinates, specify the axis using a rotation axis or two points.

For additional details on modeling momentum sources, see *Momentum Sources in the CFX-Solver Modeling Guide*.

### 17.4.1.2. Equation Sources

**Equation Sources** introduces source terms to a particular scalar equation.

#### 17.4.1.2.1. Component Mass Fractions

This will introduce a source of a particular component. A **Source per unit volume** or a **Total Source** can be used. The optional **Source Coefficient** or **Total Source Coefficient** provides improved convergence for nonlinear sources. For details, see *General Sources in the CFX-Solver Modeling Guide*.

1. In the **Option** and **Source** fields, set a component source term for a mixture.

   This can be an expression or value for the total source or the source per unit volume. For details, see *General Sources in the CFX-Solver Modeling Guide*.

2. Set an optional **Total Source / Source Coefficient**.

   For details, see *Source Coefficient / Total Source Coefficient in the CFX-Solver Modeling Guide*.

#### 17.4.1.2.2. Additional Variables

A source for an Additional Variable can be set only if it is included in the parent domain and solved for using a transport equation. (Poisson and Diffusive transports can also have sources.) A **Source per unit volume** or a **Total Source** can be used. The optional **Source Coefficient** or **Total Source Coefficient**
provides improved convergence for nonlinear sources. For details, see General Sources in the CFX-Solver Modeling Guide.

1. In the Option and Source fields, set an Additional Variable Source term.
   For details, see General Sources in the CFX-Solver Modeling Guide.

2. Set an optional Total Source / Source Coefficient.
   For details, see Source Coefficient / Total Source Coefficient in the CFX-Solver Modeling Guide.

17.4.1.2.3. Continuity

Continuity sources differ from other sources because you are introducing new fluid into the domain. Properties of the fluid entering the domain are required and appear in the Variables frame under the Continuity section. For details on the following settings, see Mass (Continuity) Sources in the CFX-Solver Modeling Guide.

- Continuity > Source: Set a mass source value for the continuity equation.
- Continuity > Option: Set the Fluid Mass Source per unit volume or the Total Fluid Mass Source.
- MCF/Energy Sink Option: Select the appropriate sink option from Local Mass Fractions and Temperature, Specified Mass Fractions and Local Temperature, or Specified Mass Fractions and Temperature, as appropriate.
- Set a value for the Mass Flux Pressure Coefficient, Total Mass Source Pressure Coefficient or Mass Source Pressure Coefficient, as appropriate.
- Set a value for the Mass Flux Volume Fraction Coefficient, Total Mass Source Volume Fraction Coefficient or Mass Source Volume Fraction Coefficient, as appropriate.
- Set the variable values for the fluid that is introduced into the domain. The options available on this section depend on the physical models used in the simulation. If the continuity source is negative, then these parameters are not relevant except in the case when either Specified Mass Fractions and Local Temperature, or Specified Mass Fractions and Temperature have been selected for the MCF/Energy Sink Option.
  - Additional Variables: Set a value for each Additional Variables that is introduced with the mass source.
  - Component Mass Fractions: Set the mass fraction for each of the components in the mass source.
  - Temperature: Enter the temperature for the mass source.
  - Set the mass source turbulence quantities as required by the selected turbulence model such as Turbulence Eddy Dissipation and Turbulence Kinetic Energy.
  - Velocity: Set velocity components for the mass source.

17.4.1.2.4. Turbulence Quantities

When the flow is turbulent, sources can be specified for the required turbulence quantities such as Turbulence Eddy Dissipation and Turbulence Kinetic Energy. A Source per unit volume or a Total Source can be used. The optional Source Coefficient or Total Source Coefficient provides improved convergence for nonlinear sources. For details, see General Sources in the CFX-Solver Modeling Guide.
17.4.1.2.5. Energy

An Energy source can be specified when the parent domain models heat transfer using the Thermal Energy or Total Energy model. A Source per unit volume or a Total Source can be used. The optional Source Coefficient or Total Source Coefficient provides improved convergence for nonlinear sources. For details, see General Sources in the CFX-Solver Modeling Guide.

17.4.2. Bulk Sources for Multiphase Simulations

In a multiphase simulation, source terms that apply to all fluid in the simulation are set on the Sources tab. Bulk sources take account of the volume fraction of each phase when applying the source term. For details, see Bulk Sources in the CFX-Solver Modeling Guide.

1. Select the Bulk Sources check box to specify bulk sources.
2. Sources are set in the same way as for single phase simulations. For details, see Single-Phase Fluid Sources (p. 182).

17.4.3. Multiplying Sources by Porosity

Selecting the Multiply by Porosity check box causes the equation source to be scaled by the porosity value. For example, if a porous domain has a volume porosity of 0.8, then if the Multiply by Porosity check box is selected, 80% of the source is applied to the fluid; if the check box is not selected then 100% of the source is applied to the fluid.

17.5. Fluids Tab

Fluid sources are used in an Eulerian multiphase simulation to apply volumetric source terms to individual fluids, and in particle transport to model absorption of particles in the subdomain. For details, see Particle Absorption (p. 185).

1. Select a fluid from the Fluid list to set fluid-specific sources.
2. Toggle on the check box next to the fluid to expand the options.
3. Sources are set in the same way as for single phase simulations. For details, see Single-Phase Fluid Sources (p. 182).

It is important to note that these source terms are not automatically multiplied by the fluid volume fraction (that is, do not automatically reduce to zero as the volume fraction goes to zero). For details, see Fluid-Specific Sources in the CFX-Solver Modeling Guide.

17.5.1. Particle Absorption

This setting is available when particle tracking is modeled. For details, see Subdomains in the CFX-Solver Modeling Guide.

1. Select a particle type to activate particle absorption.
2. Set the absorption diameter to the desired value.

17.6. Mesh Motion

When mesh deformation is selected for the domain that contains a subdomain, the Mesh Motion tab is available for the subdomain.
The available options are:

- Unspecified
- Stationary
- Specified Displacement
- Specified Location
- Rigid Body Solution

For details on these options, see Mesh Motion Options in the CFX-Solver Modeling Guide.

For details on mesh deformation, see Mesh Deformation in the CFX-Solver Modeling Guide.

See Mesh Deformation (p. 113) for information about activating mesh deformation for the domain.
Chapter 18: Rigid Bodies

This chapter describes:

18.1. Rigid Body User Interface

A rigid body is a solid object that moves through a fluid without deforming. Its motion is dictated by the fluid forces and torques acting upon it, plus any external forces (such as gravity) and external torques. Within ANSYS CFX, a rigid body can be modeled in two ways:

- A rigid body can be defined by a collection of 2D regions that form its faces. When a rigid body is modeled in this way, the rigid body itself does not need to be meshed. Mesh motion is used to move the mesh on the rigid body faces in accordance with the solution of the rigid body equations of motion.
- Alternatively, an immersed solid can be defined as a rigid body. In this case the motion of the immersed solid is dictated by the solution of the rigid body equations of motion.

Implementation information for Rigid Bodies is available in Rigid Body Theory in the CFX-Solver Theory Guide.

18.1. Rigid Body User Interface

The user interface for setting up a rigid body defined as a collection of 2D regions is presented in the following sections:

- 18.1.1. Insert Rigid Body Dialog Box
- 18.1.2. Basic Settings Tab
- 18.1.3. Dynamics Tab
- 18.1.4. Initial Conditions Tab

The user interface for setting up a rigid body implemented as an immersed solid consists of rigid body settings found on the Basic Settings tab for the immersed solid domain. These settings are essentially the same as those on the Basic Settings and Dynamics tabs in the details view for the rigid body object.

18.1.1. Insert Rigid Body Dialog Box

Use this method to simulate a rigid body by using a collection of 2D regions.

The Insert Rigid Body dialog box is used to initiate the creation of a new rigid body object. It is accessible by clicking Rigid Body, or by selecting Insert > Rigid Body.
Note

Another way to simulate a rigid body is by using an immersed solid that uses a Domain Motion option of Rigid Body Solution. In this case, the rigid body settings appear in the details view for the immersed solid domain. All of the rigid body settings for an immersed solid appear on the Basic Settings tab for the immersed solid domain. The analogous settings for the rigid body object are distributed between the Basic Settings and Dynamics tabs of the rigid body object. Although there are initialization settings on the Initialization tab of the rigid body object, there are no corresponding initialization settings for a rigid body defined as an immersed solid.

Immersed solids are described in Immerged Solids in the CFX-Solver Modeling Guide.

18.1.2. Basic Settings Tab

The Basic Settings tab for the rigid body object has the following settings:

18.1.2.1. Mass

Specify the mass of the rigid body. The mass is used in the calculation of translational acceleration due to applied forces. It is also used in combination with the specified gravity vector (the gravity vector specified with the rigid body, not with any buoyancy model) to calculate the force due to gravity. For details, see Gravity (p. 191).

The force due to gravity acts through the specified center of mass. For details, see Center of Mass (p. 192).

18.1.2.2. Location

Specify all 2D regions (belonging to fluid domains) that physically contact the faces of the rigid body. The forces and torques exerted by the fluid on all of these faces will contribute to the motion of the rigid body. Note that if the rigid body is defined as an immersed solid, then the location is automatically just the location of the immersed solid, and no further location setting is required.

To have these faces move automatically in accordance with the rigid body solution, you must also specify that these faces have mesh motion provided by the rigid body solution. To do this, use the Boundary Details tab in the details view for the boundary containing the faces. Additional faces or mesh elements, which do not form part of the rigid body, can also have their mesh motion partially or wholly specified by the rigid body solution. To do this, use the Boundary Details tab for boundaries and the Mesh Motion tab for subdomains. Applying the rigid body solution to additional faces or mesh elements could be used, for example, to help control the way the mesh distorts as the rigid body moves.

18.1.2.3. Coord Frame

You should specify a stationary coordinate frame that has its origin at the center of mass of the (physical) rigid body when the body is in its position at the start of the simulation. The coordinate frame you specify must have the same orientation as the axes used to define the mass moment of inertia of the body in its initial position (see Mass Moment of Inertia (p. 189)). In this documentation, this coordinate frame is referred to as the rigid body coordinate frame. The position and orientation of the rigid body are always calculated relative to this coordinate frame, and all other settings for the rigid body object (for example, gravity and degrees of freedom) are with respect to this coordinate frame, unless otherwise specified in this documentation.
If you choose a coordinate frame that does not have the position of the rigid body at the start of the simulation, then you must specify an initial position for the rigid body (on the **Initial Conditions** tab) that corresponds to the translation required to move the coordinate frame into the rigid body's initial position. See **Initial Conditions Tab** (p. 191) for more information. Note that initial conditions settings are not currently available for rigid bodies defined as immersed solids.

### 18.1.2.4. Mass Moment of Inertia

Specify absolute values of the components of the mass moment of inertia for the rigid body with respect to a coordinate frame that:

- Has the same initial orientation as the rigid body coordinate frame
- Has its origin at the rigid body center of mass
- Moves rigidly with the rigid body.

The mass moment of inertia components are used to define the mass moment of inertia matrix described in **Rotational Equations of Motion in the CFX-Solver Theory Guide**.

For example, **YY Component** is defined as:

\[
\int \left( (x - x_G)^2 + (z - z_G)^2 \right) \, dm
\]

and **XY Component** is defined as:

\[
\int (x - x_G) (y - y_G) \, dm
\]

where the center of mass is given by \((x_G, y_G, z_G)\), and \(dm\) is a differential element of mass.

### 18.1.3. Dynamics Tab

The **Dynamics** tab for the rigid body object contains settings for the following items that influence the motion of the rigid body:

- External forces
- External torques
- Degrees of freedom of movement
- Gravity vector.

With the exception of **Rotational Degrees of Freedom** all dynamics settings are in comparison to the rigid body coordinate frame.

The **Dynamics** tab has the following settings:

#### 18.1.3.1. External Force Definitions

External forces other than gravity are specified in the **External Force Definitions** frame. Use the **Add new item** and **Remove selected item** icons to add or remove external force definitions from the list.
Each external force definition has one of the following options:

- **None**
  
  This setting deactivates the external force.

- **Spring**
  
  These settings enable you to set up a spring force that is applied to the rigid body. Specify the neutral position with respect to the rigid body coordinate frame via the **Linear Spring Origin** settings. Whenever the center of mass of the rigid body is at the **Linear Spring Origin**, the applied spring force is zero. The spring force develops as the center of mass of the rigid body moves away from the neutral position, with a force-to-displacement ratio specified by the **Linear Spring Constant**. For details on how the center of mass is located, see *Center of Mass* (p. 192).

- **Value**
  
  These settings enable you to specify an external force using Cartesian force components (along the principal axes of the rigid body coordinate frame).

The external forces are applied through the center of mass of the rigid body so that they cause translational accelerations only (and not any rotational accelerations).

### 18.1.3.2. External Torque Definitions

External torques are specified in the **External Torque Definitions** frame (in the details view). Use the **Add new item** and **Remove selected item** icons to add or remove external torque definitions from the list.

Each external torque definition has one of the following options:

- **None**
  
  This setting deactivates the external torque.

- **Spring**
  
  These settings enable you to set up a spring torque that is applied to the rigid body. Specify the neutral orientation (with respect to the rigid body coordinate frame) via the **Equilibrium Orientation** settings. You define the orientation using three angular displacements (specifically, Euler angles), which are applied by the software using the ZYX convention:

  - The **Euler Angle Z** setting modifies the orientation by a rotation about the Z-axis (using the right-hand rule to determine the direction).
  
  - The **Euler Angle Y** setting then further modifies the orientation by a rotation about the (modified) Y-axis (using the right-hand rule to determine the direction).

  - The **Euler Angle X** setting then further modifies the orientation by a rotation about the (twice modified) X-axis (using the right-hand rule to determine the direction).

These Euler angles are described in more detail in *Rigid Body Motion in the CFX-Solver Modeling Guide*.

Whenever the orientation of the rigid body matches that specified by the **Equilibrium Orientation** settings, the applied spring torque is zero. The spring torque develops as the rigid body rotates.
away from the neutral orientation, with a torque-to-angular-displacement ratio specified by the **Torsional Spring Constant** settings.

The torque develops due to changes in Euler angles, but is applied on the corresponding axes of the rigid body coordinate frame. The torque spring implementation described here is recommended for use only when both the equilibrium orientation and the rigid body orientation can be described with small Euler angles (a few degrees).

- **Value**

These settings enable you to specify an external torque using Cartesian torque components around the principal axes of the rigid body coordinate frame.

### 18.1.3.3. Degrees of Freedom

#### 18.1.3.3.1. Translational Degrees of Freedom

This setting determines the combination of axes along which the rigid body may translate. In this context, the axes are those of the rigid body coordinate frame.

#### 18.1.3.3.2. Rotational Degrees of Freedom

This setting determines the axes about which the rigid body may rotate. In this context, the axes are of a coordinate frame that:

- Has the same initial orientation as the rigid body coordinate frame
- Has its origin at the rigid body center of mass
- Moves rigidly with the rigid body.

### 18.1.3.4. Gravity

Specify a gravity vector in the rigid body coordinate frame that defines the downward direction and the magnitude of free-fall acceleration due to gravity.

### 18.1.4. Initial Conditions Tab

The **Initial Conditions** tab contains settings for initializing the rigid body solver. These settings are described in the following subsections.

---

**Note**

These settings are not available for rigid bodies defined as immersed solids.

---

**Note**

For the settings on the **Initial Conditions** tab, the **Automatic** option provides initial values of zero, and the **Automatic with Value** option provides initial values as specified. In both cases, the values used at the beginning of a **restarted** run are taken from the results of the previous run. When you restart a run, select **Continue History From** and choose initial values from the previous results. To access this option, you should be in the **Define Run** dialog box of CFX-Solver Manager and both **Initial Values Specification** and **Continue History From** must be selected.
18.1.4.1. Center of Mass

These settings define the location (in the rigid body coordinate frame) of the center of mass of the rigid body at the start of the simulation. These settings should be set with non-zero values only if the origin of the rigid body coordinate frame is not at the center of mass of the rigid body at the start of the simulation. If non-zero values are required, then they represent the translation from the origin of the rigid body coordinate frame to the position of the rigid body center of mass at the start of the simulation.

**Note**

Setting non-zero values for the Center of Mass settings does not impose a mesh motion at the start of the simulation; rather, the initial position of the mesh is assumed to represent the physical location of the rigid body at the start of the simulation.

**Note**

It is recommended that you define a rigid body coordinate frame that has its origin located at the initial center of mass of the rigid body (that is, the center of mass of the rigid body as positioned in the initial mesh). You could then set all the Center of Mass settings on the Initial Conditions tab to zero (or select the Automatic option to set the initial values to zero automatically).

18.1.4.2. Linear Velocity

These settings initialize the translational velocity of the rigid body in the rigid body coordinate frame. The velocity components are taken as being along the principal axes of the rigid body coordinate frame.

18.1.4.3. Angular Velocity

These settings initialize the angular velocity of the rigid body in the rigid body coordinate frame. The angular velocity components are taken as being about the principal axes of the rigid body coordinate frame, using the right-hand rule to establish direction.

18.1.4.4. Linear Acceleration

These settings initialize the translational acceleration of the rigid body in the rigid body coordinate frame. The acceleration components are taken as being along the principal axes of the rigid body coordinate frame.

18.1.4.5. Angular Acceleration

These settings initialize the angular acceleration of the rigid body in the rigid body coordinate frame. The angular acceleration components are taken as being about the principal axes of the rigid body coordinate frame, using the right-hand rule to establish direction.
Chapter 19: Units and Dimensions

This chapter describes:

19.1. Units Syntax
19.2. Using Units in CFX-Pre
19.3. Setting the Solution Units

19.1. Units Syntax

Dimensional quantities are defined in units or a combination of units. For example, mass can have units of [kg], [g] or [lb] (and many others); pressure can have units of [atm], [N m^-2] and [Pa] (and many others).

The general units syntax in CFX is defined as [multiplier|unit|^power] where multiplier is a multiplying quantity (such as mega, pico, centi, and so on), unit is the unit string (kg, m, J, and so on), and power is the power to which the unit is raised. When typing units in expression, they must be enclosed by square brackets, [...]. You will usually not see the brackets when selecting units from a list of commonly used units. In general, units declarations must obey the following rules:

- A units string consists of one or more units quantities, each with an optional multiplier and optional power. Each separate units quantity is separated by one or more spaces.
- Short forms of the multiplier are usually used. n stands for nano, µ stands for micro, c for centi, k for kilo, m for milli, M for mega and G for giga.
- Powers are denoted by the ^ (caret) symbol. A power of 1 is assumed if no power is given.

Note

The / operator is not supported, so a negative power is used for unit division (for example, [kg m^-3] corresponds to kilograms per cubic meter).

- If you enter units that are inconsistent with the physical quantity being described, then a dialog box will appear informing you of the error, and the units will revert to the previous units.
- Units do not have to be given in terms of the fundamental units (mass, length, time, temperature, angle and solid angle). For instance, Pa (Pascals) and J (Joules) are both acceptable as parts of unit strings.
- Units strings are case sensitive; for example, Kg and KG are both invalid parts of units strings.

To give the units of dynamic viscosity, which has the dimensions of Mass Length^-1 Time^-1, the unit string [kg m^-1 s^-1] (or [lb ft^-1 hr^-1]) is valid.
Note

The following unit strings are invalid:

- \([\text{kg/(metre sec)}]\)  \(\text{[kg/(ms)]}\)
- \([\text{kg/m/s}]\)  \(\text{[kg/(m.s)]}\)
- \([\text{kg/(m s)}]\)  \(\text{[kg/(m*s)]}\)
- \([\text{kg/(m sec)}]\)  \(\text{[lb/(ft hr)]}\)

19.2. Using Units in CFX-Pre

There are a number of Details views in CFX-Pre that require the entry of physical quantities. For example, when you set the physical properties for a fluid, or enter values for boundary conditions, the units in which you input the data must be selected.

A list of possible units for the quantity of interest is provided, but you may want to use an expression for the quantity, in which case you must specify the units. You can use any units that are consistent with the quantity you are describing. The default units in CFX-Pre are SI.

The units selector is automatically filled in using the default units for the quantity. You can select other commonly used units for that quantity from the drop-down list in the units selector.

19.2.1. Units Commonly Used in CFX

CFX-Pre provides you with a choice of several commonly used units to ease the task of specifying quantities and converting results.

The full list of quantities where commonly used units are available is given in the following table:

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Commonly used units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>([\text{m s}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{km hr}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{mile hr}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{ft s}^{-1}, \text{knot}])</td>
</tr>
<tr>
<td>Volumetric Flow</td>
<td>([\text{m}^3 \text{s}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{litre s}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{gallon hr}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{gallonUSliquid hr}^{-1}])</td>
</tr>
<tr>
<td>Mass Flow</td>
<td>([\text{kg s}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{tonne s}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{lb s}^{-1}])</td>
</tr>
<tr>
<td>Quantity</td>
<td>Commonly used units</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>k (turbulence kinetic energy)</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
</tr>
<tr>
<td></td>
<td>([\text{J kg}^{-1}])</td>
</tr>
<tr>
<td>Epsilon (turbulence dissipation rate)</td>
<td>([\text{m}^2 \text{s}^{-3}])</td>
</tr>
<tr>
<td></td>
<td>([\text{J kg}^{-1} \text{s}^{-1}])</td>
</tr>
<tr>
<td>Pressure</td>
<td>([\text{Pa}])</td>
</tr>
<tr>
<td></td>
<td>([\text{N m}^{-2}])</td>
</tr>
<tr>
<td></td>
<td>([\text{bar}])</td>
</tr>
<tr>
<td></td>
<td>([\text{torr}])</td>
</tr>
<tr>
<td></td>
<td>([\text{mm Hg}])</td>
</tr>
<tr>
<td></td>
<td>([\text{psi}])</td>
</tr>
<tr>
<td></td>
<td>([\text{psf}])</td>
</tr>
<tr>
<td>Concentration</td>
<td>([\text{m}^{-3}])</td>
</tr>
<tr>
<td></td>
<td>([\text{litre}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{foot}^{-3}])</td>
</tr>
<tr>
<td>Dynamic Viscosity</td>
<td>([\text{kg m}^{-1} \text{s}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{centipoise}])</td>
</tr>
<tr>
<td></td>
<td>([\text{g cm}^{-1} \text{s}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{N s m}^{-2}])</td>
</tr>
<tr>
<td></td>
<td>([\text{Pa s}])</td>
</tr>
<tr>
<td></td>
<td>([\text{dyne s cm}^{-2}])</td>
</tr>
<tr>
<td></td>
<td>([\text{lb ft}^{-1} \text{hr}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{lbf s ft}^{-2}])</td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>([\text{W m}^{-1} \text{K}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{cal cm}^{-1} \text{s}^{-1} \text{K}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{BTU (ft}^{2} \text{s (F/ft)}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{BTU (ft}^{2} \text{hr (F/ft)}^{-1}])</td>
</tr>
<tr>
<td>Specific Heat Capacity</td>
<td>([\text{J kg}^{-1} \text{K}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{cal g}^{-1} \text{K}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{J g}^{-1} \text{K}^{-1}])</td>
</tr>
<tr>
<td></td>
<td>([\text{BTU lb}^{-1} \text{F}^{-1}])</td>
</tr>
<tr>
<td>Quantity</td>
<td>Commonly used units</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Thermal Expansivity</td>
<td>[K&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Kinematic Diffusivity</td>
<td>[m&lt;sup&gt;2&lt;/sup&gt; s&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[cm&lt;sup&gt;2&lt;/sup&gt; s&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Acceleration</td>
<td>[m s&lt;sup&gt;-2&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[ft s&lt;sup&gt;-2&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Temperature</td>
<td>[K]</td>
</tr>
<tr>
<td></td>
<td>[C]</td>
</tr>
<tr>
<td></td>
<td>[R]</td>
</tr>
<tr>
<td></td>
<td>[F]</td>
</tr>
<tr>
<td>Density</td>
<td>[kg m&lt;sup&gt;-3&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[g cm&lt;sup&gt;-3&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[lb ft&lt;sup&gt;-3&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Mass Concentration</td>
<td>[kg m&lt;sup&gt;-3&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[g l&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Mass Fraction</td>
<td>[kg kg&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[g kg&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Length</td>
<td>[m]</td>
</tr>
<tr>
<td></td>
<td>[mm]</td>
</tr>
<tr>
<td></td>
<td>[foot]</td>
</tr>
<tr>
<td></td>
<td>[in]</td>
</tr>
<tr>
<td>Mass Flow in</td>
<td>[kg s&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[tonne s&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[lb s&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Volumetric Flow in</td>
<td>[m&lt;sup&gt;3&lt;/sup&gt; s&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[litre s&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[gallon hr&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td></td>
<td>[gallonUSliquid hr&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Heat Transfer Coefficient</td>
<td>[W m&lt;sup&gt;-2&lt;/sup&gt; K&lt;sup&gt;-1&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Heat Flux in</td>
<td>[W m&lt;sup&gt;-2&lt;/sup&gt;]</td>
</tr>
<tr>
<td>Time</td>
<td>[s]</td>
</tr>
<tr>
<td></td>
<td>[min]</td>
</tr>
<tr>
<td>Quantity</td>
<td>Commonly used units</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>Shear Strain rate</td>
<td>[s^-1]</td>
</tr>
<tr>
<td>Energy Source</td>
<td>[W m^-3]</td>
</tr>
<tr>
<td></td>
<td>[kg m^-1 s^-3]</td>
</tr>
<tr>
<td>Energy Source Coefficient</td>
<td>[W m^-3 K^-1]</td>
</tr>
<tr>
<td></td>
<td>[kg m^-1 s^-3 K^-1]</td>
</tr>
<tr>
<td>Momentum Source</td>
<td>[kg m^-2 s^-2]</td>
</tr>
<tr>
<td>Momentum Source Lin. Coeff.</td>
<td>[kg m^-3 s]</td>
</tr>
<tr>
<td>Momentum Source Quad. Coeff.</td>
<td>[kg m^-4]</td>
</tr>
<tr>
<td>Per Time</td>
<td>[s^-1]</td>
</tr>
<tr>
<td>Angle</td>
<td>[radian]</td>
</tr>
<tr>
<td></td>
<td>[degree]</td>
</tr>
<tr>
<td>Angular Velocity</td>
<td>[radian s^-1]</td>
</tr>
<tr>
<td></td>
<td>[rev min^-1]</td>
</tr>
<tr>
<td>Specific Enthalpy</td>
<td>[J kg^-1]</td>
</tr>
<tr>
<td></td>
<td>[m^2 s^-2]</td>
</tr>
<tr>
<td>Energy</td>
<td>[J]</td>
</tr>
</tbody>
</table>

### 19.2.2. Defining Your Own Units

The commonly used units array is only a subset of the possible units you can use in CFX-Pre. Each unit is a combination of one or more base dimensions. To specify your own units for a quantity, click the **Enter Expression** icon 📊 for the associated variable and type the value and units into the data area using the syntax. For details, see *Units Syntax* (p. 193).

There are many base units to choose from; most units in common use are valid as parts of unit strings. You can specify any quantity in any valid units as long as you adhere to the units definition syntax.

### 19.3. Setting the Solution Units

There are two sets of units in CFX-Pre: the units visible when selecting **Edit > Options** from the main menu, which are also used for mesh import and transformation, and the solution units set in the **Solution Units** details view (available from the main menu under **Insert > Solver**). The solution units are the units that the CFX-Solver writes in the results file. For details, see *Units* (p. 48).

Setting the solution units does not alter the units you can use to define quantities in CFX-Pre. These are the units the results file is written in. Additionally, these are the units assumed in the summary at the end of the out file, when data such as variable range and forces on walls is presented.

When post-processing a results file in CFD-Post, the units used are not necessarily those used in the results file. CFD-Post will convert to your preferred units.
Most common units can be used for the solution units; however, some important restrictions apply:

- The temperature solution units must be an absolute scale; for example, Kelvin [K] or Rankine [R]. Celsius and Fahrenheit cannot be used. Temperature quantities elsewhere in CFX-Pre can be set in Celsius and Fahrenheit.
- The solution units must not be changed when restarting a run. The units in the initial guess file will assume the units used in the current CFX-Solver definition (.def) file.
- You must not change the length units outside of CFX-Pre, for example, by editing the CCL in a CFX-Solver input file. The mesh is written to the CFX-Solver input file using the length units; therefore, once the CFX-Solver input file has been written, these units should not change.
Chapter 20: Solver Control

**Solver Control** is used to set parameters that control the CFX-Solver during the solution stage.

This chapter describes:

- 20.1. Basic Settings Tab
- 20.2. Equation Class Settings Tab
- 20.3. External Coupling Tab
- 20.4. Particle Control Tab
- 20.5. Rigid Body Control Tab
- 20.6. Advanced Options Tab

You can find further help on setting solver parameters in *Advice on Flow Modeling in the CFX-Solver Modeling Guide*.

### 20.1. Basic Settings Tab

The **Basic Settings** tab controls the following common and simulation specific parameters:

- **Basic Settings: Common** (p. 199)
- **Basic Settings for Steady State Simulations** (p. 201)
- **Basic Settings for Transient Simulations** (p. 201)
- **Immersed Solid Control** (p. 202)

#### 20.1.1. Basic Settings: Common

##### 20.1.1.1. Advection Scheme

For details, see *Advection Scheme Selection in the CFX-Solver Modeling Guide*.

##### 20.1.1.2. Turbulence Numerics

The **Turbulence Numerics** options are **First Order** and **High Resolution**. The **First Order** option uses **Upwind advection** and the **First Order Backward Euler transient scheme**. The **High Resolution** option uses **High Resolution advection** and the **High Resolution transient scheme**.

For details, see *Advection Scheme Selection in the CFX-Solver Modeling Guide* and *Transient Scheme in the CFX-Solver Modeling Guide*.

---

**Note**

The **Turbulence Numerics** settings will override the settings on the **Equation Class Settings Tab** (p. 203).
20.1.1.3. Convergence Criteria

For details, see Monitoring and Obtaining Convergence in the CFX-Solver Modeling Guide.

- **Residual Type**: select either RMS or MAX.
- **Residual Target**: specify a value for the convergence.

  For details, see Residual Type and Target in the CFX-Solver Modeling Guide.

- **Conservation Target**: optionally specify the fractional imbalance value. The default value is 0.01.

  For details, see Conservation Target in the CFX-Solver Modeling Guide.

20.1.1.4. Elapsed Wall Clock Time Control

Select the Maximum Run Time option if you want to stop your run after a maximum elapsed time (wall clock time).

If you select this option the flow solver will automatically attempt to estimate the time to complete the next timestep or outer loop iteration. The estimated time is the average time that it takes to solve a previous iteration (includes the time to assemble and solve the linear equations, radiation and particle tracking) plus the average time it is taking to write any Standard backup or transient files. The time estimate currently does not include the time used by processes external to the flow solver. This includes mesh refinement, interpolation and FSI with Mechanical.

20.1.1.5. Interrupt Control

Interrupt control conditions are used to specify the interrupt criteria for a solver run. These conditions are specified using logical expressions that are evaluated by CFX-Solver and reported in the CFX output file. After executing each coefficient iteration and time step (or outer iteration), the solver evaluates all internal termination conditions and user defined interrupt control conditions. If any of these conditions are true, then solver execution stops and the outcome is written to the CFX output file.

Typically, interrupt control conditions are defined by single-valued logical expressions. However, single-valued mathematical expressions can also be used. In this case, a single-valued mathematical expression is considered to be true if, and only if, the result of the expression is greater than or equal to 0.5. Otherwise it is deemed to have a value of false. For a discussion of logical expressions, see CFX Expression Language Statements in the CFX Reference Guide.

20.1.1.5.1. List Box

The list box is used to select interrupt control conditions for editing or deletion. Interrupt control conditions can be created or deleted with icons that appear beside the list box.

20.1.1.5.1.1. [Interrupt Condition Name]

Enter a logical expression to specify an interrupt control condition.

20.1.1.6. Junction Box Routine

If you have created any Junction Box Routine objects, select those to include in this Solver run.

For details, see User Junction Box Routines in the CFX-Solver Modeling Guide.
20.1.2. Basic Settings for Steady State Simulations

20.1.2.1. Convergence Control: Min. Iterations

The minimum number of iterations the CFX-Solver will run.

20.1.2.2. Convergence Control: Max. Iterations

The maximum number of iterations the CFX-Solver will run.

For details, see Max. Iterations in the CFX-Solver Modeling Guide.

20.1.2.3. Convergence Control: Fluid Timescale Control

Sets the method of time scale control for a simulation. For details, see Time Scale Control in the CFX-Solver Modeling Guide.

Three options are available for steady state simulations:

- **Auto Timescale**: For details, see Auto Timescale in the CFX-Solver Modeling Guide and Automatic Time Scale Calculation in the CFX-Solver Theory Guide.
  - **Length Scale Option**
    - Three options are available: Conservative, Aggressive or Specified Length Scale.
  - **Local Timescale Factor**: For details, see Local Time Scale Factor in the CFX-Solver Modeling Guide.
  - **Physical Timescale**: For details, see Physical Time Scale in the CFX-Solver Modeling Guide.

20.1.2.4. Solid Timescale Control

This option is available in a steady state simulation when a solid domain, or a solid within a porous domain, is used. Two choices are available: Auto Timescale and Physical Timescale.

- **Solid Timescale Factor**: This option is available when Auto Timescale is used as the Solid Timescale. For details, see Solid Time Scale Control in the CFX-Solver Modeling Guide.

20.1.3. Basic Settings for Transient Simulations

20.1.3.1. Transient Scheme

For details, see Transient Scheme in the CFX-Solver Modeling Guide.

20.1.3.2. Convergence Control

You will have already specified the number of timesteps under Analysis Type. For details, see Analysis Type (p. 101).

20.1.3.2.1. Min. Coeff. Loops

This option determines the minimum number of iterations per timestep, and has a default value of 1.
Important

If a compressible transient flow is undertaken with only one iteration per time step, then the solution can be incorrect if the Heat Transfer option is not set to Total Energy, or if heat transfer is not included in the simulation. This is due to the CFX-Solver not extrapolating the pressure at the start of the time step in these circumstances. This means that density is not extrapolated, and so the solver cannot calculate an accurate value for the time derivative of density on the first iteration. The workaround for this problem is to either run with at least two iterations per time step, or to use the Total Energy option for Heat Transfer.

20.1.3.2.2. Max. Coeff. Loops

This option determines the maximum number of iterations per timestep, and has a default value of 10. For details, see Max. Iter. Per Step in the CFX-Solver Modeling Guide.

20.1.3.2.3. Fluid Timescale Control

Coefficient Loops is the only available option.

20.1.4. Immersed Solid Control

The immersed solid is represented as a source term in the fluid equations that drives the fluid velocity to match the solid velocity. The size of the source term is controlled by the Momentum Source Scaling Factor setting, which can be set globally (in the global Solver Control settings) or for individual immersed solids (on the immersed solid domain Solver Control tab). The default value of 10 is acceptable most of the time. If robustness problems are encountered, the scaling factor may be decreased (for example by a factor of 2), but at the expense of accuracy; the difference between the fluid velocity and the specified solid velocity will generally increase, even if only by a small amount.

Boundary Model has two options:

- None
  
  This is the default option.

- Modified Forcing
  
  This option enables modifications to the immersed solid source term to take better account of the boundaries of the immersed solid and their effect on the flow.

If you set Boundary Model to Modified Forcing, then the Boundary Tracking setting is available.

The Boundary Tracking setting has two options:

- Boundary Face Extrusion

  Once Boundary Model is selected, this is the default option.

  The Boundary Face Extrusion option requires you to specify two settings that must be set appropriately so that each near-wall node can be reliably projected onto the best location on the immersed boundary face. These settings are:

  - Extrusion Distance
This is the distance by which each immersed boundary face is extruded outward from, and normal to, the immersed boundary to form an imaginary volume. A bounding box, that consists of faces of constant x, y, and z coordinate, is then constructed around each imaginary volume. If a near-wall node falls within the bounding box, then CFX-Solver will project that near-wall node normal to and onto the plane of the boundary face. If the projected location lies outside the face, other mechanisms take effect to find the nearest suitable projected location.

The value of **Extrusion Distance** should be of the order of magnitude of the length of a fluid mesh element in the vicinity of the immersed boundary.

- **Extrusion Tolerance**

  This is a factor by which the solver will multiply the edge length of the bounding box for each imaginary volume. The bounding box is mentioned in the description for the **Extrusion Distance** setting. An overly large value will cause near-wall nodes to be mapped to locations on boundary faces that are not necessarily the closest face.

  The default value for **Extrusion Tolerance** is 0.01.

- **Search Through Elements**

  When using this option, CFX-Solver will search through elements near the immersed boundary and project the near-immersed-boundary fluid nodes onto the face edge or vertices of the immersed solid element. This option requires no user input.

  This method is less accurate than the **Boundary Face Extrusion** option, but can be used for cases where no suitable **Extrusion Distance** can be determined.

For details see Immersed Boundary Tracking in the *CFX-Solver Modeling Guide*.

### 20.2. Equation Class Settings Tab

Equation class settings allow you to control some aspects of the CFX-Solver on an equation class basis. For example, you can set a different time scale or advection scheme as well as convergence control and criteria parameters for each class of equations. This is useful if you suspect a convergence problem is caused by a particular equation class; you can then use a smaller timestep or a more robust advection scheme for that equation class.

- Select the equation class for which to specify settings.
- The settings in this tab are a subset of those found on the **Basic Settings** tab (see *Basic Settings: Common* (p. 199)).

  For details, see Timestep Selection in the *CFX-Solver Modeling Guide* and Advection Scheme Selection in the *CFX-Solver Modeling Guide*.

The settings you specify on this form will override those on the **Basic Settings** tab. Any equation classes that are unspecified will use the parameters set on the **Basic Settings** tab. The number and type of equation classes depends on the specific physics of the problem.

For a free surface simulation, you cannot set the advection scheme for the volume fraction (vf) equation class because the CFX-Solver uses a special compressive advection scheme.

For details, see Controlling the Timescale for Each Equation in the *CFX-Solver Modeling Guide*. 
20.3. External Coupling Tab

This section is visible when External Solver Coupling is set to ANSYS MultiField on the Analysis Type tab.

For details, see Solver Controls, External Coupling Tab in the CFX-Solver Modeling Guide.

20.4. Particle Control Tab

This section is visible when particle tracking has been selected. For details, see Particle Solver Control in the CFX-Solver Modeling Guide.

20.5. Rigid Body Control Tab

The following options handle control of the rigid body solver.

The Update Frequency setting controls when the rigid body solver updates the position of the rigid body. The options are:

- **Every Iteration** (steady-state simulations only)
  
  This option causes the rigid body solver to update the position of the rigid body at the beginning of each iteration.

- **Every Time Step** (transient simulations only)
  
  This option causes the rigid body solver to update the position of the rigid body at the beginning of each time step.

  This option is recommended only for weakly-coupled systems (for example, where fluid flow changes within a single time step have little effect on the rigid body motion) or when the time step is very small.

- **Every Coefficient Loop** (transient simulations only)
  
  This option:
  - Causes the rigid body solver to update the position of the rigid body at the beginning of each coefficient loop within each time step.
  - Is recommended when there is tight coupling between the fluid flow and the motion of the rigid body.
  - Is more computationally expensive than the Every Time Step option
  - Can cause issues if the flow solver requires several coefficient loop iterations to stabilize the applied forces/torques between calls to the rigid body solver.

- **General Coupling Control**
  
  This option causes the rigid body solver to update the position of the rigid body during each "stagger" (or coupling) iteration.

  During every stagger iteration, the following sequence occurs:

  1. The rigid body solver reads the latest calculated forces and torques.
2. The rigid body solver solves to determine the new rigid body state (position, orientation, velocity, and so on).
3. The CFX flow solver reads the new rigid body state.
4. The CFX flow solver solves all the field equations, including mesh motion where appropriate, by performing outer loop iterations (steady-state cases) or coefficient loop iterations (transient cases) until either the maximum number of iterations/coefficient loops is reached, or until all the field equations have converged. The mesh motion solution uses the latest rigid body state in order to calculate the mesh motion on all boundaries or subdomains set to use the rigid body solution. If the rigid body is an immersed solid, then the latest rigid body state is used to calculate the motion of the immersed solid domain.

Stagger iterations are repeated until the maximum number of stagger iterations is reached or until the time step (transients runs) or simulation (steady-state runs) is deemed to have converged, when the following criteria are met:

- The rigid body solver has converged (angular equations only),
- The force, torque and mesh motion data transferred between the CFX flow solver and the rigid body solver satisfy the appropriate convergence criteria, AND
- All the CFX field equations (mesh motion, mass and momentum, energy, and so on) have converged to the appropriate convergence criteria.

When the time step (transient runs) is converged, then this guarantees an implicit solution of all solution fields for each time step, providing the most stability when there is a strong coupling between the fluid flow and the motion of the rigid body.

The Internal Coupling Step Control settings set limits on the minimum and maximum number of stagger iterations.

When the Every Iteration, Every Coefficient Loop, or General Coupling Control option is selected, the Internal Coupling Data Transfer Control settings are available. These settings include:

- Mesh Motion Data Transfer Control
- Force Data Transfer Control
- Torque Data Transfer Control

For each of these Internal Coupling Data Transfer Control settings, you may:

- Optionally specify an Under Relaxation Factor for aiding convergence. The default value is 0.75 for all three transferred quantities. If a case has difficulty converging due to overshoots in the force, torque and/or mesh motion quantities passed between the two solvers, then the under-relaxation factor for one or more quantities can be reduced to damp down the overshoots. Values that are too small will tend to increase the number of iterations needed for convergence. On the other hand, for a case where the force, torque and mesh motion are steady and don’t change much from time step to time step, it may be possible to raise the under-relaxation factors to 1 to speed up convergence.

- Optionally specify a Convergence Target.

The convergence target is the target value of the convergence measures described below.

- For Mesh Motion Data Transfer Control, the convergence measure is the maximum of:
  - The distance from the previous to the current center of mass, divided by the greater of the previous and current distances from the center of mass to the rigid body coordinate frame origin.
Here, “previous” refers to the previous stagger iteration, coefficient loop, and so on — whenever the rigid body solver was last called.

\[
\sqrt{\left(\delta q_1 \right)^2 + \left(\delta q_2 \right)^2 + \left(\delta q_3 \right)^2 + \left(\delta q_0 - 1 \right)^2},\]

where \(\delta q = q^n \left[ q^n - 1 \right]^{-1}\), \(n\) refers to the current iteration (stagger iteration, coefficient loop, and so on — whenever the rigid body solver was last called), \(n - 1\) refers to the previous iteration, and \(q = \left[ q_0, q_1, q_2, q_3 \right]\) is the orientation quaternion, with \(q_0\) being the scalar component and \(q_1, q_2, q_3\) being the vector components. Here, all quantities are with respect to the rigid body coordinate frame.

- For **Force Data Transfer Control**, the convergence measure is:

  The magnitude of the change (from the previous value to the current value) in net force divided by the greater of the previous magnitude of the net force and the current magnitude of the net force, where “previous” refers to the previous stagger iteration, coefficient loop, and so on — whenever the rigid body solver was last called.

- For **Torque Data Transfer Control**, the convergence measure is:

  The magnitude of the change (from the previous value to the current value) in net torque divided by the greater of the previous magnitude of the net torque and the current magnitude of the net torque, where “previous” refers to the previous stagger iteration, coefficient loop, and so on — whenever the rigid body solver was last called.

The convergence measures are plotted on the **Rigid Body Convergence** tab in CFX-Solver Manager when running a simulation that involves the rigid body solver. For details on the plots available for such runs, see Monitor Plots related to Rigid Bodies in the CFX-Solver Modeling Guide.

**The Angular Momentum Equation Control** settings are:

- **Integration Method**

  An iterative process is used to calculate the solution to the angular momentum equation.

  Choose one of the following options to control the integration method for this process:

  - **First Order Backward Euler**

    This option provides first-order accuracy, and is vulnerable to gimbal lock problems. For details, see First Order Backward Euler in the CFX-Solver Theory Guide.

  - **Simo Wong**

    This option provides second-order accuracy. For details, see Simo Wong Algorithm in the CFX-Solver Theory Guide.

The **Iteration Convergence Criterion > Iteration Convergence** setting controls the degree to which an orientation must remain the same between successive iterations in order for the solution to be considered converged. The value is a normalized quantity; the default should be sufficient for most purposes.

**The Maximum Number of Iterations > Max. Iterations** setting (which controls the maximum number of iterations used by the Simo Wong integration method) can be increased if you see any warnings in the solver output that indicate a lack of convergence for the integration method.
20.6. Advanced Options Tab

The parameters on the Advanced Options tab should not need to be changed for most simulations.

Dynamic Model Control

When Global Dynamic Model Control is selected, it enables some special modes to be implemented in the solver for the first few iterations or timesteps. For details, see Advanced Options: Dynamic Model Control in the CFX-Solver Modeling Guide.

For details on Turbulence Control, see Turbulence Control in the CFX-Solver Modeling Guide.

For details on Combustion Control, see Advanced Combustion Controls in the CFX-Solver Modeling Guide.

For details on Hydro Control, see Hydro Control in the CFX-Solver Modeling Guide.

Pressure Level Information

Sets an X/Y/Z location for reference pressure and a pressure level.

For details, see Pressure Level Information in the CFX-Solver Modeling Guide.

Thermal Radiation Control

For details, see Thermal Radiation Control in the CFX-Solver Modeling Guide.

Body Forces

Under this option, Volume-Weighted should be generally used except for free surface cases.

For details, see Body Forces in the CFX-Solver Modeling Guide.

Interpolation Scheme

For details, see Interpolation Scheme in the CFX-Solver Modeling Guide.

Multicomponent Energy Diffusion

This option is available when a multicomponent flow is used with a heat transfer equation (that is, thermal or total energy). For details, see Multicomponent Energy Diffusion in the CFX-Solver Modeling Guide. The possible options are:

- **Automatic**: uses unity Lewis number when no component diffusivities specified and no algebraic slip model; uses generic assembly when necessary
- **Generic Assembly**: sets default component diffusivities to unity Schmidt number Sc = 1; generic treatment of energy diffusion term with support for user defined component diffusivities and algebraic slip model
- **Unity Lewis Number**: sets Le = 1; single diffusion term, rather than separate term for contribution of every component, resulting in faster solver runs; the default molecular diffusion coefficient for components is derived from thermal conductivity
Note

Forcing unity Lewis number mode when not physically valid may lead to inconsistent energy transport. Therefore this setting is not recommended.

Temperature Damping

For details, see Temperature Damping in the CFX-Solver Modeling Guide.

Velocity Pressure Coupling

The Rhie Chow Option controls the details of the Rhie Chow pressure dissipation algorithm. Fourth Order ensures that the dissipation term vanishes rapidly under mesh refinement. However, it can sometimes induce wiggles in the pressure and velocity fields; for example, near shocks. The Second Order option damps out these wiggles more rapidly, but is also less accurate. The High Resolution option uses Fourth Order as much as possible, but blends to Second Order near pressure extrema. It is a good choice for high speed flow. The default is Fourth Order for most simulations, but High Resolution is automatically chosen if High Speed Numerics is activated under Compressibility Control on the Solver Control tab. The High Resolution option may occasionally be useful in other situations as well. For example, if you observe the simulation diverging and continuity residuals are significantly higher than the momentum residuals prior to divergence.

Compressibility Control

The following options control parameters that affect solver convergence for compressible flows.

The Total Pressure Option controls the algorithm used for static-to-total conversions (and vice versa). There are three possible settings:

Incompressible
The incompressible assumption is used in all situations.

Automatic
The total pressure is calculated depending on the equation of state.

Unset
This is equivalent to Automatic when the total energy model is used, and Incompressible otherwise.

For further details, see Total Pressure in the CFX-Solver Theory Guide.

The Automatic option may experience robustness problems for slightly compressible fluids (such as compressible liquids). In such cases, you should consider using the Incompressible option instead.

When the High Speed Numerics option is selected, special numerics are activated to improve solver behavior for high-speed flow, such as flow with shocks. This setting causes three types of behavior changes. Firstly, it activates a special type of dissipation at shocks to avoid a transverse shock instability called the carbuncle effect (which may occur if the mesh is finer in the transverse direction than in the flow direction). Secondly, it activates the High Resolution Rhie Chow option to reduce pressure wiggles adjacent to shocks. Finally, for steady state flows, it modifies the default relaxation factors for the advection blend factor and gradients.

The Clip Pressure for Properties option enables the solver to accept negative absolute pressures in the converged solution. For simulations involving compressible flow, the absolute pressure should not
be negative. However, the pressure field required to satisfy the governing equations on a finite mesh may not necessarily satisfy this condition. By default, the solver is robust to a pressure field that may want to temporarily lead to negative pressures, but not if negative pressures are present in the converged solution. The solver can be made robust to negative absolute pressures in the converged solution by activating this parameter, which clips the absolute pressure to a finite value when evaluating pressure-dependent properties such as density.

**Multiphase Control**

The following options handle control of solver details specific to multiphase flows.

When the **Volume Fraction Coupling** option is set to **Segregated**, the solver solves equations for velocity and pressure in a coupled manner, followed by solution of the phasic continuity equations for the volume fractions. With the **Coupled** option, the solver implicitly couples the equations for velocity, pressure, and volume fraction in the same matrix. The coupled algorithm is particularly beneficial for buoyancy-dominated flows, such as buoyant free surface problems.

The **Initial Volume Fraction Smoothing** option can be set to **None** or **Volume-Weighted**. If the initial conditions for volume fraction have a discontinuity, startup robustness problems may occur. Choosing **Volume-Weighted** smoothing of these volume fractions may improve startup robustness.

**Intersection Control**

You can use the options described in this section to control the intersection of non-matching meshes. The parameters that you set here are applied to all interfaces where Intersection Control settings have not been applied individually in domain interface definitions. (See **Intersection Control (p. 145)** to learn how to apply Intersection Control settings to individual interfaces.)

CFX provides the GGI (General Grid Interface) capability, which determines the connectivity between the meshes on either side of the interface using an intersection algorithm. In general, two intersection methods are provided:

- **Bitmap Intersection:**

  Two faces on either side of the interface which have to be intersected are both drawn into an equidistant 2D pixel map. The area fractions are determined by counting the number of pixels that reside inside both intersected faces (that is, within the union of the two faces). The area fraction for a face is then calculated by dividing the number of overlapping pixels by the total number of pixels in the face. This method is very robust.

- **Direct Intersection (Default):**

  Two faces on either side of the interface are intersected using the Sutherland-Hodgeman clipping algorithm. This method computes the exact area fractions using polygon intersection, and is much faster and more accurate than the bitmap method.
Chapter 20: Solver Control

Note

• If Direct (one-to-one) mesh connectivity is available, the solver will ignore the Intersection Control option and will instead use a 'topological intersection', that is, use the one-to-one information to generate the intersection data.

• If you are restarting a run, the intersection step is skipped and the intersection data is read from the results file. This behavior can be overridden by setting the expert parameter force intersection to True.

The Bitmap Resolution controls the number of pixels used to fill the 2D pixel map (see description of the bitmap intersection method above). The higher this number, the more accurate the final calculation of the area fractions. In general, the default resolution of 100 should be sufficient but large differences in the mesh resolution on both sides of the interface as well as other mesh anomalies may require the bitmap resolution to be increased. Larger numbers will cause longer intersection times, for example, doubling the bitmap resolution will approximately quadruple the GGI intersection time.

When the Permit No Intersection option is set, the solver will run when there is no overlap between the two sides of an interface. This parameter is mainly useful for transient cases where interface geometry is closing and opening during the run. For example, transient rotor-stator cases with rotating valves, or moving mesh cases where the GGI interface changes from overlap to non-overlap during the simulation both can exhibit this type of behavior. This parameter is not switched on by default.

The Discernible Fraction option controls the minimum area fraction below which partially intersected faces are discarded. The following default values used by the solver depend on the intersection method:

• Bitmap Intersection: 1/(Bitmap Resolution)^1.5
• Direct Intersection: 1.0E-06

The idea is that intersection inaccuracies should not lead to tiny area fractions that have no impact on the solution.

The Edge Scale Factor option is used to control the detection of degenerate faces. Degenerate faces are detected by comparing the face edge lengths with a characteristic length of the volume touching the face. Degenerated faces will not be intersected and therefore, intersected faces of zero size are discarded so that problems with the 2D projection of those faces are avoided.

The Periodic Axial Radial Tolerance option is used when determining if the surface represented by the interface is a constant axial or radial surface. For a rotational periodic GGI interface, the solver ensures that the ratio of the radial and axial extent compared to the overall extent of each interface side is bigger than the specified value and therefore, the interface vertices do not have the same radial or axial positions.

The Circumferential Normalized Coordinates Option is used to set the type of normalization applied to the axial or radial position coordinates (η). Mesh coordinate positions on GGI interfaces using pitch change are transformed into a circumferential (θ) and axial or radial position (η). The η coordinates span from hub to shroud and are normalized to values between 0 and 1. In cases where the hub and/or shroud curves do not match on side 1 and side 2, different approaches are available to calculate the normalized η coordinates based on side local or global minimum and maximum η values:

• Mixed (Default for Fluid Fluid interfaces): Normalization of η is based on local minimum and maximum η values as well as the η range of side 1. This method forces the hub curves on side 1 and 2 to align. Non-overlap regions adjacent to the shroud may be produced if the shroud curves are not the same.
• Global (Default for Fluid Solid Interfaces): Normalization of η is based on global minimum and maximum eta values. This method intersects side 1 and 2 unchanged from their relative positions in physical coordinates. If the hub and shroud curves do not match then non-overlap regions will be produced.

• Local: Normalization of η is done locally for each side of the interface. This method will always produce an intersection of side 1 and 2, but may cause undesirable scaling of the geometry in some cases.

The **Face Search Tolerance Factor** is a scaling factor applied to the element sized based separation distance used to find candidates for intersection. For a given face on side 1 of the interface, candidate faces for intersection are identified on side 2 using an octree search algorithm. The octree search uses this tolerance to increase the sizes of the bounding boxes used to identify candidates. Making this parameter larger will increase the size of the bounding boxes, resulting in possible identification of more candidates.

The **Face Intersection Depth Factor** is a scaling factor applied to the element sized based separation distance used when performing the direct or bitmap intersection. The final intersection of faces is only applied to those faces that are closer to each other than a specified distance. This distance is calculated as the sum of the average depth of the elements on side 1 and side 2 of the interface. This factor is applied as a scaling on the default distance. It might be necessary to adjust this factor if the normal element depth on the two interfaces sides varies a lot, or side 1 and 2 of the interface are separated by thin regions (for example, thin fin type geometries).
Chapter 21: Output Control

The **Output Control** panel is used to manage the way files are written by the solver. If a transient simulation is running, you can control which variables will be written to transient results files, and how frequently files will be created. Results can be written at particular stages of the solution by writing backup files after a specified number of iterations. These backup files can be loaded into CFD-Post so that the development of the results can be examined before the solution is fully converged. Monitor data can also be written to track the solution progress. Particle tracking data can be written for post processing in CFD-Post. Surface data can be exported.

This chapter describes:
- 21.1. User Interface
- 21.2. Working with Output Control

### 21.1. User Interface

The **Output Control** dialog box is accessible by clicking **Output Control**, by selecting **Insert > Solver > Output Control**, or by editing the **Output Control** object listed in the tree view under **Simulation > Solver**. You can also edit the CCL directly to change the object definition; for details, see *Using the Command Editor* (p. 335).

The topics in this section include:

- **Results Tab** (p. 213)
- **Backup Tab** (p. 214)
- **Transient Results Tab** (p. 215)
- **Transient Statistics Tab** (p. 217)
- **Monitor Tab** (p. 219)
- **Particles Tab** (p. 224)
- **Export Results Tab** (p. 228)
- **Common Settings** (p. 230)

#### 21.1.1. Results Tab

The **Results** tab for the **Output Control** object contains settings that control the content of the results file that is written at the end of a solver run. In the case of a transient run, the results file contains information from the last timestep.

##### 21.1.1.1. Option

See **Option** (p. 230).
21.1.1.2. File Compression

See File Compression (p. 230).

21.1.1.3. Output Variable List

See Output Variables List (p. 231).

21.1.1.4. Output Equation Residuals Check Box

See Output Equation Residuals Check Box (p. 231).

21.1.1.5. Output Boundary Flows Check Box

See Output Boundary Flows Check Box (p. 231).

21.1.1.6. Output Variable Operators Check Box

See Output Variable Operators Check Box (p. 231).

21.1.1.7. Extra Output Variables List

When the Extra Output Variables List is selected, you can specify any variable that is not included in the results file by default. For more details, see Variables in ANSYS CFX in the CFX Reference Guide.

21.1.1.8. Output Particle Boundary Vertex Fields Check Box

See Output Particle Boundary Vertex Fields Check Box (p. 231).

21.1.2. Backup Tab

The Backup tab contains settings that specify the content of backup files, and the timesteps at which the files are written. The purpose of the backup file is to ensure that a solver run can be restarted. Backup files can be used to restart the simulation from the point where the error occurred, saving time and computational resources.

21.1.2.1. List Box

This list box is used to select Backup Results objects for editing or deletion. Backup Results objects can be created or deleted with the icons that appear beside the list box.

The union of all requested backup file content, across all Backup Results objects applicable for a given iteration, is written as a single backup file for that iteration. If no backup file content is specified for a given iteration in any Backup Results object, then no backup file is written for that iteration.

21.1.2.2. [Backup Results Name]

21.1.2.2.1. Option

See Option (p. 230).
21.1.2.2.2. File Compression

See File Compression (p. 230).

21.1.2.2.3. Output Variables List

See Output Variables List (p. 231).

21.1.2.2.4. Output Equation Residuals Check Box

See Output Equation Residuals Check Box (p. 231).

21.1.2.2.5. Output Boundary Flows Check Box

See Output Boundary Flows Check Box (p. 231).

21.1.2.2.6. Output Variable Operators Check Box

See Output Variable Operators Check Box (p. 231).

21.1.2.2.7. Extra Output Variables List

When the Extra Output Variables List is selected, you can specify any variable that is not included in the results file by default. For more details, see Variables in ANSYS CFX in the CFX Reference Guide.

21.1.2.2.8. Output Particle Boundary Vertex Fields Check Box

See Output Particle Boundary Vertex Fields Check Box (p. 231).

21.1.2.2.9. Include Tracks of One-way Coupled Particles Check Box

Select or clear the check box to include or exclude tracks of one-way coupled particles to be written to backup files. This option is available only for cases that involve one-way coupled particles. For details, see Particle Fluid Pair Coupling Options in the CFX-Solver Modeling Guide.

21.1.2.2.10. Output Frequency: Option

See Output Frequency Options (p. 232).

21.1.3. Transient Results Tab

The Trn Results tab for the Output Control object contains settings that specify the content of transient results files, and the timesteps at which the files are written. Each transient results file contains results for a particular timestep. The transient results files are written in addition to the full results file that will be written at the end of the transient simulation.

The settings on the Transient Results tab are analogous to those on the Backup tab; for details, see Backup Tab (p. 214).

21.1.3.1. List Box

This list box is used to select Transient Results objects for editing or deletion. Transient Results objects can be created or deleted with the icons that appear beside the list box.
Only one transient results file is written at a given time regardless of how many transient results file objects exist. Each Transient Results object will add information to the transient results file for that timestep. Thus, the resulting transient results file is a union of the data requested by all Transient Results objects for that timestep.

### 21.1.3.2. [Transient Results Name]

#### 21.1.3.2.1. Option

See [Option](p. 230).

#### 21.1.3.2.2. File Compression

See [File Compression](p. 230).

#### 21.1.3.2.3. Output Variables List

See [Output Variables List](p. 231).

#### 21.1.3.2.4. Include Mesh

When the Selected Variables option is selected, the Include Mesh check box will be selected, in which case the mesh data will be written to the results file. Using the Include Mesh option will allow for post processing of the results file and will make restarting possible.

#### 21.1.3.2.5. Output Equation Residuals Check Box

See [Output Equation Residuals Check Box](p. 231).

#### 21.1.3.2.6. Output Boundary Flows Check Box

See [Output Boundary Flows Check Box](p. 231).

#### 21.1.3.2.7. Output Variable Operators Check Box

See [Output Variable Operators Check Box](p. 231).

#### 21.1.3.2.8. Extra Output Variables List

When the Extra Output Variables List is selected, you can specify any variable that is not included in the results file by default. For more details, see Variables in ANSYS CFX in the CFX Reference Guide.

#### 21.1.3.2.9. Output Particle Boundary Vertex Fields Check Box

See [Output Particle Boundary Vertex Fields Check Box](p. 231).

#### 21.1.3.2.10. Output Frequency

See [Output Frequency Options](p. 232).

### 21.1.3.3. Transient Blade Row Results

Transient Blade Row Results settings are available when there is at least one disturbance defined in the details view of the Transient Blade Row Models object.
You can control the output of variables related to the Transient Blade Row model via the following settings:

- **Option**
  - Choose the level of output: Essential, Selected Variables, or None.

- **File Compression**
  - Choose the level of file compression as a trade-off between file size and speed.

- **Output Variables List**
  - This setting is required for the Selected Variables option.
  - You can multi-select variables from a list (using the Ctrl key) to have them added to the output.

- **Extra Output Variables List**
  - This setting is available for the Essential option.
  - You can multi-select variables from a list (using the Ctrl key) to have them added to the output.

Data compression is based on a Fourier series. The **Data Compression** settings control the number of Fourier coefficients to store in the output and the portion of the simulation over which these coefficients are accumulated.

You can specify the number of Fourier coefficients to be stored in the output.

The **Start Accumulating** setting controls when the Fourier Coefficients should start being accumulated. The available options are:

- **Last Period**
  - The solver accumulates Fourier Coefficients during the last period of the run.

**Note**

Once you have specified the output for transient blade row results, there is no need to create intermediate transient results files.

For instructions on setting up and using Transient Blade Row models, see Transient Blade Row Modeling in the *CFX-Solver Modeling Guide*.

### 21.1.4. Transient Statistics Tab

The **Trn Stats** tab for the Output Control object contains settings that specify the transient statistics data to be included in the results files; for details, see Working with Transient Statistics (p. 233).

#### 21.1.4.1. List Box

This list box is used to select Transient Statistics objects for editing or deletion. Transient Statistics objects can be created or deleted with the icons that appear beside the list box.
21.1.4.2. [Transient Statistics Name]

21.1.4.2.1. Option

The following statistics are evaluated at each node over the history of the simulation:

- Arithmetic Average
- Minimum
- Maximum
- Standard Deviation
- Root Mean Square
- Full

21.1.4.2.2. Output Variables List

See *Output Variables List* (p. 231).

If a selected output variable is a vector or a tensor, the selected operation *Option* is applied to each component of the variable separately. The result for each component is included in the results file. For example, if *Velocity* is selected as a variable, using the *Maximum* option, the results file will include the maximum value of each of the three velocity components. Note that the maximum value of each of the components will likely have occurred at different times during the simulation. Also note that the magnitude of the resulting velocity components will not be the same as the maximum of the velocity magnitude (the latter can be determined by using the *Maximum* option for an additional variable defined to be the velocity magnitude).

21.1.4.2.3. Start Iteration List Check Box

This check box determines whether or not a *Start Iteration List* is used. If this check box is cleared, statistics will start (or continue, for restart runs) accumulation during the first timestep of the current run.

21.1.4.2.3.1. Start Iteration List Check Box: Start Iteration List

Enter a comma-separated list of iteration numbers corresponding to the variables selected in the *Output Variables List*. If the start iteration list contains fewer entries than the *Output Variables List*, then the final start iteration in the list is applied for all remaining output variables.

The start iteration for a given transient statistic specifies the timestep index at which statistic accumulation begins. Prior to that timestep, statistics are initialized, as outlined in *Working with Transient Statistics* (p. 233).

---

**Note**

In the case of restarted transient runs, iteration numbers are interpreted as the total accumulated timestep index rather than the index for the current run.

21.1.4.2.4. Stop Iteration List Check Box

This check box determines whether or not a *Stop Iteration List* is used. If this check box is cleared, the statistics will continue accumulation until the end of the run.
21.1.4.2.4.1. Stop Iteration List Check Box: Stop Iteration List

Enter a comma-separated list of iteration numbers corresponding to the variables selected in the **Output Variables List**. If the stop iteration list contains fewer entries than the **Output Variables List**, then the final stop iteration in the list is applied for all remaining output variables.

The stop iteration for a given transient statistic specifies the timestep index at which statistic accumulation ceases. After that timestep, statistics are simply not modified.

---

**Note**

In the case of restarted transient runs, start and stop iterations are interpreted as the total accumulated timestep index rather than the index for the current run.

21.1.5. Monitor Tab

The **Monitor** tab for the **Output Control** object contains settings that specify monitor output. The following types of information can be monitored as a solution proceeds:

- Primitive or derived solution variables
- Fluid Properties
- Expressions.

When monitoring expressions, the expression must evaluate to a single number; for details, see *Working with Monitors* (p. 235).

21.1.5.1. Monitor Objects Check Box

This check box determines whether or not monitor data is generated as a solution proceeds. If it is selected, the following settings are available:

21.1.5.1.1. Monitor Coeff. Loop Convergence

(apply only for transient cases)

This check box determines whether or not monitor data is output within coefficient (inner) loops. Regardless of the setting, data will be output for each timestep.

21.1.5.1.2. Monitor Balances: Option

- **Full**
  
  Mass, Momentum, and other balances are written to the solver monitor file.

- **None**

21.1.5.1.3. Monitor Forces: Option

- **Full**

  Forces and moments on wall boundaries are written to the solver monitor file.
It is important to note that these forces and moments do not include reference pressure effects. You can include reference pressure effects in the force calculation by setting the expert parameter `include pref in forces = t`.

It is also important to note that for rotating domains in a transient run, forces and moments on wall boundaries are evaluated in the reference frame fixed to the initial domain orientation. These quantities are not influenced by any rotation that might occur during a transient run or when a rotational offset is specified. However, results for rotating domains in a transient run may be in the rotated position (depending on the setting of Options in CFD-Post) when they are subsequently loaded into CFD-Post for post-processing.

- None

**21.1.5.1.4. Monitor Residuals: Option**

- Full
  
  RMS/max residuals are written to the solver monitor file.

- None

**21.1.5.1.5. Monitor Totals: Option**

- Full
  
  Flow and source totals (integrals over boundaries) are written to the solver monitor file.

- None

**21.1.5.1.6. Monitor Particles: Option**

- Full
  
  If Lagrangian Particle Tracking information is included in the simulation, force, momentum, and source data for particles are written to the solver monitor file.

- None

**21.1.5.1.7. Efficiency Output Check Box**

This check box determines whether or not the device efficiency can be monitored in CFX-Solver Manager. When selected it also activates field efficiency output to CFD-Post. If activated, the following information must be specified:

**21.1.5.1.7.1. Inflow Boundary**

A single boundary condition region of type INLET.

**21.1.5.1.7.2. Outflow Boundary**

A single boundary condition region of type OUTLET.

**21.1.5.1.7.3. Efficiency Type**

Choose between Compression, Expansion, and Both Compression and Expansion.

For more information, see Activating Efficiency Output.
21.1.5.1.7.4. Efficiency Calculation Method

For each of the efficiency types, two efficiency calculation options are possible: **Total to Total** and **Total to Static**.

For more information, see *Isentropic Efficiency and Total Enthalpy*

21.1.5.1.8. Monitor Points And Expressions List Box

This list box is used to select monitor objects for editing or deletion. Monitor objects can be created or deleted with the icons that appear beside the list box.

21.1.5.1.8.1. Monitor Points and Expressions: [Monitor Name]: Option

- **Cartesian Coordinates**

  Monitor point data includes variable values at the node closest to the specified point. A crosshair will be displayed in the viewer to indicate the monitored node.

- **Cylindrical Coordinates**

  Specify the monitor point location in terms of *Position Radial Comp.*, *Position Theta Comp.*, and *Position Axial Comp.* values.

  Monitor point data includes variable values at the node closest to the specified point. A crosshair will be displayed in the viewer to indicate the monitored node.

  **Note**

  This option disables the ability to specify the points by picking in the Viewer.

- **Expression**

  An expression is monitored.

21.1.5.1.8.2. Monitor Points and Expressions: [Monitor Name]: Output Variables List

(appplies only when **Option** is set to **Cartesian Coordinates**)

Select the variables to monitor.

**Tip**

Hold the **Ctrl** key when clicking to select multiple variables.

21.1.5.1.8.3. Monitor Points and Expressions: [Monitor Name]: Cartesian Coordinates

(appplies only when **Option** is set to **Cartesian Coordinates**)

Enter coordinates for the point location to monitor.
Tip

After you click a coordinate entry area, all of the coordinate entry areas turn yellow to show that you are in Picking mode. You can then select locations from the viewer using the mouse. To manipulate the object in the viewer while in Picking mode, use the viewer icons (rotate, pan, zoom) in the toolbar. You can end Picking mode by changing the keyboard focus (by clicking in another field, for example).

21.1.5.1.8.4. Monitor Points and Expressions: [Monitor Name]: Cylindrical Coordinates

(applies only when Option is set to Cylindrical Coordinates)

Enter coordinates for the point location to monitor in terms of Position Radial Comp., Position Theta Comp., and Position Axial Comp. values.

Note

This option disables the ability to specify the points by picking in the Viewer.

21.1.5.1.8.5. Monitor Points and Expressions: [Monitor Name]: Expression Value

(applies only when Option is set to Expression)

Enter a CEL expression that evaluates to a single number that is to be monitored.

21.1.5.1.8.6. Monitor Points and Expressions: [Monitor Name]: Coord Frame Check Box

Determines whether the coordinate frame of the monitor point is specified or left at the default of Coord 0. For a monitor point that uses Cartesian or cylindrical coordinates, the coordinate frame is used to interpret the specified coordinates. For a monitor point that uses an expression, the coordinate frame affects all CEL functions that are used in the expression and that return the component of a vector (for example, force_x()).

21.1.5.1.8.7. Monitor Points and Expressions: [Monitor Name]: Coord Frame Check Box: Coord Frame

Set the coordinate frame used for the monitor point or expression; for details, see Coordinate Frames in the CFX-Solver Modeling Guide.

21.1.5.1.8.8. Monitor Points and Expressions: [Monitor Name]: Domain Name Check Box

Determines whether the specified Cartesian coordinates are restricted to a particular domain.

21.1.5.1.8.9. Monitor Points and Expressions: [Monitor Name]: Domain Name Check Box: Domain Name

Set the domain name to which the specified Cartesian coordinates will be restricted.

21.1.5.1.9. Radiometer: Frame Overview

(applies only when using the Discrete Transfer or Monte Carlo thermal radiation model)

A radiometer is a user defined point in space that monitors the irradiation heat flux (not incident radiation) arriving at the required location. The user specification involves much more than just the location...
of the sensor, as it also requires the viewing direction, its temperature and some numerical controls for each particular sensor.

By default, radiometers are ideal and the efficiency factor is 1.

A cyan arrow with a cross-hair is used to denote the location of each sensor in the viewer.

21.1.5.1.10. Radiometer: List Box

This list box is used to select Radiometer objects for editing or deletion. Radiometer objects can be created or deleted with the icons that appear beside the list box.

21.1.5.1.10.1. Radiometer: [Radiometer Name]: Option

• Cartesian Coordinates

21.1.5.1.10.2. Radiometer: [Radiometer Name]: Cartesian Coordinates

Enter Cartesian coordinates that describe the location of the radiometer. These coordinates are interpreted in the coordinate frame associated with the radiometer. For details, see Coordinate Frames (p. 255) and also Coordinate Frames in the CFX-Solver Modeling Guide.

21.1.5.1.10.3. Radiometer: [Radiometer Name]: Temperature

Enter the temperature of the radiometer.

21.1.5.1.10.4. Radiometer: [Radiometer Name]: Quadrature Points

Enter the number of rays used for ray tracing from the radiometer.

21.1.5.1.10.5. Radiometer: [Radiometer Name]: Coord Frame Check Box

This check box determines whether the coordinate frame used to interpret the location and direction specifications of the radiometer will be specified or left at the default of Coord 0.

21.1.5.1.10.6. Radiometer: [Radiometer Name]: Coord Frame Check Box: Coord Frame

Select a coordinate frame to interpret location and direction specifications of the radiometer. For details, see Coordinate Frames (p. 255) and also Coordinate Frames in the CFX-Solver Modeling Guide.

21.1.5.1.10.7. Radiometer: [Radiometer Name]: Diagnostic Output Level Check Box

This check box determines whether the diagnostic output level will be specified or left at the default of 0.

21.1.5.1.10.8. Radiometer: [Radiometer Name]: Diagnostic Output Level Check Box: Diagnostic Output Level

Enter a number greater than zero. The CFX-Solver will write the ray traces to a series of polylines in a .csv file that can be visualized in CFD-Post. This can be used to determine if the number of quadrature points is optimal.

21.1.5.1.10.9. Radiometer: [Radiometer Name]: Direction: Option

• Cartesian Components
21.1.5.10.10. Radiometer: [Radiometer Name]: Direction: X Component, Y Component, Z Component

(applies only when Monitor Objects check box: Radiometer: [Radiometer Name]: Direction: Option is set to Cartesian Components)

Enter a numerical quantity or CEL expression for each Cartesian component of a direction vector that represents the orientation of the radiometer.

21.1.6. Particles Tab

The Particles tab for the Output Control object contains settings that specify whether the particle data is recorded, and details of how the data is collected and recorded.

This tab is available only when the morphology option is set to Particle Transport Fluid or Particle Transport Solid in CFX-Pre; for details, see Basic Settings Tab (p. 107).

The particle data is initially written to particle track files, which contain a specified level of detail about particles involved in your simulation. The files are written to the directory with the same name as your current run. An option on the Particles tab controls whether or not the track files are retained after their data is copied into the final results file (and any backup results files).

21.1.6.1. Particle Track File Check Box

This check box determines whether or not to customize the type and amount of particle track data recorded in the results file.

21.1.6.1.1. Option

• All Track Positions (default)
  
  Point data is collected for all track positions, as determined by the Track Positions setting.

• Specified Position Interval
  
  Point data is collected for a subset of all track positions. The entire set of track positions is determined by the Track Positions setting. The subset is controlled by the Interval setting. For example, if Track Position Interval is left at its default value of 1, then the result is the same as setting Option to All Track Positions. Setting Interval to 2 will cause point data to be collected for every second track position; setting Interval to 3 will cause point data to be collected for every third track position, and so on.

• Specified Distance Spacing
  
  Point data is collected for evenly-spaced points along each track. The spacing is controlled by this parameter, and represents a physical distance.

• Specified Time Spacing
  
  Point data is collected for points along each track with the points spaced by time according to this parameter. The physical distance between data collection points is therefore a function of the particle velocity along each track.

• None
  
  This option can be used to avoid writing any track information. This might be useful if you are not interested in particle tracks or want to avoid the additional disk space required to store the tracks.
If this option is set, no tracks will be available in CFD-Post. In contrast to the track file information, sources are required for a clean re-start of a particle case and must be written to the results file.

**Note**

For a transient run, final particle positions are always added to the track information, and therefore can be seen at the end of a run.

### 21.1.6.1.2. Track Positions Check Box

(applies only when **Particle Track File Check Box: Option** is set to **All Track Positions** or **Specified Position Interval**)

This check box determines whether the **Track Positions** setting will be specified, or left at the default value: **Element Faces**.

### 21.1.6.1.3. Track Positions Check Box: Track Positions

- **Control Volume Faces**
  
  Points are written each time a sub-control volume boundary is crossed. This produces the more precise and larger track files than the other option.

- **Element Faces**
  
  Points are written to the track file each time a particle crosses the boundary of an element.

### 21.1.6.1.4. Interval

(applies only when **Particle Track File Check Box: Option** is set to **Specified Position Interval**)

Enter an integer that specifies the spacing (in terms of points) between points along the tracks.

### 21.1.6.1.5. Track Distance Spacing

(applies only when **Particle Track File Check Box: Option** is set to **Specified Distance Spacing**)

Enter a numerical quantity that specifies the physical distance interval between successive points on the track. Data will be collected only for those points.

### 21.1.6.1.6. Track Time Spacing

(applies only when **Particle Track File Check Box: Option** is set to **Specified Time Spacing**)

Enter a numerical quantity that specifies the physical time interval between successive points on the track. Data will be collected only for those points.

### 21.1.6.1.7. Track Printing Interval Check Box

This check box determines whether the Track Printing Interval setting will be specified, or left at the default value: 1.
21.1.6.1.8. Track Printing Interval Check Box: Interval

Output data is collected for every $n$th particle track, where $n$ is the specified number.

21.1.6.1.9. Keep Track File Check Box

Determines whether or not the track files are kept. When the track files are kept, they can be found below the working directory in a directory that has the same name as the run. For example, for the first solution of `dryer.def`, the track files are kept in a directory called `dryer_001`.

The data will be copied into the results file regardless of whether or not the track files are kept. CFD-Post can extract the track file data from the results file for post processing.

21.1.6.1.10. Track File Format Check Box

Determines whether the track file format will be specified, or left at the solver default value: Unformatted. The track file will remain in the working directory after finishing a run only if you select the **Keep Track File** option to force the solver to not delete it.

21.1.6.1.11. Track File Format Check Box: Track File Format

- **Formatted**

  Formatted track files are in human-readable ASCII format but take up much more disk space than unformatted track files.

  The general structure of formatted ASCII track files will print the Number of Particle Positions in a Block at the top of the file preceding repetitions of the following:

  ```
  Particle Track Number
  X Position
  Y Position
  Z Position
  Traveling Time
  Traveling Distance
  Particle Diameter
  Particle Number Rate
  Particle Mass Fraction Component 1
  Particle Mass Fraction Component 2
  ....
  Particle Mass Fraction Component n
  Particle U Velocity
  Particle V Velocity
  Particle W Velocity
  Particle Temperature
  Particle Mass
  ```

  **Note**

  Particle Mass Fraction Component 1- n only appear for multi-component particle materials and Particle Temperature only appears when heat transfer is activated.

- **Unformatted**

  Unformatted track files are written in a non-readable, binary, format.
21.1.6.2. *Transient Particle Diagnostics*

This section is available for transient simulations using particle tracking and enables you to output various particle data; for details, see Transient Particle Diagnostics in the CFX-Solver Modeling Guide.

21.1.6.3. *Transient Particle Diagnostics: List Box*

Shows the current Transient Particle Diagnostics outputs. You can click ![create] to create a new diagnostics output file or click ![delete] to delete an existing one.

21.1.6.4. *Transient Particle Diagnostics: [Transient Particle Diagnostics Name]*

21.1.6.4.1. Option

- Particle Penetration
- Total Particle Mass
- User Defined - This option can be used to specify a user-defined Diagnostic Routine to evaluate the diagnostics information based on particle variables specified in Particle Variables List. Optionally, you can also select the Monitored Values List check box and specify a comma-separated list of names for monitored values. For details, see User Diagnostics Routine in the CFX-Solver Modeling Guide.

21.1.6.4.2. Particles List

Select particles to be used for output from the drop-down list, or click ![... select] and select from the Particles List dialog box.


The fraction of the total spray mass contained within an imaginary cone, the half-angle of which is the spray angle. The cone tip is at the point of injection and the cone axis is parallel to the direction of injection.

21.1.6.4.4. Penetration Origin and Direction: Option

- Specified Origin and Direction

21.1.6.4.5. Penetration Origin and Direction: Injection Center

Enter the Cartesian coordinates of the center of injection.

21.1.6.4.6. Penetration Origin and Direction: Injection Direction

21.1.6.4.6.1. Option

- Cartesian Components

Specify the Cartesian components (Direction X Comp., Direction Y Comp., and Direction Z Comp.) of the injection direction.

21.1.6.4.7. Axial Penetration: Option

- Axial Penetration

- None

### 21.1.6.4.8. Radial Penetration: Option

- Radial Penetration


- None

### 21.1.6.4.9. Normal Penetration: Option

- Normal Penetration


- None

### 21.1.6.4.10. Spray Angle: Option

- Spray Angle


- None

#### 21.1.6.4.10.1. Spray Angle: *Spray Radius at Penetration Origin Check Box*

Enable to specify a spray radius for the penetration origin.

#### 21.1.6.4.10.2. Spray Angle: *Spray Radius at Penetration Origin Check Box: Spray Radius*

Enter a penetration origin spray radius.

### 21.1.7. Export Results Tab

The *Export Results* tab for the Output Control object is used to specify export files; for details, see *Working with Export Results* (p. 237).

**Note**

The flow solver *Export Results* supports "Stationary" wall boundary conditions only when mesh motion is activated.

#### 21.1.7.1. List Box

This list box is used to select *Export Results* objects for editing or deletion. *Export Results* objects can be created or deleted with the icons that appear beside the list box.
21.1.7.2. [Export Name]: Export Format

The Export Format check box determines whether the export format will be specified, or left at its default of **CGNS**. Currently, the only option is **CGNS**.

21.1.7.2.1. Filename Prefix Check Box

This check box determines whether or not a user-specified prefix is used in the filenames of exported files. By default, CFX-Solver will use the object name as the filename prefix. For details, see *File Naming Conventions* (p. 237).

21.1.7.2.2. Filename Prefix Check Box: Filename Prefix

Specify a prefix to use in the filenames of exported files.

21.1.7.3. [Export Name]: Export Frequency

21.1.7.3.1. Option

- **Time List**
  
  See *Time List* (p. 232).

- **Time Interval**
  
  See *Time Interval* (p. 232).

- **Iteration List**
  
  See *Iteration List* (p. 232).

- **Iteration Interval**
  
  See *Iteration Interval* (p. 232).

- **Every Iteration**

21.1.7.4. [Export Name]: Export Surface

21.1.7.4.1. List Box

This list box is used to select **Export Surface** objects for editing or deletion. **Export Surface** objects can be created or deleted with the icons that appear beside the list box. Solution fields are required either on individual 2D boundary regions or on composite boundary regions.

21.1.7.4.2. [Export Surface Name]: Option

- **Selected Variables**

- **Acoustic Dipole/Acoustic Rotating Dipole**

21.1.7.4.3. [Export Surface Name]: Output Boundary List

See *Output Boundary List and Output Region Naming* (p. 237).
21.1.7.4.4. [Export Surface Name]: Output Variables List

(applies only when Option is set to Selected Variables). For details, see Output Variables List (p. 231).

21.1.7.4.5. [Export Surface Name]: Output Nodal Area Vectors Check Box

(applies only when Option is set to Selected Variables)

Select this check box, and the Value check box contained within Output Nodal Area Vectors, when exporting acoustic data for LMS noise analysis.

21.1.8. Common Settings

21.1.8.1. Option

• Selected Variables

Selected vertex fields are written to the results file. The fields are chosen from the Output Variables List. No restart is possible from these files.

• Smallest (not available on the Results tab)

Mesh data and all solution vertex fields are written. A restart is possible from these files, but the restart will not be “clean” (you can expect a temporary increase in residual values).

• Essential

The smallest file that preserves a clean restart is written. This includes data written in the Smallest category and the following:
– GGI control surface fields
– Boundary face solution arrays
– Mass flow data fields

• Standard

This contains data written in the Essential category and the following:
– Hybrid fields
– Post processing fields

• None

Used when no output of results is required (for example, during solver performance benchmarking).

21.1.8.2. File Compression

• None

This offers no compression.

• Default

This is a compromise between disk space and processing load.

• Best Speed Least Compression

• Low Speed Most Compression
You may want to increase the compression level for large backup files, or if you do not have much disk space.

### 21.1.8.3. Output Variables List

Allows you to select the output variables to write to the results file. Select the desired variables from the list or click the icon to select from a list of all variables. **Output Variable List** is only available when **Selected Variables** is the option selected.

### 21.1.8.4. Output Equation Residuals Check Box

When **Output Equation Residuals** is set to **All**, the equation residuals for all equations are written to the results file for steady state solutions. The residuals can then be viewed in CFD-Post. They appear as ordinary variables available from the full list of variables. This parameter replaces the expert parameter **output eq residuals**.

### 21.1.8.5. Output Boundary Flows Check Box

When **Output Boundary Flows** is set to **All**, equation flows, including mass flows, are written to the file you have set up. These flows enable accurate evaluations of forces, heat flows, and mass flow related calculations in CFD-Post. These flows are always written for **Standard** backup/results and transient files. They are not written for **Selected Variables** and **Smallest** transient files, unless the **Output Boundary Flows** parameter is set to **All**.

### 21.1.8.6. Output Variable Operators Check Box

When **Output Variable Operators** is set to **All**, you get all available operators that the solver has calculated (for example, gradients, High Resolution betas) for the variables in the **Output Variables List**. This option only applies to minimal transient results files, selected variables, backup results and results files. These operators are always written for **Standard** files, but may also be written for **Selected Variables** and **Smallest** files by setting this parameter to **All**.

### 21.1.8.7. Output Particle Boundary Vertex Fields Check Box

For cases with particles, when **Output Particle Boundary Vertex Fields** is selected, the following boundary vertex fields are written:

- Inlets, outlets, openings and interfaces:
  - Mass flow density
  - Momentum flow density
  - Energy flow density
- Walls:
  - Mass flow density
  - Stress
  - Erosion rate density.

For transient cases, the following additional boundary vertex fields are written:

- Inlets, outlets, openings and interfaces:
  - Time integrated mass flow density
– Time integrated momentum flow density
– Time integrated energy flow density

• Walls:
  – Time integrated mass flow density
  – Time integrated erosion rate density.

For additional details, see Particle Boundary Vertex Variables in the CFX Reference Guide

21.1.8.8. Output Frequency Options

This determines how often backup and transient results files are written during a run.

21.1.8.8.1. Timestep Interval

Enter a number that specifies the number of timesteps between the writing of each results file.

21.1.8.8.2. Timestep List

Enter a comma-separated list of timestep numbers that specifies the timesteps at which files are written.

21.1.8.8.3. Time Interval

Enter a number that specifies the simulation time interval between the writing of each file. The simulation time interval is added to a running total that starts at the simulation start time. An iteration within half a timestep of the current total has a file written.

21.1.8.8.4. Time List

Enter a comma-separated list of simulation times that specifies the iterations at which files are written.

21.1.8.8.5. Every Timestep

No further input is needed. A backup or transient results file is written for every timestep in a transient simulation.

21.1.8.8.6. Every Iteration

No further input is needed. A backup or transient results file is written for every iteration.

21.1.8.8.7. Iteration Interval

Enter a number that specifies the number of iterations between the writing of each file.

21.1.8.8.8. Iteration List

Enter a comma-separated list of iteration numbers that specifies the iterations at which files are written.

21.1.8.8.9. Wall Clock Time Interval

(Only available for backup files)

Enter a number that specifies the wall clock time interval between the writing of each backup file.
This is used to create backup files every so often in real time. For example, on an overnight simulation you might choose to have a backup file created every two hours, regardless of how many iterations or timesteps had been performed.

21.1.8.8.10. Coupling Step Interval

(Only available for ANSYS Multi-field runs). Enter a number that specifies the number of coupling steps (multi-field timesteps) between the writing of each file. Note that if you are using CFX-Pre in ANSYS MultiField mode to set up the multi-field part of an ANSYS Multi-field run, then selecting this option has implications for how often the ANSYS Solver writes its results, in addition to specifying how often CFX should write results. For details, see The Processing Step in the CFX-Solver Manager User’s Guide.

21.1.8.8.11. Every Coupling Step

(Only available for ANSYS Multi-field runs). This is used to create a results file every coupling step (multi-field timestep). Note that if you are using CFX-Pre in ANSYS MultiField mode to set up the multi-field part of an ANSYS Multi-field run, then selecting this option has implications for how often the ANSYS Solver writes its results, in addition to specifying how often CFX should write results. For details, see The Processing Step in the CFX-Solver Manager User’s Guide.

21.1.8.8.12. None

No results files will be written. You might choose this option to temporarily turn off writing backup or transient files but keeping the definition of what to include in the files so that you can easily re-enable them.

21.2. Working with Output Control

The following topics will be discussed:

• Working with Transient Statistics (p. 233)
• Working with Monitors (p. 235)
• Working with Export Results (p. 237)

21.2.1. Working with Transient Statistics

This section describes the generation and output of running statistics for solution variables. The available statistics are arithmetic average, minimum, maximum, root-mean-square (RMS) and standard deviation.

This follows from the same statistical theory that is used to determine statistical Reynolds Stresses, for example, $\rho \overline{u^2}$ in turbulence modeling.

21.2.1.1. Statistic Initialization and Accumulation

Arithmetic averages are initialized using the solution values. RMS values are initialized using the absolute value of the solution values. Each of these statistics is calculated recursively by adding timestep-weighted solution values from the latest timestep to the accumulating statistic.

Minimum and maximum statistics are initialized using the solution values, and are updated as new extremes are found.
Standard deviations are initialized with a value of zero. The standard deviation is essentially an RMS of the difference between the latest solution value and the running arithmetic average. If this difference is written as $u'$, then the mean of the squared difference follows from the same statistical theory that is used to determine statistical Reynolds Stresses, for example, $\rho \overline{u'v'}$ in turbulence modeling, and can be calculated as:

$$\overline{u'^2} = \overline{u^2} - \overline{u} \overline{u} = (\text{RMS} (u) \text{ RMS} (u)) - \overline{u} \overline{u}$$

The required RMS and arithmetic average statistics are automatically activated when the standard deviation is requested. It is also important to note that an error may be introduced in evaluating the standard deviation if it is calculated before either of the mean or RMS statistics. This error varies approximately with the inverse of the number of data (that is, the number of timesteps) used to calculate the statistics. For instance, this error should be less than approximately 1% once the statistics contain more than 100 pieces of data.

### 21.2.1.2. Statistics as Variable Operators

Transient statistics are operators that act on variables (both conservative and hybrid values) identified in the **Output Variables List**. Like other variable operators, the data written to results files have names like `<variable>.<statistic>` where `<variable>` is the name of the specified variable and `<statistic>` is one of the following:

- **Trmin** (Minimum)
- **Trmax** (Maximum)
- **Trnavg** (Arithmetic average)
- **Trnrms** (Root mean square)
- **Trnsdv** (Standard deviation)

**Tip**

To output transient statistics for intermediate results, be sure to select the **Output Variable Operators** check box on the **Transient Results** tab.

Choose the **Full** option if all variable operators are desired.

A significant consequence of treating transient statistics as operators is that only one instance of a `<variable>.<statistic>` exists during the entire simulation. For example, even if multiple transient statistics objects containing the arithmetic average of velocity are requested, only one statistic will ever exist. The potential for specifying different start (stop) iterations for these transient statistics objects is addressed by using the earliest (latest) value specified; that is, statistics are accumulated over the largest range of timesteps possible as defined by the start and stop iterations for all transient statistics objects.

**Note**

If you want to re-initialize a given statistic (that is, remove the history from the statistic), you must shut down and restart the simulation with a new start (stop) iteration. This step is required to ensure that the new statistic accumulation interval is not included when searching for the earliest and latest start and stop iteration values, respectively.
21.2.1.3. Using Statistics with Transient Rotor-Stator Cases

You can use transient statistics to examine the convergence of a transient/rotor stator case. This is done by obtaining averaged variable data over the time taken for a blade to move through one pitch. By comparing consecutive data sets, you can examine if a pseudo steady-state situation has been reached. Variable data averaged from integer pitch changes should be the same if convergence has been achieved.

Each of the variables that are created by the CFX-Solver can be used in CFD-Post to create plots or perform quantitative calculations.

21.2.2. Working with Monitors

21.2.2.1. Setting up Monitors

1. Click Output Control or select Insert > Solver > Output Control from the main menu.
   
   The Output Control dialog box will appear.
2. Click the Monitor tab.
3. Select Monitor Objects.
4. Select which variables to monitor (Balances, Forces, Residuals, Totals, Particles).
   
   By default, all of the listed quantities are monitored.
5. Click Add new item.
   
   The Monitor Points and Expressions dialog box pops up to ask for the name of a new monitor point object.
6. Enter a name, or accept the default name, and then click OK.
   
   The [Monitor Name] frame expands to show a set of input fields.
7. Specify the settings for the monitor object.
8. Add more monitor objects as desired.
9. Click OK or Apply to set the definitions of all of the monitor objects. All monitor points will be displayed in the viewer.

21.2.2.2. Transient/ Mesh Deformation Runs

The closest node for Cartesian coordinate is chosen for output. For a transient run or run with a moving mesh, the closest node is identified once at the start and used for the remainder of the run. For details, see Mesh Deformation (p. 113).

21.2.2.3. Output Information

Information on the variables to be monitored is given near the start of the .out file. In the following example the variables Velocity and Pressure were requested for the Output Variables List in the .ccl file.
The “Monitor vertex location” shows the actual location that is being monitored (the closest vertex to the “User specified location”). The “Distance to user specified location” shows the difference between the specified and actual monitoring location.

The “Output variable list” shows the full name of all variables that will be monitored.

### 21.2.2.4. Expression

When using the Expression option, the results of the evaluated expression are output at each iteration. Enter an expression that evaluates to a single value at each timestep. The following are examples of expressions that could be monitored:

- \( \text{force}()@\text{MainWall} / (0.5*\text{areaAve}(@\text{density})*\text{areaAve}(@\text{vel})*\text{area}()@\text{MainWall}) \)
- \( \text{volumeAve}(@\text{CO2}.mf)@\text{Domain} \)

The variable names should be preceded with the fluid name when applicable. You can view a list of variable names in the Expression details view by right-clicking in the Definition window when editing an expression.

### 21.2.2.5. Viewing Monitor Values during a Run

You can view a plot of monitor point values during a solver run. For details, see Monitors Tab in the CFX-Solver Manager User’s Guide.

### 21.2.2.6. Viewing Monitor Point Values after a Run

After the CFX-Solver has finished, the monitor point data (if the monitor point information is required) is extracted from a .res file using the cfx5dfile command. The following syntax is used:

```
cfx5dfile <file> -read-monitor
```

where <file> is a CFX-Solver input or results file containing monitor point information. The output is sent to standard output (you may want to add a redirect to write the output to a text file, for example:

```
cfx5dfile <file> -read-monitor > out.txt
```

The output is produced as a list of variable names, followed by a comma-delimited list of values that correspond to the order of variable names. One line of these values is produced for every iteration that has been carried out.

You can enter:

```
cfx5dfile -help
```

to obtain more information.
21.2.3. Working with Export Results

The topics in this section include:

- File Naming Conventions (p. 237)
- Propagating Older Time Step Values (p. 237)
- Output Boundary List and Output Region Naming (p. 237)
- Output Variables List (p. 238)

21.2.3.1. File Naming Conventions

Each instance of an Export Results object will correspond to a particular group of files in a transient run.

Transient data is written into a series of files, named using the form:

\(<\text{prefix}>_{\text{timestep}}.\text{<extension>}\)

- \(<\text{prefix}>\) defaults to the Export Results object name unless you override this with the parameter “Filename Prefix”
- \(<\text{timestep}>\) is a string containing the timestep number
- \(<\text{extension}>\) is the only available \(<\text{extension}>\)

The mesh information (mesh coordinates and nodal area vectors, if applicable) is written into a separate file to save disk space, because the mesh information does not change with time. The mesh file name is of the form:

\(<\text{prefix}>_{\text{mesh}}.\text{cgns}\)

A link is created for each solution file (\(<\text{prefix}>_{\text{timestep}}.\text{cgns}\)) to map the mesh coordinates to the mesh file (\(<\text{prefix}>_{\text{mesh}}.\text{cgns}\)). If you write your own reader, you need not open the mesh file separately to read in the mesh coordinates for each solution file.

21.2.3.2. Propagating Older Time Step Values

When exporting results to 3rd party applications, it is possible that values from an earlier time step are written at time steps where true data does not exist - for example at time steps where minimal results files were requested in the solver control setup. This is done because some 3rd party software can only successfully read exported files when a consistent number of variables exists in each file. It is up to you to recognize that these “dummy variables” are not accurate at the particular time step.

21.2.3.3. Output Boundary List and Output Region Naming

The default behavior of this parameter is to attempt to create one composite boundary region per domain. The boundary condition patches do not have to be in the same domain so that rotating dipole sources and regular dipole sources will be contained in the same export file if this is desired.

Each export surface object name is unique. If the export surface lies within one domain, the name of each exported surface will simply be the Export Surface object name. If the export surface lies across multiple domains, a region will be exported for each domain spanned by the export surface. Such regions are named using the form “<domain name>.<export surface name>”.
21.2.3.4. Output Variables List

When either of the acoustic options are selected, the output variables list is implied. For both acoustic options, there is output for pressure on vertices and the surface mesh (x, y, z and topology). For the rotating dipole option there is also output for nodal area vectors.
Chapter 22: Transient Blade Row Models

This chapter describes the Transient Blade Row Models object that can appear in the Outline tree.

For instructions on setting up and using Transient Blade Row models, see Transient Blade Row Modeling in the CFX-Solver Modeling Guide.

This chapter describes:

22.1. Inserting a New Transient Blade Row Models Object

22.2. Transient Blade Row Models Tab

22.1. Inserting a New Transient Blade Row Models Object

Setting up a Transient Blade Row Model in the CFX-Solver Modeling Guide describes a procedure for inserting a Transient Blade Row Model object.

To insert a Transient Blade Row Models object:

1. Do one of the following:
   - Right-click Flow Analysis 1 (or whichever analysis is applicable) in the Outline tree, then select Insert > Transient Blade Models from the shortcut menu.
   - Select Flow Analysis 1 (or whichever analysis is applicable) in the Outline tree, then select Insert > Transient Blade Row Models from the main menu.

2. Click OK.

22.2. Transient Blade Row Models Tab

The Transient Blade Row Models tab is available after you insert the object of the same name. For details, see Inserting a New Transient Blade Row Models Object (p. 239).

The following sections describe the settings on the Transient Blade Row Models tab

22.2.1. Transient Blade Row Model Settings

The Transient Blade Row Model > Option setting can have one of the following values:

- None
  
  This option disables Transient Blade Row modeling. It is useful when running transient simulations without any transformations.

- Profile Transformation
The **Transient Details** settings (**Time Period**, **Time Steps**, and **Time Duration**) must be configured. These settings are described in *Transient Details* (p. 242).

- **Time Transformation**

To help the solver apply the Time Transformation method to the applicable domains, you must accurately characterize a disturbance. For details, see *Time Transformation Disturbance Settings* (p. 240).

The **Transient Details** settings (**Time Period**, **Time Steps**, and **Time Duration**) must be configured. These settings are described in *Transient Details* (p. 242).

- **Fourier Transformation**

To help the solver apply the Fourier Transformation method to the applicable domains, you must accurately characterize a disturbance. For details, see *Fourier Transformation Disturbance Settings* (p. 241).

The **Transient Details** settings (**Time Period**, **Time Steps**, and **Time Duration**) must be configured. These settings are described in *Transient Details* (p. 242).

### 22.2.1.1. Time Transformation Disturbance Settings

A given domain can receive a disturbance from:

- An upstream or downstream domain interface that uses the Transient Rotor Stator frame change/mixing model. For example, the wake from a blade can pass through a domain interface and disturb the downstream domain(s).

  The Time Transformation method improves solution accuracy over that of the Profile Transformation method when there is unequal pitch between the blade row subsets on each side of a domain interface that uses the Transient Rotor Stator frame change/mixing model.

- Inlet or outlet (or opening) boundaries. For example, a boundary condition could use a CEL function that depends on space and time in order to mimic the wake of an upstream blade.

  The Time Transformation method can be applied to a domain that has an inlet or outlet disturbance.

To characterize a disturbance, create a new item by clicking *Add new item*, enter a unique name for the disturbance, then specify information about the disturbance in one of the following ways:

- **Rotor Stator option**

  This option can be applied only when the disturbance originates from a domain interface that uses the Transient Rotor Stator frame change/mixing model.

  After selecting this option:

  1. Select a **Domain Interface** from the existing domain interfaces that use the Transient Rotor Stator frame change/mixing model.

  2. For each side of the interface (**Side 1** and **Side 2**, which correspond to the first and second sides of the selected domain interface, respectively) specify the **Option** setting.

  The **Option** setting for each side is used to determine the domain(s) to which the Time Transformation method is applied. The options for each side are:
- **Automatic**

  This option causes the solver to identify the domain(s) directly touching the applicable side of the interface. This option is suitable when all the domains that are affected by the disturbance are in contact with the applicable side of the interface.

- **Domain List**

  This option enables you to manually select the domain(s) that are on the applicable side of the interface and that are affected by the disturbance. You might need to use this option if, for example, a blade row is modeled with two domains with one being downstream of the other, in which case you would select both domains as being on one side of the interface, even though one of those domains does not touch the interface.

- **None**

  This option prevents the present disturbance (but not any other disturbances) from applying the Time Transformation method to any domain that is on the applicable side of the interface.

For details, see [Case 1: Transient Rotor Stator Single Stage in the CFX-Solver Modeling Guide](#).

- **Rotational Flow Boundary Disturbance option**

  Use this option to characterize a disturbance that originates from a boundary condition (for example, an inlet or outlet boundary condition that is specified using one or more CEL expressions that depend on space and time).

  After selecting this option:

  1. Set **Domain Name** to the name of the domain(s) that are affected by the disturbance.

  2. Set the **Signal Motion** settings:

     - **Setting Option** to **Stationary** causes the signal to be stationary in the absolute (stationary) frame of reference.

     - **Setting Option** to **Rotating** enables you to select a coordinate frame as a way of specifying the signal motion. Any boundary using this coordinate frame will be made transient periodic with the period calculated from the pitch and rotating speed of the signal. For details on moving coordinate frames, see [Frame Motion Settings](#).

  3. Specify information about the external blade row that creates the disturbance in the **External Passage Definition** settings:

     - For a case with rotational periodicity, specify **Passages in 360**: the number of passages in 360° of the external blade row that creates the disturbance. Also specify **Passages / Component**: the number of passages in the external blade row that creates the disturbance.

  4. For a case with rotational periodicity, the **Passages in 360** and **Passages / Component** settings on the domain **Basic Settings** tab apply.

For details, see [Case 2: Flow Boundary Disturbance in the CFX-Solver Modeling Guide](#).

### 22.2.1.2. Fourier Transformation Disturbance Settings

A given domain can receive a disturbance from:

- Inlet or outlet (or opening) boundaries. For example, a boundary condition could use a CEL function that depends on space and time in order to mimic the wake of an upstream blade.
The Fourier Transformation method can be applied to a domain that has an inlet or outlet disturbance.

To characterize a disturbance, create a new item by clicking Add new item, enter a unique name for the disturbance, then specify information about the disturbance:

- **Rotational Flow Boundary Disturbance option**

  Use this option to characterize a disturbance that originates from a boundary condition (for example, an inlet or outlet boundary condition that is specified using one or more CEL expressions that depend on space and time).

  After selecting this option:

  1. Specify the **Phase Corrected Intf.** and **Sampling Domain Intf.** settings.

    The **Phase Corrected Intf.** setting specifies the periodic GGI-only bitmap-intersection-method interface (having rotational periodicity) to which to apply the phase shift with respect to the sampling domain interface signal.

    The **Sampling Domain Intf.** setting specifies the non-periodic non-frame-change GGI-only bitmap-intersection-method interface on which the Fourier coefficients will be accumulated. This is the interface between a pair of adjacent blades in a given component.

  2. Set the **Signal Motion** settings:

    - Setting **Option** to **Stationary** causes the signal to be stationary in the absolute (stationary) frame of reference.

    - Setting **Option** to **Rotating** enables you to select a coordinate frame as a way of specifying the signal motion. Any boundary using this coordinate frame will be made transient periodic with the period calculated from the pitch and rotating speed of the signal. For details on moving coordinate frames, see Frame Motion Settings.

  3. Specify information about the external blade row that creates the disturbance in the **External Passage Definition** settings:

    - For a case with rotational periodicity, specify **Passages in 360**: the number of passages in 360° of the external blade row that creates the disturbance. Also specify **Passages / Component**: the number of passages in the external blade row that creates the disturbance.

  4. For a case with rotational periodicity, the **Passages in 360** and **Passages / Component** settings on the domain **Basic Settings** tab apply.

  For details, see Case 2: Flow Boundary Disturbance in the CFX-Solver Modeling Guide.

**Note**

You must ensure that the disturbance is periodic in time when using the Rotational Flow Boundary Disturbance option.

### 22.2.2. Transient Details

The **Time Period** settings are used to establish a value for the time period in which each disturbance of interest cycles an integer number of times. The options for obtaining this number are:

- **Passing Period** (not available for the Fourier Transformation method)
When this option is selected, the time period is calculated automatically as:

- For inlet disturbance cases:
  The signal pitch divided by the relative velocity between the signal and the domain.

- For transient rotor stator cases:
  The result of dividing the blade pitch by the absolute value of the angular velocity of the rotor(s), for the specified domain.

Note that the blade pitch is indirectly specified via the Passages in 360 setting on the Basic Settings tab for the domain.

This resulting time period is displayed as the Passing Period.

• Automatic

When this option is selected, the time period is calculated automatically. The calculation uses the information specified for each disturbance, and the blade pitch of the domain. Note that the blade pitch of a domain is indirectly specified via the Passages in 360 setting on the Basic Settings tab for the domain.

The time period is given a value such that, during one period, each disturbance undergoes an integer number of cycles. This time period is displayed as the Passing Period.

The Min. Timesteps / Period is computed and displayed; it is the minimum number of time steps required to resolve each disturbance cycle period into an integer number of time steps.

In a typical transient simulation, you can specify the time step size directly. However, when using a Transient Blade Row model, the time step size is set indirectly.

The Time Steps settings control the size of a time step indirectly in one of two ways, depending on the option you choose:

• Number of Timesteps per Period

  The time step size is computed by dividing the Passing Period by a number, Timesteps per Period, that you specify.

• Timestep Multiplier (available only when the Time Period option is set to Automatic)

  The time step size is computed by dividing the Passing Period by the number of time steps per period, where the latter is the product of Min. Timesteps / Period and Timestep Multiplier.

You must ensure that the number of time steps per period is sufficient to resolve each disturbance. You must also ensure that the number of time steps per disturbance cycle period is an integer number. When using the Fourier Transformation method, it is essential to use an integer number for reasons of stability and accuracy. When using the Time Transformation method, the use of an integer number is recommended and is important for accuracy in post-processing the results.

The Time Duration settings control the length of the simulation directly by controlling the number of periods. This setting also indirectly controls the total number of time steps in the simulation.
Chapter 23: Mesh Adaption

Mesh Adaption in CFX is the process by which the mesh is selectively refined in areas that are affected by the adaption criteria specified. This means that as the solution is calculated, the mesh can automatically be made finer or coarser in locations where solution variables change rapidly, in order to resolve the features of the flow in these regions.

Each mesh element is given an Adaption Level. Each time the element is split into smaller elements, the new elements are assigned an Adaption Level that is one greater than the element it was generated from. The maximum number of Adaption Levels is controlled to prevent over-refinement.

In CFX, mesh adaption is available for single domain, steady-state problems; you cannot combine mesh adaption with Domain Interfaces, combine it with Solid Domains, or use it for an ANSYS Multi-field simulation. The Mesh Adaption process is performed by CFX-Solver. However, the parameters that control the Adaption process are defined in CFX-Pre on the Mesh Adaption form.

This chapter describes:

- **Overview** (p. 245)
- **Setting Up Mesh Adaption** (p. 246)
- **The Details View for Mesh Adaption** (p. 247)
- **Advanced Topic: Adaption with 2D Meshes** (p. 250)

23.1. Overview

The following will take place when CFX-Solver is run (on steady-state problems). The process is shown in the diagrammatic form below ([Figure 23.1 (p. 246)]).

1. The CFX-Solver solves for solution variables using the mesh that is contained in the CFX-Solver input file, or specified using an initial values file. The CFX-Solver uses Convergence Criteria that have been specified on the Basic Settings tab of the Mesh Adaption form; the Convergence Criteria specified on the Solver Control form is not used at this stage.
2. A Mesh Adaption Step (one loop of the adapt-solve cycle) takes place. Using the solution calculated in this first step, together with the Adaption Criteria specified on the Mesh Adaption Basic Settings form, the mesh is refined in selected areas. For details, see Mesh Adaption in the CFX-Solver Theory Guide.
3. The CFX-Solver solves for solution variables using the mesh created by the Mesh Adaption step. The CFX-Solver uses the Convergence Criteria specified on the Basic Settings tab of the Mesh Adaption form; the Convergence Criteria specified on the Solver Control form is not used at this stage.
4. Steps 2 and 3 are repeated until the Max. Num. Steps (specified on the Basic Settings of the Mesh Adaption form) is reached.
5. Finally, CFX-Solver solves for solution variables using the mesh that was created by the final Mesh Adaption step. The Convergence Criteria used by the CFX-Solver at this stage are those specified on the Solver Control form.
The Mesh Adaption step itself consists of the following:

1. The Adaption Criteria are applied to each edge of each element in the mesh.
2. Nodes are added to the existing mesh according to the Adaption Criteria. The number of nodes added is dependent on the total number of nodes to be added and the node allocation parameter.
3. The solution already calculated on the older mesh is linearly interpolated onto the new mesh.

If the CFX-Solver is being run in parallel, then each “Solve” step is preceded by a mesh partitioning step.

Additional information on how elements are selected for adaption, how elements are divided, and the limitations of mesh adaption in CFX is available in Mesh Adaption in the CFX-Solver Theory Guide.

23.2. Setting Up Mesh Adaption

To set up mesh adaption:
1. Select **Insert > Solver > Mesh Adaption.**

   The **Mesh Adaption** dialog box appears.

2. Select or clear **Activate Adaption.**

   If selected, Mesh Adaption performs when the solver is run.

3. Under **Region List**, select the regions to adapt.

   For details, see **Region List (p. 248).**

4. Select or clear **Save Intermediate Files.**

   For details, see **Save Intermediate Files (p. 248).**

5. Specify the required **Adaption Criteria.**

   For details, see **Adaption Criteria (p. 248).**

6. Specify the required **Adaption Method.**

   For details, see **Adaption Method (p. 249).**

7. Specify **Adaption Convergence Criteria.**

   For details, see **Adaption Convergence Criteria (p. 249).**

8. Select Adaption Variables from the Variables List.

9. Enter the Maximum Number of Adaption Steps (Max. Num. Steps) allowed.

   The default is 3. For details, see **Max. Num. Steps (p. 248).**

10. Select how many nodes should be present in the adapted mesh. Options are:

    • **Multiple of Initial Mesh**
    • **Final Number of Nodes**

    For details, see **Option (p. 249).**

11. Select an option for **Adaption Method > Option.**

    For details, see **Adaption Method (p. 249).**

12. Specify the **Adaption Convergence Criteria** to be used for each adaption step.

    For details, see **Adaption Convergence Criteria (p. 249).**

    This is different from the Convergence Criteria used to terminate the run, which is set in Solver Controller. For details, see **Basic Settings Tab (p. 199).**

13. Switch to the **Advanced Options** tab or click **OK** to accept the mesh adaption settings. For details, see **Advanced Options Tab (p. 249).**

**23.3. The Details View for Mesh Adaption**

The following tabs are presented on the details view of **Mesh Adaption**:

• **Basic Settings Tab (p. 248)**
23.3.1. Basic Settings Tab

The following sections describe the options available on the Basic Settings tab for Mesh Adaption.

23.3.1.1. Region List

Region List contains the names of all 3D Regions and Assemblies in the problem. Select any or all of the 3D regions to be used for mesh adaption.

Note

Mesh adaption cannot be used in multidomain simulations or in cases with external solver coupling. Mesh adaption also cannot be used for transient, mesh-motion, radiative-tracking, or particle-transport cases.

23.3.1.2. Save Intermediate Files

If Save Intermediate Files is selected, an intermediate results file is saved immediately before each mesh adaption step begins. At the end of the run, these intermediate files are stored in a subdirectory with the same name as the run, in the directory that contains the CFX-Solver results file.

23.3.1.3. Adaption Criteria

For each adaption step, and for each mesh element, the adaption criteria are applied, and mesh elements meeting the adaption criteria are refined. There are two methods of specifying how the adaption criteria are specified. For details, see Adaption Method (p. 249).

23.3.1.3.1. Variables List

The Variables List is used to select the variables that make up part of the Adaption Criteria.

During the adaption process, if only one variable is selected, the value of the variable is observed for each element defining the selected regions specified by the Region List. The maximum variation in value of the variable along any edge of an element is used to decided whether the element is to be modified. If multiple variables are selected, the maximum of variation of all the variables for a given element is used to decide whether or not an element should be modified.

To save unnecessary processing, it is important to ensure that variables selected will vary during the calculation. For instance, do not select Density as a variable for an incompressible flow calculation.

23.3.1.3.2. Max. Num. Steps

The number of steps that the adaption process performs is specified by Max. Num. Steps. It is recommended that you select a number between 1 and 5.

Note

If CFX-Solver runs on the CFX-Solver input file and finishes normally, this number of Adaption Steps will take place. If CFX-Solver is stopped and then restarted from the results file produced, only the remaining number of Adaption Steps will take place in the restarted run.
23.3.1.3.3. Option

The number of nodes in the final mesh generated by the adaption process is controlled by the value selected in Option.

Select Final Number of Nodes, to specify the number of nodes in the final mesh, or Multiple of Initial Mesh, which enables specification of the number of nodes in the final mesh as a multiple of the initial mesh.

If Multiple of Initial Mesh is selected, it is also necessary to specify a Node Factor multiplier greater than 1.2. If Final Number of Nodes is selected, then specify the number of Nodes in Adaption Mesh that is no more than a factor of five greater than the number of nodes in the initial mesh.

---

**Note**

The final mesh will not contain exactly the number of nodes specified in either case. For details, see Mesh Adaption in the CFX-Solver Theory Guide.

23.3.1.4. Adaption Method

The Adaption Method used by the adaption process to apply the Adaption Criteria is controlled by the options specified in the Adaption Method section of the form.

23.3.1.4.1. Option

The Adaption Method is specified as either Solution Variation, or Solution Variation * Edge Length.

If Solution Variation * Edge Length is selected, the Adaption Criteria takes account of both the variation of the solution variable over the edge of the element and the length of the edge. The result of having applied the Adaption Criteria to each edge of an element is then multiplied by the length of the edge. The maximum value of all the edges of the element is used to decide whether an element is to be refined. This means that in areas of the flow where the solution variation is similar, adaption will take place preferentially in regions where the mesh length scale is largest.

23.3.1.4.2. Minimum Edge Length

When Solution Variation is specified by Option, the Adaption Criteria is applied using only the maximum variation of a solution variable across any edge associated with an element. This option does not use the length of the edge in the calculation. In this case, consider specifying a Minimum Edge Length to avoid refining the mesh too far at a discontinuity in the solution. For details, see Mesh Adaption in the CFX-Solver Theory Guide.

23.3.1.5. Adaption Convergence Criteria

The convergence criteria used to specify when the CFX-Solver stops running on the original and intermediate meshes is specified in the Adaption Convergence Criteria section of the form. The available parameters are the same as those used to determine the final convergence of the solution. For details, see Basic Settings Tab (p. 199).

23.3.2. Advanced Options Tab

It is possible to specify some further parameters to control the adaption process, these are specified on the Advanced Options tab of the Mesh Adaption form.
23.3.2.1. Node Alloc. Param.

Setting the node allocation parameter, Node Alloc. Param., controls how much the mesh is refined at each adaption step. For some problems, it may be that it is better to refine a lot in the early steps, and for others it may be more appropriate to refine more in the later steps.

Node Alloc. Param. is used as follows. On the \( n \)th adaption step, approximately \( S_n \) nodes are added to the mesh, where

\[
S_n = \frac{M n^{-c}}{\sum n^{-c}}
\]

\( M \) is the maximum number of nodes that can be added to the original mesh calculated from having applied the Adaption Criteria to the selected regions and \( c \) is the value of Node Alloc. Param.. For details, see Adaption Criteria (p. 248).

When Node Alloc. Param. is set to 0, then the same number of nodes is added for each adaption step. When Node Alloc. Param. is negative, more nodes are added in the later adaption steps. When it is positive, more nodes are added in the earlier adaption steps. The table below shows the percentage of nodes that will be added at each adaption step when Max. Num. Steps is set to a value of 3 and different values of Node Alloc. Param. are specified.

<table>
<thead>
<tr>
<th>Node Alloc. Param</th>
<th>Step 1</th>
<th>Step 2</th>
<th>Step 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>-2.0</td>
<td>7.14%</td>
<td>28.57%</td>
<td>64.28%</td>
</tr>
<tr>
<td>-1.0</td>
<td>16.66%</td>
<td>33.33%</td>
<td>50.00%</td>
</tr>
<tr>
<td>0.0</td>
<td>33.33%</td>
<td>33.33%</td>
<td>33.33%</td>
</tr>
<tr>
<td>0.5</td>
<td>43.77%</td>
<td>30.95%</td>
<td>25.27%</td>
</tr>
<tr>
<td>1.0</td>
<td>54.54%</td>
<td>27.27%</td>
<td>18.18%</td>
</tr>
<tr>
<td>2.0</td>
<td>73.47%</td>
<td>18.36%</td>
<td>8.16%</td>
</tr>
</tbody>
</table>

It is recommended that you set a value for Node Alloc. Param. in the range -2 to 2.

23.3.2.2. Number of Levels

The value of this parameter specifies the maximum number of times any element of the original mesh can be subdivided. It must not be greater than Max. Num. Steps.

23.4. Advanced Topic: Adaption with 2D Meshes

2D Meshes are not supported in CFX. However, CFX can use 3D meshes that are one element thick. This section outlines a workaround for such meshes when using mesh adaption.

CFX 2D meshes contain hexahedral, prismatic and potentially pyramidal and tetrahedral elements. In the support of prismatic inflation in 3D meshes, special restrictions are applicable to the adaption of prismatic elements. If adaption is applied to a 3D mesh that is one element thick, an error will result. In order to work around this, set the environment variable CFX5REFERNER_NO_TRICOLUMNS to 1 before starting CFX-Pre. Note that any refinement that takes place will be 3D refinement that will introduce additional elements in the third dimension. This environment variable can also be used when the
input mesh has prismatic elements that have opposite triangular faces on the boundary. This can arise if the mesh has been imported from a mesh generation tool other than CFX-Mesh.
Chapter 24: Expert Control Parameters

This chapter describes:

- **Modifying Expert Control Parameters** (p. 253)

All geometry, domain, boundary condition, mesh, initial value and solver parameter information is written to the CFX-Solver Input (.def) File.

The CFX-Solver input file contains the relevant information required by the CFX-Solver to conduct the CFD simulation. This information mainly consists of numerical values that set up the simulation, as well as controls for the CFX-Solver.

Many of these parameters are set in CFX-Pre. For example, on the **Solver Control** panel, you can set the accuracy of the numerical discretization. Other settings, particularly those controlling the CFX-Solver, cannot be set in the normal way through the CFX-Pre interface. These are called **Expert Control Parameters** and have default values that do not require modification for the majority of CFD simulations. For details, see *When to Use Expert Control Parameters in the CFX-Solver Modeling Guide* and *CFX-Solver Expert Control Parameters in the CFX-Solver Modeling Guide*.

### 24.1. Modifying Expert Control Parameters

1. Select **Insert > Solver > Expert Parameter**.

   The **Extra Parameters** details view appears.

2. Make changes to the appropriate sections on any of the following tabs: **Discretization**, **Linear Solver**, **I/O Control**, **Convergence Control**, **Physical Models**, **Particle Tracking**, or **Model Overrides**.

   Making changes requires selecting options and setting specific values. For parameters with a small number of choices (such as logical parameters), select an option from the drop-down list. Other parameters require data entry (such as real numbers).

   For details on each of the parameters listed on these tabs, see *CFX-Solver Expert Control Parameters in the CFX-Solver Modeling Guide*.

3. Repeat the previous step as desired.

4. Click **OK**.
Chapter 25: Coordinate Frames

By default, all quantities used in CFX-Pre are defined with reference to the global Cartesian coordinate frame. In some cases, it is useful to use a different coordinate frame for specifying boundary conditions, initial conditions, source components or spatially varying material properties. It is possible to specify one or more local coordinate frame objects which can then be referred to. This chapter describes the user interface for creating local coordinate frame objects. For details, see Coordinate Frames in the CFX-Solver Modeling Guide.

Local Coordinate Frame objects may be defined in terms of Cartesian coordinates. Here, the numbers 1, 2, 3 are used to denote the Cartesian X, Y, Z axes.

This chapter describes:
25.1. Creating a New Coordinate Frame
25.2. Coordinate Frame Basic Settings Tab

25.1. Creating a New Coordinate Frame

1. Select Insert > Coordinate Frame.

   The Insert Coordinate Frame dialog box appears

2. Set Name to a unique name for the coordinate frame.

   Coord 0 cannot be used as a name as it is the default coordinate frame. For details, see Valid Syntax for Named Objects (p. 55).

3. Click OK.

   The coordinate frame details view appears, with the Basic Settings tab visible.

4. Specify the basic settings.

   For details, see Coordinate Frame Basic Settings Tab (p. 255).

5. Click OK.

   An object named after the coordinate frame is created and listed in the tree view under Simulation.

25.2. Coordinate Frame Basic Settings Tab

The Basic Settings tab for a coordinate frame object contains settings that specify the coordinate frame. It is accessible by creating a new coordinate frame or by editing a coordinate frame listed in the tree view.

25.2.1. Coordinate Frame: Option
25.2.2. Coordinate Frame: Centroid
25.2.3. Coordinate Frame: Direction
25.2.4. Coord Frame Type
25.2.5. Reference Coord Frame
25.2.1. Coordinate Frame: Option

25.2.1.1. Point and Normal

This method can be used to make Cartesian coordinate frames. The origin of the coordinate frame is set to the centroid of a specified 2D region (which is available only when a mesh exists). Axis 3 of the coordinate frame is then computed as locally normal to the 2D region; its direction can be reversed if not satisfactory (after examining the coordinate frame representation in the viewer). Optionally, Axis 1 may be given a prescribed orientation about Axis 3 by specifying a point that is interpreted as lying on the 1-3 plane with a positive Axis 1 coordinate. If such a point is not specified explicitly, the global origin is used. Axis 2 is found by the right-hand rule.

25.2.1.2. Axis Points

This method can be used to make Cartesian coordinate frames. The coordinate frame is created by specifying three points. It is important to understand how these three points are used to create a coordinate frame. For details, see Coordinate Frame Details in the CFD-Post User's Guide.

25.2.2. Coordinate Frame: Centroid

25.2.2.1. Location

(applies only when Option is set to Point and Normal)

Select a 2D region or combination of 2D regions, the centroid of which will be used as the origin of the coordinate frame.

Tip

Hold the Ctrl key when clicking to select multiple regions.

Tip

With Single Select selected, you may click locations in the viewer to make them available for selection.

25.2.2.2. Centroid Type

(applies only when Option is set to Point and Normal)

• Absolute

The true centroid position is used. If the specified region is not planar, the absolute centroid may not lie on the surface.

• Nearest Point on Mesh
The mesh node nearest to the true centroid is used.

### 25.2.3. Coordinate Frame: Direction

#### 25.2.3.1. Invert Normal Axis Direction Check Box

( applies only when Option is set to Point and Normal )

This check box determines whether or not the direction of the Z-axis is reversed from that initially determined.

#### 25.2.3.2. Point on Reference Plane 1-3 Check Box

( applies only when Option is set to Point and Normal )

This check box determines whether or not the theta=0 direction is defined explicitly by a point in the 1-3 plane. If selected, you must specify that point.

#### 25.2.3.3. Point on Reference Plane 1-3 Check Box: Coordinate

Enter global Cartesian coordinates that define a point on the 1-3 plane of the coordinate frame. The direction of this point from the nearest point on Axis 3 is the direction of Axis 1. Axis 1 corresponds with the radial direction for theta=0.

---

**Tip**

With Single Select selected, you may click 2D locations in the viewer to select their corresponding points.

### 25.2.4. Coord Frame Type

( applies only when Option is set to Axis Points )

Coordinates interpreted with reference to the coordinate frame will be interpreted as Cartesian. For details, see Cartesian Coordinate Frames in the CFX-Solver Modeling Guide.

### 25.2.5. Reference Coord Frame

( applies only when Option is set to Axis Points )

Select an existing coordinate frame to use as a basis for interpreting the point data that defines the present coordinate frame.

### 25.2.6. Origin

( applies only when Option is set to Axis Points )

In the reference Coordinate Frame, enter coordinates that define the origin of the present coordinate frame.
Chapter 25: Coordinate Frames

Tip

With Single Select selected, you may click 2D locations in the viewer to select their corresponding points.

25.2.7. Z-Axis Point

(applies only when Option is set to Axis Points)

In the reference Coordinate Frame, enter coordinates that define a point on the positive side of the Z-axis of the present Coordinate Frame.

Tip

With Single Select selected, you may click locations in the viewer.

25.2.8. X-Z Plane Point

(applies only when Option is set to Axis Points)

In the reference Coordinate Frame, enter coordinates that define a point on the X-Z plane of the present Coordinate Frame.

The direction of this point from the nearest point on the Z-axis is the direction of the X-axis.

Tip

With Single Select selected, you may click locations in the viewer.

25.2.9. Frame Motion Settings

The options are:

- Stationary
- Rotating

You can specify a constant angular velocity for the coordinate frame by setting Option to Rotating and specifying a (constant) value (which could be in the form of a CEL expression) for the Angular Velocity. You will also have to specify a stationary axis about which the rotation occurs, using the Axis Definition settings.

A boundary condition can use a rotating coordinate frame as its local frame of reference in order to cause an applied profile (for example, a pressure profile) to move.

25.2.10. Visibility Check Box

This check box determines whether or not the graphics representation of the coordinate axis is displayed in the viewer.
Chapter 26: Materials and Reactions

The tree view contains a Materials object and a Reactions object, which contain all the currently available materials and reactions.

A Material details view is available for editing the properties of new or existing fluids, solids, and mixtures. The new or modified materials can then be selected for use in your simulation or reaction definitions. For details, see Materials (p. 259).

A Reaction details view is available for editing the properties of new or existing reactions. For details, see Reactions (p. 270).

Note

You can set only those material properties that will be used in the CFD model. For example, you can set the buoyancy properties only if your model involves buoyant flow.

You can use CEL to define fluid property variation through an expression if it is required. For example, you could define Dynamic Viscosity to be a function of Temperature.

26.1. Materials

The Material details view, accessible by editing a material from the tree view or by creating a new material, is used to prepare materials for availability in a simulation.

The following topics will be discussed:

26.1.1. Library Materials
26.1.2. Material Details View: Common Settings
26.1.3. Material Details View: Pure Substance
26.1.4. Material Details View: Fixed Composition Mixture
26.1.5. Material Details View: Variable Composition Mixture
26.1.6. Material Details View: Homogeneous Binary Mixture
26.1.7. Material Details View: Reacting Mixture
26.1.8. Material Details View: Hydrocarbon Fuel

26.1.1. Library Materials

CFX-Pre provides an extensive list of library materials. Properties for these have already been defined and are known to CFX-Pre. If you modify a library material during a simulation using the Material details view, the modified definition is stored in the simulation file and is therefore local to your simulation.

On the Outline tab, right-click Materials and select Import Library Data to open the Select Library Data to Import dialog box. From here, you can select a material to load.

If necessary, you can open the File to Import dialog box by clicking Browse. The dialog box will open with the default location: <CFXROOT>/etc/materials-extra/. This directory contains CCL
files that can be used to load additional materials into CFX-Pre (for example, Redlich Kwong, IAPWS, or Interphase Mass Transfer materials).

If you want to use a material defined in one simulation in another simulation, the recommended method is to use the Export and Import CCL features to load the material definition from a local file. This is done by exporting CCL objects of type LIBRARY:LIBRARY/MATERIAL. For details, see Import CCL Command (p. 35) and Export CCL Command (p. 36).

### 26.1.2. Material Details View: Common Settings

#### 26.1.2.1. Option

Any material can consist of one or more materials. If a material contains only a single pure species, then it is known as a pure substance. If it contains more than one species, then it is known as a mixture. The materials are assumed to be mixed at the molecular level in the mixture.

The type of material is set using the following options:

- **The Pure Substance** option should be used to create a fluid whose properties, such as viscosity, density, or molar mass, are known. All existing and newly created pure substances appear in the materials list and you can then create mixtures from them. For details, see Material Details View: Pure Substance (p. 263).

- **The Fixed Composition Mixture** option should be used to create a mixture with fixed mass fractions of each material. The mass fraction of each material is specified and is not allowed to change during the course of the simulation in space or time. For details, see Material Details View: Fixed Composition Mixture (p. 266).

- **The Variable Composition Mixture** option should be used to create a mixture whose mass fractions are allowed to change during the course of a simulation in space and time. The mass fraction of each material is not specified when defining the fluid. You can use a fixed composition mixture as a material in a variable composition mixture.

  For details, see Material Details View: Variable Composition Mixture (p. 267).

- **The Homogeneous Binary Mixture** option applies to equilibrium phase change calculations. For details, see Material Details View: Homogeneous Binary Mixture (p. 267).

- **The Reacting Mixture** option is used for a chemical reaction, such as combustion.

  For details, see Material Details View: Reacting Mixture (p. 268).

- **The Hydrocarbon Fuel** option. For details, see Material Details View: Hydrocarbon Fuel (p. 269).

#### 26.1.2.2. Material Group

The Material Group filter is used to group materials by type, as well as restrict what materials can be mixed when the physical models include reactions or phase change. A material can be a member of more than one material group if it has a consistent set of properties. Material Group will always be set to at least one of the following:

#### 26.1.2.2.1. User

Any user-defined materials, not assigned to one of the other groups, are shown in or can be added to this group. For example, materials loaded from a previous CFX-Pre simulation are shown in this group.
26.1.2.2.2. Air Data

This group contains Ideal Gas and constant property air. Constant properties are for dry air at both 0 [°C], 1 [atm] (STP) and 25 [°C], 1 [atm].

26.1.2.2.3. CHT Solids

Contains solid substances that can be used for solid domains when performing conjugate heat transfer modeling.

26.1.2.2.4. Calorically Perfect Ideal Gases

Contains gases that obey the Ideal Gas Law.

26.1.2.2.5. Constant Property Gases / Liquids

These groups contain gas and liquid substances with constant properties.

The gas properties are calculated at STP (0 [°C] and 1 [atm]). Gas materials in this group can be combined with NASA SP-273 materials for use in combustion modeling simulations.

26.1.2.2.6. Dry/Wet Redlich Kwong

No materials appear in this group by default, they must be loaded from a pre-supplied materials file. All materials in this group use the built-in Redlich-Kwong equation of state and are suitable for performing equilibrium, homogeneous, phase change modeling.

For any given pure substance, there are three different materials. There is a material with a RK tag, used for dry vapor calculations, and three materials with RKv, RKl and RKlv suffixes, which are used for equilibrium phase change (wet vapor) calculations.

26.1.2.2.7. Dry/Wet Redlich Kwong RGP

No materials appear in this group by default, they must also be loaded from a pre-supplied materials file. All materials in this group use the Redlich-Kwong equation of state with properties specified in a TASCflow RGP file. These materials are suitable for performing equilibrium, homogeneous, phase change modeling.

Like the built-in Redlich Kwong group, for any given pure substance there are three different materials. There is a material with a RK tag, used for dry vapor calculations, and three materials with RKv, RKl and RKlv suffixes, which are used for equilibrium phase change (wet vapor) calculations.

26.1.2.2.8. Dry/Wet Peng Robinson RGP

No materials appear in this group by default, they must also be loaded from a pre-supplied materials file. All materials in this group use the Redlich-Kwong equation of state with properties specified in a TASCflow RGP file. These materials are suitable for performing equilibrium, homogeneous, phase change modeling.

Like the built-in Redlich Kwong group, for any given pure substance there are three different materials. There is a material with a RK tag, used for dry vapor calculations, and three materials with RKv, RKl and RKlv suffixes, which are used for equilibrium phase change (wet vapor) calculations.
26.1.2.2.9. Dry/Wet Soave Redlich Kwong RGP

No materials appear in this group by default, they must also be loaded from a pre-supplied materials file. All materials in this group use the Redlich-Kwong equation of state with properties specified in a TASCflow RGP file. These materials are suitable for performing equilibrium, homogeneous, phase change modeling.

Like the built-in Redlich Kwong group, for any given pure substance there are three different materials. There is a material with a RK tag, used for dry vapor calculations, and three materials with RKv, RKl and RKlv suffixes, which are used for equilibrium phase change (wet vapor) calculations.

26.1.2.2.10. Dry/Wet Steam

No materials appear in this group by default, they must also be loaded from a pre-supplied materials file. Materials in this group use the IAPWS equation of state. Again, the materials are suitable for either dry or wet steam calculations.

26.1.2.2.11. Gas Phase Combustion

Contains materials that can be used for gas phase combustion. All materials in this group use the Ideal Gas equation of state. The specific heat capacity, enthalpy and entropy for each of the materials are specified using the NASA SP-273 format. For details, see NASA Format in the CFX-Solver Modeling Guide.

26.1.2.2.12. Interphase Mass Transfer

This group contains materials that can be used for Eulerian or Lagrangian interphase mass transfer. This group currently contains a number of materials that have liquid or gas reference states, which are consistent for performing phase change calculations. The gas phases use the ideal gas equation of state and temperature dependent specific heat capacity. The associated liquid phases use constant properties.

26.1.2.2.13. Particle Solids

Contains a list of solids that can be used in Particle Tracking calculations.

26.1.2.2.14. Soot

This group contains solid substances that can be used when performing soot calculations.

26.1.2.2.15. Water Data

This group contains liquid and vapor water materials with constant properties. The materials in this group can be combined with NASA SP-273 materials for use in combustion modeling simulations.

26.1.2.3. Material Description

This parameter can be toggled on to view a detailed description of the substance. Click Edit the Material Description to edit the description (to a maximum of 120 alphanumeric characters).

26.1.2.4. Thermodynamic State

This parameter sets the state of a substance to solid, liquid or gas. There are certain limitations imposed by selecting a particular state. For example, a solid must always have at least density, specific heat capacity and thermal conductivity specified.
26.1.2.5. Coord Frame

For material properties that are set using expressions containing X, Y, or Z, you may want to supply a custom coordinate frame as the basis for evaluation of such properties. For details, see Coord Frame (p. 263), Coordinate Frames (p. 255), and Coordinate Frames in the CFX-Solver Modeling Guide.

26.1.3. Material Details View: Pure Substance

The following topics will be discussed:

• Basic Settings Tab (p. 263)
• Material Properties Tab (p. 263)

26.1.3.1. Basic Settings Tab

The Basic Settings tab is used to set the type of material, its state, an optional description and an optional coordinate frame.

1. Set the Material Group.
   For details, see Material Group (p. 260).
2. The Material Description field is optional.
   For details, see Material Description (p. 262).
3. Select the Thermodynamic State.
   For details, see Thermodynamic State (p. 262).
4. Optionally set a custom coordinate frame for any material properties that depend on expressions in X, Y, or Z.
   For details, see Coord Frame (p. 263), Coordinate Frames (p. 255), and Coordinate Frames in the CFX-Solver Modeling Guide.

26.1.3.2. Material Properties Tab

There are two main categories specifying properties of a pure substance: General Material and Table. A General Material can have its thermodynamic, transport and radiation properties defined in the most general manner using any of the built-in flow solver models, constants, or CEL expressions. A table material uses a TASCflow RGP file to look up the required values. For details, see Table (p. 265).

26.1.3.2.1. General Material

General Materials can have their Equation of State set to the following options:

• Equation of State - Value (p. 264).
• Equation of State - Ideal Gas (p. 264).
• Equation of State - Real Gas (p. 264).

For details on equations of state, see Equation of State in the CFX-Solver Modeling Guide.
26.1.3.2.1.1. Equation of State - Value

The following tab appears when Equation of State is set to Value. Value uses whichever model for density that is supplied by the user. For example, the equation of state model could be a constant or a CEL expression.

- **Equation of State > Option.** For details, see Option in the CFX-Solver Modeling Guide.
- Specify the **Density** and **Molar Mass.** An expression can be used for Density that depends on temperature and/or pressure. In this case, the CFX-Solver may build property tables in order to calculate enthalpy and entropy. If you use this option, check the table generation settings.

Additional information on Material Properties is available in:

- Specific Heat Capacity in the CFX-Solver Modeling Guide
- Transport Properties in the CFX-Solver Modeling Guide
- Radiation Properties in the CFX-Solver Modeling Guide
- Buoyancy Properties in the CFX-Solver Modeling Guide

26.1.3.2.1.2. Equation of State - Ideal Gas

- If you set the specific heat capacity using a CEL expression, the solver will build tables for enthalpy and entropy. If you use this option, check the table generation settings.
- For an ideal gas, specify the **Molar Mass.** For details, see Molar Mass in the CFX-Solver Modeling Guide.

Additional information on ideal gas is available in:

- Ideal Gas in the CFX-Solver Modeling Guide
- Reference State Properties in the CFX-Solver Modeling Guide
- Transport Properties in the CFX-Solver Modeling Guide.

26.1.3.2.1.3. Equation of State - Real Gas

The Real Gas option can be specified to model non-ideal gases and some liquid phase properties. Set **Model** to one of the following:

- Aungier Redlich Kwong (the default model)
- Peng Robinson
- Soave Redlich Kwong
- Standard Redlich Kwong.

To load the Real Gas materials into CFX-Pre:

1. On the **Outline** tab, right-click Materials and select **Import Library Data.**
2. In the **Select Library Data to Import** dialog box, click **Browse** and open the MATERIALS-redkw.ccl, MATERIALS-sredkw.ccl, or MATERIALS-pengrob.ccl file, which contain pre-defined real gas materials model.
3. Select the group of materials to load and click **OK.**
4. Complete all of the data fields on the **Materials Properties** tab to use a Real Gas equation of state, then click **OK**.

Additional information on Real Gas models is available in:

- Real Gas in the *CFX-Solver Modeling Guide*
- Specific Heat Capacity in the *CFX-Solver Modeling Guide*
- Transport Properties in the *CFX-Solver Modeling Guide*.
- Real Gas Properties in the *CFX-Solver Theory Guide*

### 26.1.3.2.2. Table

**Table** uses a CFX-TASCflow real gas property (RGP) file to load real fluid property data (see *Real Fluid Properties in the CFX-Solver Modeling Guide*). You can load all of the RGP files that are supplied with CFX quickly by following the instructions given in *Loading an .rgp file in the CFX-Solver Modeling Guide*. When defining materials that use data in tables not supplied with CFX, the definition is carried out separately by specifying the filename and component name for each material in turn. When **Table** is selected, the following form appears:

TASCflow RGP file **Table Format** is the only type supported for CFX.

1. Click **Browse** beside **Table Name** to browse to the file containing the Real Gas Property Table data.
2. Enter the **Component Name** (as an RGP file can contain many components).

   The component name corresponds to the name of a component in an RGP file. You may need to open the RGP file in a text editor to discover the exact name of the component you want to select.

   For details, see *Detailed .rgp File Format in the CFX-Solver Modeling Guide*.

### 26.1.3.2.3. Table Generation

For some equation of state and specific heat capacity settings (such as Redlich Kwong, IAPWS, and general materials having variable density and specific heat set with CEL expressions), the CFX-Solver builds internal property tables for efficient property evaluation. The most commonly required table is enthalpy as a function of temperature and possibly pressure. This table is built if the specific heat capacity is a function of temperature, and, possibly pressure. Entropy tables are also used to convert static and total pressure (or vice versa). For example, at a boundary condition you may specify the total pressure and the flow solver will use entropy tables to calculate the static pressure. When using CEL expressions for density and specific heat capacity the solver uses an adaptive algorithm to control the generation of the tables. In some cases, it may be necessary to alter some table generation details, as described by the following parameters:

#### 26.1.3.2.3.1. Minimum and Maximum Temperature

These correspond to the lower and upper temperature bounds of the table. The selected values should exceed the expected temperature range somewhat, but to keep the size of the table from becoming too big, it should not exceed the expected range by a factor much greater than 2.

#### 26.1.3.2.3.2. Minimum and Maximum Absolute Pressure

These correspond to the lower and upper absolute pressure bounds of the table. As with the temperature bounds, the selected values should exceed the expected absolute pressure range, but not by too much.
26.1.3.2.3. Error Tolerance

The table generation algorithm used by the solver is adaptive, and may cluster values where needed to resolve nonlinearities in the property definitions. The table generation is required to satisfy an error tolerance, defined as the relative error between the interpolation error and the exact value. The default tolerance (0.01 for enthalpy and 0.03 for entropy) is usually adequate.

26.1.3.2.3.4. Maximum Points

This parameter specifies the maximum number of points (values) for each table dimension. Fewer points may be required if the error criterion is met sooner. The default value of 100 is usually adequate.

Note

If the error tolerance cannot be met with the specified maximum number of points, the CFX-Solver will revert to a uniform table with a resolution set to the maximum number of points.

26.1.3.2.3.5. Pressure/Temperature Extrapolation

This controls the solver behavior when evaluating properties at temperatures or pressures beyond the table range. If extrapolation is activated, the property will be extrapolated based on its slope at the table boundary; otherwise, the value at the table boundary will be used. In either case, a message is written to the output file that an out-of-bounds has occurred. If this happens, you should consider increasing the table range accordingly.

26.1.4. Material Details View: Fixed Composition Mixture

This panel describes the Material details view when creating a fixed composition mixture. Fixed composition mixtures can consist of pure substances only and not other fixed composition mixtures. You can include any combination of materials in a fixed composition mixture. To combine materials from different material groups, however, you must first select the Material Groups that contain those materials. For example, to select Air at 25 C and Water at 25 C, you would first need to select the groups Air Data and Water Data.

For details, see Multicomponent Flow in the CFX-Solver Modeling Guide.

26.1.4.1. Basic Settings Tab

1. Select the Material Group(s) that contain the required materials.
2. Use Materials List to add new materials to the mixture.
3. The Material Description field is optional.

   For details, see Material Description (p. 262).

4. Select the Thermodynamic State.

   For details, see Thermodynamic State (p. 262).

5. Optionally set a custom coordinate frame for any material properties that depend on expressions in X, Y or Z.

   For details, see Coord Frame (p. 263), Coordinate Frames (p. 255), and Coordinate Frames in the CFX-Solver Modeling Guide.
6. Select a material, from the **Child Materials** list box.
7. Enter the fixed **Mass Fraction** of the material within the mixture.

The sum of the mass fractions for all the materials in a mixture **must be 1**.

### 26.1.4.2. Mixture Properties Tab

**Mixture Properties** can be used to explicitly set values when the **Ideal Mixture** model produces unsatisfactory results. The same options apply for fixed composition mixtures as for variable composition mixtures. For details, see **Mixture Properties Tab** (p. 267).

### 26.1.5. Material Details View: Variable Composition Mixture

This panel describes the **Material** details view when creating a variable composition mixture. Components of a variable composition mixture can be pure substances and fixed composition mixtures. For details, see **Multicomponent Flow in the CFX-Solver Modeling Guide**.

#### 26.1.5.1. Basic Settings Tab

1. Select the **Material Group(s)** that contain the required materials.
2. Use **Materials List** to add new materials to the mixture.
3. The **Material Description** field is optional.

   For details, see **Material Description** (p. 262).
4. Select the **Thermodynamic State**.

   For details, see **Thermodynamic State** (p. 262).
5. Optionally set a custom coordinate frame for any material properties that depend on expressions in X, Y or Z.

   For details, see **Coord Frame** (p. 263), **Coordinate Frames** (p. 255), and **Coordinate Frames in the CFX-Solver Modeling Guide**.

#### 26.1.5.2. Mixture Properties Tab

When you create a fixed composition, variable composition, or a reacting mixture, then the fluid properties are determined by mass averaging the properties of the component materials. In some cases, the ideal mixture rule used by the CFX-Solver may not be representative of the mixture properties. You can override the individual thermodynamic and transport properties by enabling the appropriate toggles and directly specifying the mixture properties. For details, see **Mixture Properties (Fixed and Variable)** in the **CFX-Solver Modeling Guide**. For additional information on options for Specific Heat Capacity, see **Specific Heat Capacity in the CFX-Solver Modeling Guide**. For details on modeling the reacting mixtures, see **Using Combustion Models in the CFX-Solver Modeling Guide**.

### 26.1.6. Material Details View: Homogeneous Binary Mixture

Homogeneous binary mixtures are used to define the phase boundary between two chemically equivalent materials in different thermodynamic states. For example, you could define the vapor pressure curve between water and steam. The vapor pressure curve is used by the flow solver to determine the saturation properties of the two materials. A homogeneous binary mixture is required for running the Equi-
librium phase change model. Additionally, it can be used with the Eulerian multiphase thermal phase change model or the Lagrangian particle tracking evaporation model.

The **Basic Settings** tab is used to specify the two materials that form the mixture. On the **Saturation Properties** tab, the saturation properties can be specified.

### 26.1.6.1. Basic Settings Tab

1. Select the **Material Group(s)**.
2. Select the two constituent materials for the binary mixture.
3. The **Material Description** field is optional.

   For details, see *Material Description* (p. 262).

### 26.1.6.2. Saturation Properties Tab

#### 26.1.6.2.1. General

The **General** option can be used to specify the saturation temperature or Antoine coefficients for materials that do not use a table or Redlich Kwong equation of state. If you set **Pressure > Option** to Antoine Equation option, then the flow solver automatically calculates saturation temperature. For details, see *Antoine Equation in the CFX-Solver Modeling Guide*. If you set **Pressure > Option** to Value, you must specify the saturation pressure and the corresponding saturation temperature. For details, see *Using a General Setup in the CFX-Solver Modeling Guide*.

#### 26.1.6.2.2. Table

Files of type (*.rgp) are filtered from the list of files in the current directory.

#### 26.1.6.2.3. Real Gas

When **Real Gas** is chosen, the saturation properties are calculated using the material properties specified for the constituent components, and there is no need to set any values. As a consequence, the material properties for components in the mixture must all use the same Real Gas equation of state. For details, see *Using a Real Gas Equation of State in the CFX-Solver Modeling Guide*.

#### 26.1.6.2.4. Table Generation

For details, see *Table Generation* (p. 265).

### 26.1.7. Material Details View: Reacting Mixture

The following topics will be discussed:

- **Basic Settings Tab** (p. 268)
- **Mixture Properties Tab** (p. 269)

### 26.1.7.1. Basic Settings Tab

A reacting mixture contains at least one reaction. For details, see *Reactions* (p. 270). The details for each of the components are set under **Component Details** on the **Fluid Models** tab when defining your domain. For details, see *Fluid Models Tab* (p. 113).
1. Select the **Material Group** types.
2. Select the reactions from the **Reactions List**.
3. The **Material Description** field is optional.
   
   For details, see *Material Description (p. 262)*.
4. Select the **Thermodynamic State**.
   
   For details, see *Thermodynamic State (p. 262)*.
5. Optionally set a custom coordinate frame for any material properties that depend on expressions in X, Y, or Z.
   
   For details, see *Coord Frame (p. 263), Coordinate Frames (p. 255), and Coordinate Frames in the CFX-Solver Modeling Guide*.
6. From **Additional Materials List**, select any additional inert materials (which do not take part in any reaction).

### 26.1.7.2. Mixture Properties Tab

Mixture properties for reacting mixtures are the same as for fixed and variable composition mixtures.
For details, see *Mixture Properties Tab (p. 267)*.

### 26.1.8. Material Details View: Hydrocarbon Fuel

The following topics will be discussed:

- **Basic Settings Tab** (p. 269)
- **Proximate/ Ultimate Analysis Tab** (p. 269)
- **Mixture Materials Tab** (p. 269)

More information about hydrocarbon fuel models is available in Hydrocarbon Fuel Model Setup in the CFX-Solver Modeling Guide and in Hydrocarbon Fuel Analysis Model in the CFX-Solver Theory Guide.

#### 26.1.8.1. Basic Settings Tab

This tab is identical to the Basic Settings tab for pure substances. For details, see *Basic Settings Tab (p. 263)*.

#### 26.1.8.2. Proximate/ Ultimate Analysis Tab

For details, see Hydrocarbon Fuel Analysis Model in the CFX-Solver Theory Guide.

#### 26.1.8.3. Mixture Materials Tab

The material components in the model need to be mapped to solver alias names. For example, carbon dioxide could be represented in the solver by CO2, Carbon Dioxide CO2, CO2 modified, and so on.

**Particle Mixture** defines the components of the hydrocarbon fuel particles. The names for the ash, char and raw combustible component materials must be given.

**Gas Mixture** is for identifying the components of the gas-phase reacting mixture. Two options are available:
• **Mixture** asks for the name of the associated gas-phase material (reacting mixture) and provides parameters to identify the components of the gas phase, which are relevant for the hydrocarbon fuel model.

• **Mixture with HCN NO** additionally enables entering the names for the gas components involved in the fuel-nitrogen model.

Note that here the components of the gas phase are identified only for the hydrocarbon fuel model. The reacting mixture material still must be created with all its components in the same way as for gaseous combustion. It may have additional components in addition to those identified here.

**Binary Mixture** is for defining the homogeneous binary mixture material, which describes the heat transfer between the particle and the fluid mixture. For the two materials in the binary mixture you should specify the raw combustible material for the particle and the volatiles fuel for the gas phase.

### 26.2. Reactions

The **Reaction** details view, accessible by editing a reaction from the tree view or by creating a new reaction, is used to prepare reactions for availability in a simulation.

Once a reaction is created, it is available for inclusion in a fluid that is a reacting mixture or a variable composition mixture. For details, see:

- **Material Details View: Reacting Mixture** (p. 268)
- **Material Details View: Variable Composition Mixture** (p. 267).

#### 26.2.1. Basic Settings Tab

Four types of reactions can be created on the **Basic Settings** tab:

- **Single Step** (p. 270)
- **Multiple Step** (p. 271)
- **Flamelet Library** (p. 272)
- **Multiphase** (p. 272)

#### 26.2.2. Single Step

This option displays three other tabs in addition to **Basic Settings**. One of them is a **Reactants** tab, displaying a list of reactants and specifying the ratio with which they react together and the order of the reaction. A list of products is also set on the **Products** tab and includes the ratio with which they are produced. **Reaction Rates** has optional forward and backward reaction rates and third body terms can be applied.

#### 26.2.2.1. Single Step: Basic Settings

1. Optionally, select **Reaction Description** to enter a description for the reaction (to a maximum of 120 alphanumeric characters).
2. Optionally, specify any additional materials for this reaction using the **Additional Materials List**.
3. Optionally, select **Reaction or Combustion** to set a reaction or combustion model.

Any settings specified here will override the choice of models selected on the **Fluid Models** tab of the domains form (unless the choice of models on the **Fluid Models** form is set to **None**).
This is implemented to allow reaction-step specific combustion modeling for multi-step reactions. For details, see Reaction-Step Specific Combustion Model Control in the CFX-Solver Modeling Guide.

### 26.2.2.2. Single Step: Reactants

For details, see Multiphase: Reactants (p. 272).

1. **Option** assumes the value Child Materials when creating a reaction involving one phase.
2. Choose the reactant(s) to add from the Materials List drop-down.
3. Enter the Stoichiometric Coefficient for each of the selected components.
4. Optionally, specify a reaction order.

   If the reaction order is not entered, it will default to the same value as the stoichiometric coefficient.

### 26.2.2.3. Single Step: Products

The Products tab is identical to the Reactants tab, with the only difference being that the settings here apply to the products instead of the reactants.

### 26.2.2.4. Single Step: Reaction Rates

1. For each of Forward Reaction Rate and Backward Reaction Rate, Option defines the reaction rate dependency. Select from:
   
   - Arrhenius in the CFX-Solver Modeling Guide
   - Arrhenius with Temperature PDF in the CFX-Solver Modeling Guide
   - Expression in the CFX-Solver Modeling Guide

2. The Pre Exponential Factor and Temperature Exponent are required elements for the Arrhenius reaction type.

3. The temperature limit list (Lower Temperature and Upper Temperature) is required for the Arrhenius with Temperature PDF reaction type.

4. Reaction Activation enables Activation Temperature or Activation Energy to be set.

5. Some reactions require a Third Body Term to proceed.

   For details, see Third Body Terms in the CFX-Solver Theory Guide.

6. You can define a reaction in terms of a dependency, equilibrium or an expression.

   For details, see Reaction Rate Types in the CFX-Solver Modeling Guide.

### 26.2.3. Multiple Step

A list of Single Step reactions is required to define a Multi Step reaction.

1. Set Option to Multi Step.

   Hold the Ctrl key to select multiple reactions from the list.

   Alternatively, click Select from a second list to open the Materials List list box.

2. Optionally, select Reaction Description to enter a description for the reaction.
26.2.4. Flamelet Library

A flamelet library is imported with optional customization of the Laminar Burning Velocity.

1. Set Option to Flamelet Library.
2. Click Browse to browse to the flamelet library file. The file that contains your flamelet library should be selected. Flamelet libraries can be created by library generation software, such as CFX-RIF. For details, see CFX-RIF in the CFX-Solver Modeling Guide.
3. Optionally, select Reaction Description to enter a description for the reaction.
4. Select Laminar Burning Velocity to specify an expression for the laminar flame speed definition.

When using a flamelet library, the definition for the library is specified in the Reaction details view. The name, library file and, optionally, laminar flame speed definition is specified. The reaction can then be used in a fluid that is a variable composition mixture. For details, see Material Details View: Variable Composition Mixture (p. 267) and Laminar Flamelet with PDF Model in the CFX-Solver Modeling Guide.

26.2.5. Multiphase

This option is used to create reactions between more than one phase. For details, see Reaction Models in the CFX-Solver Modeling Guide.

26.2.5.1. Multiphase: Basic Settings

The setup of multiphase reactions is carried out by selecting the reaction Option to Multiphase. For details, see Multiphase Reactions and Combustion in the CFX-Solver Modeling Guide.

1. For multiphase reactions the only option available for the Material Amount Option is Mass Coefficient.
2. Optionally, select Reaction Description to enter a description for the reaction.

26.2.5.2. Multiphase: Reactants

Multiphase reactions are specified in terms of Parent Materials (the phase containing a reacting material), and Child Materials (the reacting materials themselves).

The Parent Materials List contains the phases from which reacting materials are selected.

1. For the currently selected parent material, (such as Coal), select the reactant materials from that phase from the materials list (for example, Coal > Materials List).
   
   If a participating phase is a pure substance, it should be selected as both a parent and child material.
2. For each child material, enter a mass coefficient.
3. Reaction Order is only required for reactions of type Mass Arrhenius.
   
   If unset, it defaults to 1.

26.2.5.3. Multiphase: Products

The setup on the Products tab is identical to the Reactants tab. For details, see Multiphase: Reactants (p. 272).
26.2.5.4. Multiphase: Multiphase Reactions

The **Multiphase Reaction Rate** > **Option** can be one of:

- Mass Arrhenius in the *CFX-Solver Modeling Guide*
- Gibb Char Oxidation Model in the *CFX-Solver Modeling Guide*
- Field Char Oxidation Model in the *CFX-Solver Modeling Guide.*
Chapter 27: Additional Variables

Additional Variables are non-reacting scalar components that can be transported through the flow.

Modeling information for Additional Variables is available:

- Additional Variables in the CFX-Solver Modeling Guide
- Additional Variables in Multiphase Flow in the CFX-Solver Modeling Guide

Implementation information for Additional Variables in multiphase flow is available:

- Additional Variables in the CFX-Solver Theory Guide
- Additional Variables in Multiphase Flow in the CFX-Solver Theory Guide

This chapter describes the procedure for creating an Additional Variable and the user interfaces used to define and apply Additional Variables:

27.1. User Interface
27.2. Creating an Additional Variable

27.1. User Interface

The following topics are discussed:

- Insert Additional Variable Dialog Box (p. 275)
- Basic Settings Tab for Additional Variable Objects (p. 275)
- Fluid Models and Fluid Specific Models Tabs for Domain Objects (p. 276)
- Boundary Details and Fluid Values Tabs for Boundary Condition Objects (p. 279)

27.1.1. Insert Additional Variable Dialog Box

The Insert Additional Variable dialog box is used to initiate the creation of a new Additional Variable. It is accessible by clicking the Additional Variable icon, or by selecting Insert > Expressions, Functions and Variables > Additional Variable.

27.1.2. Basic Settings Tab for Additional Variable Objects

The Basic Settings tab is used to define the fundamental properties of an Additional Variable. It is accessible by creating a new Additional Variable or by editing an Additional Variable listed in the tree view.

27.1.2.1. Variable Type

- Specific

The Additional Variable is solved on a per-unit-mass basis. For details, see Volumetric and Specific Additional Variable in the CFX-Solver Modeling Guide.
• Volumetric

The Additional Variable is solved on a per-unit-volume basis. For details, see Volumetric and Specific Additional Variable in the CFX-Solver Modeling Guide.

• Unspecified

The Additional Variable is defined in terms of an algebraic expression using CEL. For details, see Unspecified Additional Variables in the CFX-Solver Modeling Guide.

27.1.2.2. Units

Specify the units that describe the Additional Variable. For details, see Additional Variables in the CFX-Solver Modeling Guide.

27.1.2.3. Tensor Type

The Additional Variable's Tensor Type can be set to Scalar or Vector. If an Additional Variable is defined as type Vector, the components of a vector algebraic equation can be defined at the domain level.

Vector Additional Variables cannot be directly referenced in CEL expressions. The syntax for referencing a component of a vector Additional Variable is as follows:

  <Component Name>.<Additional Variable Name>_x

27.1.3. Fluid Models and Fluid Specific Models Tabs for Domain Objects

The settings for Additional Variables on the Fluid Models tab are used to enable Additional Variables in the domain. For multiphase simulations, settings for unspecified and volumetric Additional Variables are available only on the Fluid Specific Models tab. For specific Additional Variables homogeneous transport equations can be set on the Fluid Models tab or on a per-fluid basis on the Fluid Specific Models tab if the Additional Variable has been set to Fluid Dependent on the Fluid Models tab.

27.1.3.1. Additional Variable Details: List Box

This list box is used to select an Additional Variable in order to set the details of its application to the domain.

27.1.3.2. Additional Variable Details: [Additional Variable Name] Check Box

This check box determines whether or not the Additional Variable is to be modeled in the domain.

27.1.3.2.1. Option

27.1.3.2.1.1. Transport Equation

The transport of the Additional Variable of type Volumetric is modeled by a transport equation. For details, see Additional Variables in the CFX-Solver Theory Guide.

27.1.3.2.1.2. Diffusive Transport Equation

The transport of the Additional Variable is modeled by a transport equation. The advection term is dropped from the transport equation. For details, see Additional Variables in the CFX-Solver Theory Guide.
27.1.3.2.1.3. Homogeneous Transport Equation

The transport of the Additional Variable is modeled by a transport equation. This option is available only on the Fluid Models tab and only for multiphase flows (that is, only for homogeneous applications). For details, see:

- Homogeneous Additional Variables in Multiphase Flow in the CFX-Solver Modeling Guide
- Homogeneous Additional Variables in Multiphase Flow in the CFX-Solver Theory Guide.

27.1.3.2.1.4. Homogeneous Diffusive Transport Equation

The transport of the Additional Variable is modeled by a transport equation. The advection term is dropped from the transport equation. This option is available only on the Fluid Models tab and only for multiphase flows (that is, only for homogeneous applications). For details, see:

- Homogeneous Additional Variables in Multiphase Flow in the CFX-Solver Modeling Guide
- Homogeneous Additional Variables in Multiphase Flow in the CFX-Solver Theory Guide.

27.1.3.2.1.5. Poisson Equation

The transport of the Additional Variable is modeled by a transport equation. The transient and advection terms are dropped from the transport equation. For details, see Additional Variables in the CFX-Solver Theory Guide.

27.1.3.2.1.6. Homogeneous Poisson Equation

The transport of the Additional Variable is modeled by a transport equation. The transient and advection terms are dropped from the transport equation. This option is available only on the Fluid Models tab and only for multiphase flows (that is, only for homogeneous applications). For details, see:

- Homogeneous Additional Variables in Multiphase Flow in the CFX-Solver Modeling Guide
- Homogeneous Additional Variables in Multiphase Flow in the CFX-Solver Theory Guide.

27.1.3.2.1.7. Fluid Dependent

When the Fluid Dependent option is selected, the Additional Variable model details can be set for each fluid on the Fluid Specific Models tab.

27.1.3.2.1.8. Algebraic Equation

A given quantity or CEL expression specifies the value of the Additional Variable throughout the domain. Application of this option is, in the context of the fluids to which the Additional Variable is applied, effectively the same as setting the Additional Variable type to Unspecified.

27.1.3.2.1.9. Vector Algebraic Equation

A total of three given quantities, CEL expressions, or both, specifies the vector value of the Additional Variable throughout the domain. Application of this option is, in the context of the fluids to which the Additional Variable is applied, effectively the same as setting the Additional Variable type to Unspecified.

27.1.3.2.2. Value

(applies only when Additional Variable Details: [Additional Variable name] Check Box: Option is set to Algebraic Equation)
Enter a numerical quantity or CEL expression that specifies the value of the Additional Variable throughout the domain.

27.1.3.2.3. Kinematic Diffusivity Check Box

( applies only when Additional Variable Details: [Additional Variable name] Check Box: Option is set to Transport Equation, Diffusive Transport Equation, or Poisson Equation)

When running a Transport Equation Additional Variable, this check box determines whether the molecular diffusion term is added to the transport equation for the Additional Variable. For turbulent flow, the turbulent diffusion term (which is a consequence of averaging the advection term) is automatically included. Setting the kinematic diffusivity to zero includes the turbulent diffusion term only.

You must select this check box when using the Poisson equation or diffusive transport equation. If you do not, a blue warning message will appear to remind you.

27.1.3.2.4. Kinematic Diffusivity Check Box: Kinematic Diffusivity

( applies only when Additional Variable Details: [Additional Variable name] check box: Option is set to Transport Equation, Poisson Equation, Diffusive Transport Equation)

Enter a numerical quantity or CEL expression that specifies the value of the kinematic diffusivity throughout the domain.

27.1.3.2.5. AV Properties for Fluid: Frame Overview

( applies only for homogeneous Additional Variables)

The settings contained in this frame are used to optionally specify the kinematic diffusivity of the selected Additional Variable. The kinematic diffusivity may differ for each fluid in the domain. The solver calculates a single effective kinematic diffusivity based on the kinematic diffusivity of the Additional Variable in each fluid. For details, see Homogeneous Additional Variables in Multiphase Flow in the CFX-Solver Theory Guide.

27.1.3.2.6. AV Properties for Fluid: List Box

This list box is used to select a fluid in the domain in order to optionally specify the kinematic diffusivity of the selected Additional Variable in that fluid.

27.1.3.2.7. AV Properties for Fluid: [Fluid Name] Check Box

This check box determines whether or not the kinematic diffusivity of the selected Additional Variable in the selected fluid is specified. Not specifying the kinematic diffusivity implies that the Additional Variable is non-diffusive.

27.1.3.2.8. AV Properties for Fluid: [Fluid Name] Check Box: Kinematic Diffusivity

( applies only when Additional Variable Details: [Additional Variable name] Check Box: Option is set to Homogeneous Transport Equation, Homogeneous Diffusive Transport Equation, or Homogeneous Poisson Equation)

Enter a numerical quantity or CEL expression that specifies the value of the kinematic diffusivity, throughout the domain, of the selected Additional Variable in the selected fluid.
27.1.3.2.9. Vector xValue, Vector yValue, and Vector zValue

(applies only when Additional Variable Details: [Additional Variable Name] Check Box: Option is set to Vector Algebraic Equation)

Enter a numerical quantity or CEL expression for each vector algebraic equation component.

27.1.4. Boundary Details and Fluid Values Tabs for Boundary Condition Objects

The Boundary Details and Fluid Values tabs for a boundary condition object contain settings that specify the values, fluxes, and transfer coefficients of Additional Variables at the boundary condition location. These tabs are accessible, when applicable, by editing a boundary condition object.

The Additional Variables that require specification are those that have been applied to the domain (to which the boundary condition belongs) in a form other than an algebraic equation.

For single phase flow, the Additional Variable settings are on the Boundary Details tab. For multiphase flow, the Additional Variable settings for homogeneous Additional Variables are on the Boundary Details tab and those for fluid-specific Additional Variables are either on the Boundary Details tab or the Fluid Values tab.

The types of boundary conditions that may allow the specification of Additional Variables are:

* Inlet
* Opening
* Wall
* Outlet

27.1.4.1. Additional Variables: List Box

This list box is used to select an Additional Variable in order to set the details of its boundary condition specification.

27.1.4.2. Additional Variables: [Name]

27.1.4.2.1. Option

* Zero Flux
* Value
* Flux in

This option is applicable for Wall boundary conditions and, for Poisson and Diffusive transport models, Inlet boundary conditions.

* Transfer Coefficient
* Wall Flux In

This option is applicable for multiphase flow only.

* Wall Transfer Coefficient

This option is applicable for multiphase flow only.
27.1.4.2.2. Value

(applies when Additional Variables: [Additional Variable Name]: Option is set to Value or Transfer Coefficient)

27.1.4.2.3. Flux

(applies when Additional Variables: [Additional Variable Name]: Option is set to Flux in)

27.1.4.2.4. Transfer Coefficient

(applies when Additional Variables: [Additional Variable Name]: Option is set to Transfer Coefficient)

27.2. Creating an Additional Variable

1. Click the Additional Variable icon or select Insert > Expressions, Functions and Variables > Additional Variable.
   
   The Insert Additional Variable dialog box appears.

2. Set Name to a unique name for the new Additional Variable. For details, see Valid Syntax for Named Objects (p. 55).

3. Click OK.
   
   The Additional Variable details view opens on the Basic Settings tab.

4. Specify the basic settings. For details, see Basic Settings Tab for Additional Variable Objects (p. 275).

5. Click OK.
   
   An object named after the Additional Variable is created and listed in the tree view under Expressions, Functions and Variables > Additional Variables.
Chapter 28: Expressions

The Expressions workspace is used to generate and edit expressions using the CFX Expression Language (CEL), which you can then use in CFX-Pre in place of almost any numeric value (as long as the correct units are returned by the expression).

---

**Note**

In an expression, a term that has no units can be added to a term that has angular units, in which case the software internally applies radians to the term that has no units.

---

**Important**

There is some CEL that works in CFX-Pre and CFX-Solver, but not in CFD-Post. Any expression created in CFX-Pre and used as a Design Exploration output parameter could potentially cause fatal errors during the Design Exploration run, so you should create all expressions for Design Exploration output parameters in CFD-Post.

This chapter describes:

28.1. Expressions Workspace  
28.2. Creating an Expression  
28.3. Modifying an Expression  
28.4. Importing or Exporting an Expression

### 28.1. Expressions Workspace

By double-clicking Expressions in the Outline workspace, or by inserting or editing an existing expression, the Expressions workspace opens in a new tab (see Figure 28.1 (p. 282)). This workspace consists of a tree view and a details view. The following tabs are available in the details view:

- **Definition**, used to edit the definition of an expression selected in the Expressions tree view. For details, see Definition (p. 282).
- **Plot**, used to plot an expression versus a variable. For details, see Plot (p. 283).
- **Evaluate**, used to evaluate an expression when all quantities on which it depends are given. This is useful for verifying that an expression is correctly specified. For details, see Evaluate (p. 283).
28.1.1. Definition

CEL expressions can be defined using any combination of constants, variables, mathematical functions and other CEL expressions. For details, see CFX Expression Language (CEL) in the CFX Reference Guide.

Tip

Right-clicking in the Definition window provides access to a list of all available variables, expressions, locators, functions and constants. Although valid values can be chosen from each of the various lists, the validity of the expression itself is not checked until you click Apply.

Additional Variables can be used in expressions as soon as they have been completely specified. After they have been created, they appear in the list of available variables when right-clicking in the Definition window. For details, see:

- CFX Expression Language (CEL) in the CFX Reference Guide
- CEL Operators, Constants, and Expressions in the CFX Reference Guide.

Click Reset to undo changes made after opening the CEL expression for editing.
28.1.2. Plot

The **Plot** tab is used to plot the selected expression against one variable. CFX-Pre automatically finds the variables associated with an expression, even if the expression depends on another expression.

For example, when previewing the expression `halfRadius`, defined as `0.5*radius`, where `radius` is an expression that depends on the variables `x` and `y`, CFX-Pre presents `x` and `y` as the variables upon which `halfRadius` depends.

1. Set up an expression in the **Definition** tab, or open an existing expression. Click the **Plot** tab.
2. Under **Number of Points**, set the number of sample data points for the plot.
   - Sample points are connected by line segments to approximate the functional relationship.
3. Under **Expression Variables**, select the independent variable.
4. Set the range for the independent variable.
5. Set **Fixed Value** for all of the remaining independent variables.
6. Click **Plot Expression** to view the resulting chart.
   - The **Plot Expression** button changes to **Define Plot**. This can be clicked after viewing the plot in order to make adjustments to the plot specification.

28.1.3. Evaluate

The **Evaluate** tab is used to evaluate an expression when all variables upon which the equation depends are specified. CFX-Pre automatically finds the variables associated with an expression, even if the expression depends on another expression.

For example, when previewing the expression `halfRadius`, defined as `0.5*radius`, where `radius` is an expression that depends on the variables `x` and `y`, CFX-Pre presents `x` and `y` as the variables upon which `halfRadius` depends.

1. Under **Expression Variables**, enter values for all listed variables.
2. Click **Evaluate Expression**.
   - The resulting expression is evaluated using the given variable values.

28.2. Creating an Expression

1. You can create an expression using any of the following methods:
   - On the **Outline** tab, right-click **Expressions** and select **Insert > Expression**.
   - Click **Expression** in the main toolbar.
   - Select **Insert > Expressions, Functions and Variables > Expression** from the menu bar.
   - Whichever method you choose, the **Insert Expression** dialog box appears.
2. Under **Name**, type a name for the new expression.
3. Click **OK**.
4. In the **Expressions** details view, under **Definition**, enter an expression. For details on using the **Definition** area, see **Definition** (p. 282).
5. Click **Apply**.
6. Optionally, select **Plot** or **Evaluate** to examine the expression.

### 28.3. Modifying an Expression

1. In the **Expressions** tree view, double-click any expression, or right-click an expression and select **Edit**.

   The **Expression** details view displays the definition of the expression.

2. Under **Definition**, modify the expression. For details on using the **Definition** area, see *Definition* (p. 282).

3. Make any desired changes and click **Apply**.

4. Optionally, select **Plot** or **Evaluate** to examine the expression.

### 28.4. Importing or Exporting an Expression

Expressions can be imported and exported in simulations. For details, see:

- **Import CCL Command** (p. 35)
- **Export CCL Command** (p. 36).

Any number of CCL objects can be exported; this section describes exporting only expressions to a file.

#### 28.4.1. Importing CCL Expressions

You can import expressions using the **Import CCL** function. For details, see *Import CCL Command* (p. 35).

1. Select **File > Import > CCL**.

2. Under **Import Method**, select **Append** or **Replace**.

   Append imports expressions and overwrites any that currently exist in memory. Expressions that do not match ones being imported are not changed. Replace deletes all expressions in memory before importing.

3. Select a location from which to import.

4. Select a file to import.

5. Click **Open**.

---

**Important**

Take care when importing CCL files because data can be overwritten.

#### 28.4.2. Exporting CCL Expressions

You can export expressions using the **Export CCL** function. For details, see *Export CCL Command* (p. 36).

1. Select **File > Export > CCL** from the main menu bar.

2. Clear **Save All Objects**.

3. Under **Save All Objects**, select **LIBRARY > CEL > EXPRESSIONS**.

4. Select a location to which to export.

5. Enter a name for the exported file.
6. Click **Save**.
Chapter 29: User Functions

The User Function details view is used to create new interpolation functions (1D or 3D Cloud of Points), and User CEL Functions. It is accessed from the Insert > Expressions, Functions and Variables > User Function or the User Function icon on the main toolbar.

User Function objects you create are listed under Expressions, Functions and Variables > User Functions in the tree view.

The import of data from a file is discussed in the documentation for profile boundary conditions. For details, see Profile Boundary Conditions in the CFX-Solver Modeling Guide.

After creating, modifying, or deleting functions, the CCL tree is checked for errors.

This chapter describes:

29.1. Interpolation Function
29.2. User Defined Function

29.1. Interpolation Function

This section describes:

- One Dimensional Interpolation (p. 287)
- Three Dimensional Interpolation (p. 288)
- Importing Data from a File (p. 289)

29.1.1. One Dimensional Interpolation

1D interpolation functions can be used to specify any quantity in CFX-Pre for which a standard CEL function (such as sin, cos, step, and so on) can be used. The function is created by interpolating from a list of points and a list of values at those points.

For a 1D interpolation, you should set a single coordinate value and a single value associated with the coordinate. You can also import data from a file. The coordinate and the value are interpreted in the local coordinate frame, which will depend on where the function is used. For example, if the function is used to set a boundary condition value, the coordinate frame selected for that boundary condition will apply. For details, see Coordinate Frames in the CFX-Solver Modeling Guide.

1. Set Option to Interpolation (Data Input).

Additional information on the other function type is available in:

- Three Dimensional Interpolation (p. 288)
- User Defined Function (p. 290).

2. Enter a single Argument Units.
This will usually be a coordinate axis dimension (for example, m, cm, rad, and so on), but can be any dimension. A variable using these units is passed to the interpolation function (for example, \( x, y, r, z \), and so on) when setting a quantity in CFX-Pre.

3. Enter a single Result Units.

   This unit should be a valid unit for the quantity you will be specifying (for example, type \( m \ s^{-1} \) for a velocity).

4. Set Interpolation Data > Option to One Dimensional.

5. Right-click in the window to import data from a file or delete an entry.

6. Enter a single Coordinate value.

7. Enter a Value associated with the Coordinate.

8. Click Add to add the point value to the list (or Remove to remove a highlighted value from the list).

   For details on the Extend Min and Extend Max options, see Extended Minimum and Maximum (p. 288).

The coordinate axis to which the coordinate value relates is determined by the argument passed when calling the interpolation function. For example, for a Cartesian Velocity Component specified inlet, the U component could be set to the expression \( \text{MyInterpFunction}(r) \), where \( \text{MyInterpFunction} \) is the function name of the 1D Interpolation function, and \( r \) is the CFX radius system variable. The coordinate values you specify in this details view will then refer to values of \( r \) on the inlet boundary, and the value would be the velocity value at each \( r \) location.

### 29.1.1.1. Extended Minimum and Maximum

The Extend Min and Extend Max options enable you to increase the valid range of the interpolation function beyond the maximum or minimum specified coordinate values. The value the function will take at coordinate values lower than the minimum specified coordinate, which is equal to the value at the minimum specified coordinate. Similarly, the value at the maximum specified coordinate is extended for higher coordinate values.

![Graph showing Extend Minimum and Extend Maximum](image)

### 29.1.2. Three Dimensional Interpolation

Three dimensional functions can be used to specify any quantity in CFX-Pre for which a standard CEL function (for example, \( \sin, \cos, \text{step}, \) and so on) can be used. The function is created by interpolating values between a “cloud of points” using a distance weighted average based on the closest three points. Common applications include setting an initial guess or a profile boundary condition from experimental data values.
For a three dimensional function, you should set X, Y, and Z coordinate values and a single value associated with the coordinate. The coordinates and the value are interpreted in the local coordinate frame, which will depend on where the function is used. For example, if the function is used to set a boundary condition value, the coordinate frame selected for that boundary condition will apply. For details, see Coordinate Frames (p. 255) and Coordinate Frames in the CFX-Solver Modeling Guide. If the local coordinate frame is cylindrical, the units for the Argument List should still be those of a Cartesian frame.

1. Enter a unique function name that you will use when setting the value of a quantity using an expression.
2. **Argument Units**: Enter a comma separated list of the units used for the coordinates.
   These will usually be coordinate axis dimensions (for example, [m], [cm], and so on).
3. Enter a single **Result Units**.
   This unit should be a valid unit for the quantity you will be specifying (for example, [ms⁻¹] for a velocity).
4. Right-click in the window to import data from a file or delete an entry.
5. Enter a comma, separating X, Y, Z coordinate values.
   The coordinates are interpreted in the local coordinate frame, which will depend on where the function is used.
6. Enter a **Value** associated with the **Coordinate**.
7. Click **Add** to add the point to the list (or **Remove** to remove a highlighted value from the list).

### 29.1.3. Importing Data from a File

After you create a user function (Insert > Expressions, Functions and Variables > User Function), you see the function in the details view with the **Option** set to Interpolation (Data Input).

To import data from a file, set the **Interpolation Data: Option** as desired, then right-click in the Interpolation Data pane and select Import Data. This displays the Import Cloud Interpolation Data dialog box.

- For 1D data, **Column Selection** fields appear. You can select which column of data in your import file is appropriate for the coordinates and values.
- For 3D interpolations, columns are selected in the same way, with X, Y, and Z data all required.

### 29.1.4. Viewing and Editing Data Imported from a File

When you create a user function, it appears in the Outline view under Simulation > Expressions, Functions and Variables > User Functions. Right-click the user function and select **Edit** to view and edit the **Basic Settings**.

In the **Basic Settings** tab, the **Value Field** interacts with the **Parameter List** to control the variables associated with each field.

To change the variables associated with a field:

1. Select an element in the **Value Field**.
2. Click the drop-down arrow beside the **Parameter List** field and select (or Ctrl-select) the variables that you want to associate with the field you specified in the previous step. If the variable you want to select does not appear, click **Multi-select from extended list** to see all of the variables that are available.
29.2. User Defined Function

User CEL Functions are used in conjunction with User CEL Routines. A User Function must be created after a User CEL Routine. For details, see User CEL Routines (p. 293). User Functions set the name of the User CEL Routine associated with the function, the input arguments to pass to the routine and the expected return arguments from the routine.

1. Select the User CEL Routine name (user routine name) from the drop-down list that the function will apply to. For details, see Function Name (p. 290).
2. Enter the input Argument Units list to pass to the subroutine.
   For details, see Argument Units (p. 290).
3. Enter the Result Units list output from the subroutine.
   For details, see Result Units (p. 291).

29.2.1. Function Name

The function name is assigned when you create a new User CEL Function, and is equivalent to the name you would set for an expression. You use this name, together with the input arguments, when setting the expression for the quantity of interest. For details, see Defining Quantities with User CEL Functions (p. 290). The function name should follow usual naming rules (it may contain spaces but should not include underscores).

29.2.1.1. Defining Quantities with User CEL Functions

After you have created a User CEL Function, you can use it to specify any quantity in CFX-Pre for which a standard CEL function (for example, sin, cos, step, and so on) can be used. You should enter an expression using the notation:

\[ \text{<Function Name>(arg1[units], arg2[units], ...)} \]

When using a system variable, an expression or a value, you do not need to specify units. For example, a pipe inlet velocity profile might be set by entering:

\[ \text{inletvelocity(MaxVel, r, 0.2[m])} \]

where \text{inletvelocity} is the function name of the User CEL Function, \text{MaxVel} is an existing expression or value, \text{r} is a system variable and \text{0.2[m]} corresponds to the pipe diameter.

You would enter the above expression as one of the velocity components at the inlet boundary condition (you may also want to use it as a velocity component of the initial guess).

29.2.2. Argument Units

You should enter the units of each argument that you will be passing to the Subroutine. Units should be comma separated and correspond to the order used when setting the expression for a quantity in CFX-Pre. For example, enter [m], [m s^{-1}], [Pa] if you are passing a length, velocity and pressure value to the subroutine. The values of arguments passed to a Subroutine are specified when you set an expression for a quantity in CFX-Pre. For details, see Defining Quantities with User CEL Functions (p. 290).
29.2.3. Result Units

The result argument units are the units of the return arguments from the **Subroutine**. Units should be comma separated and correspond to a valid unit for the quantity that you are specifying.
Chapter 30: User Routines

User routines are Fortran subroutines (User CEL Functions, Junction Box Routines, and Particle User Routines) that you write for the CFX-Solver. You use the User Routine details view to create objects that link your Fortran subroutines to the CFX-Solver. To access the User Routine details view, either select Insert > Expressions, Functions and Variables > User Routines or click Insert User Routine in the main toolbar.

Once your User Routines have been created and linked, they appear in the tree view under Simulation > Expressions, Functions and Variables > User Routines.

Important

User routines cannot be used in the large memory partitioner.

User Routine Details View

The User Routine details view creates objects that link your Fortran subroutines to the CFX-Solver.

There are four types of user routines:

- User CEL Routines (p. 293)
- Junction Box Routines (p. 295)
- Particle User Routines (p. 295)
- For details on the fourth user-routine option, Transient Particle Diagnostics Routine, refer to User Diagnostics Routine in the CFX-Solver Modeling Guide.

30.1. User CEL Routines

Available when Option is set to User CEL Function, User CEL Routines are used in conjunction with User CEL Functions to define quantities in CFX-Pre based on a Fortran subroutine. The User CEL Routine is used to set the calling name, the location of the subroutine, and the location of the Shared Libraries associated with the subroutine.

1. Enter the Calling Name (p. 294) of the subroutine within the subroutine file.

   You should always use lowercase letters for this even when the subroutine name in the Fortran file is in uppercase.

2. Enter the Library Name and Library Path.

   The library name will usually be your subroutine file name (without any extensions). The library path is the path to the directory containing the system dependent directories and supports lists of paths. For details, see Library Name and Library Path (p. 294).

User CEL Functions are created after the associated routine has been defined. For details, see:
30.1.1. Calling Name

The **Calling Name** is the name of the subroutine within a Fortran file. This name appears immediately after the `SUBROUTINE` statement in a Fortran file. It is usually in upper case in the Fortran file, but should always be entered in lower case. It must not include spaces but may contain underscores (this is different from the usual naming rules).

30.1.2. Library Name and Library Path

This is the name of the shared library. The **Library Name** will be the name of the file containing the subroutine, ignoring any file extensions (for example, `InletProfile` for the file named `InletProfile.F`). The file name depends on how you ran the `cfx5mkext` command:

- If you *did not* specify a `-name` option when running the `cfx5mkext` command, the file name will be the name of your shared library. For details, see [Shared Libraries in the CFX-Solver Modeling Guide](#).
- If you *did* specify the `-name` option when running the `cfx5mkext` command, the file name will be the name you specified.

Note that if you look at the actual file name of the shared library, it will have a `lib` prefix (UNIX only) and either a `.so`, `.sl`, or `.dll` suffix depending on your platform. Do not include the prefix or suffix in the **Library Name**.

The **Library Path** is the absolute path to the directory that contains the shared libraries in subdirectories for each platform. The path name depends on how you ran the `cfx5mkext` command:

- If you *did not* specify a `-dest` option when running the `cfx5mkext` command, this will be the path to the directory in which the `cfx5mkext` command was executed. For details, see [Shared Libraries in the CFX-Solver Modeling Guide](#).
- If you *did* specify the “-dest” option when running the `cfx5mkext` command, the path name will be the name you specified.

On UNIX platforms, the **Library Path** will look like:

```
/home/user/SharedLibraries
```

On Windows systems, the **Library Path** will look like:

```
F:\user\SharedLibraries
```

If you are running in parallel and specify only a single library path, then each machine should be able to locate the shared libraries using the specified **Library Path**. On Windows systems, you may have to map network drives so that the path to the libraries is the same on each machine. However, you can also specify the **Library Path** as a list. ANSYS CFX will try to locate your shared libraries on each machine in the parallel run using the list of paths provided. Comma (,), colon (:) and semi-colon (;) separated lists are valid. For example, when running in parallel across Windows and UNIX machines, a valid path may look like:

```
/home/user/SharedLibraries,C:\Shared Libraries
```

The colon used after a Windows drive letter is treated correctly and is not interpreted as a list separator.
30.2. Junction Box Routines

Junction box routines are used to call your own Fortran subroutines during execution of the CFX-Solver. You must create a junction box routine object so that the CFX-Solver knows the location of the subroutine, the location of the shared libraries associated with the subroutine, and when to call the subroutine. Each of these items is specified in the details view. For details, see User Junction Box Routines in the CFX-Solver Modeling Guide.

To complete the Junction Box Routine details:

1. The first three parameters are identical to those described for the User Function option, under Calling Name (p. 294) and Library Name and Library Path (p. 294).

2. Enter the Junction Box Location at which to call the subroutine. For details, see Junction Box Routine Options and Parameters in the CFX-Solver Modeling Guide.

Junction box routines appear in the LIBRARY section of a CCL file. You can create many junction box routines in CFX-Pre, but only call the required routines during execution of the CFX-Solver. This enables you to read in a CCL file containing a list of junction box routines and then select only those that you want to call. This selection is made on the Solver Control tab. For details, see Basic Settings Tab (p. 199).

30.3. Particle User Routines

Particle user routines are used to create user defined injection regions and particle user sources. Creating a user routine with the Particle User Routine option selected is identical to creating a routine with the User CEL Function option selected. For details, see:

- User CEL Routines (p. 293)
- Particle Injection Regions Tab (p. 131)
- Particle User Sources in the CFX-Solver Modeling Guide.
Chapter 31: Simulation Control

Simulation controls allow you to define the execution of analyses and related tasks like remeshing in the simulation. Specific controls include definitions of global execution and termination controls and one or more configurations. Additional information regarding these topics are provided in Execution Control (p. 299) and Configurations (p. 307), respectively.
Chapter 32: Execution and Termination Control

This chapter describes:
32.1. Execution Control
32.2. Termination Control

32.1. Execution Control

The Execution Control settings described below apply to all configurations in the simulation. You can override these settings for any configuration from the Run Definition tab on the details view of the Configuration (for details, see Run Definition Tab (p. 313)) or the Define Run dialog box in the CFX-Solver Manager (for details, see The Define Run Dialog Box in the CFX-Solver Manager User’s Guide).

This section describes:
32.1.1. Overview of Defining CFX-Solver Startup
32.1.2. The Details View for Execution Control

32.1.1. Overview of Defining CFX-Solver Startup

To define how a CFX-Solver can be started, the number of settings that you need to set up for Execution Control depends on the case:

- In some cases, you need to specify only the name of a CFX-Solver input file (*.def or *.mdef). For cases that require initialization from previous results, you also need to specify the name of a results file (*.res).
- You can configure runs in serial or parallel:
  - Serial run is the default way of running a CFD case. During a serial run, all computation is done by a single process running on one processor.
  - Parallel run partitions the computation into more than one process and is done on more than one processor in a single machine (local parallel processing) or on more than one machine (distributed parallel processing). You also have the option of specifying how the computation is partitioned for a parallel run.
- You can optionally select the system priority for the interpolator and solver computation as well as settings such as precision and memory allocation.

When you have finished defining how CFX-Solver will start, click OK or Apply to save the settings.

Details of the above steps are described in the next section.

32.1.2. The Details View for Execution Control

You access the details view for Execution Control from CFX-Pre by clicking Insert > Solver > Execution Control or by right-clicking on Simulation Control in the details view and selecting Insert > Execution Control.

The tabs presented in the details view for Execution Control are described in the following sections:
32.1.2.1. Solver Input File Name

Ensure that the name of a CFX-Solver input file (extension .def or .mdef) is specified under Solver Input File.

32.1.2.2. Run Definition Tab

1. Select Initial Values Specification so that you can specify one or more sources of initial values. Note that for cases with multiple configurations, initial values specifications are not valid for Global Settings. For each source of initial values (most runs only require one), do the following:

   a. Click New to create an initial values object.

   b. Select an initial values object from the list and select either the Results File or Configuration Results option for Initial Values > Option.

      1. If you selected the Results File option, then specify the file name of a file from which initial values should be used.

      2. If you selected the Configuration Results option, then specify the name of the configuration from which initial values should be used. Note that this option is only available in the context of multi-configuration simulations. It allows the introduction of dependencies on initial values that will become available at run time.

   c. The Use Mesh From setting determines which mesh is used for the analysis: the one specified in the Solver Input File option, or the one in the Initial Values. The mesh from the Initial Values File can only be used in a limited set of circumstances. See Using the Mesh from the Initial Values File in the CFX-Solver Modeling Guide for details.

   d. Select Continue History From if you want to continue the run history (convergence history, monitor plots, time and time step counters, etc…) and use the smoothest restart possible from the selected Initial Values File. The run will continue from the one contained the specified initial values object. Note that the run history will reset if Continue History From is not selected.

   Full details of the settings can be found in Reading the Initial Conditions from a File in the CFX-Solver Modeling Guide.

2. Set Type of Run to Full or Partitioner Only.

   • Full runs the partitioner if applicable, and then runs Solver.

   • Partitioner Only is used for parallel runs only and does not run Solver. This writes a .par file.

3. Select or clear Double Precision. This setting will determine the default (single or double) precision of the partitioner, solver and interpolator executables. For details on the precision of executables, see Double-Precision Executables in the CFX-Solver Manager User’s Guide. The precisions of the partitioner, solver, and interpolator executables can be set individually on the Partitioner, Solver, and Interpolator tabs.
4. Configure the **Parallel Environment** as required.
5. If required, under **Run Environment**, set the working directory.
6. If required, select **Show Advanced Controls** to display other tabs.

Additional information is provided in the next section, *Parallel Environment*, and in Initial Condition Modeling in the *CFX-Solver Modeling Guide*.

### Parallel Environment

For a distributed parallel setup, specify the number of partitions assigned to each host. If choosing a specified partition weighting (under Partitioner), click directly on the partition weight number to edit it. There should be one weight entry per partition.

1. Under **Parallel Environment**, select a **Run Mode**.
2. Configure the mode as required.

   Run Mode determines whether the run is serial (the default when defining a run in which a problem solved as one process), or parallel (problem split into partitions).
   
   - A serial run (the default) requires no additional configuration
   - To learn how to configure a parallel run, see Parallel Run in the *CFX-Solver Manager User's Guide*.

#### 32.1.2.2.1. Mesh Node Reordering

You can change the order of the nodes in the mesh. Depending on the case this reordering may result in a reduction in the run time for the CFX-Solver. From **Mesh Options > Node Reordering > Options**, you can select **None**, **Cuthill McKee** and **Reverse Cuthill McKee**.

#### 32.1.2.2.2. Optional Quitting CFX-Pre

Optionally, you can elect to have CFX-Pre quit upon writing CFX-Solver Input file.

#### 32.1.2.3. Partitioner Tab

Use the **Partitioner** tab to configure the mesh partitioning options.

---

**Note**

An existing partition file cannot be used if the simulation involves either the Monte Carlo or Discrete Transfer radiation models.

Partitions may be viewed prior to running CFX-Solver. For details, see CFX Partition File in the CFX-Solver Manager User's Guide.

1. Select the **Partitioner** tab.
   
   If this is not available, ensure Show Advanced Controls is selected in the **Run Definition** tab.

2. If required, under **Initial Partition File**, click **Browse** and select the partition file to load.

   The *.par file is only required if a model has already been partitioned. The number of partitions in the partitioning file must be the same as that selected on the Run Definition tab.
3. **Under Run Priority**, select Idle, Low, Standard or High. For a discussion of these priorities, see *The cfxScontrol Application in the CFX-Solver Manager User's Guide*.

4. Optionally, set the precision: under **Executable Settings**, select **Override Default Precision** and choose either *Single* or *Double*. This setting for the partitioner will override the corresponding specification, if set, on the **Run Definition** tab.

   For details, see *Double-Precision Executables in the CFX-Solver Manager User's Guide*.

5. If required, select the **Use Large Problem Partitioner** option, which is available on 64-bit platforms only. This option starts the large problem partitioner which can partition problems up to $2^{31}-1$ elements. This partitioner uses 64-bit integer and logical variables so it will allocate more memory than the default partitioning executable. For details, see *Large Problem Partitioner Executables in the CFX-Solver Manager User's Guide*.

6. **Under Partitioning Detail**, choose a **Partition Type** and configure it.

   Depending on the selected partition type, various options must be configured. Partition types include:

   - **Multilevel Graph Partitioning Software - MeTiS** in the *CFX-Solver Modeling Guide*. When first running in parallel, it is recommended that **Partition Type** be set to MeTiS.
   - **Recursive Coordinate Bisection** in the *CFX-Solver Modeling Guide*
   - **Optimized Recursive Coordinate Bisection** in the *CFX-Solver Modeling Guide*
   - **Directional Recursive Coordinate Bisection** in the *CFX-Solver Modeling Guide*
   - **User Specified Direction** in the *CFX-Solver Modeling Guide*
   - **Simple Assignment** in the *CFX-Solver Modeling Guide*
   - **Radial** in the *CFX-Solver Modeling Guide*
   - **Circumferential** in the *CFX-Solver Modeling Guide*

7. If required, configure the **Partition Weighting** as described below.

8. If required, configure the **Multidomain Option**. You can select from the following options:

   - **Independent Partitioning**: Each domain is partitioned independently into the specified number of partitions.
   - **Coupled Partitioning**: All domains that are connected together are partitioned together. Note that solid domains are still partitioned separately from fluid/porous domains. Coupled partitioning often leads to better scalability, reduced memory requirements, and sometimes better robustness, than independent partitioning because there are fewer partition boundaries.

   For details, see *Selection of the Partitioning Mode for Multi-Domain Cases in the CFX-Solver Modeling Guide*.
When the coupled partitioning option is activated, you can further choose to set the **Multipass Partitioning** option. The **Transient Rotor Stator** option is relevant only for simulations having transient rotor stator interfaces. It uses a special multipass algorithm to further optimize the partition boundaries. This approach generates circumferentially-banded partitions adjacent to each transient rotor stator interface, which ensures that interface nodes remain in the same partition as the two domains slide relative to each other. Away from the interface, the partitioning is handled using whichever method is specified for the **Partition Type**.

Performance of particle transport calculations may be made worse when using coupled partitioning.

9. If required, under **Partitioner Memory**, adjust the memory configuration. For details, see Configuring Memory for the CFX-Solver in the CFX-Solver Manager User's Guide.

**Partitioning Weighting**

As discussed below, partitions can be weighted in different ways. The default setting is Automatic.

- Uniform
- Specified
- Automatic

**Uniform**

Assigns equal-sized partitions to each process.

**Specified**

Requires **Run Definition** to be configured with individual partition weights.

**Partition Weights** is added to the parallel environment. This allows partition weights to be entered. When more than one partition is assigned to any machine, the number of partition weight entries must equal the number of partitions. The partition weight entries should be entered as a comma-separated list. For a distributed run like the following:

<table>
<thead>
<tr>
<th>Host</th>
<th># of Partitions</th>
<th>Partition Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sys01</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Sys02</td>
<td>2</td>
<td>2, 1.5</td>
</tr>
<tr>
<td>Sys03</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

*Sys01* is therefore a single partition and the weight is 2. *Sys02* has two partitions and they are individually weighted at 2 and 1.5. The final system has a single partition with a weight of 1.

If partition weight factors are used, the ratio of partition weights assigned to each partition controls the partition size.

Once started, the run progresses through the partitioning, and then into the solution of the CFD problem. Extra information is stored in the CFX output file for a parallel run. For details, see Partitioning Information in the CFX-Solver Manager User's Guide.
Automatic

Calculates partition sizes based on the **Relative Speed** entry specified for each machine in the `hostinfo.ccl` file.

Machines with a faster relative speed than others are assigned proportionally larger partition sizes. The entry of relative speed values is usually carried out during the CFX installation process, and accurate entries for relative speed can significantly optimize parallel performance.

### 32.1.2.4. Solver Tab

1. Select the **Solver** tab.

   If this is not available, ensure **Show Advanced Controls** in the **Run Definition** tab is selected.

2. Under **Run Priority**, select **Idle**, **Low**, **Standard** or **High**. For a discussion of these priorities as well as how you can change them after the execution of the solver has started, see *The cfxScontrol Application in the CFX-Solver Manager User's Guide*.

3. If required, from **Double Precision Override** or **Executable Settings > Double Precision Override**, select or clear **Double Precision**. This setting for the solver will override the corresponding specification, if set, on the **Run Definition** tab.

   For details, see *Double-Precision Executables in the CFX-Solver Manager User's Guide*.

4. If required, under **Solver Memory**, adjust the memory configuration. For details, see *Configuring Memory for the CFX-Solver in the CFX-Solver Manager User's Guide*.

### 32.1.2.5. Interpolator Tab

1. Select the **Interpolator** tab.

   If this is not available, ensure **Show Advanced Controls** in the **Run Definition** tab is selected.

2. Under **Run Priority**, select **Idle**, **Low**, **Standard** or **High**. For a discussion of these priorities, see *The cfxScontrol Application in the CFX-Solver Manager User's Guide*.

3. Optionally, set the precision: under **Executable Settings**, select **Override Default Precision** and choose either **Single** or **Double**. This setting for the interpolator will override the corresponding specification, if set, on the **Run Definition** tab.

   For details, see *Double-Precision Executables in the CFX-Solver Manager User's Guide*.

4. If required, under **Interpolator Memory**, adjust the memory configuration. For details, see *Configuring Memory for the CFX-Solver in the CFX-Solver Manager User's Guide*.

### 32.2. Termination Control

The Termination Control settings apply to the simulations with one or more configurations. This section describes:

- **32.2.1. Overview of Configuration Termination**
- **32.2.2. Details View for Termination Control**

#### 32.2.1. Overview of Configuration Termination

Many simulations with one or more configurations will terminate naturally without explicitly introducing **Termination Control**. However, in some cases explicit **Termination Control** is required. For example,
consider a case where a simulation has a sequence of configurations that are set up to run one after the other with the sequence to then return to the first configuration in the sequence (this could occur when modeling an internal combustion engine where there could be a configuration for each of the intake, compression, power and exhaust strokes and the simulation repeatedly cycles through each of the four configurations). There can be one or more conditions for terminating a simulation. Each termination condition can be based on the number of times a configuration has been executed or whenever a CFX-Solver interrupt condition for a configuration has been satisfied.

To define the conditions under which a simulation should be terminated you need to:

1. If required, create one or more termination Control Conditions.
2. For each Control Condition, select the appropriate termination control Option.
3. For each Control Condition set the Configuration Name appropriate for the termination control condition.
4. For each Control Condition, set the appropriate Number of Steps or Condition Name(s).

When you have finished defining how the simulation will terminate, click OK or Apply to save the settings. Details of the above steps are described in the next section.

### 32.2.2. Details View for Termination Control

You access the details view for Termination Control from CFX-Pre by clicking Insert > Configurations > Termination Control or by right-clicking on Simulation Control in the details view and selecting Insert > Termination Control.

The following describes the details of the Termination Control tab.

**Control Conditions**

A list displaying the available termination control conditions. Click Add new item to add a new termination control condition. To change its settings, the termination control condition must be highlighted. You can highlight a condition by selecting it from the displayed list. Click Delete to delete a highlighted termination control condition.

**Control Condition: Options**

The options for termination control are either Max. Configuration Steps or Solver Interrupt Conditions. The former setting is used to terminate a simulations after a selected configuration has been executed the prescribed number of times. The latter setting is used to terminate a simulation whenever the named CFX-Solver interrupt conditions for the selected configurations have been satisfied. Note that the latter option is only valid if CFX-Solver interrupt conditions have been defined. For details, see Interrupt Control (p. 200).

**Control Condition: Configuration Name**

Choose the configuration for which the termination control is to be applied.

**Control Condition: Number of Steps**

This setting is used to set to the maximum number of times the specified configuration is to be executed in the course of the simulation.

**Control Condition: Condition Name(s)**

This setting is used to identify the names of the solver interrupt condition for the specified configuration to be used to terminate the simulation.
Chapter 33: Configurations

This chapter describes how to control the sequencing of configurations for a simulation, how to define when remeshing is required, and procedures for defining how CFX-Solver can be started for a configuration. The Configuration settings described below apply to a specified flow analyses in the simulation.

This chapter describes:
33.1. Overview of Defining a Configuration
33.2. The Details View for Configuration

33.1. Overview of Defining a Configuration

To set up the sequencing of configurations in a simulation, you need to define a configuration for each step in the simulation. Typically, there is a configuration for each analysis in the simulation. You are required to define at least one activation condition for each configuration. You set up the desired sequencing of configurations in a simulation by your choice of activation conditions. For each required configuration:

1. Create the configuration.
2. Set the name of the analysis to be associated with the configuration.
3. Create the required number of activation controls for the configuration.
4. Set the activation control option to activate the configuration at the start of the simulation or following the completion of another configuration.

Note that it is possible to have more than one configuration activated at the start of the simulation. You also have the option of specifying more than one activation condition for a configuration (for example, a configuration can be activated at the start of the simulation as well as at the completion of another configuration).

To control when remeshing is to occur, you are required to:

1. Create a remeshing definition.
2. Select the appropriate remeshing option.
3. Set up the remeshing activation condition.
4. Identify the location where the remeshing is to occur.
5. Supply any additional information required by the selected remeshing option.

To define how a CFX-Solver can be started, the number of settings that you need to define for Configuration depends on the case:

- In some cases, you need only to specify the name of a CFX-Solver input file (*.def or *.mdef). For cases that require initialization from previous results, you also need to specify the name of a results file (*.res).
- You can configure runs in serial or parallel:
Serial run is the default way of running a CFD case. During a serial run, all computation is done by a single process running on one processor.

Parallel run partitions the computation into more than one process and is done on more than one processor in a single machine (local parallel processing) or on more than one machine (distributed parallel processing). You also have the option of specifying how the computation is partitioned for a parallel run.

- You can optionally select the system priority for the interpolator and solver computation as well as settings such as precision and memory allocation.

When you have finished setting the parameters for the configuration, click OK or Apply to save the settings.

Details of the above steps are described in the next section.

### 33.2. The Details View for Configuration

You access the details view for a configuration in CFX-Pre by double-clicking its Simulation Control > Configurations entry in the Outline view or by right-clicking its Simulation Control > Configurations entry in the Outline view and selecting Edit.

The tabs presented in the details view for the configurations are described in the following sections:

- **General Settings Tab** (p. 308)
- **Remeshing Tab** (p. 309)
- **Run Definition Tab** (p. 313)
- **Partitioner Tab** (p. 314)
- **Solver Tab** (p. 316)
- **Interpolator Tab** (p. 317)

#### 33.2.1. General Settings Tab

The General Settings tab for a configurations requires that you:

1. Select the Flow Analysis for the configuration.
2. Define at least one Activation Condition. There are two Option values available for each Activation Condition:
   - Start of Simulation to activate the configuration at the start of the simulation.
   - End of Configuration to activate the configuration whenever any one of a prescribed configuration completes.

One activation condition is automatically generated for you and the default Option is set to Start of Simulation. If required, create additional activation conditions by clicking New. To change the settings for an activation condition or to delete a condition (by clicking Delete), you must highlight a condition by selecting it from the displayed list.
# 33.2.2. Remeshing Tab

The **Remeshing** tab allows you to introduce one or more remeshing definitions within the configuration being edited. To create a remeshing definition, click **New**. For additional details, see **Remeshing Guide in the CFX Reference Guide**.

Each remeshing definition requires that you:

1. Select either the **User Defined** or **ICEM CFD Replay** value for the **Option** setting. Additional settings, which depend on the option selected, are described in the sections **User Defined Remeshing** (p. 310) and **ANSYS ICEM CFD Replay Remeshing** (p. 311), presented below.

2. Select one or more activation condition(s) to be used to activate the remeshing object during the configuration's execution. This selection is made from a list of the solver **Interrupt Control** conditions (for details, see **Interrupt Control** (p. 200)) that were defined for the **Flow Analysis** specified in the **General Settings** tab.

3. Select the mesh **Location** that will be replaced by remeshing. This selection is made from a list of the 3D mesh regions that are used in the **Flow Analysis** specified in the **General Settings** tab.

Each remeshing definition also allows you to specify a comma separated list of **Mesh Reload Options** that control how the new mesh replaces the previous one. The new mesh could, for example, be reloaded as a **.gtm** file using [mm] length units and all relevant mesh transformations by specifying:

```
Mesh Reload Options = "replacetype=GTM,replaceunits=mm,notransform=false"
```

These and other options are summarized in the table below.

## Table 33.1 Reload Options

<table>
<thead>
<tr>
<th>Reload Option</th>
<th>Description and Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>nottransform</td>
<td>True (default) ensures mesh transformations are not performed on mesh reload.</td>
</tr>
<tr>
<td></td>
<td>True or False</td>
</tr>
<tr>
<td>replace-type</td>
<td>Type of replacement mesh file.</td>
</tr>
<tr>
<td></td>
<td>ANSYS: cdb and inp files</td>
</tr>
<tr>
<td></td>
<td>CFX4: geo files</td>
</tr>
<tr>
<td></td>
<td>CFX5: CFX 5.1 files</td>
</tr>
<tr>
<td></td>
<td>CGNS: cgns and cgn files</td>
</tr>
<tr>
<td></td>
<td>GEM: Tfc files</td>
</tr>
<tr>
<td></td>
<td>GTM: gtm files</td>
</tr>
<tr>
<td></td>
<td>GtmDirect: def and res files</td>
</tr>
<tr>
<td></td>
<td>GTM_DSDB: ANSYS cmdb and dsdb files</td>
</tr>
<tr>
<td></td>
<td>Def: def files that are older than CFX 5.6 (or if duplicate node removal is required)</td>
</tr>
<tr>
<td>Option</td>
<td>Description and Values</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fluent: cas and msh files</td>
<td>Generic: ICEM CFD mesh (cfx, cfx5, msh) files</td>
</tr>
<tr>
<td>Generic: ICEM CFD mesh (cfx, cfx5, msh) files</td>
<td>GRD: CFX-TASCflow (grd) files</td>
</tr>
<tr>
<td>IDEAS: unv files</td>
<td>MSC: Patran out and neu files</td>
</tr>
</tbody>
</table>
| PDC: GridPro files | **replace-gen-args** Generic mesh import options (as space separated list):  
- g: Ignore degenerate element errors  
- n: Do not do duplicate node removal  
- T: specify duplicate node removal tolerance (float).  
- D: Primitive naming strategy; either Standard Naming Strategy or Derived Naming Strategy. |
| replacespecargs | Space-separated list of type-specific import arguments, as discussed in Supported Mesh File Types (p. 67)                                                                                                               |
| replaceunits   | Length units of the replacement mesh. micron, mm, cm, m, in, ft                                                                                                                                                    |

### 33.2.2.1. User Defined Remeshing

Full control over how the replacement mesh is generated is provided by the **User Defined** remeshing option. When this option is used, a user-defined command is required to gather all input data needed for remeshing and for create the replacement mesh file. The CFX-Solver, however, automatically executes the following tasks:

- Import the new mesh into the problem definition
- Interpolate solution data from the previous mesh onto the new mesh
- Repartition the new mesh if a parallel run mode is used
- Restart the equation solution process.

In addition to the required and optional general settings described above, the **User Defined** option requires specification of:

- An **External Command** that is responsible for generating a replacement mesh file
- The name of the **Replacement File**.

The **External Command** is submitted to the operating system for execution. This may be a command to start a mesh (re)generation executable directly with certain inputs, or a shell script that executes several commands. It is important to note that this command is submitted from the current run directory (for example case_001.dir), so care is required when using relative paths to files during remeshing.
Useful inputs to the remeshing process may be extracted from the most recently generated CFX-Solver Results file. For details, see Remeshing Guide in the CFX Reference Guide. This file is located in the run directory, and is simply called res (no prefix or suffix) at the time of submitting the External Command to the operating system.

For additional details, see User Defined Remeshing in the CFX Reference Guide.

33.2.2.2. ANSYS ICEM CFD Replay Remeshing

Remeshing using the ANSYS ICEM CFD mesh generator is highly automated when the ICEM CFD Replay remeshing option is used. This is accomplished by combining settings made in the Flow Analysis (specified on the configuration's General Settings tab) with a batch run of the ANSYS ICEM CFD mesh generator using replay (session) files.

When this option is used the CFX-Solver automatically executes the following tasks:

- Compile a comprehensive remeshing replay file from a combination of provided and user-specified replay files
- Execute the ANSYS ICEM CFD mesh generator in batch mode, using the remeshing replay file
- Import the new mesh into the problem definition
- Interpolate solution data from the previous mesh onto the new mesh
- Repartition the new mesh if a parallel run mode is used
- Restart the equation solution process.

In addition to the required and optional general settings described above, the ICEM CFD Replay option requires specification of:

- An ANSYS ICEM CFD Geometry File (with a tin extension) that contains the reference geometry
- A Mesh Replay File (with an rpl extension) that contains a recording of the steps (that is, the commands) used to generate the mesh in the ANSYS ICEM CFD application.

Additional, optional settings include:

- ICEM CFD Geometry Control definitions
- ICEM CFD Mesh Control definitions
- Scalar Parameter definitions.

For additional details, see ICEM CFD Replay Remeshing in the CFX Reference Guide.

33.2.2.2.1. ICEM CFD Geometry Control

Option settings for ICEM CFD Geometry Control other than None are used to modify the reference geometry contained in the ICEM CFD Geometry File according to the mesh motion specifications defined in the CFX case setup. If the geometry control option is set to Automatic, then one or more ICEM CFD Part Map definitions may be defined. Each definition provides a mapping between:

- An ICEM CFD Parts List, which is a list of parts (or families) defined in the referenced Geometry File
- The translation of the centroid of a Boundary defined in the Flow Analysis.
These definitions are applied, in conjunction with the default geometry control replay file (icemcfde_GeomCtrl.rpl contained the <CFXROOT>/etc/Remeshing directory), to modify the reference geometry prior to regenerating the mesh. If the geometry control option is set to User Defined Replay File, then a File Name is required and the specified file is used instead of the default geometry control replay file.

33.2.2.2. ICEM CFD Mesh Control

Options settings for ICEM CFD Mesh Control other than None are used to set values of some predefined parameters used by ANSYS ICEM CFD during remeshing. If the mesh control option is set to Automatic, then one or more ICEM CFD Part Parameter definitions may be defined. Each definition provides a mapping for an ICEM CFD Parameter that governs mesh attributes like the maximum element size (emax) or the maximum element height (ehgt), between:

- An ICEM CFD Parts List, which is a list of parts (or families) defined in the referenced Geometry File
- A Monitor Point defined in the Flow Analysis.

These definitions are applied in conjunction with the default mesh control replay file (icemcfde_MeshCtrl.rpl contained the <CFXROOT>/etc/Remeshing directory), to modify the reference geometry prior to regenerating the mesh. If the mesh control option is set to User Defined Replay File, then a File Name is required and the specified file is used instead of the default mesh control replay file.

33.2.2.3. Scalar Parameter

Scalar Parameter definitions are used to set values of additional pre- or user-defined parameters referenced in any of the replay files used by ANSYS ICEM CFD during remeshing. Each definition provides a mapping between a scalar parameter used during remeshing (with the same name as the Scalar Parameter definition) and a Monitor Point defined in the Flow Analysis.

The parameters listed in the table below are used in the default geometry control replay file, and become relevant if a Scalar Parameter definition is created with the same name.

### Table 33.2 Scalar Parameters

<table>
<thead>
<tr>
<th>Scalar Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICEM CFD Geometry Scale</td>
<td>The specified scale is used to address length unit differences between the geometry contained in the specified ANSYS ICEM CFD Geometry File and the mesh contained in the CFX-Solver Input file. For example, if the length unit is [mm] in the ANSYS ICEM CFD geometry and [m] in the CFX-Solver Input file, then the geometry scale should be set to 0.001.</td>
</tr>
<tr>
<td>OFFSET X PartName</td>
<td>The specified offset values are added to the centroid displacements (see the discussion on ICEM CFD Geometry Control presented above) that are applied for the part (or family) named PartName. Note that the ICEM CFD Geometry Scale is also applied to the offset specified offset.</td>
</tr>
</tbody>
</table>
33.2.3. Run Definition Tab

The Run Definition tab settings described below apply to a specified configuration in the simulation. You can override these settings for the specific configuration from the Define Run dialog box in the CFX-Solver Manager (for details, see The Define Run Dialog Box in the CFX-Solver Manager User's Guide).

1. Select Initial Values Specification so that you can specify one or more sources of initial values. Note that for cases with multiple configurations, initial values specifications are not valid for Global Settings. For each source of initial values (most runs only require one), do the following:
   a. Click New to create an initial values object.
   b. Select an initial values object from the list and select either the Results File or Configuration Results option for Initial Values > Option.
      1. If you selected the Results File option, then specify the file name of a file from which initial values should be used.
      2. If you selected the Configuration Results option, then specify the name of the configuration from which initial values should be used. Note that this option is only available in the context of multi-configuration simulations. It allows the introduction of dependencies on initial values that will become available at run time.
   c. The Use Mesh From setting determines which mesh is used for the analysis: the one specified in the Solver Input File option, or the one in the Initial Values. The mesh from the Initial Values File can only be used in a limited set of circumstances. See Using the Mesh from the Initial Values File in the CFX-Solver Modeling Guide for details.
   d. Select Continue History From if you want to continue the run history (convergence history, monitor plots, time and time step counters, etc…) and use the smoothest restart possible from the selected Initial Values File. The run will continue from the one contained the specified initial values object. Note that the run history will reset if Continue History From is not selected.

   Full details of the settings can be found in Reading the Initial Conditions from a File in the CFX-Solver Modeling Guide.

2. Set Type of Run to Full or Partitioner Only.
   - Full runs the partitioner if applicable, and then runs Solver.
   - Partitioner Only is used for parallel runs only and does not run Solver. This writes a .par file.

3. Select or clear Double Precision. This setting will determine the default (single or double) precision of the partitioner, solver and interpolator executables. For details on the precision of executables, see Double-Precision Executables in the CFX-Solver Manager User's Guide. The precisions of the partitioner, solver, and interpolator executables can be set individually on the Partitioner, Solver, and Interpolator tabs.

4. Configure the Parallel Environment as required.

5. If required, under Run Environment, set the working directory.

6. If required, select Show Advanced Controls to display other tabs.

Additional information is provided in the next section, Parallel Environment, and in Initial Condition Modeling in the CFX-Solver Modeling Guide.
**Parallel Environment**

For a distributed parallel setup, specify the number of partitions assigned to each host. If choosing a specified partition weighting (under Partitioner), click directly on the partition weight number to edit it. There should be one weight entry per partition.

1. Under **Parallel Environment**, select a **Run Mode**.
2. Configure the mode as required.

Run Mode determines whether the run is serial (the default when defining a run in which a problem solved as one process), or parallel (problem split into partitions).

- A serial run (the default) requires no additional configuration
- To learn how to configure a parallel run, see **Parallel Run in the CFX-Solver Manager User’s Guide**.

### 33.2.4. Partitioner Tab

The **Partitioner Tab** settings described below apply to a specified configuration in the simulation. You can override these settings for the specific configuration from the Define Run dialog box in the CFX-Solver Manager (for details, see **The Define Run Dialog Box in the CFX-Solver Manager User’s Guide**).

Use the **Partitioner** tab to configure the mesh partitioning options.

**Note**

An existing partition file cannot be used if the simulation involves either the Monte Carlo or Discrete Transfer radiation models.

Partitions may be viewed prior to running CFX-Solver. For details, see **CFX Partition File in the CFX-Solver Manager User’s Guide**.

1. Select the **Partitioner** tab.

   If this is not available, ensure Show Advanced Controls is selected in the **Run Definition** tab.

2. If required, under **Initial Partition File**, click **Browse** and select the partition file to load.

   The *par* file is only required if a model has already been partitioned. The number of partitions in the partitioning file must be the same as that selected on the Run Definition tab.

   **Note**

   A partition file generated in ANSYS CFX 11.0 or earlier versions is not supported in ANSYS CFX 12.0. If such a file is used in ANSYS CFX 12.0, then an error message is generated.

3. Under **Run Priority**, select Idle, Low, Standard or High. For a discussion of these priorities, see **The cfx5control Application in the CFX-Solver Manager User’s Guide**.

4. Optionally, set the precision: under **Executable Settings**, select **Override Default Precision** and choose either **Single** or **Double**. This setting for the partitioner will override the corresponding specification, if set, on the **Run Definition** tab.
5. If required, select the **Use Large Problem Partitioner** option, which is available on 64-bit platforms only. This option starts the large problem partitioner which can partition problems up to $2^{31}-1$ elements. This partitioner uses 64-bit integer and logical variables so it will allocate more memory than the default partitioning executable. For details, see Large Problem Partitioner Executables in the *CFX-Solver Manager User's Guide*.

6. Under **Partitioning Detail**, choose a **Partition Type** and configure it. Depending on the selected partition type, various options must be configured. Partition types include:

   - **Multilevel Graph Partitioning Software - MeTiS** in the *CFX-Solver Modeling Guide*. When first running in parallel, it is recommended that **Partition Type** be set to **MeTiS**.
   - **Recursive Coordinate Bisection** in the *CFX-Solver Modeling Guide*
   - **Optimized Recursive Coordinate Bisection** in the *CFX-Solver Modeling Guide*
   - **Directional Recursive Coordinate Bisection** in the *CFX-Solver Modeling Guide*
   - **User Specified Direction** in the *CFX-Solver Modeling Guide*
   - **Simple Assignment** in the *CFX-Solver Modeling Guide*
   - **Radial** in the *CFX-Solver Modeling Guide*
   - **Circumferential** in the *CFX-Solver Modeling Guide*

7. If required, configure the **Partition Weighting** as described below.

8. If required, configure the **Multidomain Option**. You can select from the following options:

   - **Independent Partitioning**: Each domain is partitioned independently into the specified number of partitions.
   - **Coupled Partitioning**: All domains that are connected together are partitioned together. Note that solid domains are still partitioned separately from fluid/porous domains. Coupled partitioning often leads to better scalability, reduced memory requirements, and sometimes better robustness, than independent partitioning because there are fewer partition boundaries.

   For details, see Selection of the Partitioning Mode for Multi-Domain Cases in the *CFX-Solver Modeling Guide*.

   When the coupled partitioning option is activated, you can further choose to set the **Multipass Partitioning** option. The Transient Rotor Stator option is relevant only for simulations having transient rotor stator interfaces. It uses a special multipass algorithm to further optimize the partition boundaries. This approach generates circumferentially-banded partitions adjacent to each transient rotor stator interface, which ensures that interface nodes remain in the same partition as the two domains slide relative to each other. Away from the interface, the partitioning is handled using whichever method is specified for the **Partition Type**.

   Performance of particle transport calculations may be made worse when using coupled partitioning.

9. If required, under **Partitioner Memory**, adjust the memory configuration. For details, see Configuring Memory for the CFX-Solver in the *CFX-Solver Manager User's Guide*.
Partitioning Weighting

As discussed below, partitions can be weighted in different ways. The default setting is Automatic.

- Uniform
- Specified
- Automatic

Uniform

Assigns equal-sized partitions to each process.

Specified

Requires Run Definition to be configured with individual partition weights.

Partition Weights is added to the parallel environment. This allows partition weights to be entered. When more than one partition is assigned to any machine, the number of partition weight entries must equal the number of partitions. The partition weight entries should be entered as a comma-separated list. For a distributed run like the following:

<table>
<thead>
<tr>
<th>Host</th>
<th># of Partitions</th>
<th>Partition Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sys01</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Sys02</td>
<td>2</td>
<td>2, 1.5</td>
</tr>
<tr>
<td>Sys03</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Sys01 is therefore a single partition and the weight is 2. Sys02 has two partitions and they are individually weighted at 2 and 1.5. The final system has a single partition with a weight of 1.

If partition weight factors are used, the ratio of partition weights assigned to each partition controls the partition size.

Once started, the run progresses through the partitioning, and then into the solution of the CFD problem. Extra information is stored in the CFX output file for a parallel run. For details, see Partitioning Information in the CFX-Solver Manager User's Guide.

Automatic

Calculates partition sizes based on the Relative Speed entry specified for each machine in the hostinfo.ccl file.

Machines with a faster relative speed than others are assigned proportionally larger partition sizes. The entry of relative speed values is usually carried out during the CFX installation process, and accurate entries for relative speed can significantly optimize parallel performance.

33.2.5. Solver Tab

The Solver Tab settings described below apply to a specified configuration in the simulation. You can override these settings for the specific configuration from the Define Run dialog box in the CFX-Solver Manager (for details, see The Define Run Dialog Box in the CFX-Solver Manager User's Guide).

1. Select the Solver tab.
If this is not available, ensure Show Advanced Controls in the Run Definition tab is selected.

2. Under Run Priority, select Idle, Low, Standard or High. For a discussion of these priorities as well as how you can change them after the execution of the solver has started, see The cfx5control Application in the CFX-Solver Manager User’s Guide.

3. If required, from Double Precision Override or Executable Settings > Double Precision Override, select or clear Double Precision. This setting for the solver will override the corresponding specification, if set, on the Run Definition tab.

   For details, see Double-Precision Executables in the CFX-Solver Manager User’s Guide.

4. If required, under Solver Memory, adjust the memory configuration. For details, see Configuring Memory for the CFX-Solver in the CFX-Solver Manager User’s Guide.

### 33.2.6. Interpolator Tab

The Interpolator Tab settings described below apply to a specified configuration in the simulation. You can override these settings for the specific flow configuration from the Define Run dialog box in the CFX-Solver Manager (for details, see The Define Run Dialog Box in the CFX-Solver Manager User’s Guide).

1. Select the Interpolator tab.

   If this is not available, ensure Show Advanced Controls in the Run Definition tab is selected.

2. Under Run Priority, select Idle, Low, Standard or High. For a discussion of these priorities, see The cfx5control Application in the CFX-Solver Manager User’s Guide.

3. Optionally, set the precision: under Executable Settings, select Override Default Precision and choose either Single or Double. This setting for the interpolator will override the corresponding specification, if set, on the Run Definition tab.

   For details, see Double-Precision Executables in the CFX-Solver Manager User’s Guide.

4. If required, under Interpolator Memory, adjust the memory configuration. For details, see Configuring Memory for the CFX-Solver in the CFX-Solver Manager User’s Guide.
Chapter 34: Quick Setup Mode

Quick Setup mode is a mode of operation for CFX-Pre that greatly simplifies the physics setup for a case. More complex physics, such as multiphase, combustion, radiation, advanced turbulence models, and so on are not available in Quick Setup mode. You can, however, use Quick Setup mode to get started, and then add more physics details later.

Note

You can switch to Quick Setup mode by selecting Tools > Quick Setup Mode from the main menu.

This chapter describes:
34.1. Starting a New Case in Quick Setup Mode
34.2. Simulation Definition Tab
34.3. Physics Definition
34.4. Boundary Definition
34.5. Final Operations

34.1. Starting a New Case in Quick Setup Mode

To start a new simulation in Quick Setup mode:
1. Start CFX-Pre.
2. Select File > New Case from the main menu.
   - The New Case dialog box appears.
3. Select Quick Setup and click OK.
   - The Simulation Definition area opens.

34.2. Simulation Definition Tab

Under Simulation Definition, you can set the analysis type data, the fluid data, and import a mesh file.

• Simulation Data (p. 319)
• Working Fluid (p. 320)
• Mesh Data (p. 320)

34.2.1. Simulation Data

A short description of each of the Problem Type options is displayed in CFX-Pre.
34.2.1.1. Problem Type

**Problem Type** can be set to any of the following:

- **Single Phase**
  
  Only one fluid is present in a single phase simulation, and it is usually a pure substance.

- **Multi-Component**
  
  If this option is selected, the simulation is used to model the average properties of a mixture of chemical species.

- **Multi-Phase**
  
  This option contains more than one fluid, each of which is modeled separately. In general, unlike multi-component simulations, the fluids are of different chemical species.

34.2.2. Working Fluid

Under **Working Fluid**, you select the fluids for use in the domain.

- **Fluid(s)**
  
  If **Analysis Type** is set to **Single Phase**, you may select only one fluid for the domain. If **Multi-Phase** was chosen, you may select at least two fluids.

- **Mixture**
  
  If you are defining a multi-component simulation, you must provide a name for your custom material, which is defined by the fluids specified under **Components**.

- **Components**
  
  Select the fluids you plan to use in the simulation from this drop-down menu. At least two fluids are required.

34.2.3. Mesh Data

- **Mesh File**
  
  Click **Browse** to open the **Import Mesh** dialog box and search for the mesh file to import.

  The most common mesh file formats can be imported in Quick Setup mode. If other mesh formats, advanced options or user import methods are required, General mode should be used.

  For details, see *Importing and Transforming Meshes* (p. 65).

- **Available Volumes > 3D Regions**
  
  Using the drop-down menu, select the 3D region you want to use for the domain. By default, all 3D regions of mesh from the selected mesh file will be selected.

34.3. Physics Definition

Under **Physics Definition**, you will set the type of simulation and specify model data such as the pressure, heat transfer, and turbulence options.
• Analysis Type (p. 321)
• Model Data (p. 321)

34.3.1. Analysis Type

Select the analysis type: Steady State or Transient.

• Steady State
  
  No further settings are required.

• Transient
  
  If Transient is selected, set the Total Time and Time Step values for the transient simulation.

34.3.2. Model Data

• Reference Pressure
  
  Set a value for the reference pressure. For details, see Setting a Reference Pressure in the CFX-Solver Modeling Guide.

• Heat Transfer
  
  Select the heat transfer model. For details, see Heat Transfer: Option (p. 114).

• Turbulence
  
  Select the turbulence model. For details, see Turbulence: Option (p. 115).

34.4. Boundary Definition

CFX-Pre will automatically create boundary conditions based on name matching criteria, but you can define your own as follows:

1. Right-click in the blank area and select New to create a new boundary condition.
   
   A dialog box will pop up and ask for the name of the boundary condition you want to create.

2. Accept the default name or enter a new name.

3. Click OK.

4. Set Boundary Type to one of: Inlet, Outlet, Symmetry, or Wall.
   
   Opening type boundary conditions are not available using Quick Setup mode.

5. Set the location (2D Region) for the boundary condition.
   
   You may use the Ctrl key to multi-select a group of 2D regions for the single boundary condition.

6. Fill in information specific to the type of boundary condition.
   
   Additional information for a particular setting is available. For details, see Boundary Details Tab (p. 152).

7. Repeat the preceding steps for each remaining boundary condition you want to create.
You may delete any boundary conditions that are not required for the simulation simply by right-clicking the boundary condition in the list and selecting **Delete** from the shortcut menu.

A default boundary condition will be created automatically for any 2D regions on the boundary of the domain, which have not been assigned a boundary condition. By default, the default boundary condition is a no-slip adiabatic wall.

8. Click **Next** to continue.

### 34.5. Final Operations

The final step enables you to select from various options.

---

**Important**

If there are additional settings you need to address that are not covered in Quick Setup mode, you must select **Enter General Mode**. The other two options will automatically write a solver (.def) file based on the settings defined in Quick Setup mode.

1. Select one of these options:
   - **Start Solver** enters General mode, writes the solver (.def) file, and passes it to the CFX-Solver Manager.
   - **Start Solver and Quit** (available in stand-alone mode) writes the solver (.def) file, passes it to the CFX-Solver Manager, and then shuts down CFX-Pre.
   - **Enter General Mode** enters General mode in CFX-Pre.

2. Click **Finish** to exit Quick Setup mode.
Chapter 35: Turbomachinery Mode

Turbo mode in CFX-Pre is a specialist mode allowing you to set up turbomachinery simulations, such as compressors or turbines, in a simple manner. Each component of a rotating machine can be simply defined by selecting a mesh file and some basic parameters and then the boundary conditions and interfaces between the components are automatically generated. In addition to the quick setup, existing turbomachinery simulations can be easily modified to use alternative meshes or to add extra components with minimum effort. Turbo mode is designed to complement ANSYS TurboGrid but supports all the common mesh file formats that are supported in the General mode.

Consider an axial turbine made up of three stages (three stators and three rotors). In a design process you may first want to construct six individual cases in order to check the flow around each individual component. Next you might want to analyze some of the “stator-rotor-stator” portions of the machine, creating three more analysis cases. Once these analyses are complete, you might wish to re-design one of the rotors, and re-create the stator-rotor-stator analysis with the new rotor. Other cases to investigate might include multiple blade passages for some/all components, and ultimately you will want to analyze the entire three stage (six component) machine. Turbo mode is designed to handle all of these cases.

Note

- You can switch to Turbo mode when working on a general simulation by selecting Tools > Turbo Mode at any time during the simulation.
- Turbo Mode is designed specifically for the setup of Turbo cases, so if it is used for unsuitable cases some data may be lost.
- After setting up a turbomachinery simulation in a CFX component system, if you change topology or number of blades in the mesh, then refreshing or updating the CFX Setup cell (directly or indirectly) will fail to propagate the new information correctly. This will lead to incorrect results. To compensate, you can manually correct the number of blades in CFX-Pre by re-entering Turbo Mode (available from the Tools menu). In addition, the boundaries may need to be manually corrected in CFX-Pre.

This chapter describes:
35.1. Starting a New Case in Turbo Mode
35.2. Navigation through Turbo Mode
35.3. Basic Settings
35.4. Component Definition
35.5. Physics Definition
35.6. Interface Definition
35.7. Disturbance Definition
35.8. Boundary Definition
35.9. Final Operations

35.1. Starting a New Case in Turbo Mode

To start a new case in Turbo Mode:
1. Launch CFX-Pre from the ANSYS CFX Launcher.
2. Select File > New Case from the main menu.
3. Select Turbomachinery and click OK.

**Note**

You do not need to specify a file name until the end of Turbo mode, as you will either specify the name for the .def file on the Final Operations panel, or you will return to General mode and make any further required changes to your simulation definition.

### 35.2. Navigation through Turbo Mode

There are a number of buttons available in Turbo mode to navigate through the wizard. In the most part, these behave in the standard manner (that is, Next moves to the following page, Back moves to the previous page, etc.).

The Cancel button:

- Will close Turbo mode (revert back to General mode)
- Will not cause data to be committed, except for any changed component definitions
- Will not delete from the simulation any meshes that have already been imported while in Turbo mode.

### 35.3. Basic Settings

When Turbo mode is first entered, the Basic Settings panel appears.

#### 35.3.1. Machine Type

The machine type can be any one of Pump, Fan, Axial Compressor, Centrifugal Compressor, Axial Turbine, Radial Turbine, or Other. In all cases, as part of the Turbo System functionality, the machine type will be part of the data passed between CFX-Pre and CFD-Post in order to aid workflow.

#### 35.3.2. Axes

The axis of rotation for the turbo component is set relative to the Global Coordinate frame (Coord 0) by default. You can choose a user-specified coordinate frame from the drop-down list or create a new one by selecting . For details, see Coordinate Frames (p. 255). For details, see Coordinate Frames in the CFX-Solver Modeling Guide.

##### 35.3.2.1. Coordinate Frame

Choose a Coordinate Frame or click the to create a new coordinate frame. For details, see Coordinate Frames (p. 255). For details, see Coordinate Frames in the CFX-Solver Modeling Guide.

##### 35.3.2.2. Rotational Axis

Select the rotational axis relative to the chosen coordinate frame.
35.3.2.3. Axis Visibility

Toggle to select the visibility of the axis.

35.3.3. Analysis Type

The analysis type determines whether your problem is Steady State, Transient, or Transient Blade Row. If the problem is transient, set Total Time to the total simulation time and Time Steps to the timestep increment. For example, to study 10 timesteps over 0.1 seconds, set Total Time to 0.1 [s] and Time Steps to 0.01 [s]. If you choose the Transient Blade Row option under Analysis type, you have the option of choosing between the Time Transformation and Fourier Transformation methods under Methods.

For details, see Analysis Type (p. 101).

35.4. Component Definition

The Component Definition panel is used to set up the component names, and import and/or transform the meshes used in the simulation.

35.4.1. Component Selector

Displays the components currently being used in the simulation. Components can be added, removed and altered using the commands available through right-clicking in the component selector area.

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Component</td>
<td>Creates a new component.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes an existing component.</td>
</tr>
<tr>
<td>Move Component Up</td>
<td>Moves the selected component up in the component list.</td>
</tr>
<tr>
<td>Move Component Down</td>
<td>Moves the selected component down in the component list.</td>
</tr>
<tr>
<td>Axial Alignment</td>
<td>Automatically moves meshes, along the axis of rotation, in order to align the inlet and outlet regions.</td>
</tr>
</tbody>
</table>

You must ensure that the components are ordered correctly in the selector from top (inlet end) to bottom (outlet end).

35.4.2. Component Type

If the component is rotating, the angular speed is required under Value. The rotation axis is defined on the Basic Settings panel. For details, see Rotational Axis (p. 324).

35.4.3. Mesh File

Click Browse to assign a mesh file to the selected component. The Import Mesh dialog box will appear requesting the file name, location, and file type. For some file types, the mesh units must be specified; this is indicated by the presence of a Mesh Units dropdown menu. If a mesh file has previously been specified, selecting a new mesh file will result in the original file being deleted and the new mesh
being imported. In addition to this, the **Reload Mesh Files** feature is available in General mode which allows multiple mesh files to be replaced at once. For details, see *Reload Mesh Files Command* (p. 34).

**Note**

The **Reload Mesh Files** feature is not required (and is not available) in CFX-Pre launched from ANSYS Workbench.

If you want to use a mesh volume that has already been imported as part of another component, do not specify a mesh file here and set **Available Volumes > Volumes** to the appropriate region.

### 35.4.4. Passages and Alignment

This section shows the details of the mesh geometry. In the default state, it will display the number of blades in the mesh file and the number in 360 degrees. To change these values click the **Edit** button.

For quick response, the **Preview** button provides immediate feedback of the changes made. Once the correct settings are selected, clicking **Done** will apply the transformation. You can select **Cancel** to discard your latest change or select **Reset** to return all parameters to their default values.

#### 35.4.4.1. Passages/Mesh

**Passages Per Mesh** is an indication of the number of blade passages that exist in the selected mesh file. The value will normally be 1.

#### 35.4.4.2. Passages to Model

This parameter is used to specify the number of passages in the section being modeled. This parameter is optional for most cases except for Transient Blade Row using the Fourier Transformation method. For the Fourier Transformation method, you have to specify at least two passages. This value is used in CFD-Post. For details, see *Fourier Transformation in the CFX-Solver Modeling Guide*.

#### 35.4.4.3. Passages in 360

This parameter is optional and is used to specify the number of passages in the machine. This value is used in CFD-Post.

If this value is not specified it is automatically calculated based on how many copies of the mesh are required for modeling a full 360 degree section.

#### 35.4.4.4. Theta Offset

Rotates the selected mesh, about the rotational axis, through an angle theta. The offset can be a single value or set to an expression by clicking.

#### 35.4.5. Available Volumes

Set **Volumes** to the 3D region(s) that apply for the selected component.

Normally this will not be required—it simply contains all of the mesh volumes for the mesh file specified above. However, if you wish to set up a case where a single mesh file contains the meshes for multiple components, select the appropriate mesh volume here.
35.4.6. Region Information

This section shows the names of the mesh regions that have been recognized as potential boundaries and interfaces. This name matching is done using the template names provided, which can be configured for your particular mesh files as appropriate. If the list of names that is shown is incorrect or incomplete, these can be modified accordingly. In the default case, this data should not need changing.

35.4.7. Wall Configuration

The Wall Configuration settings, which are available only for rotating components, are Tip Clearance at Shroud and Tip Clearance at Hub. A setting of Yes causes the applicable wall (shroud or hub) to be counter-rotating in the rotating frame of reference such that it is stationary in the absolute frame of reference.

Note that each of the settings affects only whether the applicable wall is counter-rotating or not. Thus, in the case of a hub-mounted swiveling blade with a clearance at the hub, it is true that the blade rotates with the hub, and so, for that case, the appropriate setting for Tip Clearance at Hub is No.

The default values for the Wall Configuration settings are Yes for Tip Clearance at Shroud and No for Tip Clearance at Hub.

35.5. Physics Definition

Properties of the fluid domain and solver parameters are specified on the Physics Definition panel.

35.5.1. Fluid

Choose a Fluid from the list. Only one is permitted.

35.5.2. Model Data

35.5.2.1. Reference Pressure

This is used to set the absolute pressure level that all other relative pressure set in a simulation are measured relative to. For details, see Setting a Reference Pressure in the CFX-Solver Modeling Guide.

35.5.2.2. Heat Transfer

This model selection will depend upon the type of fluid you have chosen. For details, see Heat Transfer in the CFX-Solver Modeling Guide.

35.5.2.3. Turbulence

The models available will depend upon the fluid which has been chosen. For details, see Turbulence and Near-Wall Modeling in the CFX-Solver Modeling Guide.

35.5.3. Boundary Templates

Select from one of the commonly used configurations of boundary conditions or choose None. The configurations are listed from the least robust option to the most robust. For details, see Recommended Configurations of Boundary Conditions in the CFX-Solver Modeling Guide.
35.5.4. Interface

Select a default interface type that will be applied to components. This can be modified later on a per-component basis.

35.5.5. Solver Parameters

35.5.5.1. Advection Scheme

For details, see Advection Scheme Selection in the CFX-Solver Modeling Guide.

35.5.5.2. Convergence Control

This option is only available for steady state simulations and determines how the timestep size is used to aid convergence. You can select Automatic (timestep size controlled by the solver) or Physical Timescale (enter a timestep value).

35.5.5.3. Time Scale Option

This option is only available for steady state simulations. The automatic time scale algorithm can be either conservative or aggressive. For details, see Automatic Time Scale Calculation in the CFX-Solver Theory Guide.

35.5.5.4. Max. Coeff. Loops

This option is only available for transient simulations. With a default value of 10, this option determines the maximum number of iterations per timestep. For details, see Max. Iter. Per Step in the CFX-Solver Modeling Guide.

35.6. Interface Definition

Domain interfaces are used to connect multiple assemblies together, to model frame change between domains, and to create periodic regions within and between domains. Domain interfaces are automatically generated based on the region information.

- The list box shows the existing interfaces. You can right-click and select New to create a new interface or Delete to delete an existing one.

- Clicking on an interface from the list allows for the viewing and editing of its properties, including Side 1, Side 2 and Type. For details, see Type (p. 329).

CFX-Pre will automatically attempt to determine the frame change and periodic regions. For details, see Type (p. 329). Such interfaces are named according to the following: for two domains, A and B:

- Internal Interface connection in domain A: A Internal Interface

  **Note**

  For Transient Blade Row cases using the Fourier Transformation method, a new internal interface is created between the two blade passages.

- Periodic connection in domain A: A to A Periodic
• Periodic connection in domain B: B to B Periodic
• Fluid-Fluid interface between domain A and B: A to B <type> or B to A <type>

where <type> can be one of Frozen Rotor, Stage, or Transient Rotor Stator. For details, see Type (p. 329).

35.6.1. Type

The frame change interfaces model the interface between a rotating assembly and a stationary assembly. For details, see Frame Change/Mixing Model in the CFX-Solver Modeling Guide. When the analysis type is steady state, four options are available to model frame change:

• None
• Stage: For details, see Stage in the CFX-Solver Modeling Guide.
• Periodic
• Frozen Rotor: For details, see Frozen Rotor in the CFX-Solver Modeling Guide.

For transient or Transient Blade Row simulations, the following four options are available to model frame change:

• None
• Stage: For details, see Stage in the CFX-Solver Modeling Guide.
• Periodic
• Transient Rotor-Stator: For details, see Transient Rotor-Stator in the CFX-Solver Modeling Guide.

In addition, a frame change interface of type None is created for tip clearance regions and disconnected regions of mesh within a component (for example between an inlet section and a blade section). Periodic interfaces are used in regions where a portion of the flow field is repeated in many identical regions. The flow around a single turbine blade in a rotating machine, or around a single louver in a whole array in a heat exchanger fin are such examples.

35.7. Disturbance Definition

For a Transient Blade Row simulation, the Disturbance Definition panel is used to define the type of disturbance being modeled for the Time Transformation and Fourier Transformation methods.

35.7.1. Type

For both, Time Transformation and Fourier Transformation methods, the following options are available under Disturbance Type:

• Rotor Stator

This option can be applied only when the disturbance originates from a domain interface that uses the Transient Rotor Stator frame change/mixing model.

• Rotational Flow Boundary

Use this option to characterize a disturbance that originates from a boundary condition (for example, an inlet or outlet boundary condition that is specified using one or more CEL expressions that depend on space and time).
For details, see Transient Blade Row Models Tab (p. 239).

35.8. Boundary Definition

The **Boundary Definition** panel is used to set boundary conditions for the remaining surfaces in the simulation.

- The list box shows the existing interfaces. You can right-click and select **New** to create a new interface or **Delete** to delete an existing one.
- The **Flow Specification** options (**Wall Influence On Flow**) vary with the boundary type. For details, see Flow Specification/Wall Influence on Flow (p. 330).

CFX-Pre uses the information gained from domain interfaces and region specification to automatically create the required boundary condition locations, in addition to any template boundary configuration that you have chosen. You can check the definition for each one by clicking on a boundary and viewing the properties displayed. You can change the properties of any of the automatic boundary conditions. You should ensure that you set the parameter values for the inlet and outlet boundary conditions because they will assume default values.

35.8.1. Boundary Data

Specify the boundary type and select the location from the drop-down list. Alternatively, while the **Location** list is active, click in the viewer to directly select the surface.

35.8.2. Flow Specification/Wall Influence on Flow

The options available for **Flow Specification** and **Wall Influence on Flow** will depend on the boundary type. For information on each type of boundary, refer to the relevant section in the Boundary Conditions documentation:

- **Boundary Details: Inlet** (p. 153)
- **Boundary Details: Outlet** (p. 153)
- **Boundary Details: Opening** (p. 154)
- **Boundary Details: Wall** (p. 154)
- **Symmetry Boundary Conditions** (p. 164)

35.9. Final Operations

1. Select one of the following operations:
   - Start Solver enters General mode, writes the solver (.def) file with the specified name and passes it to the CFX-Solver Manager.
   - Start Solver and Quit writes the solver (.def) file with the specified name, passes it to the CFX-Solver Manager and shuts down CFX-Pre. This option is not available when running CFX in ANSYS Workbench.
   - Enter General Mode simply enters General mode without writing any files.

   If you are running CFX-Pre in ANSYS Workbench, the only available option is Enter General Mode. In this case, the solver can be started from ANSYS Workbench.

2. Click **Finish** to exit Turbo mode.
Chapter 36: Library Objects

Model library templates contain CCL physics definitions for complex simulations. Loading a Model Library imports the CCL definition contained in a template file.

Once this is done, a mesh can be imported and the locations of domains, boundaries, and so on can be assigned. Template files are located in `<CFXROOT>/etc/model-templates/` directory (CFX-Pre will open this directory when a new simulation is created in Library mode).

Model libraries are designed to simplify the problem setup of simulations involving complex physics. Once the problem definition is loaded, CFX-Pre enters General mode, allowing changes to any or all parameters.

Selecting **Library Template** from the **New Case** dialog box in CFX-Pre enables you to choose one of the following simulation model templates:

- *Boiling Water* (p. 331)
- *Cavitating Water* (p. 332)
- *Coal Combustion* (p. 332)
- *Comfort Factors* (p. 332)
- Evaporating Drops (see Liquid Evaporation Model in the **CFX-Solver Modeling Guide**)
- *Multigray Radiation* (p. 333)
- Oil Combustion (see Liquid Evaporation Model: Oil Evaporation/Combustion in the **CFX-Solver Modeling Guide**)
- Spray Dryer (see Liquid Evaporation Model: Spray Dryer with Droplets Containing a Solid Substrate in the **CFX-Solver Modeling Guide**)

### 36.1. Boiling Water

The boiling water model template contains domain settings for a simulation modeling the boiling of water. The domain boiling device is specified with two fluids: Water at 100 °C and Water Vapour at 100 °C. Water at 100 °C is the continuous phase and Water Vapour at 100 °C is the dispersed phase. The inhomogeneous multiphase model is employed. For details, see The Inhomogeneous (Interfluid Transfer) Model in the **CFX-Solver Modeling Guide**.

Boiling is modeled by setting the **Mass Transfer** option on the **Fluid Pair Models** tab to **Phase Change** (which uses the Thermal Phase Change model and requires a saturation temperature).

Review all settings applied to the simulation and create suitable boundary conditions. For details, see Thermal Phase Change Model in the **CFX-Solver Modeling Guide**. Initialization data must also be set. For details, see Initial Conditions for a Multiphase Simulation in the **CFX-Solver Modeling Guide**.
36.2. Cavitating Water

The cavitating model template contains domain settings and fluid models for a cavitating flow. The domain cavitating device is specified with two fluids, Water at 25°C and Water Vapour at 25°C. The homogeneous multiphase model is employed. The Homogeneous Model in the CFX-Solver Modeling Guide.

The Rayleigh Plesset model is used to model cavitation in the domain. For details, see Rayleigh Plesset Model in the CFX-Solver Modeling Guide.

Boiling is modeled by setting the Mass Transfer option on the Fluid Pair Models tab to Phase Change (which uses the Thermal Phase Change model and requires a saturation temperature).

Review all settings applied to the simulation and create suitable boundary conditions. For details, see Cavitation Model in the CFX-Solver Modeling Guide.

Initialization data must also be set. For details, see Initial Conditions for a Multiphase Simulation in the CFX-Solver Modeling Guide.

36.3. Coal Combustion

The coal combustion analysis template contains all the material definitions to perform a coal calculation using proximate/ultimate input data. Analysis data is provided for a commonly used coal. The template includes a global single-step devolatilization mechanism, together with materials and reactions for performing NOx calculations, including fuel NOx generation and NO reburn.

Further information on proximate/ultimate analysis is available. For details, see Hydrocarbon Fuel Model Setup in the CFX-Solver Modeling Guide.

36.4. Comfort Factors

There are expressions for calculating Mean Radiant Temperature and Resultant Temperature for use in HVAC simulations. Resultant Temperature is a comfort factor defined in [92]. Two options are available:

- Derive the factors during post-processing, as user scalar variables.
- Compute them as runtime Additional Variables.

This method is best used when the control system depends upon a derived comfort factor. The approach involves using the comfort-factors.ccl library file in CFX-Pre.

Most users are likely to prefer the first option, but sometimes the second option will be required, for example when the model simulates a ventilation system in which the control system depends dynamically on derived comfort factors.

The model library template creates two Additional Variables: PMV (Predicted Mean Vote) and PPD (Predicted Percentage of Dissatisfied), which are comfort factors defined in [93].

A User Fortran routine named usr_pmvppd.F has been developed for computing the values of PMV, and can be found in the etc/model-templates/ directory of your ANSYS CFX installation. The template contains a CCL definition for the user routine named pmvppd, which calls the Fortran routine.
Values for U, V, W, temperature and radiation intensity are passed to the routine and the dimensionless value of \( PMV \) is returned. The value is then used to calculate \( PPD \) based on the formula:

\[
PPD = 100 - 95 \times \exp ( -0.03353 \times PMV^4 - 0.2179 \times PMV^2 )
\] (36–1)

Only a fixed value for humidity for \( PMV \) and \( PPD \) can be used at the present time. The values should be supplied as partial pressure of water vapor.

Radiation and the ISO tables for metabolic rate and clothing thermal resistance are included in the template file, which can be accessed by opening the following file in a text editor:

\(<CFXROOT>/etc/model-templates/comfort-factors.ccl\)

You can also use customized values pertinent to your simulation. Full details are given in the template file itself.

Compiling the routine requires the use of the \texttt{cfx5mkext} utility. For details, see Creating the Shared Libraries in the \textit{CFX-Solver Modeling Guide}.

It is required that an absolute \textbf{Library Path} must be explicitly set to the User Routine. For details, see \textit{User CEL Routines} (p. 293).

### 36.5. Multigray Radiation

The multigray radiation template contains domain settings for a simulation modeling combustion. The domain \textit{combustor} is specified with a methane/air burning mixture. It is solved using the Eddy Dissipation combustion model, the Discrete Transfer thermal radiation model and the Multigray spectral model.

Review all settings applied to the simulation and create suitable boundary conditions. For details, see:

- Combustion Modeling in the \textit{CFX-Solver Modeling Guide}
- Radiation Modeling in the \textit{CFX-Solver Modeling Guide}.

Additional information on multigray radiation is available; for details, see:

- Eddy Dissipation Model in the \textit{CFX-Solver Modeling Guide}
- The Discrete Transfer Model in the \textit{CFX-Solver Modeling Guide}
- Spectral Model in the \textit{CFX-Solver Modeling Guide}. 
Chapter 37: Command Editor Dialog Box

The Command Editor dialog box is a text interface for CFX-Pre and CFD-Post. You can use it to issue commands or to create or modify the CCL that defines the state.

This chapter describes:
37.1. Using the Command Editor
37.2. Performing Command Actions
37.3. Using Power Syntax

37.1. Using the Command Editor

To start the Command Editor:

1. Select Tools > Command Editor. Alternatively, right-click any object that can be modified using the Command Editor and select Edit in Command Editor.
   - If you select Tools > Command Editor, the Command Editor opens and displays the current state regardless of any selection.
     - If the Command Editor dialog box has not been used previously, it will be blank.
     - If the Command Editor dialog box has been used previously, it will contain CCL commands. If you do not want to edit the CCL that appears, click Clear to erase all content.
   - If you right-click an object and select Edit in Command Editor, the CCL definition of the specific object populates the Command Editor automatically. Modify or add parameters as required, then process the new object definition to apply the changes.

2. Click in the Command Editor.

3. Prepare the content of the Command Editor by adding new content, modifying the existing content, or both.

   The types of content that may be prepared are CCL, action commands, and power syntax. Combinations of these types of content are allowed. For details, see:
   - CFX Command Language (CCL) Syntax in the CFX Reference Guide
   - Command Actions in the CFD-Post User's Guide
   - Power Syntax in ANSYS CFX in the CFX Reference Guide.

   Right-click in the Command Editor to access basic editing functions. These functions include Find, which makes a search tool appear at the bottom of the Command Editor dialog box. Enter a search term and click either Next or Previous to search upwards or downwards from the insertion point or text selection. To hide the search tool, press Esc.

4. Click Process.

   The contents are processed: CCL changes will affect CCL object definitions, actions will be carried out, and power syntax will be executed.
Chapter 37: Command Editor Dialog Box

To replace the CCL currently displayed in the Command Editor with CCL in a file:

1. From the Command Editor, right-click Import. The Import CCL dialog is displayed. For details, see Import CCL Command (p. 35)
2. Select the appropriate file.
3. Click Open. Note that independent of the Import Method selection on the Import CCL dialog, the CCL in the Command Editor is always replaced by the CCL loaded from the file.
4. Click Process.

37.2. Performing Command Actions

Many of the operations performed in the user interface can also be driven by processing a command action in the Command Editor. For example, you can delete a domain named Domain1 by processing the following command:

```
>delete /FLOW/DOMAIN:Domain1
```

Command actions are preceded by a prompt consisting of a right angle bracket (>). For details, see Command Actions in the CFD-Post User's Guide.

37.3. Using Power Syntax

Power Syntax (Perl) commands can be issued through the Command Editor. This can be useful when performing repeated operations such as creating multiple objects with similar properties. Any valid power syntax command can be entered in the editor and processed. Power Syntax commands are preceded by a prompt consisting of an exclamation mark (!). For details, see Power Syntax in ANSYS CFX in the CFX Reference Guide.
Index

Symbols
1:1 domain interface type, 145
1D interpolation, 287
3D Viewer, 17
    shortcut menus, 22
toolbar, 19

A
adaptation
    convergence criteria, 247, 249
criteria, 247–248
criteria method, 249
level, 245
maximum number of levels, 250
maximum number of steps, 248
node allocation parameter, 250
number of nodes in adapted mesh, 249
solution variation, 249
step, 245
variation * edge length, 249
Additional Variables
    editor, 275
models, 119
pairs, 125
tensor type, 276
allocation of nodes per step, 250
analysis type, 101
ANSYS
    cdb file mesh import, 69
ANSYS TurboGrid
    importing grids from, 75
argument units
    input, 290
    return, 291
assembly
    mesh, 91
automatic connections, 145
Automatic Transformation Preview, 88

B
batch mode
    in CFX-Pre, 2
bitmap (bmp), 37
blockoff
    retaining during mesh import, 74
body forces, 207
boiling, 125
boiling water model template, 331
boundary
    contour, 163
    profile visualization, 163
    vector, 163
boundary conditions
    and thin surfaces, 141
Basic Settings tab, 150
Boundary Details tab, 152
Boundary Plot Options tab, 163
Boundary Sources tab, 163
default, 149
Fluid Values tab, 157
interface, 163
Solid Values tab, 162
symmetry, 164
working with, 164
boundary label, 27
boundary marker, 27

C
calling name, 294
camera, 27
case file, 14
cavitation
    setting in CFX-Pre, 125
cavitation model template, 332
CEL limitations
    create Design Exploration expressions in CFD-Post, 281
CFD Viewer State (3D), 37
CFX BladeGen
    bg Plus file mesh import, 79
CFX-4 mesh import, 76
CFX-Mesh
    gtm file mesh import, 69
CFX-Pre
    command line flags, 1
    file types, 13
    interface, 3
    macro calculator, 60
    starting, 1
    workspace, 4
CFX-Solver
    def/res file mesh import, 69
CFX-Solver input file
    in CFX-Pre, 14
CFX-TASCflow
    importing mesh from, 74
cfx5dfile, 236
cfx5gtmconv, 93
cloud of points, 288
cmdb files
errors when loading into CFX-Pre, 33
require ANSYS Workbench to be installed, 67
coal combustion analysis template, 332
color
  boundary, 163
  comfort factors, 332
command editor, 335
composite regions, 91
compressibility control, 208
condensation, 125
conditional connection control
  settings, 143
conditional connections
  settings, 143
contour
  boundary, 163
convergence control
  equation class settings, 203
  steady state simulations - iterations, 201
  steady state simulations - timescale control, 201
  transient simulations, 201
convergence criteria
  for mesh adaption, 245, 247, 249
convert 3D region labels, 74
counter-rotating, 154
cylindrical coordinates
  specifying monitor points in, 222

D
default boundary condition, 149
Define Run dialog box, 299, 308
direct domain interface type, 145
domain
  creating, 105
  definition, 105
  topology, 91
domain interfaces
  1:1 connections, 145
  automatic connections, 145
  direct connections, 145
  GGI connections, 145
  one-to-one connections, 145
domain models
  Additional Variables, 275
domains
  using multiple, 106
double buffering, 48
dsdb files
  require ANSYS Workbench to be installed, 67
duplicate node checking, 67

E
elapsed wall clock time control, 200
encapsulated PostScript (eps), 37
equation class settings, 203
evaporation, 125
expressions
  create in CFD-Post for Design Exploration, 281
external magnetic field, 128

F
figure
  changing the definition of, 28
  switching to, 28
figures, 27
file
  quit, 39
file types
  in CFX-Pre, 13
finite slip, 154
fixed composition mixture, 266
fixed mass fraction, 267
flamelet libraries, 272
fluid
  models, 113
fluid domains, 105
fluid polydisperse fluid, 119
fluid specific models, 119
frames
  rotating and stationary, 151
free slip, 154
function name, 290

G
GGI interface type, 145
GridPro/az3000, 79

H
heat transfer
  at walls, 162
heat transfer specification
  wall - heat transfer, 162

I
ICEM CFD, 69
IDEAS Universal, 79
ignore connections, 74
immersed solids
  momentum source scaling factor, 202
import
  mesh, 65
  mesh from - ANSYS cdb file, 69
mesh from - CFX BladeGen bg Plus file, 79
mesh from - CFX-4, 76
mesh from - CFX-Mesh gtm file, 69
mesh from - CFX-Solver def/res file, 69
mesh from - CFX-TASCflow, 74
mesh from - CGNS, 70
mesh from - GridPro/az3000, 79
mesh from - ICEM CFD, 69
mesh from - IDEAS Universal, 79
mesh from - MSC/NASTRAN, 80
mesh from - Patran neutral, 79
mesh from - Pointwise Gridgen, 80
mesh from - user mesh import, 80
Initial Volume Fraction Smoothing, 209
input argument units, 290
interface boundary condition, 163
interpolation
  1D, 287
    cloud of points, 288
interpolation 1D, 287

J
jpeg (jpg), 37
junction box routines, 295

L
label, 27
library name, 294
library objects, 331
library path, 294
light
  moving, 26

M
macro calculator
  in CFX-Pre, 60
marker, 27
mass transfer, 125
material and reaction selector, 259
melting, 125
mesh
  importing, 65
topology, 91
mesh adaption
  basic parameters, 248
  convergence criteria, 247, 249
  maximum number of levels, 250
  number of nodes in adapted mesh, 249
  running in parallel, 246
  solution variation, 249
  variation * edge length, 249
Mesh Adaption Advanced Parameters form, 249
meshes
  importing multiple, 65
mixture
  fixed composition, 266
  variable composition, 267
model library templates, 331
monitor
  objects, 219
  points, 219
monitor points
  specifying cylindrical coordinates in, 222
monitors
  working with, 235
mouse button
  mapping, 24
mouse mapping, 48
move light, 26
moving mesh
  mesh deformation, 113
transient, 235
MSC/Nastran mesh import, 80
multi-step reaction, 271
multicomponent energy diffusion, 207
multigray radiation template, 333
multiphase control, 209
multiple meshes
  importing, 65

N
name
  function, 290
library, 294
New Case dialog box, 2
no slip, 154
node allocation parameter, 250
node removal tolerance, 67

O
objects
  selecting, 26
  visibility of, 18
one-to-one domain interface type, 145
options
  ANSYS CFX-Pre, 42
  common, 47
Outline tree view in CFX-Pre, 5
Output Control panel
  accessing, 213
  overview, 213
P
parallel with mesh adaption, 246
particle injection regions
cone injection velocity, 133
particle user routines, 295
partitioning
coupled, 302, 315
independent, 301, 314
Patran
neutral mesh import, 79
phase change, 125
picking mode, 26
play
  session, 52
png (portable network graphics), 37
Pointwise Gridgen, 80
porosity
  multiplying sources by, 179, 185
Porosity Settings tab, 129
porous domain
  defining, 129
PostScript (ps), 37
ppm (portable pixel map), 37
pressure level information, 207
pressure velocity coupling, 208
primitive regions, 91
profile
  contour, 163
  data format, 165
  vector, 163
ps (PostScript), 37
pure substance, 263
Q
quitting
  from the file menu, 39
R
reaction
  multi-step, 271
reaction editor, 270
reaction selector, 259
recording
  start and stop, 52
regions
  composite, 95, 98
  edit, 96
  primitive, 95–96
  topology, 91
usage, 96
remeshing, 309
  ICEM CFD replay, 311
  user defined, 310
Resultant Temperature comfort factors, 332
retain blockoff, 74
return argument units, 291
rigid body
  rigid body object, 187
  solver control, 204
rotate, 26
rotating, 154
rotating and stationary frames, 151
S
session
  play, 52
  recording a new, 51
session files
  in CFX-Pre, 51
set
  pivot, 26
shortcuts
  for meshes and regions, 81
shortcuts (CFX-Pre), 22
simulation
  creating a new, 2
single step reaction, 270
solid
  side heat transfer coefficient, 162
solid motion, 128
solid timescale control
  steady state simulations, 201
solidification, 125
solution and geometry units, 197
solution units, 197
solver control
  Advanced Options tab, 207
  advection scheme, 199
  basic settings - common settings, 199
  basic settings - steady state, 201
  basic settings - transient, 201
  Basic Settings tab, 199
  body forces, 207
  combustion control, 207
  compressibility control, 208
  convergence criteria, 200
  External Coupling tab, 204
  global dynamic model control, 207
  hydro control, 207
  interpolation scheme, 207
  interrupt control, 200
junction box routine, 200
multicomponent energy diffusion, 207
multiphase control, 209
Particle Control, 204
pressure level information, 207
pressure velocity coupling, 208
temperature damping, 208
thermal radiation control, 207
turbulence control, 207
turbulence numerics, 199
sources
   subdomain, 182
specified shear, 154
start
   recording, 52
stationary and rotating frames, 151
stationary wall boundaries
   requires mesh motion, 228
steady state, 101
steady state simulations
   convergence control - iterations, 201
   convergence control - timescale control, 201
   solid timescale control, 201
stereo viewer
   enabling, 28
stop
   recording, 52
subdomain
   sources, 182
topology, 91
subdomains, 181
   creating, 181
symmetry boundary condition, 164
syntax
   for units, 193
T
tensor type
   of Additional Variable, 276
thermal radiation control, 207
thin surfaces
   and boundary conditions, 141, 150
tools
   command editor, 335
   Outline tree view in CFX-Pre, 5
topology
   for domains and subdomains, 91
   transient, 101
transient blade row models object, 239
transient results, 215
transient scheme
   transient simulations, 201
transient simulations
   convergence control, 201
   transient scheme, 201
transient statistics
   working with, 233
Transient Statistics tab
   accessing, 217
translate (viewer control), 25
TurboPre
   importing grids from, 76
U
units
   input argument, 290
   return argument, 291
strings, 193
syntax, 193
user defined, 197
user
   mesh import, 80
user CEL function, 293
user function editor, 287
user function selector, 293
user routines, 293
V
variable composition mixture, 267
vector
   boundary profile visualization, 163
view
   changing the definition of, 28
   switching to, 28
viewer
   accessing, 17
   keys, 23
   shortcuts (CFX-Pre), 22
   toolbar, 19
views, 27
Volume Fraction Coupling, 209
vrml (virtual reality modelling language), 37
VRML viewer
   Cortona viewer is supported, 37
W
wall
   counter-rotating, 154
   finite slip, 154
   free slip, 154
   heat transfer, 162
   no slip, 154
   rotating, 154
specified shear, 154
wrl (vrml file extension), 37

Z
zoom (viewer control), 25
zoom box (viewer control), 25